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1. O

verview

N
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e and Function of Parts
Power Supply
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1. 
LIG

H
T (video light) sw

itch
D

eterm
ines how

 a video light connected to the 
LIG

H
T connector (page 4) is turned on and off.

AU
TO

: W
hen the PO

W
ER sw

itch of the video light 
is in the on position, the video light is turned 
on autom

atically w
hile the cam

corder is 
recording.

M
AN

U
AL: You can turn the video light on or off 

m
anually, using its ow

n sw
itch.

[N
ote]

W
hen the cam

corder is set for recording in Picture Cache 
m

ode, it is not possible to turn on the light before operation 
to start recording is carried out (or w

hile data is being stored 
in m

em
ory).

2. 
PO

W
ER sw

itch
Turns the m

ain pow
er supply on (Ò) and off (Æ

).

3. 
D

C IN
 (D

C pow
er input) connector (XLR type, 

4-pin, m
ale)

4. 
D

C O
U

T 12V (D
C pow

er output) connector 
(4-pin, fem

ale)
Supplies pow

er for an optional W
RR-

855S/860C/861/862 U
H

F Synthesizer D
iversity 

Tuner or H
D

VF-L750 View
finder (m

axim
um

 1.8 A).

[N
ote]

D
o not connect any equipm

ent other than the U
H

F 
synthesized diversity tuner.

5. 
Battery attachm

ent shoe
Attach a BP-FLX75 Battery Pack. Alternatively, 
you can attach an AC-D

N
2B/D

N
10 AC Adaptor to 

operate the cam
corder from

 an AC pow
er supply.

“Preparing a Pow
er Supply” (page 22)

“Attaching a W
ireless Receiver” (page 28)

[N
ote]

For your safety, and to ensure proper operation of the 
cam

corder, Sony recom
m

ends the use of the BP-FLX75 
Battery Pack.

6. 
Cam

era adaptor connector
Enables connection of a CA-TX70/FB70 H

D
 Cam

era 
Adaptor. To connect an adaptor, rem

ove the 
cover.
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1. 
W

ireless receiver insertion slot

2. 
Shoulder strap fitting (page 29)

3. 
Accessory shoe (page 29)

4. 
View

finder front-to-back positioning lever 
(page 24)

5. 
View

finder left-to-right positioning ring 
(page 23)

6. 
View

finder attachm
ent shoe (page 23)

7. 
VF (view

finder) connectors (26-pin, 
rectangular and 20-pin, round)

The analog interface connector (20-pin) is for 
connection of an H

D
VF series view

finder, and 
the digital interface connector (26-pin) is for 
connection of a CBK-VF02 H

D
 view

finder.
Connect a view

finder connection cable to the 
connector com

patible w
ith the view

finder being 
used.

[N
ote]

D
o not connect view

finders to both connectors at the sam
e 

tim
e.

8. 
Lens m

ount securing rubber
After locking the lens in position using the lens 
locking lever, fit this rubber over the low

er of 
the tw

o projections. This fixes the lens m
ount, 

preventing it from
 com

ing loose.

9. 
View

finder front-to-back positioning knob 
(page 23)

10. Attachm
ent for optional m

icrophone holder 
(page 28)

11. LIG
H

T (video light) connector (2-pin, fem
ale) 

(page 29)

12. Shoulder pad (page 29)

13. Lens cable clam
p

Clam
ps the lens cable.

14. M
IC IN

 (m
icrophone input) (+48 V) connector 

(XLR type, 5-pin, fem
ale)

Connect a stereo m
icrophone to this connector. 

The pow
er (+48 V) is supplied via this connector.

15. LEN
S connector (12-pin) (page 26)

[N
ote]

W
hen connecting or disconnecting the lens cable to this 

connector, pow
er off the cam

corder first.

16. Tripod m
ount

W
hen using the cam

corder on a tripod, attach the 
tripod adaptor (optional).

17. Lens m
ount (special bayonet m

ount) 
(page 26)

18. Lens locking lever (page 26)

19. Lens m
ount cap

Rem
ove by pushing the lens locking lever up. 

W
hen no lens is m

ounted, keep this cap fitted for 
protection from

 dust.

Controls Near the Lens

1

3456
21. 

REC START (recording start) button
Press to start recording. Press it again to stop 
recording. The operation is the sam

e as that of the 
VTR button on the lens.

2. 
SH

U
TTER sw

itch
Set to O

N
 to use the electronic shutter. Push to 

SELECT to sw
itch the shutter speed or shutter 

m
ode setting. W

hen this sw
itch is operated, the 

new
 setting appears on the view

finder screen for 
about three seconds.

“Setting the Electronic Shutter” (page 39)
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[N
ote]

If Flash Band Reduce is on, setting the SH
U

TTER sw
itch 

to O
N

 turns off the Flash Band Reduce function and the 
FBR indicator disappears from

 the view
finder screen. 

Subsequently, setting the SH
U

TTER sw
itch to O

FF turns 
on the Flash Band Reduce function and the FBR indicator 
reappears on the view

finder screen.

3. 
FILTER knob

Sw
itches betw

een four N
D

 filters built into this 
cam

corder.

W
hen this selector is used, the new

 setting 
appears on the view

finder screen for about three 
seconds.

FILTER knob 
setting

N
D

 filter

1
CLEAR

2
1/4 N

D
 (attenuates light to 

approxim
ately 1/4)

3
1/16 N

D
 (attenuates light to 

approxim
ately 1/16)

4
1/64 N

D
 (attenuates light to 

approxim
ately 1/64)

You can change a M
aintenance m

enu setting so 
that different w

hite balance settings can be stored 
for different FILTER knob positions. This allow

s you 
to autom

atically obtain optim
um

 w
hite balance 

for the current shooting conditions in linkage w
ith 

the filter selection.

“Adjusting the W
hite Balance” (page 37)

4. 
M

EN
U

 knob (page 86)

5. 
AU

TO
 W

/B BAL (autom
atic w

hite/black 
balance adjustm

ent) sw
itch

Activates the autom
atic w

hite/black balance 
adjustm

ent functions.
W

H
ITE: Adjust the w

hite balance autom
atically. 

If the W
H

ITE BAL sw
itch (page 6) is set 

to A or B, the w
hite balance setting is stored 

in the corresponding m
em

ory. If the W
H

ITE 
BAL sw

itch is set to PRST, the autom
atic 

w
hite balance adjustm

ent function does not 
operate.

BLACK: Adjust the black set and black balance 
autom

atically.
You can use the AU

TO
 W

/B BAL sw
itch even w

hen 
the ATW

 (Auto Tracing W
hite Balance) function is 

operating.
If you push the sw

itch to the W
H

ITE side once 
m

ore during the autom
atic w

hite balance 
adjustm

ent, the adjustm
ent is canceled and 

the w
hite balance setting returns to the original 

setting.
If you push the sw

itch to the BLACK side once 
m

ore during the autom
atic black balance 

adjustm
ent, the adjustm

ent is canceled and 
the black balance setting returns to the original 
setting.

6. 
M

IC (m
icrophone) LEVEL knob (page 43)

LCD Monitor Side (1)

6
7
8
9

2
1

10
12

12

1314

11

3
4

5
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1. 
ASSIG

N
. (assignable) 1/2/3 sw

itches
You can assign a function using O

peration 
>Assignable Sw

itch in the setup m
enu 

(page 114).
The ASSIG

N
. 1/3 sw

itches are provided w
ith an 

indicator to show
 w

hether a function is assigned 
to the sw

itch (O
N

) or not (O
FF).

2. 
O

N
LIN

E button
W

hen netw
ork client m

ode or the stream
ing 

function is assigned to this button, press and hold 
until the indicator is lit orange. Then, press the 
button again, turning the indicator blue, to enable 
netw

ork client m
ode or the stream

ing function.
To exit the enabled function, press and hold the 
button until the indicator turns off.
The button can also be used as an assignable 
sw

itch w
hen assigned w

ith functions other than 
those above (page 115).

3. 
ALARM

 (alarm
 tone volum

e adjustm
ent) 

knob
Controls the volum

e of the w
arning tone that 

is output via the built-in speaker or optional 
earphones. W

hen the knob is turned to the 
m

inim
um

 position, no sound can be heard.
H

ow
ever, if M

aintenance >Audio >M
in Alarm

 
Volum

e in the setup m
enu is set to [Set], the alarm

 
tone is audible even w

hen this volum
e control is at 

the m
inim

um
 position.

A
LA

RM

M
inim

um
M

axim
um

4. 
M

O
N

ITO
R (m

onitor volum
e adjustm

ent) 
knob

Controls the volum
e of the sound other than the 

w
arning tone that is output via the built-in speaker 

or earphones. W
hen the knob is turned to the 

m
inim

um
 position, no sound can be heard.

5. 
M

O
N

ITO
R (audio m

onitor selection) sw
itches

By m
eans of com

binations of the tw
o sw

itches, 
you can select audio that you w

ant to hear 
through the built-in speaker or earphones.

W
hen the low

er sw
itch is set to CH

-1/2

U
pper sw

itch
Audio output

CH
-1/CH

-3
Channel 1 audio

M
IX

Channels 1 and 2 m
ixed audio 

(stereo)  a)

CH
-2/CH

-4
Channel 2 audio

W
hen the low

er sw
itch is set to CH

-3/4

U
pper sw

itch
Audio output

CH
-1/CH

-3
Channel 3 audio

M
IX

Channels 3 and 4 m
ixed audio 

(stereo)  a)

CH
-2/CH

-4
Channel 4 audio

a)  By connecting stereo headphones to the EARPH
O

N
E jack, 

you can hear the audio in stereo. (M
aintenance >Audio 

>H
eadphone O

ut in the setup m
enu m

ust be set to 
Stereo.)

6. 
ASSIG

N
. (assignable) 0 sw

itch
You can assign a function using O

peration 
>Assignable Sw

itch in the setup m
enu 

(page 114).
O

ff is assigned to these sw
itches w

hen the 
cam

corder is shipped from
 the factory.

This is a m
om

entary type sw
itch. Each press of the 

sw
itch turns the function assigned to this sw

itch 
on or off.

7. 
G

AIN
 sw

itch
Sw

itches the gain of the video am
plifier to m

atch 
the lighting conditions during shooting. The gain 
values corresponding to the L, M

, and H
 settings 

can be selected using O
peration >G

ain Sw
itch in 

the setup m
enu (page 94) (factory settings are 

L=0 dB, M
=6 dB, and H

=12 dB).
W

hen this sw
itch is adjusted, the new

 setting 
appears on the view

finder screen for about three 
seconds.

8. 
O

U
TPU

T/D
CC (output signal/dynam

ic 
contrast control) sw

itch
Sw

itches the video signal output from
 the cam

era 
m

odule, betw
een the follow

ing tw
o.

BARS: O
utput the color bar signal.

CAM
: O

utput the video signal being shot. W
hen 

this is selected, you can sw
itch D

CC
 1) on and 

off.
1)  D

CC (D
ynam

ic Contrast Control): Against a very bright 
background w

ith the iris opening adjusted to the subject, 
objects in the background w

ill be lost in the glare. The 
D

CC function w
ill suppress the high intensity and restore 

m
uch of the lost detail. It is particularly effective for 

shooting in the follow
ing cases.

ˎˎ Shooting people in the shade on a sunny day
ˎˎ Shooting a subject indoors, against a background 

through a w
indow

ˎˎ Any high contrast scene

9. 
W

H
ITE BAL (w

hite balance m
em

ory) sw
itch

Controls adjustm
ent of the w

hite balance.
PRST: Adjust the color tem

perature to the preset 
value (the factory default setting: 3200K). U

se 
this setting w

hen you have no tim
e to adjust 

the w
hite balance.

A or B: Recall the w
hite balance adjustm

ent 
settings already stored in A or B. Push the 
AU

TO
 W

/B BAL sw
itch (page 5) to the 

W
H

ITE position to autom
atically adjust the 

w
hite balance and save the adjustm

ent 
settings in m

em
ory A or m

em
ory B.

B (ATW
 1)):W

hen this sw
itch is set to B and 

O
peration >W

hite Setting >W
hite Sw

itch 
<B> is set to [ATW

] in the setup m
enu, ATW

 is 
activated.  
You can use the AU

TO
 W

/B BAL sw
itch even 

w
hen ATW

 is in use.  
W

hen this sw
itch is adjusted, the new

 setting 
appears on the view

finder screen for about 
three seconds.

1)  ATW
 (Auto Tracing W

hite balance): The w
hite balance 

of the picture being shot is adjusted autom
atically for 

varying lighting conditions.

[N
ote]

It m
ay not be possible to adjust to the appropriate colors 

using ATW
, depending on the lighting and subject 

conditions.

Exam
ples:

ˎˎ W
hen a single color dom

inates the subject, such as sky, 
sea, ground, or flow

ers. 
ˎˎ W

hen the subject is under a light source of extrem
ely 

high or extrem
ely low

 color tem
perature. 

If execution of autom
atic tracing by the ATW

 
function takes an unacceptably long tim

e or only 
results in an inadequate effect, then execute the 
AW

B function.

10. Sw
itch cover

O
pen this cover to use the M

EN
U

 O
N

/O
FF sw

itch 
or the M

EN
U

 CAN
CEL/PRST/ESCAPE sw

itch.

11. M
EN

U
 O

N
/O

FF sw
itch

To use the sw
itch, open the cover.

This sw
itch is used to display the m

enu on the 
view

finder screen or the test signal screen. Each 
tim

e the sw
itch is pushed dow

n, the m
enu screen 

is turned on and off.
The function of this sw

itch is the sam
e as that 

of the M
EN

U
 button in the thum

bnail screen 
operations section.

[N
ote]

It is not possible to turn off the m
enu screen by closing the 

cover.

12. M
EN

U
 CAN

CEL/PRST (preset) /ESCAPE sw
itch

To use the sw
itch, open the cover.

This sw
itch has different functions depending on 

w
hether or not a m

enu is displayed.

U
se the sw

itch in the follow
ing w

ay w
hen the 

m
enu is displayed.

CAN
CEL/PRST: Pushing this sw

itch up to this 
position after a setting is changed in the 
setup m

enu displays the m
essage to confirm

 
w

hether the previous settings are canceled. 
Pushing this sw

itch up to this position again 
cancels the previous settings.  
Pushing this sw

itch up to this position before a 
setting is changed in the setup m

enu or after a 
setting change is canceled in the setup m

enu 
displays the m

essage to confirm
 w

hether the 
setting is reset to the initial value. Pushing 
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this sw
itch up to this position again resets the 

settings to the initial value.
ESCAPE: U

se this sw
itch w

hen the m
enu page, 

w
hich has a hierarchical structure, is opened. 

Each tim
e the sw

itch is pushed to this position, 
the page returns to one stage higher in the 
hierarchy.

U
se the sw

itch in the follow
ing w

ay w
hen the 

m
enu is not displayed.

CAN
CEL/PRST: Each tim

e this sw
itch is pushed 

upw
ard, a w

indow
 to confirm

 the m
enu 

settings and status of the cam
corder appears 

on the view
finder screen (page 13). The 

w
indow

 consists of several pages, w
hich are 

sw
itched each tim

e the sw
itch is pushed 

upw
ard.

ESCAPE: To clear the page, push this sw
itch dow

n 
to the O

FF position.

13. U
TILITY SD

 card slot
Insert an SD

 card for saving cam
corder settings.

14. ACCESS indicator
Lights up orange w

hen the SD
 card is being 

accessed.

LCD Monitor Side (2)

12

7
8

935 46

13

10

14
15

16
17

[1]
[2]

11
12

1. 
Built-in speaker

The speaker can be used to m
onitor E-E

 1) sound 
during recording, and playback sound during 
playback. The speaker also sounds alarm

s to 
reinforce visual w

arnings (page 133).
If you connect earphones to the EARPH

O
N

E jack, 
the speaker output is suppressed autom

atically.
1)  E-E: Abbreviation of “Electric-to-Electric.” In E-E m

ode, 
video and audio signals input to the cam

corder are 
output after passing through internal electric circuits only. 
This can be used to check input signals.

2. 
LCD

 m
onitor

D
isplays rem

aining battery capacity, rem
aining 

m
edia capacity, audio levels, tim

e data, and so on. 
It also allow

s you to check cam
era and playback 

pictures (page 13).
You can adjust the position and angle of the LCD

 
m

onitor.

3. 
W

ARN
IN

G
 indicator

Lights up or flashes w
hen an abnorm

ality occurs 
(page 133).

4. 
ACCESS indicator

Lights up in blue w
hen data is w

ritten to or read 
from

 the recording m
edia.

5. 
Audio control section (page 9)

6. 
Thum

bnail screen operation section (page 9)

7. 
F REV (fast reverse) button and indicator

This plays back at high speed in the reverse 
direction. The playback speed changes in the order 
×4 �

 ×15 �
 ×24 w

ith each press of the button. 
The indicator lights during high-speed playback in 
the reverse direction.
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8. 
PLAY/PAU

SE button and indicator
Press this button to view

 playback video im
ages 

using the view
finder screen or the LCD

 m
onitor. 

The indicator lights during playback.
Press this button again during playback to pause, 
outputting a still im

age. At this tim
e the indicator 

flashes at a rate of once per second.
Pressing the F REV or F FW

D
 button during 

playback or pause starts high speed playback in 
the forw

ard or reverse direction.

9. 
F FW

D
 (fast forw

ard) button and indicator
This plays back at high speed in the forw

ard 
direction. The playback speed changes in the order 
×4 �

 ×15 �
 ×24 w

ith each press of the button. 
The indicator lights during high-speed playback in 
the forw

ard direction.

10. PREV (previous) button
This jum

ps to the first fram
e of the current clip.

If you press this together w
ith the F REV button, 

the jum
p is to the first fram

e of the first recorded 
clip on the recording m

edia.
If you press this button tw

ice in rapid succession, 
the jum

p is to the first fram
e of the preceding 

clip (or the first fram
e of the current clip w

hen no 
preceding clips exist).

11. STO
P button

Press this button to stop playback.

12. N
EXT button

This jum
ps to the first fram

e of the next clip.
If you press this together w

ith the F FW
D

 button, 
the jum

p is to the last fram
e of the last recorded 

clip on the recording m
edia.

13. D
ISP SEL (display selection)/EXPAN

D
 

(expand function) button
W

ith each press of this button, the display in the 
LCD

 m
onitor changes as follow

s.

D
isplay indication

D
escription

Video w
ith 

superim
posed 

inform
ation (CH

AR)

The LCD
 m

onitor displays 
the sam

e text inform
ation as 

the view
finder.

D
isplay indication

D
escription

Video w
ithout 

superim
posed 

inform
ation (M

O
N

I)

O
nly the video appears.

Status display 
(STATU

S)
Counter indications, 
w

arnings, audio levels, and 
sim

ilar inform
ation appear. 

N
o video im

age appears.

The EXPAN
D

 button function w
ill be supported in 

a future upgrade.

14. H
O

LD
 (display hold) button

Pressing this button instantly freezes the tim
e 

data displayed in the LCD
 m

onitor. (The tim
ecode 

generator continues running.) Pressing this button 
again releases the hold.

For details about the tim
e data display, see page 13.

15. RESET/RETU
RN

 button
Resets the value show

n in the tim
e data display in 

the LCD
 m

onitor. According to the settings of the 
PRESET/REG

EN
/CLO

CK sw
itch (page 9) and the 

F-RU
N

/SET/R-RU
N

 sw
itch (page 9), this button 

resets the display as follow
s.

Sw
itch settings

RESET/RETU
RN

 button 
operation

D
ISPLAY sw

itch:
CO

U
N

TER
Reset counter to 00:00:00:00.

D
ISPLAY sw

itch:
TC

PRESET/REG
EN

/
CLO

CK sw
itch:

PRESET
F-RU

N
/SET/R-RU

N
 

sw
itch:

SET

Reset tim
ecode to 

00:00:00:00.

Sw
itch settings

RESET/RETU
RN

 button 
operation

D
ISPLAY sw

itch:
U

-BIT
PRESET/REG

EN
/

CLO
CK sw

itch:
PRESET

F-RU
N

/SET/R-RU
N

 
sw

itch:
SET

Reset user bits data
 a) to 

00:00:00:00.

a)  O
f the tim

ecode bits for every fram
e recorded on the 

m
edia, those bits w

hich can be used to record useful 
inform

ation for the user such as scene num
ber, shooting   

place, etc.

“Setting Tim
e D

ata” (page 45)

This button returns to the previous screen w
hen 

pressed during thum
bnail screen display or 

essence m
ark thum

bnail screen display.

16. D
ISPLAY sw

itch
This cycles the data displayed in the tim

e data 
display in the LCD

 m
onitor through the sequence 

CO
U

N
TER, TC, and U

-BIT (page 13).
CO

U
N

TER: D
isplay recording/playback duration 

counter.
TC: D

isplay tim
ecode.

U
-BIT: D

isplay user bits data.

17. BRIG
H

T (brightness) button
Sw

itches the brightness of the LCD
 m

onitor 
backlight.
Each press of the button selects the next setting in 
the order show

n in the follow
ing table. If you press 

the button w
ith the LCD

 m
onitor off, the LCD

 
backlight com

es on in the H
 state.

Setting
LCD

 m
onitor backlight

H
H

igh (select this to view
 the LCD

 
m

onitor outdoors in the daytim
e)

M
Brightness betw

een H
 and L

L
Low

 (select this to view
 the LCD

 
m

onitor indoors or outdoors at night)
O

FF
O

ff (the display is also off)
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Thumbnail screen operations section and audio control section

1
2

3
5

8

6

9
1011

12

7
4

1. 
Thum

bnail indicator
This lights w

hen the thum
bnail screen is displayed.

2. 
TH

U
M

BN
AIL button

Press this button to display the thum
bnail 

screen (page 78) and to carry out a thum
bnail 

operation.
Press once m

ore to return to the original display.

3. 
SET button and arrow

 buttons
U

se these buttons to m
ake tim

ecode and user bit 
settings, and for thum

bnail screen operations.
W

hen the m
enu is displayed, press this button to 

select an item
 or to confirm

 the setting change.

4. 
M

EN
U

 button
Each press of this button turns the setup m

enu 
display on and off.
The function of this button is the sam

e as that of 
the M

EN
U

 O
N

/O
FF sw

itch.

5. 
F-RU

N
/SET/R-RU

N
 (free run/set/recording 

run) sw
itch

Selects the operating m
ode of the internal 

tim
ecode generator. The operating m

ode is set 
as explained below

, depending on the position of 
the sw

itch.

F-RU
N

: Tim
ecode keeps advancing, regardless of 

w
hether the cam

corder is recording. U
se this 

setting w
hen synchronizing the tim

ecode w
ith 

external tim
ecode.

SET: Sets the tim
ecode or user bits.

R-RU
N

: Tim
ecode advances only during recording. 

U
se this setting to have a consecutive 

tim
ecode on the recording m

edia.

“Setting the Tim
ecode” (page 45)

“Setting the User Bits” (page 45)

6. 
LEVEL CH

1/CH
2/CH

3/CH
4 (audio channel 

1/2/3/4 recording level) knobs
Adjust the audio levels to be recorded on channels 
1, 2, 3, and 4 w

hen the AU
D

IO
 SELECT CH

1/CH
2 

and AU
D

IO
 SELECT CH

 3-4 sw
itches are set to 

M
AN

U
AL.

7. 
AU

D
IO

 SELECT CH
 3-4 (audio channel 3/4 

adjustm
ent m

ethod selection) sw
itches

Select the audio level adjustm
ent m

ethod for 
audio channels 3 and 4.
AU

TO
: Autom

atic adjustm
ent

M
AN

U
AL: M

anual adjustm
ent

8. 
ESSEN

CE M
ARK button

By pressing this button w
hen a thum

bnail display 
is on the screen, you can view

 the follow
ing 

thum
bnail displays of the essence-m

arked fram
es 

of the selected clip, depending on the item
 

selected in a list displayed on the screen.
All: Thum

bnail display of all fram
es m

arked w
ith 

essence m
arks.

Rec Start: Thum
bnail display of fram

es m
arked 

w
ith Rec Start m

arks and of the first fram
es of 

clips (w
hen the first fram

es are not m
arked 

w
ith Rec Start m

arks).
Shot M

ark1: Thum
bnail display of the fram

es 
m

arked w
ith Shot M

ark 1.
Shot M

ark2: Thum
bnail display of the fram

es 
m

arked w
ith Shot M

ark 2.
You can also select Shot M

ark 0 and Shot M
ark 3 to 

Shot M
ark 9.

If a clip is recorded using planning m
etadata that 

defines nam
es for shot m

ark 0 to shot m
ark 9, the 

selection options in the list are displayed by the 
defined nam

es.

9. 
SH

IFT button
U

se this in com
bination w

ith other buttons.

10. PRESET/REG
EN

 (regeneration)/CLO
CK sw

itch
Selects the type of tim

ecode to record.
PRESET: Record new

 tim
ecode on the m

edia.
REG

EN
: Record tim

ecode continuous w
ith the 

existing tim
ecode recorded on the m

edia. 
Regardless of the setting of the F-RU

N
/SET/R-

RU
N

 sw
itch, the cam

corder operates in R-RU
N

 
m

ode.
CLO

CK: Record tim
ecode synchronized to the 

internal clock. Regardless of the setting of 
the F-RU

N
/SET/R-RU

N
 sw

itch, the cam
corder 

operates in F-RU
N

 m
ode.

11. AU
D

IO
 SELECT CH

1/CH
2 (audio channel 1/2 

adjustm
ent m

ethod selection) sw
itches

Select the audio level adjustm
ent m

ethod for 
audio channels 1 and 2.
AU

TO
: Autom

atic adjustm
ent

M
AN

U
AL: M

anual adjustm
ent

12. AU
D

IO
 IN

 CH
1/CH

2/CH
3/CH

4 (audio channel 
1/2/3/4 input selection) sw

itches
Select the audio input signals to be recorded on 
audio channels 1, 2, 3 and 4.
FRO

N
T: Audio input signals from

 the m
icrophone 

connected to the M
IC IN

 connector
REAR: Audio input signals from

 an audio device 
connected to the AU

D
IO

 IN
 CH

-1/CH
-2 

connectors
W

IRELESS: Audio input signals from
 the U

H
F 

portable tuner if it is attached
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Handle and Memory Card Slot Side

10

13
14

11
12

1

7

2
3

4
5

6

9
8

SxS m
em

ory card slots (page 30)

1. 
ASSIG

N
ABLE 4/5 sw

itches
You can assign a function using O

peration 
>Assignable Sw

itch in the setup m
enu 

(page 115).

O
ff is assigned to these sw

itches w
hen the 

cam
corder is shipped from

 the factory.

2. 
G

PS m
odule

Contains a built-in G
PS m

odule.

[N
ote]

D
o not grasp this part of the cam

corder w
hen the G

PS 
function is in use.

3. 
PC connector

U
sed to put this cam

corder into U
SB connection 

m
ode and use it as an external storage device 

for a com
puter. W

hen a com
puter is connected 

to this connector, every m
em

ory card inserted 
in the cam

corder is recognized as a drive on the 
com

puter.

4. 
External device connector

Connect to a PSZ-H
A50 Portable Storage H

D
D

 
(option), PSZ-SA25 Portable Storage SSD

 (option), 
a general-purpose external U

SB H
D

D
, or U

SB flash 
drive to copy clips from

 the recording m
edia 

inserted in an SxS card slot of the cam
corder to 

U
SB m

edia.

[N
ote]

This connector should be used only for connecting the type 
of devices above. It cannot be used for connecting a U

SB 
hub or other devices.

5. 
U

SB w
ireless LAN

 m
odule connector

Connect to an IFU
-W

LM
3 U

SB W
ireless LAN

 
M

odule (supplied), CBK-W
A02 W

ireless LAN
 

Adaptor (option), or com
bination of CBK-N

A1 
N

etw
ork Adaptor Kit (option) and m

odem
 (option) 

to enable com
m

unications w
ith w

ireless LAN
 

devices and netw
orks.

“Connecting D
evices using W

ireless LAN” (page 59)

“Connecting to the Internet” (page 63)

6. 
PRO

XY SD
 card slot (page 53)

Insert an SD
 card for recording proxy data.

7. 
 (N

FC) m
ark 

A built-in N
FC antenna is provided.

8. 
SLO

T SELECT (SxS m
em

ory card select) 
button

W
hen SxS m

em
ory cards are loaded in both card 

slots A and B, press this button to select the card 
you w

ant to use (page 30).

9. 
N

etw
ork connector 

Connects to a netw
ork via a w

ired LAN
 connection 

using a LAN
 cable (sold separately).

[CAU
TIO

N
]

ˎˎ For safety, do not connect the connector for peripheral 
device w

iring that m
ight have excessive voltage to this 

port. 
Follow

 the instructions for this port. 
ˎˎ W

hen you connect the LAN
 cable of the unit to peripheral 

device, use a shielded-type cable to prevent m
alfunction 

due to radiation noise.

“Connecting to the Internet” (page 63)

10. H
D

M
I connector

Connect an H
D

M
I device, such as a m

onitor or 
recording unit, to output H

D
 or SD

 H
D

M
I video 

and audio signals.

11. G
EN

LO
CK IN

 (genlock signal input) 
connector (BN

C type)
This connector inputs a reference signal w

hen the 
cam

corder is to be genlocked or w
hen tim

ecode 
is to be synchronized w

ith external equipm
ent. 

The supported reference signals vary depending 
on the current system

 frequency as show
n in the 

follow
ing table.

System
 frequency

Supported reference signals
59.94i

1080/59.94i, 480/59.94i
59.94P

1080/59.94i, 480/59.94i
50i

1080/50i, 576/50i
50P

1080/50i, 576/50i
29.97P

1080/59.94i, 480/59.94i
25P

1080/50i, 576/50i
23.98P

1080/23.98PsF

12. TC IN
 (tim

ecode input) connector (BN
C type)

To apply an external lock to the tim
ecode of the 

cam
corder, input the reference tim

ecode.

“Setting the Tim
ecode” (page 45)

13. VID
EO

 O
U

T connector (BN
C type)

O
utputs video signals for m

onitoring.
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14. TC O
U

T (tim
ecode output) connector (BN

C 
type)

To lock the tim
ecode of an external VTR to 

the tim
ecode of this cam

corder, connect this 
connector to the external VTR’s tim

ecode input 
connector.

Tally Indicator and Connector Section

4
3

1
8

9
10

11
7

6
5

2 1

1. 
TALLY (back tally) indicator (red)

Lights up during recording. It w
ill not light if the 

TALLY sw
itch is set to O

FF. It also flashes w
hen the 

W
ARN

IN
G

 indicator operates. The tally indicator on 
the front of the view

finder and the REC indication 
on the view

finder screen light or flash in the sam
e 

m
anner.

“Error/W
arning System

” (page 133)

2. 
TALLY sw

itch
Set to O

N
 to activate the TALLY indicator function.

3. 
EARPH

O
N

E jack (stereo, m
inijack)

You can m
onitor the E-E sound during recording 

and playback sound during playback. W
hen an 

alarm
 is indicated, you can hear the alarm

 sound 
through the earphone. Plugging an earphone into 
the jack autom

atically cuts off the built-in speaker.
You can select m

onaural or stereo using 
M

aintenance >Audio >H
eadphone O

ut in the 
setup m

enu.

4. 
AU

D
IO

 IN
 selector sw

itch
Select the audio source you connect to the AU

D
IO

 
IN

 CH
1/CH

2 connectors.
LIN

E: W
hen connecting a stereo am

plifier or other 
external audio signal source

AES/EBU
: W

hen connecting an external digital 
audio signal source

M
IC: W

hen connecting a m
icrophone.

5. 
+48V/O

FF (+48V external pow
er source on/

off) sw
itch

Sw
itch betw

een the follow
ing settings, according 

to the m
icrophone used for audio input.

+48V: M
icrophone requiring external pow

er 
source (phantom

 pow
er)

O
FF: M

icrophone using internal pow
er source or 

not requiring a pow
er source

6. 
SD

I IN
 (SD

I input) connector (BN
C type)

Connector used w
hen connecting an external SD

I 
signal source to the cam

corder.
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7. 
AU

D
IO

 IN
 CH

-1/CH
-2 (audio channel 1 and 

channel 2 input) connectors (XLR type, 3-pin, 
fem

ale)
Connect to audio equipm

ent or a m
icrophone.

8. 
Bottom

 cover
This is provided for protecting the cables 
connected to the connectors on the rear panel.
By loosening the screw

s w
hich retain the cover to 

the bottom
 of the cam

corder, you can adjust the 
position of the cover depending on the size and 
shape of the m

icrophone or audio cable plugs. 
After adjusting the position, tighten the screw

s to 
secure the cover.

9. 
AU

D
IO

 O
U

T connector (XLR type, 5-pin, 
m

ale)
O

utputs the audio signals recorded on audio 
channels 1 and 2 or audio channels 3 and 4.
The audio signals are selected by the M

O
N

ITO
R 

sw
itch.

10. REM
O

TE connector (8-pin)
Connect a rem

ote control unit to control the 
cam

corder rem
otely.

[N
ote]

Before connecting/disconnecting the Rem
ote Control U

nit 
to/from

 the cam
corder, be sure to turn off the cam

corder 
PO

W
ER sw

itch.

11. SD
I O

U
T 1/2 connectors (BN

C type)
O

utputs an H
D

 SD
I or SD

 SD
I signal (w

ith 
em

bedded audio). The output from
 this connector 

can be turned on/off using O
peration >Input/

O
utput >SD

I O
ut1 O

utput or SD
I O

ut2 O
utput in 

the setup m
enu.
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Information Screen

1
2

3
4

5

6

7
8

9 10 11

12 13

1. 
Recording m

ode indicator

2. 
File form

at indicator

3. 
Status display

PB: Appears during m
edia playback.

N
D

F: Appears w
hen non-drop-fram

e tim
ecode is 

selected.
EXT-LK: Appears w

hen the internal tim
ecode 

generator is locked to an external signal input 
to the TC IN

 (tim
ecode input) connector.

H
O

LD
: Appears w

hen the operation m
ode of the 

internal tim
ecode generator is set to R-RU

N
 

and stopped.

4. 
System

 frequency indicator
Indicates the system

 frequency of video being 
currently played or recorded.

5. 
Audio form

at indicator
Indicates the audio recording form

at or the audio 
form

at of clip being currently played.

Indicator
Recording form

at
16bit

H
D

420 H
Q

D
VCAM

M
PEG

 IM
X 50

Indicator
Recording form

at
24bit

H
D

422 50
M

PEG
 IM

X 50
XAVC Intra
XAVC Long

6. 
Audio level m

eters
Indicates the audio recording or playback levels of 
channels 1 to 4.

7. 
Rem

aining battery capacity indicator
D

isplays the battery rem
aining capacity icon and 

the rem
aining recording tim

e.

8. 
Rem

aining m
edia capacity indicator

Show
s bar segm

ents indicating the rem
aining 

capacity of recording m
edia in the slots.

9. 
W

arning indicator area
D

isplays w
arnings w

hen trouble w
ith recording 

occurs.

For details, see “Error/W
arning System

” (page 133).

10. Clip nam
e display

D
isplays the nam

e of the clip currently recording 
w

hen recording, or displays the nam
e of the next 

clip to be recorded during recording standby.

11. Tim
e data display

Sw
itches displays of duration, tim

ecode, and 
user bits data, depending on the position of the 
D

ISPLAY sw
itch.

D
isplays the type of data currently show

n in the 
tim

e data display, as follow
s.

TCG
: Recorded tim

ecode
TCR: Playback tim

ecode
U

BG
: Recorded user bits

U
BR; Playback user bits

CN
T: Counter

D
U

R: D
uration

CLK: Tim
e display (w

hen the PRESET/REG
EN

/
CLO

CK sw
itch is set to CLO

CK)

W
hen the H

O
LD

 button is pressed to hold the 
tim

ecode value, the tim
ecode is displayed in the 

form
at show

n below
. W

hen the H
O

LD
 button is 

pressed again to release the hold, the tim
ecode is 

displayed in the norm
al form

at.

The three dots indicate that the tim
ecode and 

counter progress are displayed in hold m
ode.

12. Resolution indicator
Indicates the resolution of the output video.

13. Recording form
at indicator

Indicates the current recording form
at or the 

recording form
at of clip being currently played.

Status Screens

The status screens allow
 you to check cam

corder 
settings and various types of status inform

ation.

W
hen no m

enu is displayed, push the M
EN

U
 

CAN
CEL/PRST/ESCAPE sw

itch up to the CAN
CEL/

PRST position to display the status screen. Each 
push selects the next status screen.
The follow

ing status screens can be displayed.

Camera Status screen
D

isplays settings and status inform
ation related to 

shooting.

D
isplay item

D
escription

G
ain

G
ain level in dB units

Shutter
Electronic shutter status

G
am

m
a

G
am

m
a category and curve

W
hite

W
hite balance m

ode setting

G
ain Sw

itch
G

AIN
 sw

itch status
Zebra

Zebra pattern status
Iris

Iris f-stop value
Focal Length

Focal length
Focus D

istance
Focus distance

D
epth O

f Field
D

epth of field
Zoom

 Speed
Zoom

 speed configured for the 
lens ZO

O
M

 button

Audio Status screen
D

isplays settings and status inform
ation related to 

audio input and output.

Screen D
isplay
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D
isplay item

D
escription

CH
 1/CH

 2/CH
 

3/CH
 4

Audio level, input source, 
reference input level, and w

ind 
noise reduction filter settings for 
each channel

System Status screen
D

isplays settings and status inform
ation related to 

recording.

D
isplay item

D
escription

System
 

Frequency
System

 frequency

File System
Recording m

ode
Rec Form

at
Recording form

at
Clip 
Continuous 
Rec

Clip Continuous Rec function on/
off setting

Title Prefix
Clip nam

e prefix
Picture Size

Picture size
Sim

ul Rec
Sim

ul Rec function on/off

Rec Function
Enabled special recording form

at 
and settings

Picture Cache 
Rec

Picture cache function on/off 
setting

D
isplay item

D
escription

N
um

ber
Clip nam

e suffix

G
am

m
a

G
am

m
a category in use

Proxy 
Recording 
M

ode

Proxy data recording function on/
off setting

Video Output Status screen
D

isplays settings and status inform
ation related to 

video output.

D
isplay item

D
escription

SD
I

SD
I O

U
T connector output 

settings (output picture size, 
output form

, output rate, 
superim

position)
H

D
M

I
H

D
M

I connector output settings 
(output picture size, output form

, 
output rate, superim

position)
Video

VID
EO

 O
U

T connector output 
settings (output picture size, 
superim

position)

Network Status 1 screen
The N

etw
ork Status 1 screen displays settings and 

status inform
ation related to the netw

ork.

D
isplay item

D
escription

Setting
N

etw
ork setting status

W
ireless 

N
etw

ork
W

ireless netw
ork setting status

D
evice N

am
e

N
am

e of device attached to the 
U

SB w
ireless LAN

 m
odule 

connector
IP Address 
(W

ireless)
IP address of w

ireless LAN
 

connection

M
AC Addr. 

(W
ireless)

M
AC address of device attached 

the U
SB w

ireless LAN
 m

odule 
connector

W
ired LAN

W
ired LAN

 netw
ork connection 

status
W

ired LAN
 

Rem
ote

Rem
ote control enabled/disabled 

state w
hen connected using a 

LAN
 cable

IP Address 
(W

ired)
IP address of w

ired LAN
 

connection

Network Status 2 screen
The N

etw
ork Status 2 screen displays settings and 

status inform
ation related to stream

ing.

D
isplay item

D
escription

N
W

 Client 
M

ode Status
N

etw
ork client m

ode status
For details about the status, see 
“N

etw
ork client m

ode status” 
(page 14).

CCM
 N

am
e

N
am

e of the connected CCM
 

w
hen using netw

ork client m
ode

Stream
ing 

Status
Stream

ing distribution status

Stream
ing Size

Picture size of the currently 
selected stream

ing setting

Stream
ing Bit 

Rate
Bit rate of the currently selected 
stream

ing setting
Stream

ing Type
Type of the currently selected 
stream

ing setting
Stream

ing 
D

est. Add.
Stream

ing destination address

Stream
ing 

D
est. Port

Stream
ing destination port

N
um

ber of 
D

istribution
N

um
ber of stream

ing distribution 
destinations

File Transfer
File transfer progress status

Transfer to:
Server nam

e of file transfer 
destination

N
etw

ork client m
ode status 

Status 
display

State
D

escription

O
ff

CCM
 not 

connected
N

etw
ork client 

m
ode is off.

Connected
CCM

 connected
N

etw
ork client 

m
ode is on, CCM

 is 
connected, and 
CCM

 control is 
enabled.
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Status 
display

State
D

escription

Connecting
Connecting to 
CCM

 
(disconnected)

Attem
pting to 

connect to CCM
 (or 

disconnecting). W
ait 

until connection 
(disconnection) is 
successful. If the 
status does not 
change from

 
“Connecting,” the 
CCM

 address setting 
m

ay be incorrect. 
Check that the 
address is set 
correctly.

Aw
aiting

CCM
 connection 

standby
N

etw
ork client 

m
ode is on, but the 

netw
ork setting is 

off. Enable the 
netw

ork setting to 
connect to the 
CCM

.
Address 
Error

CCM
 address 

error
The host nam

e or IP 
address of the CCM

 
to connect m

ay be 
incorrect. Check 
that the setting is 
correct.

Auth. 
Failed

CCM
 user nam

e/
passw

ord error
The user nam

e or 
passw

ord used to 
connect to the CCM

 
m

ay be incorrect. 
Check that the 
setting is correct.

N
o Inet 

Access
Internet 
connection error

Cannot connect to 
the netw

ork. The 
netw

ork settings 
m

ay be incorrect. 
Check the netw

ork 
settings.

Status 
display

State
D

escription

Cert. not 
Valid

CCM
 

certification not 
valid error

The CCM
 certificate 

is not valid. The date 
setting m

ay be 
invalid. Check the 
date setting.

Assignable Button Status screen
D

isplays the nam
es of functions assigned to 

assignable sw
itches.

Battery Status screen
D

isplays the status of the battery attached to the 
cam

corder.

D
isplay item

D
escription

D
etected 

Battery
D

etected type of the battery

Rem
aining

Rem
aining capacity (%

)
Charge Count 

N
um

ber of recharges
Capacity 

Rem
aining capacity (Ah)

Voltage
Voltage

M
anufacture 

D
ate 

D
ate of battery m

anufacture

Pow
er Source 

Pow
er supply source

D
isplay item

D
escription

Supplied 
Voltage 

Supplied pow
er source voltage

Media Status screen
D

isplays the status of the recording m
edia.

D
isplay item

D
escription

SxSA
Rem

aining capacity (bar graph 
and rem

aining tim
e display) and 

m
edia life of m

edia in slot A
SxSB

Rem
aining capacity (bar graph 

and rem
aining tim

e display) and 
m

edia life of m
edia in slot B

SD
 Proxy

Rem
aining capacity (bar graph 

and rem
aining tim

e display) and 
m

edia life (displayed only if 
available) of m

edia in PRO
XY SD

 
card slot

SD
 U

tility
Rem

aining capacity (bar graph 
and rem

aining capacity) and 
m

edia life (displayed only if 
available) of m

edia in U
TILITY SD

 
card slot

A 
 m

ark is displayed if the m
edia is protected.
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Viewfinder Screen

The view
finder screen displays im

ages during 
shooting (recording or recording standby) 

and playback w
ith cam

corder inform
ation 

superim
posed on the display.

You can toggle the display of inform
ation on/off 

using the D
ISPLAY sw

itch.
The inform

ation to display is linked to the settings 
in O

peration >Super Im
pose in the setup m

enu, 
and the settings of the corresponding sw

itches.

1
2

5
6

8
4

3
7

9
1011

12

13
14

15
16

17192123

24

182022

25
28

29
30

31 33 35 37

32

26
27

34 36

1. 
Extender indicator

D
isplays the status of the digital extender function 

and lens extender function.
EX: Appears w

hen the lens extender function is O
N

X2D
: Appears w

hen the digital extender function 
(×2) is O

N
X3D

: Appears w
hen the digital extender function 

(×3) is O
N

X4D
: Appears w

hen the digital extender function 
(×4) is O

N
EX2D

: Appears w
hen both the lens extender 

function and digital extender function (×2) are 
O

N
EX3D

: Appears w
hen both the lens extender 

function and digital extender function (×3) are 
O

N

EX4D
: Appears w

hen both the lens extender 
function and digital extender function (×4) are 
O

N
Turn the digital extender on/off using an 
assignable sw

itch assigned w
ith the D

igital 
Extender function.

[N
ote]

The digital extender cannot be turned on w
hen Slow

 & Q
uick 

M
otion is enabled.

2. 
Zoom

 position indicator (w
ith lens m

ounted)
D

isplays the zoom
 position of the zoom

 lens in the 
range 0 to 99.

3. 
Color tem

perature indicator
D

isplays the color tem
perature of the w

hite 
balance.

4. 
Focus position indicator (w

ith lens m
ounted)

D
isplays the focus position as a distance to the 

subject (unit: m
eters).

5. 
Iris position indicator (w

ith lens m
ounted)

D
isplays the iris position setting.

6. 
Electric color tem

perature filter indicator
Appears w

hen the CC5600K function is on.

7. 
D

epth of field indicator (serial lens m
ounted)

D
isplays the depth of field using a bar. The units 

for display are set using O
peration >D

isplay O
n/O

ff 
>Lens Info in the setup m

enu, and can be set to 
m

eters or feet.

8. 
Recording m

ode indicator
D

isplays the follow
ing recording operation states 

of the cam
corder.

Indicator
M

eaning
Ć

Rec
D

uring recording
Stby

Recording standby
Ć

Cont Rec
Clip continuous recording in 
progress

Cont Stby
Recording standby in clip continuous 
recording m

ode
Ć

S&Q
 Rec

Recording in progress in Slow
 & 

Q
uick M

otion m
ode

S&Q
 Stby

Recording standby in Slow
 & Q

uick 
M

otion m
ode

Ć
Rec

Recording in picture cache m
ode

Ć
Cache

Recording standby in picture cache 
m

ode
Ć

Int Rec
Recording in progress in Interval Rec 
m

ode
Int Stby

Recording standby in Interval Rec 
m

ode
Ć

Int Stby
Recording paused in Interval Rec 
m

ode (during pause intervals)
Ć

Sm
l Rec

Recording in progress in Sim
ul Rec 

m
ode

Sm
l Stby

Recording standby in Sim
ul Rec 

m
ode

Indicator
M

eaning
CALL

Call received from
 external 

connected device

G
reen tally is displayed w

hen the cam
corder is in 

the follow
ing states.

ˎˎ M
aintenance >Cam

era Config >H
D

-SD
I Rem

ote 
I/F is set to G

reen Tally in the setup m
enu and a 

recording control signal is output from
 the SD

I 
O

U
T connector.

ˎˎ G
reen tally signal received (w

hen a cam
era 

adaptor is m
ounted on the cam

corder and a 
cam

era extension unit is connected)

9. 
W

ireless receiver function indicator
D

isplays “W
” w

hen a slot-in receiver is attached to 
the cam

corder, and displays the reception level 
for each channel that can be used by the receiver 
(1ch, 2ch, or 4ch).
N

orm
al: D

isplays the strength of the received 
signal level by the num

ber of w
hite segm

ent 
indicators.

Analog receiver m
uting/D

igital receiver error rate 
w

arning: D
isplays the strength of the received 

signal level by the num
ber of gray segm

ent 
indicators.

If the received level exceeds the peak: D
isplays “P” 

in place of the indicator.  1)

Receiver battery is low
: The corresponding channel 

num
ber and indicators flash.  1)

1)  W
hen using the D

W
R-S02D

10. S&Q
 M

otion (Slow
 & Q

uick) fram
e rate 

indicator
D

isplays the shooting fram
e rate w

hen the 
cam

corder is set to Slow
 & Q

uick M
otion recording 

m
ode.

11. G
PS indicator (page 57)

12. Battery capacity/voltage display
D

isplays the follow
ing indicators according to the 

type of battery pow
er source.
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Battery type
Indicator

Info battery
Battery rem

aining capacity 
icon and rem

aining recording 
tim

e
Anton/Bauer 
battery

Rem
aining battery capacity (%

 
indicator)

O
ther batteries

Input voltage

13. Recording form
at (picture size) indicator

D
isplays the picture size of clips recorded onto SxS 

m
em

ory cards.

14. Recording form
at (system

 frequency and 
scan m

ethod) indicator
D

isplays the currently configured cam
corder 

system
 frequency and the recording form

at scan 
m

ethod.

15. Recording form
at (codec) indicator

D
isplays the form

at nam
e of clips recorded onto 

SxS m
em

ory cards.

16. G
am

m
a indicator

D
isplay the gam

m
a setting.

M
enu settings

Indicator

O
peration 

>D
isplay 

O
n/O

ff 
>G

am
m

a

Paint >G
am

m
a setting

G
am

m
a

G
am

m
a 

Category
G

am
m

a 
Select

O
ff

—
—

—
—

M
enu settings

Indicator

O
peration 

>D
isplay 

O
n/O

ff 
>G

am
m

a

Paint >G
am

m
a setting

G
am

m
a

G
am

m
a 

Category
G

am
m

a 
Select

O
n

O
ff

—
—

G
am

m
a 

O
ff

O
n

STD
STD

1 D
VW

STD
1

STD
2 x4.5

STD
2

STD
3 x3.5

STD
3

STD
4 240M

STD
4

STD
5 R709

STD
5

STD
6 x5.0

STD
6

H
G

H
G

1 
3250G

36
H

G
1

H
G

2 
4600G

30
H

G
2

H
G

3 
3259G

40
H

G
3

H
G

4 
4609G

33
H

G
4

O
n

O
n

U
ser

U
ser 1

U
ser 1

U
ser 2

U
ser 2

U
ser 3

U
ser 3

U
ser 4

U
ser 4

U
ser 5

U
ser 5

17. Tim
ecode external lock indicator

D
isplays tim

ecode lock w
hen the tim

ecode is 
input from

 an external source.

18. W
ired LAN

 connection status
D

isplays the w
ired LAN

 netw
ork setting and 

connection status using icons.

State
Icon

O
peration 

>D
isplay 

O
n/O

ff 
>N

etw
ork 

Condition

M
aintenance 

>N
etw

ork 
>W

ired LAN

N
etw

ork 
connection 
status

O
ff

—
—

—

O
n

D
isable

—
—

Enable
Connecting 
to LAN

(flashing)
Connected 
to LAN

LAN
 

connection 
error

19. Stream
ing indicator

D
isplays the status of stream

ing using icons.

State
Stream

ing 
state/Icon

O
peration 

>D
isplay 

O
n/O

ff 
>Stream

ing 
Status

M
aintenance 

>Stream
ing 

>Setting

M
aintenance 

>N
etw

ork 
Client M

ode 
>Setting

O
ff

—
—

—

O
n

O
ff

O
ff

–

O
n

O
ff

N
ot 

stream
ing

Stream
ing

Error

The follow
ing icons are displayed w

hen stream
ing 

from
 a CCM

.

State
Stream

ing 
state/Icon

O
peration 

>D
isplay 

O
n/O

ff 
>Stream

ing 
Status

M
aintenance 

>Stream
ing 

>Setting

M
aintenance 

>N
etw

ork 
Client M

ode 
>Setting

O
n

O
ff

O
n

N
ot 

stream
ing

Stream
ing

[N
ote]

Icons are not displayed before stream
ing starts.

20. W
ireless netw

ork status indicator
D

isplays the netw
ork setting and connection 

status using icons.State
Icon

O
peration 

>D
isplay 

O
n/O

ff 
>N

etw
ork 

Condition

M
aintenance 

>N
etw

ork 
>W

ireless 
N

etw
ork

N
etw

ork 
connection 
status

O
ff

—
—

—
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State
Icon

O
peration 

>D
isplay 

O
n/O

ff 
>N

etw
ork 

Condition

M
aintenance 

>N
etw

ork 
>W

ireless 
N

etw
ork

N
etw

ork 
connection 
status

O
n

O
ff

—
—

W
i-Fi Access 

Point
Connecting 
using W

i-Fi 1)

(flashing)

W
i-Fi standby 

(connected)

W
i-Fi Station

Connecting 
using W

i-Fi
(flashing)

Access point 
search

Access point 
connection

Icon varies 
w

ith signal 
strength.

Access point 
connection 
error 1)

M
odem

Connecting 
using 3G

/4G
(flashing)

Connected 
using 3G

/4G
3G

/4G
 

connection 
error 1)

1) This icon is displayed in the follow
ing cases.

ˎˎ W
hen a device is not attached

ˎˎ W
hen a device is attached w

ith different settings

21. Proxy indicator
D

isplays “Proxy” w
hen proxy recording is on 

(O
peration >Proxy Recording M

ode >Setting 
in the setup m

enu is set to O
n). D

uring setup, 
“Proxy” blinks. “Proxy Rec” is displayed during 
proxy recording. D

isplays 
 and transfer rate (%

) 

during proxy file transfer. W
hen transfer finishes, 

 
disappears to indicate 100%

 transfer.

22. N
etw

ork client m
ode indicator

D
isplays the status of the connection to the CCM

 
(N

etw
ork RX Station configured as Connection 

Control M
anager) using icons w

hen netw
ork client 

m
ode is on.

State
Icon

O
peration 

>D
isplay 

O
n/O

ff >N
W

 
Client M

ode 
Status

M
aintenance 

>N
etw

ork 
Client M

ode 
>Setting

State

O
ff

—
—

—

O
n

O
ff

—
—

O
n

CCM
 

connected

Connecting to 
CCM

 
(disconnected)

(flashing)

CCM
 

connection 
standby

–

CCM
 

connection 
error

For details 
about errors, 
see 
(page 14).

23. Video signal indicator
D

isplays the video signal in realtim
e as a 

w
aveform

, vectorscope, or histogram
.

24. Recording m
edia state/rem

aining capacity 
indicator for each m

edia slot
D

isplays the state and rem
aining capacity of the 

m
edia in SxS slot A, SxS slot B, and the PRO

XY SD
 

card slot.

SxS slot icon indicator
* SxS slot A (SxSA) exam

ple. The icons for SxS slot B are 
labeled SxSB.

Icon
M

edia state
–

M
edia not inserted or not m

ounted

M
edia m

ounted

(flashing)

M
edia m

ounting

(orange bar)

Recording (active)

(green 
indicator)

Playback (active)

(orange bar 
+ green 
indicator)

Recording/playback (active)

SD
 card (for proxy data recording) icon indicator

Icon
M

edia state
–

M
edia not inserted or not m

ounted

M
edia m

ounted

(flashing)

M
edia m

ounting

(orange bar)

Recording (active)

The rem
aining recording tim

e is displayed 
num

erically.

25. Audio level m
eter indicators

D
isplays the levels of audio channels 1 and 2.

26. Clip nam
e display

D
isplays the nam

e of the clip currently recording 
w

hen recording, or displays the nam
e of the next 

clip to be recorded during recording standby.

27. Focus assist indicator
D

isplays a detection fram
e (focus area m

arker) 
indicating the area for detection of degree of 
focus, and a level bar (focus assist indicator) 
indicating the degree of focus w

ithin that area.

28. Tim
e data display

D
isplays the rem

aining recording/playback 
tim

e, tim
ecode, user bits, etc., as selected by the 

D
ISPLAY sw

itch (page 8).

29. SD
 card indicator for saving configuration 

data
D

isplays the state of the SD
 card (for saving 

configuration data) inserted in the U
TILITY SD

 card 
slot.

Icon
M

edia state
—

SD
 card not inserted or not m

ounted

SD
 card m

ounted

M
ounted SD

 card is protected

(flashing)

SD
 card m

ounting

30. SD
I output REC trigger indicator

D
isplays the superim

position state of the recording 
com

m
and sent to the SD

I connector output.
It is displayed w

hen M
aintenance >Cam

era Config 
>H

D
 SD

I Rem
ote I/F is set to “Characters” in the 

setup m
enu.

31. ALAC indicator
D

isplays “ALAC” w
hen the ALAC (Auto Lens 

Aberration Correction) function is set to be 
perform

ed autom
atically.

ALAC w
ill be perform

ed autom
atically w

hen 
an ALAC-com

patible lens is attached, the ALAC 
function is enabled, and M

aintenance >Cam
era 

Config >ALAC is set to “Auto” in the setup m
enu.

32. AE (auto iris) m
ode indicator

D
isplays the current operating m

ode of the auto 
iris function using an icon and auto iris override 
level.

Icon
M

eaning
Backlight m

ode

Standard m
ode
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Icon
M

eaning
Spotlight m

ode

33. Auto focus m
ode indicator (w

hen an auto 
focus lens is attached only)

D
isplays the focus adjustm

ent m
ode of the 

cam
corder.

ˎˎ AF (auto focus)
ˎˎ M

F (m
anual focus)

ˎˎ M
F* (m

anual focus w
ith M

F assist function on)
ˎˎ Full M

F (full m
anual focus)

34. N
D

 filter indicator
D

isplays the position num
ber of the currently 

selected N
D

 filter (page 5).
W

hen “Electrical CC” is assigned to an assignable 
sw

itch, the position (A/B/C/D
) of the electrical 

CC filter is displayed on the right of the N
D

 filter 
indicator (1 to 4).

35. G
ain indicator

D
isplays the gain setting (dB), set using the G

AIN
 

sw
itch, of the video am

plifier.

36. Shutter m
ode/shutter speed indicator/Flash 

Band Reduce status indicator
D

isplays the shutter m
ode or shutter speed.

“Setting the Electronic Shutter” (page 39)

If Flash Band Reduce (page 98) is set to O
n in 

the O
peration m

enu, FBR is displayed w
hen the 

shutter is in a non-operating state.

37. W
hite balance m

ode indicator
D

isplays the currently selected w
hite balance 

autom
atic adjustm

ent m
em

ory.
ATW

: ATW
 (Auto Tracing W

hite Balance) m
ode

W
:A: M

em
ory A m

ode
W

:B: M
em

ory B m
ode

W
:C: M

em
ory C m

ode
W

:P: Preset m
ode

3200K: Appears w
hen an assignable sw

itch 
assigned w

ith Color Tem
p SW

 3200K is on
4300K: Appears w

hen an assignable sw
itch 

assigned w
ith Color Tem

p SW
 4300K is on

5600K: Appears w
hen an assignable sw

itch 
assigned w

ith Color Tem
p SW

 5600K is on
6300K: Appears w

hen an assignable sw
itch 

assigned w
ith Color Tem

p SW
 6300K is on

Lens Supplied with the PXW
-X400KC

The PXW
-X400KC is supplied w

ith a lens.

7891011
13141517

654321

12
1618

1. 
D

IP sw
itches (page 20)

U
sed for the shuttle shot function.

2. 
Iris gain adjustm

ent trim
m

er (page 41)

3. 
Iris push auto sw

itch
W

hen the iris m
ode sw

itch is in the M
 (m

anual) 
position, press this sw

itch for instantaneous auto 
iris adjustm

ent. The iris is autom
atically adjusted 

w
hile the sw

itch is held dow
n.

4. 
Iris m

ode sw
itch

A (auto): The iris is adjusted autom
atically.

M
 (m

anual): Adjust the iris w
ith the iris ring.

5. 
Zoom

 seesaw
 sw

itch
This is enabled w

hen the zoom
 servo/m

anual 
knob is in the SERVO

 position. Set to the W
 (w

ide 
angle) position w

hen you w
ant w

ide-angle, and 
set to the T (telephoto) side w

hen you w
ant 

telephoto.
Press the sw

itch harder for a faster zoom
 action, or 

softer for slow
er zoom

 action.

6. 
RET sw

itch
W

hile pressed, the last few
 seconds recorded 

appear on the view
finder screen (Rec Review

) 
(page 21).

7. 
F.B. lock screw

 / F.B. adjustm
ent ring 

(page 41)

8. 
Positioning pin

W
hen attaching the lens, align this pin w

ith the 
recess in the top center of lens m

ount on the 
cam

corder.

9. 
M

acro button / m
acro ring

Press and hold the m
acro button and turn the 

m
acro ring to adjust the focus (m

inim
um

 focus 
distance: 10 m

m
).

10. Iris ring
For m

anual iris adjustm
ent, set the iris m

ode 
sw

itch to the M
 (m

anual) position, then turn this 
ring.
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[N
ote]

Alw
ays set the iris m

ode sw
itch to the M

 (m
anual) position 

first and then adjust the iris.

11. Zoom
 lever / zoom

 ring
For m

anual zoom
 adjustm

ent, set the zoom
 servo/

m
anual sw

itch to the M
AN

U
 position, then operate 

the lever/ring.

12. Focus ring
Turn this ring to adjust the focus.

13. Zoom
 servo / m

anual knob
SERVO

 (servo): Selects pow
er zoom

. O
perate the 

zoom
 w

ith the zoom
 seesaw

 sw
itch.

M
AN

U
 (m

anual): Selects m
anual zoom

. O
perate 

the zoom
 w

ith the zoom
 lever/zoom

 ring.

14. Pow
er/iris control cable

Connect to the LEN
S connector on the cam

corder.

15. VTR sw
itch

U
se this to start and stop recording. Press once to 

start recording, then press once m
ore to stop.

16. Shtl (shuttle) sw
itch (page 20)

U
sed for the shuttle shot function.

17. Zoom
 rem

ote control connector
Connect to an optional zoom

 servo controller to 
enable rem

ote control of zoom
ing.

18. M
em

o sw
itch (page 20)

U
sed for the shuttle shot function.

About shuttle shot
Shuttle shot is a shooting function for rapidly 
m

oving to a preset zoom
 position set by the user.

1 
Set the D

IP sw
itch 1 to O

N
.

2 
Set the zoom

 position that you w
ant to 

register.

3 
Press and hold the M

em
o sw

itch and press the 
Shtl (shuttle) sw

itch.
The zoom

 position is registered as the shuttle 
position.

To m
ove rapidly to the shuttle position, press 

and hold the Shtl (shuttle) sw
itch.

The zoom
 rapidly returns to the previous zoom

 
position w

hen the Shtl (shuttle) sw
itch is 

released.

Current zoom
 

position

Press and hold Shtl 
(shuttle) sw

itch

Shuttle 
position

Release Shtl 
(shuttle) sw

itch

O
riginal zoom

 
position

Lens Supplied with the PXW
-X400KF

The PXW
-X400KF is supplied w

ith a lens.

1011121314

123456789
1. 

PU
SH

 AF (auto focus) button
W

hen adjusting focus in m
anual m

ode, pressing 
this button enables auto focus adjustm

ent on the 
subject.
Press the button to activate auto focus, and release 
the button w

hen the subject is in focus.

2. 
FO

CU
S (adjustm

ent m
ode) sw

itch
A (Auto): Activates the norm

al auto focus function. 
You can also adjust the focus m

anually using 
the focus ring, even w

hen the sw
itch is in the 

“A” position.
M

 (m
anual): Selects m

anual m
ode for focus 

adjustm
ent w

ith the focus ring.
 

In m
anual m

ode, auto focus adjustm
ent is also 

possible, by pressing the PU
SH

 AF button.

3. 
M

ACRO
 sw

itch
W

hen this sw
itch is in the O

N
 position, m

acro 
m

ode is enabled, allow
ing focusing over the 

w
hole range (5 cm

 1) to ∞
) including the m

acro 
range (from

 5 cm
 1) to 80 cm

 from
 the front of the 

lens).
This operation is independent of w

hether the 
focus adjustm

ent m
ode is auto or m

anual.
1) At the w

ide-angle setting

4. 
Iris ring

For m
anual iris adjustm

ent, set the IRIS sw
itch to 

the M
 (m

anual) position, then turn this ring.

5. 
Zoom

 ring
For m

anual zoom
 adjustm

ent, set the ZO
O

M
 

sw
itch to the M

AN
U

AL position, then turn this ring.

6. 
Focus ring

Turn this ring to adjust the focus.
W

hen the ring is set to AF/M
F m

ode, the faster 
you turn ring the faster the focusing m

echanism
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operates, m
inim

izing the am
ount of turning 

required for focusing.
W

hen you slide the focus ring back (tow
ard the 

cam
corder), the focus m

ode is set to Full M
F 

m
ode, in w

hich all focus adjustm
ents are m

anual 
(page 42).

7. 
Flange focal length adjustm

ent button
Press this to adjust the flange focal length (the 
distance from

 the lens m
ounting flange plane to 

the focusing plane) (page 26).

8. 
Zoom

 control connector (8-pin)
Connect to an optional zoom

 servo controller to 
enable rem

ote control of zoom
ing.

9. 
ZO

O
M

 sw
itch

SERVO
: Selects pow

er zoom
. O

perate the zoom
 

w
ith the pow

er zoom
 lever.

M
AN

U
AL (m

anual): Selects m
anual zoom

. O
perate 

the zoom
 w

ith the zoom
 ring.

10. PU
SH

 AU
TO

 (instant auto iris) button
W

hen the IRIS sw
itch is in the M

 position for 
m

anual adjustm
ent, press this button for 

instantaneous auto adjustm
ent. The iris is 

autom
atically adjusted w

hile the button is held 
dow

n.

11. IRIS (adjustm
ent m

ode) sw
itch

A (auto): The iris is adjusted autom
atically.

M
 (m

anual): Adjust the iris w
ith the iris ring.

12. Pow
er zoom

 lever
This is enabled w

hen the ZO
O

M
 sw

itch is in the 
SERVO

 position. Set to the W
 (w

ide angle) position 
w

hen you w
ant w

ide-angle, and set to the T 
(telephoto) side w

hen you w
ant telephoto.

Press the lever harder for a faster zoom
 action, or 

softer for slow
er zoom

 action.
N

otes about auto focus
ˎˎ It m

ay be difficult to focus on the subject in the 
follow

ing cases. If this does happen, use m
anual 

focusing.
– If the subject has no contrast
– If the subject is m

oving rapidly

– W
hen shooting point light sources, under 

street lighting or at night
– W

hen there are very bright objects close to 
the subject

– W
hen shooting through a glass w

indow
ˎˎ If there are a num

ber of objects w
ithin the 

screen at close and far range, the focus m
ay not 

be on the intended subject. In this case, w
ith 

the subject on w
hich you w

ant to focus in the 
center of the screen, press the PU

SH
 AF button.

ˎˎ After focusing w
ith the PU

SH
 AF button, if you 

operate the zoom
 or adjust the iris, the depth of 

field m
ay becom

e shallow
er, losing crisp focus. 

In such cases, press the PU
SH

 AF button once 
m

ore.
ˎˎ If you focus at w

ide-angle then zoom
 to 

telephoto, the subject m
ay no longer be in 

focus.
ˎˎ It m

ay take tim
e until the im

age is in focus w
hile 

using the slow
 shutter m

ode.

13. RET (return video) button
You can assign a function and use this as an 
assignable sw

itch (page 114).
W

hen “Lens RET” is assigned to this button (factory 
default setting), press this after recording stops 
to review

 the last few
 seconds recorded on the 

view
finder screen (Rec Review

) (page 47).
Press this button (single click) during recording or 
playback to record a Shot M

ark 1 m
ark, or double-

click to record a Shot M
ark 2 m

ark (page 49).

14. VTR button
U

se this to start and stop recording. Press once to 
start recording, then press once m

ore to stop.

Viewfinder

12345678
9

10
11

15

16

14
13

12

1. 
Connector

Connect to the VF connector (26-pin) on the 
cam

corder.

2. 
View

finder cable

3. 
Slide stopper

Prevents the view
finder from

 com
ing off the 

cam
corder w

hen it is slid from
 side to side.

4. 
Eyecup

5. 
D

iopter adjustm
ent ring

Turn this ring to adjust the im
age until it is in 

sharpest focus.

6. 
Eyepiece

You can raise this up w
hen required by the 

situation.

7. 
View

finder barrel
You can raise this up or rotate w

hen required by 
the situation.

8. 
Tally indicator

Lights up w
hen recording is started by a press of 

the REC START button on this cam
corder, the VTR 

button on the lens, or the START/STO
P button on 

the rem
ote control unit.

W
hen an abnorm

ality occurs, the tally indicator 
flashes to indicate a w

arning.

9. 
PEAKIN

G
 knob

Turning this knob clockw
ise adjusts the picture 

sharpness, and m
akes focusing easier. This 

control has no effect on the output signals of the 
cam

corder.

10. CO
N

TRAST knob
Adjusts the contrast of the screen. This control has 
no effect on the output signals of the cam

corder.

11. BRIG
H

T knob
Adjusts the brightness of the screen. This control 
has no effect on the output signals of the 
cam

corder.

12. TALLY sw
itch

Controls the tally indicator located on the front of 
the view

finder.
H

IG
H

: The tally indicator brightness is set to high.
O

FF: The tally indicator is disabled.
LO

W
: The tally indicator brightness is set to low

.

13. ZEBRA (zebra pattern) sw
itch

Controls the zebra pattern display.
O

N
: D

isplay a zebra pattern.
O

FF: D
o not display a zebra pattern.

14. D
ISPLAY sw

itch
O

N
: D

isplay text inform
ation.

O
FF: D

o not display text inform
ation.

15. M
IRRO

R sw
itch

The im
age display on the m

onitor screen becom
es 

reversed horizontally or vertically w
hen the 

view
finder barrel is raised up or rotated.

L/R: Reverse the im
age horizontally.

O
FF: D

o not reverse the im
age.

B/T: Reverse the im
age vertically.

16. M
icrophone holder
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Preparing a Pow
er Supply

For safety, use only the Sony battery packs and AC 
adaptors listed below

.
ˎˎ BP-FLX75 Lithium

-ion Battery Pack

[CAU
TIO

N
]

D
anger of explosion if battery is incorrectly replaced.  

Replace only w
ith the sam

e or equivalent type 
recom

m
ended by the m

anufacturer.  
W

hen you dispose of the battery, you m
ust obey the law

 in 
the relative area or country.

Using a Battery Pack

Press the battery pack against the back of the 
cam

corder, aligning the line on the side of the 
battery pack w

ith the line on the cam
corder. Then 

slide the battery pack dow
n until its “LO

CK” arrow
 

aligns w
ith the line on the cam

corder.
To detach the battery pack, pull the battery pack 
up by holding the release button in.

[N
otes]
ˎˎ If the battery pack is not attached correctly, the term

inals 
m

ay becom
e dam

aged.
ˎˎ D

uring recording and playback (w
hile the ACCESS lam

p 
on the right-side panel is lit in blue and the ACCESS lam

p 
in the card slot section is lit in orange), be careful never to 
rem

ove the battery pack.  
D

oing so m
ay corrupt the data recorded on the card.

ˎˎ M
ake sure to pow

er the cam
corder off before replacing 

the battery pack.

W
hen a BP-FLX75 Battery Pack is used, the 

cam
corder w

ill operate continuously for 
approxim

ately 170 m
inutes.

[W
ARN

IN
G

]
Batteries shall not be exposed to excessive heat 
such as sunshine, fire or the like.

[N
ote]

The battery pack operating tim
e depends on the frequency 

of use of the battery pack, and the am
bient tem

perature 
w

hen used.

Before use, charge the battery pack w
ith a charger 

suitable for each battery.

For details on the battery charging procedure, refer to the battery 
charger operation m

anual.

Note on using the battery pack
A w

arm
 battery pack m

ay not be able to be fully 
recharged.

Using AC Power

M
ount an AC-D

N
2B/D

N
10 on the cam

corder in 
the sam

e w
ay as a battery pack, then connect to 

the AC pow
er supply.
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Attaching a View
finder

This section describes the view
finder supplied w

ith 
the PXW

-X400KC/PXW
-X400KF m

odels.

[CAU
TIO

N
]

W
hen the view

finder is attached, do not leave the cam
corder 

w
ith the eyepiece lens facing the sun.

D
irect sunlight can enter through the lens, be focused in the 

view
finder and cause fire.

[N
ote]

A view
finder is supplied w

ith the PXW
-X400KC/PXW

-
X400KF m

odels. A view
finder for the PXW

-X400 is available 
separately.

Attaching the Supplied Viewfinder

[N
ote]

W
hen attaching a view

finder, take note of the follow
ing 

points.
ˎˎ Be sure to the pow

er off the cam
corder before coupling 

the view
finder connector to the cam

corder’s VF 
connector (26-pin). If you m

ake this connection w
hen the 

cam
corder pow

er is on, the view
finder m

ay not function 
properly.
ˎˎ Couple the view

finder connector firm
ly to the 

cam
corder’s VF connector (26-pin). If the coupling is loose, 

noise m
ay appear on the video or the tally light m

ay not 
operate properly.

1 
[1] Loosen the view

finder left-to-right 
positioning ring, [2] attach the view

finder to 
the view

finder fitting shoe, and [3] tighten the 
view

finder left-to-right positioning ring.

[2]
[1]

[3]

Slide stopper

Left-to-right positioning 
ring

2 
Couple the view

finder connector to the VF 
connector (26-pin).
VF connector (26-pin)

U
p

You can detach the view
finder by follow

ing the 
attaching procedure in reverse order. But, w

hen 
detaching the view

finder from
 the attachm

ent 
shoe, pull up the stopper.

Adjusting the Viewfinder Position

To adjust the view
finder left-right position, loosen 

the left-right positioning ring, and to adjust the 
front-back position, loosen the front-to-back 
positioning knob.

View
finder left-to-right 

positioning ring

View
finder front-to-back 

positioning knob

Adjusting the Viewfinder Angle

You can adjust the angle of the view
finder.

Reversing the Display (image/text 
indication) Vertically

The view
finder can be rotated as m

uch as 180 
degrees tow

ard the direction facing the subject.
W

hen you do this, the picture and other 
inform

ation displayed in the view
finder appear 

upside dow
n.

To restore the norm
al display, set the M

IRRO
R 

sw
itch on the rear panel of the view

finder to B/T.

Lifting Up the Viewfinder Barrel and 
Eyepiece

You can view
 the LCD

 screen inside the view
finder 

or its m
irrored im

age by lifting up the view
finder 

barrel or the eyepiece.

1 
Push the clip on the bottom

 to release and flip 
up the view

finder barrel.

2 
It locks at the 120-degree position.

2

1

N
orm

ally use it in the locked position.
Although you can open it farther from

 the lock 
position, you m

ust return it to the closed position 
to lock it at the 120-degree position again.
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Detaching the Viewfinder Barrel

1 
Push the clip on the bottom

 to release.

2 
Flip up the view

finder barrel.

3 
Slide the knob on the top to the opposite side 
of the view

finder barrel.

4 
D

etach the view
finder barrel by horizontally 

sliding it.

3
42

1

Reversing the Display (image/text 
indication) Horizontally

By setting the M
IRRO

R sw
itch on the rear panel of 

the view
finder to L/R, you can reverse the picture 

and other inform
ation displayed in the view

finder 
horizontally.

Adjusting the Diopter

Turn the diopter adjustm
ent ring until the 

view
finder im

age is sharpest.

D
iopter adjustm

ent ring

You can also attach a com
m

ercially available 
protection filter, close-up lens, etc. that is 52 m

m
 

in diam
eter.

Adjusting the Screen

Adjust the brightness, contrast, and peaking of the 
view

finder screen w
ith the controls show

n below
.

O
utlines: Adjust using the PEAKIN

G
 knob.

Contrast: Adjust using the CO
N

TRAST knob.
Brightness: Adjust using the BRIG

H
T knob.

Attaching the BKW
-401 Viewfinder 

Rotation Bracket

By fitting an optional BKW
-401 View

finder Rotation 
Bracket, you can rotate the view

finder out of 
the w

ay so that your right leg does not hit the 
view

finder w
hile you are carrying the cam

corder.

1 
Loosen the front-to-back view

finder 
positioning levers and the front-to-back 
view

finder positioning knobs, and then pull 
the view

finder slide assem
bly forw

ard.

2 
U

sing a 2.5 m
m

 diam
eter hexagonal w

rench, 
detach the view

finder slide assem
bly.

View
finder slide assem

bly H
ex socket bolts

3 
Attach the BKW

-401 w
ith the supplied bolts.

Bolts supplied w
ith the BKW

-401

4 
Adjust the front-to-back position so that the 
arm

 of the BKW
-401 does not touch the 

handle w
hen it is raised.

Adjust position so that arm
 does not 

touch handle
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W
hen using the cam

corder for the first tim
e, 

configure the follow
ing settings in the m

enu.

For details about m
enu operations, see “Basic Setup M

enu 
O

perations” (page 86).

Setting the Time Zone

Set the tim
e zone for the region of use. The default 

value is “U
TC G

reenw
ich.”

1 
Select O

peration >Tim
e Zone >Tim

e Zone in 
the setup m

enu.

2 
Select the tim

e zone to use.

Setting the Date and Time of the 
Internal Clock

Set the year, m
onth, day, and day-of-w

eek of the 
internal clock.

1 
Select M

aintenance >Clock Set >D
ate in the 

setup m
enu.

The D
ate screen appears.

2 
Turn the M

EN
U

 knob to select the year, m
onth, 

or day, and then press the knob.
The selected year, m

onth, or day becom
es 

editable.

3 
Turn the M

EN
U

 knob to set the year, m
onth, or 

day, and then press the knob.

4 
Repeat steps 2 and 3 to set the rem

aining 
digits.

5 
Press the SET button.
The internal clock is set to the date set in steps 
2 to 4.
N

ext, set the tim
e.

6 
Select M

aintenance >Clock Set >Tim
e in the 

setup m
enu.

The Tim
e screen appears.

7 
Set the tim

e in the sam
e w

ay as w
hen setting 

the date.

8 
Press the SET button.
The tim

e is registered in the internal clock.

To cancel the setting, press the Cancel button.

U
sing the Cam

corder for the First Tim
e
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M
ounting and Adjusting the Lens

[N
ote]

W
hen connecting or disconnecting the lens cable to this 

connector, pow
er off the cam

corder first.

Attaching a Lens

This section describes how
 to attach the lens 

supplied w
ith the PXW

-X400KF as an exam
ple.

1 
Push the lens locking lever up and rem

ove the 
lens m

ount cap from
 the lens m

ount.

2 
Align the center pin on the lens w

ith the 
center slot in the lens m

ount, and insert the 
lens into the m

ount.

1

1
2

3 
H

olding the lens in place, push the lens 
locking lever dow

n to lock the lens.

 
[Caution]
If the lens is not firm

ly locked, it m
ay com

e off 
w

hile the cam
corder is being used. This could 

cause a serious accident. M
ake sure the lens is 

firm
ly locked. It is recom

m
ended that the lens 

m
ount securing rubber be put on the lens 

locking lever as illustrated below
.

3

Lens m
ount securing rubber

4 
Connect the lens cable to the LEN

S connector.

5 
Secure the lens cable w

ith the cable clam
p.

If an aberration correction lens is attached
The aberration correction function is activated 
autom

atically.  1) Starting the cam
corder w

ith an 
aberration correction lens m

ay require m
ore tim

e 
than norm

al because of data loading at start-up.
The lens supplied w

ith the PXW
-X400 is an 

aberration correction lens. Contact a Sony sales or 
service representative for inform

ation about other 
aberration correction lenses.
1) The aberration correction function does not operate if 

M
aintenance >Cam

era Config >ALAC in the setup m
enu 

is set to O
ff.

Adjusting the Flange Focal Length

If the lens does not stay in focus properly as you 
zoom

 from
 telephoto to w

ide angle, adjust the 
flange focal length (the distance from

 the plane 
of the lens m

ounting flange to the im
aging plane, 

also called flange-back).
M

ake this adjustm
ent just one tim

e after m
ounting 

or changing the lens.

W
hen carrying out the adjustm

ent, use a flange 
focal length adjustm

ent chart as the subject.

Approx. 3 m
 (10 ft.)

[N
otes]
ˎˎ If you use a subject w

ith insufficient contrast, or m
ove the 

cam
corder or subject during adjustm

ent, this w
ill cause 

an adjustm
ent error.

ˎˎ Place the subject (the flange focal length adjustm
ent 

chart) so that it appears at the center of the screen at the 
telephoto end. Arrange it so that no nearby object (no 
object closer to the cam

era than the chart) enters the 
screen at the w

ide-angle end.

Adjusting the flange focal length on the lens 
supplied with the PXW

-X400KC

1 
Place a subject (Siem

ens star chart, for 
exam

ple) 3 m
 (10 ft) in front of the cam

era.

2 
O

pen the iris.
The depth-of-field is reduced w

hen the iris is 
open, m

aking adjustm
ent easier.

3 
Set the lens zoom

 to T (telephoto).

4 
Adjust the focus on the subject.

5 
Set the lens zoom

 to W
 (w

ide angle).

6 
Loosen the F.B. lock screw

 on the lens, and 
turn the F.B. adjustm

ent ring to adjust the 
focus.

7 
Repeat steps 3 to 6 until the proper focus is 
achieved at both ends of the zoom

 ring.

8 
W

hen the optim
um

 position of the F.B. 
adjustm

ent ring is achieved, tighten the F.B. 
lock screw

.

Adjusting the flange focal length on the lens 
supplied with the PXW

-X400KF
W

ith an auto focus lens, zoom
 and focus 

operations autom
atically adjust the flange focal 

length.

1 
Place the supplied focal length adjustm

ent 
chart about 3m

 (10 ft) in front of the cam
era.

2 
O

pen the iris.
The depth-of-field is reduced w

hen the iris is 
open, m

aking adjustm
ent easier.

3 
Set the ZO

O
M

 sw
itch to SERVO

 (pow
er zoom

 
m

ode).

4 
Hold dow

n the flange focal length adjustm
ent 

button for 3 seconds.
The follow

ing m
essage appears on the 

view
finder screen.

Auto FB Adjust
Executing...

After successful adjustm
ent, the m

essage on 
the view

finder screen changes to the follow
ing.

Auto FB Adjust
O

K

If the flange focal length adjustment is not 
successful
Check the subject and lighting conditions, and 
repeat the adjustm

ent.
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Adjusting the flange focal length on manual 
lenses other than the PXW

-X400KC/PXW
-X400KF

1 
Set the iris to m

anual.

2 
Place the supplied flange focal length 
adjustm

ent chart about 3m
 (10 ft) in front of 

the cam
era.

3 
O

pen the iris.
The depth-of-field is reduced w

hen the iris is 
open, m

aking adjustm
ent easier.

4 
Loosen the fixing screw

s on the F.f or F.B ring 
(flange focal length adjustm

ent ring).

5 
U

se m
anual or pow

er zoom
 to set the lens to 

telephoto.

6 
Point the cam

corder at the chart by turning 
the focus ring and focus on it.

7 
Set the zoom

 ring to w
ide angle.

8 
Turn the F.f or F.B ring until the chart is in 
focus, being careful not to disturb the focus 
ring.

9 
Repeat steps 5 to 8 until the chart stays in 
focus all the w

ay from
 w

ide angle to 
telephoto.

10 Tighten the F.f or F.B ring fixing screw
s.
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Preparing the Audio Input System
Connecting a Microphone to the MIC 
IN Connector

Attach the supplied m
icrophone to the 

m
icrophone holder of the supplied view

finder.

1 
Loosen the screw

 and open the m
icrophone 

holder clam
p.

[1]
[2]

M
icrophone holder clam

p

2 
Place the m

icrophone in the m
icrophone 

holder.
[1] Place the m

icrophone in the holder so that 
“U

P” is at the top.
[2] Close the m

icrophone holder.
[3] Tighten the screw

.

[2]
[3]

[1]

O
n how

 to attach the m
icrophone, refer to the operation 

m
anual for the m

icrophone.

3 
Plug the m

icrophone cable into the M
IC IN

 
connector, then set the AU

D
IO

 IN
 sw

itch for 
the channel on w

hich you w
ant to record the 

audio from
 this m

icrophone to FRO
N

T.

4 
Secure the m

icrophone cable w
ith the cable 

clam
p.

Connecting Microphones to the 
AUDIO IN Connectors

You can connect up to tw
o m

onaural 
m

icrophones to the AU
D

IO
 IN

 CH
-1/CH

-2 
connectors, using an optional CAC-12 M

icrophone 
H

older.
Supported m

icrophones: ECM
-674/678 electret 

condenser m
icrophone

For details about attaching the m
icrophone holder and 

m
icrophone, refer to the instruction m

anual of each product.

Attaching a W
ireless Receiver

To use a Sony w
ireless m

icrophone system
, pow

er 
the cam

corder off and then attach a w
ireless 

receiver.
ˎˎ D

W
R-S02D

 D
igital W

ireless Receiver
ˎˎ W

RR-855S, U
RX-S03D

 U
H

F Synthesized Tuner 
U

nit

For details about attaching a w
ireless receiver, refer to the 

instruction m
anual of each product.

Connecting Line Input Audio 
Equipment

1 
Connect the audio output connector of the 
audio equipm

ent that supplies the line input 
signal to the AU

D
IO

 IN
 CH

-1 or CH
-2 

connector.

2 
Set the AU

D
IO

 IN
 selector for the channel to 

w
hich the audio signal source is connected to 

LIN
E.

XLR connection automatic detect function

ˎˎ W
ith the XLR connection autom

atic detection 
function sw

itched off (the factory default 
setting): Set the AU

D
IO

 IN
 CH

1/CH
2 sw

itch 
to REAR for the channels to w

hich the audio 
equipm

ent is connected.
ˎˎ W

ith the XLR connection autom
atic detection 

function sw
itched on: W

hen a cable is 
connected to the AU

D
IO

 IN
 CH

-1 or CH
-2 

connector, the input from
 that connector is 

autom
atically selected for audio recording, 

regardless of the setting of the AU
D

IO
 IN

 CH
1/

CH
2 sw

itch.

The XLR connection autom
atic detection function 

can be sw
itched on/off using M

aintenance >Audio 
>Rear XLR Auto in the setup m

enu.

[2]
[1]

[3]

[4]

[1] Place the m
icrophone in the holder so that 

“U
P” is at the top.

[2] Close the m
icrophone holder.

[3] Tighten the screw
.
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Mounting on a Tripod

1 
Attach the optional VCT-14/U

14 Tripod 
Adaptor to the tripod.

2 
M

ount the cam
corder on the tripod adaptor.

Slide the cam
corder forw

ard along the 
groove in the adaptor until it clicks.

3 
M

ake sure that the cam
corder is securely 

attached by m
oving it back and forth.

To rem
ove the cam

corder from
 the tripod 

attachm
ent, hold dow

n the red button and pull 
the lever in the direction of the arrow

.

Red button

Lever

[N
ote]

The tripod adaptor pin m
ay rem

ain in the engaged position 
even after the cam

corder is rem
oved. If this happens, press 

the red button and m
ove the lever as show

n above until 
the pin returns to the stow

ed position. If the pin rem
ains 

in the engaged position, you w
ill not be able to m

ount the 
cam

corder on the tripod adaptor.

Connecting a Video Light

W
ith this cam

corder, you can use the Anton Bauer 
U

ltralight 2 or equivalent video light (pow
ered by 

12 V w
ith m

axim
um

 pow
er consum

ption of 50 W
).

ˎˎ If you connect the video light to the LIG
H

T 
connector on the cam

corder and set the LIG
H

T 
sw

itch to AU
TO

, you can turn the light on and 
off autom

atically as you start and stop recording 
on this cam

corder.
ˎˎ The output of the LIG

H
T connector on the 

cam
corder is regulated to 12 V even w

hen the 
cam

corder is supplied w
ith over 12 V pow

er 
(through the D

C IN
 connector or battery pack). 

The brightness or color tem
perature of the light 

w
ill not change in response to voltage increase.

[N
otes]
ˎˎ D

o not connect video lights w
ith pow

er consum
ption of 

50 W
 or greater.

ˎˎ The brightness or color tem
perature of the light w

ill 
change w

hen the voltage (supplied through the D
C IN

 
connector or from

 the battery pack) is less than 12 V.

To attach a video light, fit the video light to 
the accessory shoe on the cam

corder grip, 
and connect the video light cable to the LIG

H
T 

connector.

[N
ote]

The accessory shoe on the cam
corder is of the 1/4-inch 

tapped hole type. If you w
ant to replace this w

ith a slide-type 
shoe, use the supplied cold shoe kit.

Attaching the Shoulder Strap

1 
Fit one of the clips to a shoulder strap fitting.

Pull up the strap to lock the fitting.

Clip

2 
Fit the other clip to the shoulder strap fitting 
on the other side of the grip in the sam

e w
ay.

To rem
ove the shoulder strap, refer to the 

follow
ing diagram

.
Press here and pull in the direction show

n 
by the arrow

 to release.

Adjusting the Shoulder Pad Position

You can slide the shoulder pad back and forth 
w

ithin a 40 m
m

 range. This adjustm
ent helps 

you get the best balance for shooting w
ith the 

cam
corder on your shoulder.

1,3

2
Shoulder pad

1 
Raise the lever in the center of the shoulder 
pad to unlock the shoulder pad.

2 
Slide the shoulder pad backw

ard or forw
ard 

until it is in the m
ost convenient position.

3 
Bring dow

n the lever to lock the shoulder pad 
in the selected position.

Attaching and Adjusting Peripheral D
evices



000
2. Preparation

30

H
andling SxS M

em
ory Cards

This cam
corder records video and audio on SxS 

m
em

ory cards (not supplied) loaded into one or 
both of its m

em
ory card slots.

You can use the cam
corder w

ith the follow
ing 

devices to m
ake recordings.

ˎˎ M
EAD

-SD
02 M

edia Adaptor (SD
XC only 

supported) or Q
D

A-EX1 XQ
D

 ExpressCard 
Adaptor

About SxS Memory Cards

SxS memory cards
U

se Sony SxS m
em

ory cards (SxS PRO
+, SxS PRO

, 
or SxS-1) w

ith this cam
corder.

SxS PRO
+ series 

SxS PRO
 series 

SxS-1 series

The m
em

ory cards listed above com
ply w

ith the 
ExpressCard m

em
ory card standard.

ˎˎ SxS, SxS PRO
+, SxS PRO

, and SxS-1 are 
tradem

arks of Sony Corporation.
ˎˎ The ExpressCard label and logo are the 
property of the Personal Com

puter M
em

ory 
Card International Association (PCM

CIA) and 
are licensed to Sony Corporation. All other 
tradem

arks and trade nam
es are the property of 

their respective ow
ners.

Inserting SxS Memory Cards

1 
Slide the cover to the left to open.

2 
Insert an SxS m

em
ory card into a card slot.

Slot A

Slot B

 
[N

ote]
M

ake sure to insert the SxS card in the correct 
orientation. H

old the card w
ith the arrow

 on one side 
facing the direction show

n in the diagram
, and then 

insert the card.

The ACCESS indicator lights in orange, and 
then lights in green to indicate that the 
m

em
ory card is usable.

3 
Close the cover.

ACCESS indicator status
Card slots A and B each have an ACCESS indicator 
that indicate the slot status.

Slot A access indicator

Slot B access indicator

Indicator
Slot status

Lights in 
orange

Accessing the SxS m
em

ory card 
(lights during data reading and 
w

riting)

Indicator
Slot status

Lights in 
green

Standby (the loaded SxS m
em

ory 
card is ready for recording or 
playback)

N
ot lit

N
o SxS m

em
ory card is loaded.

An unusable card is loaded.
An SxS m

em
ory card is loaded, but 

the other slot is selected.

Ejecting SxS Memory Cards

1 
O

pen the cover, and then press the EJECT 
button to release the lock and extract the 
button.

Press the button once 
to release the lock.

2 
Press the EJECT button again to eject the card.

 
[N

ote]
W

hen you press the EJECT button, take care not to 
im

pede the SxS m
em

ory card. If the m
ovem

ent of 
the SxS m

em
ory card is im

peded, the lock m
ay fail to 

release.

[N
ote]

D
ata integrity cannot be guaranteed if you pow

er the 
cam

corder off or rem
ove a m

em
ory card w

hile the card 
is being accessed. All data recorded on the card m

ay be 
discarded. Alw

ays m
ake sure that the ACCESS indicator is 

lit green or not lit before you pow
er the cam

corder off or 
rem

ove a m
em

ory card.

Selecting the SxS Memory Card to 
Use

W
hen SxS m

em
ory cards are loaded in both slot A 

and slot B, you can press the SLO
T SELECT button 

to select the SxS m
em

ory card to use.
W

hen the rem
aining recording tim

e on the 
recording SxS m

em
ory card falls below

 60 
seconds, the rem

aining capacity indicator for 
the corresponding m

edia slot flashes on the 
view

finder screen to indicate that the cam
corder 

w
ill sw

itch SxS m
em

ory cards soon.
Subsequently, the cam

corder sw
itches 

autom
atically to the other card w

hen the selected 
card becom

es full, and recording continues.
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[N
ote]

The SLO
T SELECT button is disabled during playback. The 

m
em

ory cards are not sw
itched even if you press the button. 

Button operations are enabled w
hen a thum

bnail screen 
(page 78) is displayed.

Formatting (Initializing) SxS Memory 
Cards

W
hen an unform

atted SxS m
em

ory card or an SxS 
m

em
ory card form

atted in another specification is 
inserted, a m

essage notifying you that the m
edia 

has a different file system
 appears. In this case, 

form
at the m

em
ory card in the follow

ing w
ay.

SxS m
em

ory cards are form
atted in exFAT or FAT 

by factory default.

[N
ote]

SxS m
em

ory cards m
ust be form

atted on an XD
CAM

 device 
that supports the exFAT or U

D
F file system

 or on this 
cam

corder. Cards in other form
ats cannot be used.

1 
Select O

peration >Form
at M

edia in the setup 
m

enu.

2 
Select M

edia(A) (slot A) or M
edia(B) (slot B).

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
A confirm

ation screen prom
pting w

hether to 
form

at the card appears.

4 
Turn the M

EN
U

 knob to select [Execute] on the 
confirm

ation m
essage screen, then press the 

knob.
Form

atting begins.
D

uring form
atting, a m

essage is displayed, and 
the ACCESS indicator is lit orange.
W

hen form
atting ends, a com

pletion m
essage 

appears. Press the M
EN

U
 knob to dism

iss the 
m

essage.

If formatting fails
A form

at operation m
ay fail because the SxS 

m
em

ory card is w
rite protected, or because it is 

not the type of card specified for use w
ith this 

cam
corder.

In this case, an error m
essage appears. Follow

 the 
instructions in the error m

essage and exchange 
the card for an SxS m

em
ory card that can be used 

w
ith this cam

corder.

[N
otes]
ˎˎ Form

atting a m
em

ory card erases all data, including 
recorded video data and setup files. 
ˎˎ U

se the form
at function of this cam

corder to form
at SxS 

m
em

ory cards for use on this cam
corder. The form

ats of 
cards form

atted on other devices are not recognized as 
valid form

ats, m
aking it necessary to form

at them
 again 

on this cam
corder.

Checking the Remaining Recording 
Time

You can check the rem
aining capacity of the SxS 

m
em

ory cards loaded in the tw
o slots by checking 

the recording m
edia rem

aining capacity indicator 
in the view

finder.
The rem

aining recording tim
e is calculated from

 
the rem

aining capacity of the m
edia in each slot 

and the current video form
at (recording bit rate), 

and is displayed in units of m
inutes.

You can check the rem
aining capacity on a bar 

graph by displaying the M
edia Status screen 

(page 15).

[N
ote]

A 
 m

ark appears w
hen a m

em
ory card is w

rite protected.

W
hen to exchange SxS memory cards

ˎˎ The w
arning m

essage “M
edia N

ear Full” appears, 
the W

ARN
IN

G
 indicator and the REC indication 

on the view
finder screen flash, and the buzzer 

sounds w
hen the total rem

aining recording 

tim
e of the tw

o m
em

ory cards falls to five 
m

inutes during recording.  
Exchange one of the cards for m

edia w
ith 

available recording capacity.
ˎˎ If you continue recording, the m

essage “M
edia 

Full” appears and recording stops w
hen the 

total rem
aining recording tim

e falls to 0.

[N
ote]

About up to 600 clips can be recorded on one SxS m
em

ory 
card.
The display of rem

aining recording tim
e changes to “0” 

and the m
essage “M

edia Full” appears w
hen the clip lim

it is 
reached.

Restoring SxS Memory Cards

If for any reason an error should occur in a m
em

ory 
card, the card m

ust be restored before use.
W

hen you load an SxS m
em

ory card that needs to 
be restored, a m

essage appears in the view
finder 

to ask w
hether you w

ant to restore it.

To execute the restore, turn the M
EN

U
 knob to 

select [Execute], and then press the knob.
The restoration starts.
D

uring restoration, a m
essage is displayed, and the 

ACCESS indicator is lit orange.
W

hen restoration ends, a com
pletion m

essage 
appears. Press the M

EN
U

 knob to dism
iss the 

m
essage.

If restoration fails

ˎˎ W
rite protected SxS m

em
ory cards and cards on 

w
hich m

em
ory errors have occurred cannot be 

restored. A w
arning m

essage appears for such 
cards. Follow

 the instructions in the m
essage 

and unprotect the card or replace it w
ith 

another card.
ˎˎ SxS m

em
ory cards on w

hich m
em

ory errors 
have occurred m

ay becom
e usable if they are 

reform
atted.

ˎˎ In som
e cases, som

e clips can be restored w
hile 

others cannot. The restored clips can be played 
norm

ally.
ˎˎ If the m

essage “Could not Restore Som
e Clips” 

keeps appearing after repeated attem
pts at 

restoration, it m
ay be possible to restore the SxS 

m
em

ory card w
ith the follow

ing procedure.
[1] U

se the application softw
are (page 147) 

to copy the required clips to another SxS 
m

em
ory card.

[2] Form
at the unusable SxS m

em
ory card on 

the cam
corder.

[3] Copy the required clips back to the new
ly 

form
atted SxS m

em
ory card.



000
2. Preparation

32

The follow
ing SD

 cards can be used for saving 
configuration data.

SD
H

C m
em

ory cards* (Speed Class: 4 to 10, non-
U

H
S, Capacity: 4 to 32 G

B)
* 

Referred to as “SD
 cards” in this m

anual.

Formatting (Initializing) SD Cards

SD
 cards m

ust be form
atted the first tim

e they are 
used in the cam

corder.
SD

 cards for use in the cam
corder should be 

form
atted using the form

at function of the 
cam

corder. If a m
essage appears w

hen the SD
 card 

is inserted into the cam
corder, form

at the SD
 card.

1 
Select O

peration >Form
at M

edia >SD
 Card 

(U
tility) in the setup m

enu.
A confirm

ation screen prom
pting w

hether to 
form

at the card appears.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
Form

atting begins.
D

uring form
atting, a m

essage is displayed, and 
the ACCESS indicator is lit orange.
W

hen form
atting ends, a com

pletion m
essage 

appears. Press the M
EN

U
 knob to dism

iss the 
m

essage.

[N
ote]

Form
atting an SD

 card erases all data on the card. The card 
cannot be restored.

Checking the Remaining Capacity

You can check the rem
aining capacity on an SD

 
card on the M

edia Status screen (page 15).
To use an SD

 card form
atted on the cam

corder in 
the slot of another device, m

ake a backup of the 
card, then reform

at the card in the device to be 
used.

H
andling SD

 Cards for Saving Configuration D
ata
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U
sing a M

edia Adaptor
[N

otes]
ˎˎ For professional applications, the use of other m

edia w
ill 

not provide the sam
e high reliability and durability that is 

obtained using SxS m
em

ory cards.
ˎˎ N

ot all m
em

ory cards are guaranteed to w
ork w

ith this 
cam

corder. For com
patible m

em
ory cards, contact your 

Sony dealer.

XQD Memory Cards

By using an optional Q
D

A-EX1 XQ
D

 ExpressCard 
Adaptor, you can insert an XQ

D
 m

em
ory card into 

the SxS m
em

ory card slot and use it instead of an 
SxS m

em
ory card.

For details about using a Q
D

A-EX1 XQ
D

 ExpressCard Adaptor, 
refer to the instruction m

anual supplied w
ith the adaptor.

[N
otes]
ˎˎ H

igh-speed playback m
ay not be properly achieved w

ith 
an XQ

D
 m

em
ory card.

ˎˎ Slow
 m

otion recording using the Slow
 & Q

uick M
otion 

recording function cannot be used w
ith an XQ

D
 m

em
ory 

card.

Formatting (initializing)
XQ

D
 m

em
ory cards m

ust be form
atted the first 

tim
e they are used in the cam

corder.
XQ

D
 m

em
ory cards for use in the cam

corder 
should be form

atted using the form
at function 

of the cam
corder. If a m

essage appears w
hen the 

XQ
D

 m
em

ory card is inserted into the cam
corder, 

form
at the XQ

D
 m

em
ory card.

If an unform
atted XQ

D
 m

em
ory card or an XQ

D
 

m
em

ory card that w
as form

atted in a different 
specification is inserted, a m

essage asking for 
confirm

ation to form
at m

edia or a m
essage 

notifying you that the m
edia has a different file 

system
 appears.

1 
Select O

peration >Form
at M

edia in the setup 
m

enu.

2 
Select M

edia(A) (slot A) or M
edia(B) (slot B).

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
A confirm

ation screen prom
pting w

hether to 
form

at the card appears.

4 
Turn the M

EN
U

 knob to select [Execute] on the 
confirm

ation m
essage screen, then press the 

knob.
Form

atting begins.
D

uring form
atting, a m

essage is displayed, and 
the ACCESS indicator is lit orange.
W

hen form
atting ends, a com

pletion m
essage 

appears. Press the M
EN

U
 knob to dism

iss the 
m

essage.

[N
ote]

Form
atting an XQ

D
 m

em
ory card erases all data on the card, 

including protected video. The data cannot be restored.

Connection between the camcorder and a 
computer
Insert the recorded XQ

D
 m

em
ory card into a slot 

in the cam
corder, and connect the cam

corder to a 
com

puter using a U
SB cable.

To use a memory card formatted on the 
camcorder in the slot of another device
First, m

ake a backup of the card, then reform
at the 

card in the device to be used.

SDXC Cards

By using an optional M
EAD

-SD
02 M

edia Adaptor, 
you can insert an SD

XC card into an SxS m
em

ory 
card slot and use it for recording and playback.

[N
ote]

D
o not use SD

XC cards at the sam
e tim

e as other m
em

ory 
cards. If a m

ix of cards are used at the sam
e tim

e, the 
cam

corder cannot sw
itch cards w

hen the m
edia becom

es 
full.

The follow
ing SD

XC cards are supported.
SD

XC m
em

ory cards (SD
 speed class: Class 10)

For details about using an M
EAD

-SD
02 M

edia Adaptor, refer to 
the instruction m

anual supplied w
ith the adaptor.

[N
otes]
ˎˎ H

igh-speed playback m
ay not be properly achieved w

ith 
an SD

XC card.
ˎˎ Slow

 m
otion recording using the Slow

 & Q
uick M

otion 
recording function cannot be used w

ith an SD
XC card.

ˎˎ Recording and playback using SD
XC cards is not 

guaranteed w
hen shooting in XAVC Intra form

at.

Formatting (initializing)
SD

XC cards m
ust be form

atted the first tim
e they 

are used in the cam
corder.

SD
XC cards for use in the cam

corder should 
be form

atted using the form
at function of the 

cam
corder. If a m

essage appears w
hen the SD

XC 
card is inserted into the cam

corder, form
at the 

SD
XC card.

If an unform
atted SD

XC card or an SD
XC card 

that w
as form

atted in a different specification is 
inserted, a m

essage asking for confirm
ation to 

form
at m

edia or a m
essage notifying you that the 

m
edia has a different file system

 appears.
Form

at the card using the follow
ing procedure.

1 
Select O

peration >Form
at M

edia in the setup 
m

enu.

2 
Select M

edia(A) (slot A) or M
edia(B) (slot B).

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
A confirm

ation screen prom
pting w

hether to 
form

at the card appears.

4 
Turn the M

EN
U

 knob to select [Execute] on the 
confirm

ation m
essage screen, then press the 

knob.
Form

atting begins.
D

uring form
atting, a m

essage is displayed, and 
the ACCESS indicator is lit orange.

W
hen form

atting ends, a com
pletion m

essage 
appears. Press the M

EN
U

 knob to dism
iss the 

m
essage.

[N
otes]
ˎˎ Form

atting an SD
XC card erases all data on the card, 

including protected video. The data cannot be restored.
ˎˎ An SD

XC card cannot be form
atted in U

D
F m

ode.

Connection between the camcorder and a 
computer
Insert the recorded SD

XC card into a slot in the 
cam

corder, and connect the cam
corder to a 

com
puter using a U

SB cable.

To use a memory card formatted on the 
camcorder in the slot of another device
First, m

ake a backup of the card, then reform
at the 

card in the device to be used.

XQ
D

 is a registered tradem
ark of Sony 

Corporation.
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You can set the recording m
ode, system

 frequency, and video form
at using O

peration >Form
at in the 

setup m
enu.

For details about m
enu operations, see “Basic Setup M

enu O
perations” (page 86).

Selecting the Recording Mode

You can select exFAT or U
D

F recording m
ode.

1 
Select O

peration >Form
at >File System

 in the setup m
enu.

2 
Turn the M

EN
U

 knob to select exFAT or U
D

F, and press the knob.
A confirm

ation screen appears.

3 
Select [Execute] to execute, or select [Cancel] to cancel, and then press the M

EN
U

 knob.
The cam

corder w
ill reboot autom

atically after executing [Execute].

[N
ote]

The recording m
ode cannot be changed during recording/playback or w

hile the thum
bnail screen is displayed.

Switching the System Frequency

You can sw
itch the system

 frequency as required.

[N
otes]
ˎˎ The system

 frequency cannot be changed during recording/playback or w
hile the thum

bnail screen is displayed.
ˎˎ After sw

itching betw
een 29.97 and 59.94 or betw

een 25 and 40, the cam
corder does not reboot autom

atically.

1 
Select O

peration >Form
at >Frequency in the setup m

enu.

2 
Turn the M

EN
U

 knob to select the system
 frequency, and press the knob.

A confirm
ation screen appears.

3 
Select [Execute] to execute, or select [Cancel] to cancel, and then press the M

EN
U

 knob.
The cam

corder w
ill reboot autom

atically after executing [Execute].

Switching the Video Format

Refer to “Video Form
ats” (page 34) as required w

hen sw
itching the video form

at.

1 
Select O

peration >Form
at >Rec Form

at in the setup m
enu.

2 
Turn the M

EN
U

 knob to change the video form
at, and press the knob.

A confirm
ation screen appears.

3 
Select [Execute] to execute, or select [Cancel] to cancel, and then press the M

EN
U

 knob.

Video Formats

The follow
ing recording form

ats can be selected for different com
binations of video resolution and 

system
 frequency.

System
 frequency

Video form
at 

(O
peration >Form

at >Rec Form
at in setup m

enu)
Picture size

59.94/50
XAVC-I 1920×1080P

1920×1080
XAVC-I 1920×1080i
XAVC-I 1280×720P

1280×720
XAVC-L 50 1920×1080P

1920×1080
XAVC-L 50 1920×1080i

1920×1080
XAVC-L 50 1280×720P

1280×720
XAVC-L 35 1080P

1920×1080
XAVC-L 35 1080i
XAVC-L 25 1080i
H

D
422 50 1080i  a)

1920×1080
H

D
422 50 720P

 a)
1280×720

H
Q

 1920×1080i  a)
1920×1080

H
Q

 1440×1080i  a)
1440×1080

H
Q

 1280×720P
 a)

1280×720
M

PEG
 IM

X 50
 a)

720×486/720×576
D

VCAM
 a)

720×480/720×576
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System
 frequency

Video form
at 

(O
peration >Form

at >Rec Form
at in setup m

enu)
Picture size

29.97/25/23.98
XAVC-I 1920×1080P

1920×1080
XAVC-L 50 1920×1080P
XAVC-L 35 1080P
H

D
422 50 1080P

 a)
1920×1080

H
D

422 50 720P
 a)

1280×720
H

Q
 1920×1080P

 a)
1920×1080

a) exFAT and U
D

F files system
s are supported. O

nly exFAT is supported for other options.

SDI OUT Connector and HDMI Output Connector Output Formats

The signals that can be output from
 the SD

I O
U

T connector and H
D

M
I output connector are show

n in the 
follow

ing table according to the O
peration >Form

at setting in the setup m
enu.

O
peration m

enu

Form
at

Input/O
utput

Frequency
Rec Form

at (codec om
itted)

O
utput Form

at

SD
I

H
D

M
I

59.94
1920×1080P

1920×1080P (Level A)
1920×1080P

1920×1080P (Level B)
N

o signal

1920×1080i
1920×1080i

720×486i
720×480i

1920×1080i
1920×1080i

1920×1080i

720×486i
720×480i

1440×1080i
1920×1080i

1920×1080i

720×486i  a)
720×480i  a)

1280×720P
1280×720P

1280×720P

720×486i
720×480i

720×480i
720×486i

720×480i

N
o signal

720×480P

29.97
1920×1080P

1920×1080PsF
1920×1080i

720×486i
720×480i

1280×720P
1280×720P

1280×720P

720×486i
720×480i

O
peration m

enu

Form
at

Input/O
utput

Frequency
Rec Form

at (codec om
itted)

O
utput Form

at

SD
I

H
D

M
I

23.98
1920×1080P

1920×1080PsF
N

o signal

1920×1080i (2-3PD
)

1920×1080i (2-3PD
)

720×486i (2-3PD
)

720×480i (2-3PD
)

1280×720P
1280×720P (2-3PD

)
1280×720P (2-3PD

)

720×486i (2-3PD
)

720×480i (2-3PD
)

50
1920×1080P

1920×1080P (Level A)
1920×1080P

1920×1080P (Level B)
N

o signal

1920×1080i
1920×1080i

720×576i
720×576i

1920×1080i
1920×1080i

1920×1080i

720×576i
720×576i

1440×1080i
1920×1080i

1920×1080i

720×576i  a)
720×576i  a)

1280×720P
1280×720P

1280×720P

720×576i
720×576i

720×576i
720×576i

720×576i

N
o signal

720×576P

25
1920×1080P

1920×1080PsF
1920×1080i

720×576i
720×576i

1280×720P
1280×720P

1280×720P

720×576i
720×576i

a) Sw
itches to 1920×1080i w

hen proxy recording or w
ireless LAN

 connection function is on.



000
3. Settings and Adjustm

ents: Form
at Settings

36

VIDEO Connector Output Formats

The signals that can be output from
 the VID

EO
 connector are show

n in the follow
ing table according to 

the O
peration >Form

at setting in the setup m
enu.

O
peration m

enu
VID

EO
 O

U
T signal form

at

Form
at

Frequency
Rec Form

at (codec om
itted)

Proxy recording/W
ireless LAN

 connection function

O
FF

O
N

59.94
1920×1080P

H
D

 Y
H

D
 Y

H
D

 Y
H

D
 Y

H
D

 Y
H

D
 Y

Com
posite

 
Com

posite
 c)

1920×1080i
H

D
 Y

H
D

 Y

Com
posite

Com
posite

 c)

1440×1080i
H

D
 Y

H
D

 Y

Com
posite

–

1280×720P
H

D
 Sync

 a)
H

D
 Sync

 a)

Com
posite

Com
posite

 c)

720×480i
Com

posite
Com

posite
 c)

Com
posite

H
D

 Y

29.97
1920×1080P

H
D

 Y
 

H
D

 Y

Com
posite

 
Com

posite
 c)

1280×720P
H

D
 Y

 b) 
H

D
 Y

 b)

Com
posite

 
Com

posite
 c)

23.98
1920×1080P

H
D

 Y
 

H
D

 Y

H
D

 Y/H
D

 Sync
H

D
 Y

Com
posite

 
Com

posite
 c)

1280×720P
H

D
 Y

 b) 
H

D
 Y

 b)

Com
posite

Com
posite

 c)

O
peration m

enu
VID

EO
 O

U
T signal form

at

Form
at

Frequency
Rec Form

at (codec om
itted)

Proxy recording/W
ireless LAN

 connection function

O
FF

O
N

50
1920×1080P

H
D

 Y
H

D
 Y

H
D

 Y
H

D
 Y

H
D

 Y
H

D
 Y

Com
posite

Com
posite

 c)

1920×1080i
H

D
 Y

H
D

 Y

Com
posite

Com
posite

 c)

1440×1080i
H

D
 Y

H
D

 Y

Com
posite

 
–

1280×720P
H

D
 Sync

 a)
H

D
 Sync

 a)

Com
posite

Com
posite

 c)

720×576i
Com

posite
 

Com
posite

 c)

Com
posite

H
D

 Y

25
1920×1080P

H
D

 Y
H

D
 Y

Com
posite

Com
posite

 c)

1280×720P
H

D
 Y

 b) 
H

D
 Y

 b) 

Com
posite

Com
posite

 c)

a) 1080i sync signal output.
b) 1080PsF sync signal output.
c) Character inform

ation (superim
posed) turns on/off in sync w

ith the SD
I O

U
T2/H

D
M

I character inform
ation display sw

itching.
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Adjusting the Black Balance and W
hite Balance

To ensure excellent im
age quality w

hen using this 
cam

corder, conditions m
ay require that both the 

black balance and the w
hite balance be adjusted.

Black balance and w
hite balance adjustm

ent 
values that are autom

atically set by the cam
corder 

and the various settings are stored in the 
cam

corder m
em

ory and retained even w
hen the 

pow
er is turned off.

Adjusting the Black Balance

The black balance w
ill require adjustm

ent in the 
follow

ing cases.
ˎˎ W

hen the cam
corder is used for the first tim

e
ˎˎ W

hen the cam
corder has not been used for a 

long tim
e

ˎˎ W
hen the cam

corder is used under conditions 
in w

hich the surrounding tem
perature has 

changed greatly
ˎˎ W

hen the G
AIN

 selector (L/M
/H

/Turbo) values 
have been changed w

ith O
peration >G

ain 
Sw

itch in the setup m
enu.

It is not usually necessary to adjust the black 
balance w

hen using the cam
corder after it has 

been off.

In autom
atic black balance m

ode, adjustm
ents are 

perform
ed in the follow

ing order: black set and 
black balance. M

anual black balance adjustm
ent 

can be selected from
 the setup m

enu.

Autom
atic black balance adjustm

ent is disabled in 
the follow

ing cases.
ˎˎ D

uring recording
ˎˎ D

uring special recording m
odes

ˎˎ W
hen the shutter m

ode is SLS

1 
Set the O

U
TPU

T/D
CC sw

itch to CAM
.

2 
Push the AU

TO
 W

/B BAL sw
itch to BLACK and 

release the sw
itch.

The m
essage “Executing…

” appears during 
execution, and changes to “O

K” w
hen the 

adjustm
ent finishes.

Adjustm
ent values are saved to m

em
ory 

autom
atically.

[N
otes]
ˎˎ D

uring the black balance adjustm
ent, the iris is 

autom
atically closed.

ˎˎ D
uring the black balance adjustm

ent, the gain selection 
circuit is autom

atically activated so you m
ay see flickering 

on the view
finder screen, but this is not a fault.

If automatic black balance adjustment cannot be 
made
If the black balance adjustm

ent cannot be 
com

pleted norm
ally, an error m

essage w
ill appear 

for about three seconds on the view
finder screen.

Error m
essage

M
eaning

N
G

: Iris not Closed
The lens iris did not close; 
adjustm

ent w
as im

possible.

N
G

: Tim
eout

Adjustm
ent could not be 

com
pleted w

ithin the 
standard num

ber of 
attem

pts.

If any of the above error m
essages is displayed, 

retry the black balance adjustm
ent.

If the error m
essage occurs again, an internal 

check is necessary.

For inform
ation about this internal check, refer to the 

M
aintenance M

anual.

[N
ote]

If the lens cable is not firm
ly connected to the LEN

S 
connector, it m

ay not be possible to adjust the lens iris. If this 
happens, the black balance w

ill be incorrect.

Adjusting the W
hite Balance

Alw
ays readjust the w

hite balance w
hen the 

lighting conditions change.

1 
Set the sw

itches and selectors as show
n 

below
.

ˎˎ G
AIN

 sw
itch: L (set to a gain value that is as 

sm
all as possible)

ˎˎ O
U

TPU
T/D

CC sw
itch: CAM

ˎˎ W
H

ITE BAL sw
itch: A or B

 1)

1) Adjustm
ent values are saved to m

em
ory B only w

hen 
O

peration >W
hite Setting >W

hite Sw
itch<B> in the 

setup m
enu is set to M

em
ory.

2 
Set the FILTER knob to suit the lighting 
conditions as follow

s.

3 
Place a w

hite test card under the sam
e lighting 

conditions as the subject to be shot and zoom
 

in on it.
Alternatively, any w

hite object such as a cloth 
or a w

all can be used.
The absolute m

inim
um

 w
hite area is as 

follow
s.

Rectangle centered on the screen
The lengths of the sides are 70%

 of the length 
and w

idth of the screen. 10%
 or m

ore of the 
surface area of the im

age w
ithin the rectangular 

area m
ust be w

hite.

[N
ote]

M
ake sure there are no bright spots in the rectangle.

4 
Adjust the lens iris.
Iris adjusted m

anually: Set the iris to an 
appropriate setting.

Iris adjusted using auto iris: Set the autom
atic/

m
anual sw

itch on the lens to autom
atic.

5 
Push the AU

TO
 W

/B BAL sw
itch to W

H
ITE and 

then release the sw
itch.

The m
essage “Executing…

” appears during 
execution, and changes to “O

K: (color 
tem

perature of subject)” w
hen the adjustm

ent 
finishes.
The adjustm

ent values are saved autom
atically 

in the m
em

ory selected in step 1 (A or B).
[N

ote]
The iris m

ay hunt  1)  during the adjustm
ent. To prevent 

this, adjust the iris gain knob (indicated as IG
, IS, or S) on 

the lens.

1) H
unting: Repeated brightening and darkening of 

the im
age, resulting from

 repeated response to 
autom

atic iris control.

For details, refer to the lens operation m
anual.

If the automatic white balance adjustment cannot 
be made
If the w

hite balance adjustm
ent cannot be 

com
pleted norm

ally, an error m
essage w

ill appear 
for about three seconds on the view

finder screen.

Error m
essage

M
eaning

N
G

: Low
 Light

The w
hite video level is too 

low
. Either open the lens iris or 

increase the gain.
N

G
: H

igh Light
The w

hite video level is too 
high. Either stop dow

n the lens 
iris or change the N

D
 filter.

N
G

: Color Tem
p. 

H
igh

The color tem
perature of the 

subject lighting is too high, 
and could not be adjusted. 
Adjust the color tem

perature 
of the lighting, then update 
m

em
ory.
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Error m
essage

M
eaning

N
G

: Color Tem
p. 

Low
The color tem

perature of the 
subject lighting is too low

, and 
could not be adjusted. Adjust 
the color tem

perature of the 
lighting, then update m

em
ory.

N
G

: O
ut of Range

Value could not be adjusted 
because the difference 
betw

een the current value and 
reference value exceeds the 
adjustm

ent range.
N

G
: Poor W

hite 
Area

The w
hite surface of the 

subject is too narrow
, and 

could not be adjusted.
N

G
: Tim

eout
Adjustm

ent could not be 
com

pleted w
ithin the standard 

num
ber of attem

pts. 
Adjustm

ent could not be 
com

pleted w
ithin the specified 

tim
e.

If any of the above error m
essages is displayed, 

retry the w
hite balance adjustm

ent. If the error 
m

essage occurs again, an internal check is 
necessary.

For inform
ation about this internal check, refer to the 

M
aintenance M

anual.

If you have no time to adjust the white balance
Set the W

H
ITE BAL sw

itch to PRST.

Changing the color temperature when the ND 
filter is switched
You can assign electrical CC (color correction) 
filters to N

D
 filters (page 5) allow

ing you to 
change the color tem

perature autom
atically w

hen 
the N

D
 filter is sw

itched.

1 
Set M

aintenance >W
hite Filter >N

D
 Filter C.

Tem
p to O

n in the setup m
enu (page 107).

2 
To assign an electrical CC filter to FILTER knob 
position num

ber 1, select [N
D

 FLT C.
Tem

p<1>]. To assign it to positions 2 to 4, 
select [N

D
 FLT C.Tem

p<2-4>].

3 
Turn the M

EN
U

 knob to select the desired 
color tem

perature.

4 
Repeat steps 2 and 3 as required.

Switching electrical CC filters with an assignable 
switch
You can assign the function that sw

itches betw
een 

electrical CC filters to an assignable sw
itch. This 

allow
s you to sw

itch betw
een color tem

peratures 
(3200K/4300K/5600K/6300K) that have been 
assigned using up to four positions (A to D

) w
ith 

each press of the assignable sw
itch.

Regardless of assignm
ents to assignable 

sw
itches, you can also sw

itch betw
een the color 

tem
peratures assigned to each position from

 a 
RM

-B170/B750 Rem
ote Control U

nit.

1 
Select M

aintenance >W
hite Filter in the setup 

m
enu.

2 
Select the position to w

hich to assign a CC 
filter by selecting one of [Electrical CC<A>] to 
[Electrical CC <D

>], and then turn the M
EN

U
 

knob to select the desired color tem
perature.

Select “-----” w
ith Electrical CC <C> or <D

> 
selected.
W

hen the assignable sw
itch is pressed, the 

setting for that position is not displayed. For 
exam

ple, if “-----” is set for one position, then 
sw

itching betw
een the rem

aining three 
positions is carried out.

3 
Repeat step 2 as required.

4 
Assign the electrical CC filter sw

itching 
function (ELECTRICAL CC) to an assignable 
sw

itch (page 115).

W
hite balance memory

Values stored in m
em

ory are held until the w
hite 

balance is next adjusted, even if the cam
corder 

pow
er is turned off.

The cam
corder has tw

o w
hite balance m

em
ories, 

A and B. You can autom
atically save adjustm

ent 
values for each N

D
 filter in the m

em
ory that 

corresponds to the W
H

ITE BAL sw
itch setting (A 

or B). The cam
corder has four built-in N

D
 filters, 

allow
ing you to save a total of eight adjustm

ent 
values (4×2). H

ow
ever, the contents of the 

m
em

ories are not linked to N
D

 filter settings in the 
follow

ing cases.
ˎˎ W

hen the num
ber of m

em
ories allocated to 

each of A and B is lim
ited to one by setting 

O
peration >W

hite Setting >Filter W
hite M

em
ory 

in the setup m
enu to O

ff.
ˎˎ W

hen the electrical CC filter sw
itching function 

has been assigned to an assignable sw
itch, 

or w
hen a rem

ote control unit has been 
connected. (In these cases, the contents of 
w

hite balance m
em

ory are linked to electrical 
CC filter positions (A to D

).)
Also, w

hen O
peration >W

hite Setting >W
hite 

Sw
itch<B> in the setup m

enu is set to [ATW
 

(Auto Tracing W
hite Balance)], and the W

H
ITE BAL 

sw
itch is set to B, the ATW

 function is activated 
to autom

atically adjust the w
hite balance of the 

picture being shot for varying lighting conditions.
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Shutter Modes

The shutter m
odes that can be used w

ith the 
electronic shutter and the shutter speeds that can 
be selected are listed below

.

[N
ote]

W
hen a rem

ote control unit, such as the RM
-B170, is 

connected, only standard m
ode (Speed) can be selected.

Standard mode
Select this m

ode for shooting fast-m
oving subjects 

w
ith little blurring.

You can set the shutter speed in one of tw
o 

shutter m
odes: Speed m

ode, in w
hich the speed 

is set in seconds, and Angle m
ode, in w

hich the 
speed is set in degrees.
Speed m

ode

System
 

frequency
Shutter speed (unit: seconds)

59.94i 
59.94P
50i
50P

1/60, 1/100, 1/120, 1/125, 1/250, 1/500, 
1/1000, 1/2000

29.97P
1/40

 a), 1/50
 a), 1/60, 1/100, 1/120, 1/125, 

1/250, 1/500, 1/1000, 1/2000

25P
1/33

 a), 1/50
 a), 1/60, 1/100, 1/120, 1/125, 

1/250, 1/500, 1/1000, 1/2000

23.98P
1/32

 a), 1/48
 a), 1/50

 a), 1/60, 1/96, 1/100, 
1/120, 1/125, 1/250, 1/500, 1/1000, 
1/2000

a) This speed cannot be selected w
hen the cam

corder is in 
Slow

 & Q
uick M

otion m
ode and O

peration >Rec Function 
>Fram

e Rate in the setup m
enu is set to a value that is 

greater than the system
 frequency.

Angle m
ode

180°, 90°, 45°, 22.5°, 11.25°

ECS (Extended Clear Scan) mode
Select this m

ode for obtaining im
ages w

ith no 
horizontal bands of noise w

hen shooting subjects 
such as m

onitor screens.
As show

n in the follow
ing tables, the range of 

shutter speeds that can be set varies depending 
on w

hether the Slow
 & Q

uick M
otion (S&Q

) 
function is on or off.

System
 

frequency
Shutter speed (unit: H

z)
S&Q

: O
ff

S&Q
: O

n
59.94i

60.00 to 7000
—

59.94P
60.00 to 8000

60.00 to 8000
29.97P

30.00 to 8000
30.00 to 8000

23.98P
23.99 to 6000

30.03 to 6000
50i

50.00 to 7000
—

50P
50.00 to 7000

50.00 to 7000
25P

25.02 to 7000
30.00 to 7000

SLS (slow speed shutter) mode
This m

ode is used to shoot subjects w
ith low

 
illum

ination. The num
ber of accum

ulated fram
es 

shot w
hen using the slow

 speed shutter function 
can be set to 2, 3, 4, 5, 6, 7, 8, 16 using O

peration 
>Slow

 Shutter >N
um

ber of Fram
es in the setup 

m
enu.

[N
otes]
ˎˎ SLS m

ode cannot be used w
hen the cam

corder is in Slow
 

& Q
uick M

otion m
ode.

ˎˎ It is not possible to turn the SLS m
ode on or off, or change 

the num
ber of accum

ulated fram
es w

hen recording.

Setting the Shutter Mode and Shutter 
Speed

[N
otes]
ˎˎ W

hen the autom
atic iris is used, the iris opens w

ider as the 
shutter speed increases, thus reducing the depth of field.

ˎˎ The selectable shutter speeds vary depending on the 
current system

 frequency.

Switching between Speed mode and Angle mode

1 
Select O

peration >Shutter >M
ode in the setup 

m
enu.

2 
Turn the M

EN
U

 knob to select [Speed] or 
[Angle], and then press the knob.

Setting the shutter mode and shutter speed 
(standard mode)
O

nce the shutter speed is selected, it is retained 
even w

hen the cam
corder pow

er is turned off.

1 
Push the SH

U
TTER sw

itch from
 O

N
 to SELECT.

The current shutter setting indication appears 
in the view

finder for about three seconds.

2 
Before the shutter setting in step 1 disappears, 
push the SH

U
TTER sw

itch dow
n to SELECT 

again. Repeat this step until the desired m
ode 

or speed appears.
W

hen all m
odes and speeds are displayed, the 

display changes in the follow
ing order.

Speed M
ode (w

ith system
 frequency 59.94i)

ECS M
ode

[N
ote]

D
epending on the fram

e rate setting (page 50), som
e 

shutter speeds cannot be selected in Slow
 & Q

uick M
otion 

m
ode. These speeds are replaced by the slow

est selectable 
shutter speed.

Exam
ple w

hen shooting in XAVC-I 1080P/29.97P, 
fram

e rate of 60, and Slow
 & Q

uick M
otion:

ˎˎ Slow
 & Q

uick M
otion m

ode: O
ff 

1/40�
1/50�

1/60�
1/100�

…
ˎˎ Slow

 & Q
uick M

otion m
ode: O

n 
1/60�

1/100�
…

Setting the shutter speed (ECS mode)

1 
Set the shutter m

ode to ECS (see the previous 
item

).

2 
Turn the M

EN
U

 knob to select the desired 
frequency or num

ber of fram
es.

Setting the shutter speed (SLS mode)

1 
Select O

peration >Slow
 Shutter >Setting in the 

setup m
enu and set the shutter m

ode to O
n.

2 
Select O

peration >Slow
 Shutter >N

um
ber of 

Fram
es in the setup m

enu and select the 
desired num

ber of fram
es.

Setting the Electronic Shutter
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Setting Auto Iris
The reference value for autom

atic iris adjustm
ent 

can be changed to aid the shooting of clear 
pictures of back-lit subjects, or to prevent blow

n-
out highlights.

Setting the Auto Iris Operating Mode

Set the operating m
ode used w

hen adjusting 
levels using auto iris.

1 
Select O

peration >Auto Iris >M
ode in the 

setup m
enu.

2 
Turn the M

EN
U

 knob to select the operating 
m

ode, then press the knob.

O
perating 

m
ode

D
escription

Backlight
M

ode for shooting in backlight 
conditions

Standard
Standard m

ode
Spotlight

M
ode for reducing blow

n out 
highlights w

hen there are 
spotlights centered on a 
subject.

Set the target convergence level for 
auto iris

1 
Select O

peration >Auto Iris >Level in the setup 
m

enu.

2 
Turn the M

EN
U

 knob to select the level in the 
range –99 to +99, then press the knob.

Convergence 
level

D
escription

–99
Sets the iris 2 f-stops or m

ore 
darker

±0
Reference level

+99
Sets the iris 2 f-stops or m

ore 
lighter

Setting the auto iris speed

Set the operating speed w
hen adjusting levels 

using auto iris.

1 
Select O

peration >Auto Iris >Speed in the 
setup m

enu.

2 
Turn the M

EN
U

 knob to select the speed in the 
range –99 (slow

est) to +99 (fastest), then press 
the knob.

Changing the Reference Value of the 
Lens Iris

The reference value for the lens iris can be set 
w

ithin the follow
ing range w

ith respect to the 
standard value.
ˎˎ +0.25 to +1 (increm

ents of 0.25): About 0.25 to 1 
stop further open
ˎˎ –0.25 to –1 (increm

ents of 0.25): About 0.25 to 1 
stop further closed

Also you can set the area w
here light detection 

occurs.

1 
Set O

peration >Auto Iris >Iris O
verride in the 

setup m
enu to O

n.

2 
Set the M

EN
U

 O
N

/O
FF sw

itch to O
FF.

3 
Turn the M

EN
U

 knob to change the reference 
value.

[N
ote]

Be sure to confirm
 that the current shutter m

ode is not 
ECS.

The current reference value is show
n by the iris 

position indicator (page 16) on the 
view

finder screen.
ˎˎ To open the iris slightly, turn the M

EN
U

 
knob counterclockw

ise as seen from
 the 

front of the cam
corder.  

Select one of +0.25, +0.5, +0.75, or +1.
ˎˎ To close the iris slightly, turn the M

EN
U

 
knob clockw

ise as seen from
 the front of the 

cam
corder.  

Select one of –0.25, –0.5, –0.75, or –1.

The changed reference value is retained until 
the pow

er of the cam
corder is turned off. Even 

if the reference value is changed, it reverts to 
the standard value every tim

e the pow
er is 

turned on.

Setting the Auto Iris Detection 
W

indow

1 
Set O

peration >Auto Iris >D
etect W

indow
 

Indication in the setup m
enu to O

n.
The current autom

atic iris w
indow

 appears on 
the view

finder screen.
If it is not necessary to display the auto iris 
w

indow
 on the screen, set to O

ff.

2 
Select O

peration >Auto Iris >D
etect W

indow
 

in the setup m
enu.

3 
Turn the M

EN
U

 knob until the desired auto iris 
w

indow
 appears, and then press the knob.

The shaded parts indicate the area 
of light detection.

If you select Var, the follow
ing item

s becom
e 

effective and you can set the w
indow

 of the 
desired size. Set O

peration >Auto Iris >Iris Var 
W

idth, Iris Var H
eight, Iris Var, Iris Var H

 Position, 
and Iris Var V Position in the setup m

enu.

Item
setting

Iris Var W
idth

The w
idth of the w

indow
Iris Var H

eight
The height of the w

indow
Iris Var H

 
Position

The position of the w
indow

 
in the horizontal direction

Iris Var V 
Position

The position of the w
indow

 
in the vertical direction.

W
hen you exit the m

enu, the auto iris w
indow

 
selected in step 3 appears.
U

nless you need to keep this w
indow

 displayed, 
set O

peration >Auto Iris >D
etect W

indow
 

Indication in the setup m
enu to O

ff.

Reducing the Effect of Bright 
Highlights

If the subject is too bright, the iris m
ay close too 

m
uch, leaving the overall im

age dark, a condition 
know

n as clipped blacks. In such cases, sw
itching 

the clip highlight function on w
ill clip the signal 

above a certain level, reducing the effects of the 
auto iris.
Set O

peration >Auto Iris >Clip H
igh Light in the 

setup m
enu to O

n.
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Adjusting the Iris Gain on the Lens 
Supplied with the PXW

-X400KC

1 
Set the iris m

ode sw
itch to the A (auto) 

position.

2 
Flip off the rubber cap of the iris gain 
adjustm

ent trim
m

er.

3 
Turn the iris gain adjustm

ent trim
m

er using a 
screw

driver, or sim
ilar object, to adjust the 

gain.
Turn clockw

ise to increase the gain. Turn 
counterclockw

ise to decrease the gain.
Adjust w

hile w
atching the iris ring on the lens 

body.

4 
Reattach the rubber cap.
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Adjusting the Focus
This section describes the focus adjustm

ent w
hen 

using the lens supplied w
ith the PXW

-X400KF.

[N
ote]

The lens is designed w
ith an extra m

argin at the infinity 
position (∞

), to com
pensate for focus drifting due to 

variations in tem
perature. W

hen shooting a subject at infinity 
in M

F or Full M
F m

ode, check the picture in the view
finder 

as you focus.

Adjusting in Full MF Mode

W
hen you slide the focus ring back (tow

ard the 
cam

corder), the focus m
ode is set to Full M

F m
ode 

for full m
anual focus adjustm

ent.

[N
ote]

W
hen you slide the focus ring back, the focus instantly 

m
oves to the m

arker position.

Focus by turning the focus ring w
hile view

ing the 
view

finder.
The distance indications on the ring are valid in 
Full M

F m
ode. The distances w

here the picture is 
in focus correspond to absolute positions of the 
focus ring.

Peaking
You can turn the PEAKIN

G
 knob on the view

finder 
to use the peaking function. Edges are em

phasized 
in the m

onitor picture, w
hich facilitates m

anual 
focusing.
The recorded video signals are not affected.

Using the Focus Ring

Adjust the focus by turning the focus ring w
hile 

view
ing the view

finder.
The distance indications on the ring are invalid in 
M

F m
ode.

One-push Auto Focus

Press the PU
SH

 AF button. The auto focus activates 
tem

porarily.
The one-push auto focus stops w

hen the subject 
com

es into focus.

MF Assist Function

W
hen the M

F assist function is on (page 115), 
auto focus is activated after you stop focusing 
using the focus ring and provides fine control 
adjustm

ent of the focus of the subject in the 
center of the display (focus tracking).
W

hen fine adjustm
ent stops, the M

F assist auto 
focus operation ends.

Adjusting in AF Mode

W
hen you slide the focus ring forw

ard and set 
the FO

CU
S sw

itch to A (auto), the focus m
ode 

becom
es AF m

ode, in w
hich auto focus is available 

continuously.
The distance indications on the ring are invalid in 
AF m

ode.

Using Macro Mode

W
hen the focus m

ode is M
F or AF, set the M

ACRO
 

sw
itch to the O

N
 position to enable m

acro m
ode. 

M
acro m

ode allow
s you to adjust the focus over a 

range that includes the m
acro area.

M
acro m

ode is disabled in Full M
F m

ode.
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Adjusting the Audio Level
W

hen you set the AU
D

IO
 SELECT sw

itch to AU
TO

, 
the input levels of analog audio signals recorded 
on each channel are adjusted autom

atically. You 
can also m

ake m
anual adjustm

ents.

[N
ote]

Even if you set the AU
D

IO
 SELECT sw

itch to AU
TO

, the input 
levels of digital audio signals are not adjusted autom

atically.

Target Audio Level for Manual 
Adjustment

M
ake adjustm

ent using –20 dB as the target level.
If the audio level m

eter show
s a m

axim
um

 level of 
0 dB, then it indicates that the input audio level is 
excessive.

Excessive input level

Target input level

Manually Adjusting the Audio Levels 
of the Audio Inputs from the AUDIO 
IN CH-1/CH-2 Connectors

1 
To adjust the signal input to the AU

D
IO

 IN
 

CH
-1 or CH

-2 connector, set the AU
D

IO
 IN

 CH
1 

or CH
2 sw

itch to REAR.
To adjust both input signals, set both sw

itches 
to REAR.

2 
Set the AU

D
IO

 SELECT sw
itch(es) 

corresponding to the channel(s) selected in 
step 1 to M

AN
U

AL.

3 
W

ith the LEVEL knob(s) for the channel(s) 
selected in step 1, adjust so that the audio 
level m

eter show
s up to –20 dB for a norm

al 
input volum

e.

Selecting the knob used for adjusting the 
recording level
In M

aintenance >Audio in the setup m
enu, you 

can select w
hich audio level control controls 

the audio recording level of the input to each 
of the AU

D
IO

 IN
 CH

-1/CH
-2 connectors. The 

correspondences betw
een the settings of the 

m
enu item

s and the controls are as follow
s.

[N
ote]

If an AES/EBU
 digital audio signal is input, the recording level 

cannot be adjusted using the cam
corder.

Rear1/W
RR Level: Channel 1 recording level

Setting
Knob

Side1
LEVEL (CH

1) knob
Front

M
IC LEVEL knob

Front+Side1
LEVEL (CH

1) knob and M
IC LEVEL 

knob (linked operation)

Rear2/W
RR Level: Channel 2 recording level

Setting
Knob

Side2
LEVEL (CH

2) knob
Front

M
IC LEVEL knob

Front+Side2
LEVEL (CH

2) knob and M
IC LEVEL 

knob (linked operation)

[N
ote]

W
hen you have operation of the LEVEL (CH

1/CH
2) knobs 

and M
IC LEVEL knob linked together, if the M

IC LEVEL knob 
is set to 0, the audio signals on channels 1 and 2 cannot be 
recorded. Check the position of the M

IC LEVEL knob before 
adjusting the LEVEL (CH

1/CH
2) knobs.

Manually Adjusting the Audio Level 
of the MIC IN Connector

1 
Set either or both of the AU

D
IO

 IN
 sw

itch(es) 
to FRO

N
T.

2 
Set the AU

D
IO

 SELECT sw
itch(es) for the 

desired channel(s) selected in step 1 to 
M

AN
U

AL.

3 
Turn the M

IC LEVEL knob, and adjust so that 
the audio level m

eter show
s up to –20 dB for a 

norm
al input volum

e.

Selecting the knob used for adjusting the 
recording level
In M

aintenance >Audio in the setup m
enu, you 

can select w
hich audio level control controls the 

audio recording level of the front m
icrophone 

input. The correspondences betw
een the settings 

of the m
enu item

s and the controls are as follow
s.

M
IC CH

1 Level: Channel 1 recording level

Setting
Knob

Side1
LEVEL (CH

1) knob
Front

M
IC LEVEL knob

Front+Side1
LEVEL (CH

1) knob and M
IC LEVEL 

knob (linked operation)

M
IC CH

2 Level: Channel 2 recording level

Setting
Knob

Side2
LEVEL (CH

2) knob
Front

M
IC LEVEL knob

Front+Side2
LEVEL (CH

2) knob and M
IC LEVEL 

knob (linked operation)

[N
ote]

W
hen you have operation of the M

IC LEVEL knob and LEVEL 
(CH

1/CH
2) knobs linked together, if the LEVEL (CH

1/CH
2) 

knobs are set to 0, the audio signals on channels 1 and 2 
cannot be recorded. Check the position of the LEVEL (CH

1/
CH

2) knobs before adjusting the M
IC LEVEL knob.

Recording Audio on Channels 3 and 4

1 
Select the audio recorded on audio channels 3 
and 4 w

ith the AU
D

IO
 IN

 CH
3/CH

4 sw
itches.

CH
3 sw

itch
Channel 3 recording target

FRO
N

T
Front m

icrophone audio
REAR

Audio signal input to AU
D

IO
 IN

 
CH

1 connector
W

IRELESS
W

ireless m
icrophone audio

CH
4 sw

itch
Channel 4 recording target

FRO
N

T
Front m

icrophone audio
REAR

Audio signal input to AU
D

IO
 IN

 
CH

2 connector
W

IRELESS
W

ireless m
icrophone audio

2 
To adjust autom

atically, set the AU
D

IO
 SELECT 

CH
 3-4 sw

itch to AU
TO

.
To adjust m

anually, set the AU
D

IO
 SELECT CH

 
3-4 sw

itch to M
AN

U
AL.

3 
Select the knobs that adjust the audio levels 
w

ith the Audio CH
3 Level and Audio CH

4 Level 
item

s under M
aintenance >Audio in the setup 

m
enu.

Audio CH
3 Level: Channel 3 recording level

Setting
Knob

Side3
LEVEL (CH

3) knob
Front

M
IC LEVEL knob
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Setting
Knob

Front+Side3
LEVEL (CH

3) knob and M
IC 

LEVEL knob (linked operation)

Audio CH
4 Level: Channel 4 recording level

Setting
Knob

Side4
LEVEL (CH

4) knob
Front

M
IC LEVEL knob

Front+Side4
LEVEL (CH

4) knob and M
IC 

LEVEL knob (linked operation)

You can now
 adjust the levels of audio 

channels 3 and 4 w
ith the knobs selected here.
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Setting Tim
e D

ata
Setting the Timecode

The tim
ecode setting range is from

 00:00:00:00 to 
23:59:59:29 (hours:m

inutes:seconds:fram
es).

1 
Press the D

ISP SEL/EXPAN
D

 button to sw
itch 

the display in the LCD
 m

onitor to status 
display.

2 
Set the D

ISPLAY sw
itch to TC.

3 
Set the PRESET/REG

EN
/CLO

CK sw
itch to 

PRESET.

4 
Set the F-RU

N
/SET/R-RU

N
 sw

itch to SET.
The first (leftm

ost) digit of the tim
ecode 

flashes.

5 
U

se the up and dow
n arrow

 buttons to 
change values, and use the left and right arrow

 
buttons to m

ove the flashing digit. Repeat 
until all digits are set.
To reset the value to 00:00:00:00, press the 
RESET/RETU

RN
 button.

6 
Set the F-RU

N
/SET/R-RU

N
 sw

itch to F-RU
N

 or 
R-RU

N
.

F-RU
N

: Free run (tim
ecode generator keeps 

running)
R-RU

N
: Recording run (tim

ecode generator 
runs only w

hile recording)

[N
ote]

W
hen picture cache m

ode is active, tim
e data cannot be set 

by sw
itching the F-RU

N
/SET/R-RU

N
 sw

itch to SET. To set tim
e 

data, turn picture cache m
ode off.

Switching between DF and NDF
You can select the drop fram

e (D
F) m

ode or 
non-drop fram

e (N
D

F) m
ode using M

aintenance 
>Tim

ecode >D
F/N

D
F in the setup m

enu.

To make the timecode consecutive
W

hen the F-RU
N

/SET/R-RU
N

 sw
itch is set to 

R-RU
N

, recording a num
ber of scenes on the 

m
edia norm

ally produces consecutive tim
ecode. 

H
ow

ever, once you rem
ove the m

edia and record 
on another m

edia, the tim
ecode w

ill no longer 
be consecutive w

hen you use the original m
edia 

again for recording.
In this case, to m

ake the tim
ecode consecutive, set 

the PRESET/REG
EN

/CLO
CK sw

itch to REG
EN

.

Saving the real time in the timecode
Setting the PRESET/REG

EN
/CLO

CK sw
itch to 

CLO
CK saves the real tim

e in the tim
ecode. The 

tim
e of the cam

corder internal clock is applied as 
the real tim

e.

For details about adjusting the internal clock, see “Setting the 
D

ate and Tim
e of the Internal Clock” (page 25).

Setting the User Bits

By setting the user bits (up to 8 hexadecim
al 

digits), you can record user inform
ation such as 

the date, tim
e, or scene num

ber on the tim
ecode 

track.

1 
Press the D

ISP SEL/EXPAN
D

 button to sw
itch 

the display in the LCD
 m

onitor to status 
display.

2 
Set the D

ISPLAY sw
itch to U

-BIT.

3 
Set the F-RU

N
/SET/R-RU

N
 sw

itch to SET.
The first (leftm

ost) digit flashes.

4 
U

se the up and dow
n arrow

 buttons to 
change values, and use the left and right arrow

 
buttons to m

ove the flashing digit. Repeat 
until all digits are set.

To reset the value to 00 00 00 00, press the 
RESET/RETU

RN
 button.

5 
Set the F-RU

N
/SET/R-RU

N
 sw

itch to F-RU
N

 or 
R-RU

N
, corresponding to the desired operating 

m
ode for the tim

ecode generator.

User bit memory function
The user bit setting (apart from

 the real tim
e) is 

autom
atically retained in m

em
ory even w

hen the 
pow

er is turned off.

Synchronizing the Timecode to an 
External Source

You can synchronize the internal tim
ecode 

generator of this cam
corder w

ith an external 
generator. You can also synchronize the tim

ecode 
generators of other cam

corders/VTRs w
ith the 

internal generator of this cam
corder.

1 
Connect both the reference video signal and 
the external tim

ecode as illustrated below
.

Exam
ple 1: Synchronizing w

ith an external 
signal

[2]
[1]

External tim
ecode

Reference video signal

[1] G
EN

LO
CK IN

 connector
[2] TC IN

 connector

Exam
ple 2: Interconnecting a num

ber of 
cam

corders w
ith one cam

corder as reference

To next cam
corder

[1] VID
EO

 O
U

T connector
[2] TC O

U
T connector

[3] TC IN
 connector

[4] G
EN

LO
CK IN

 connector

2 
Turn on the PO

W
ER sw

itch.

3 
Set the PRESET/REG

EN
/CLO

CK sw
itch to 

PRESET.

4 
Set the F-RU

N
/SET/R-RU

N
 sw

itch to F-RU
N

.

5 
Set the D

ISPLAY sw
itch to TC.

6 
Supply a tim

ecode signal and a reference 
video signal, com

plying w
ith the SM

PTE 
standard and in proper phase relationship, to 
the TC IN

 connector and to the G
EN

LO
CK IN

 
connector, respectively.
This operation synchronizes the internal 
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tim
ecode generator w

ith the external 
tim

ecode. O
nce about ten seconds have 

elapsed after the tim
ecode locks, the external 

lock state is m
aintained even if the external 

tim
ecode source is disconnected.

To release the external synchronization, first 
stop the external tim

ecode input, then set the 
F-RU

N
/SET/R-RU

N
 sw

itch to R-RU
N

.

[N
otes]
ˎˎ W

hen you finish the above procedure, the internal 
tim

ecode is im
m

ediately synchronized w
ith the external 

tim
ecode and the tim

e data display w
ill show

 the value of 
the external tim

ecode. H
ow

ever, w
ait for a few

 seconds 
until the sync generator stabilizes before recording.
ˎˎ If the frequency of the reference video signal is not the 

sam
e as the system

 frequency of the cam
corder, the 

cam
corder cannot be correctly genlocked. If this occurs, 

the tim
ecode w

ill not acquire successful lock w
ith the 

external tim
ecode.

User bit settings during synchronization
W

hen the tim
ecode is synchronized to an external 

signal, only the tim
e data is synchronized w

ith the 
external tim

ecode value.

Note on changing the power supply from the 
battery pack to an external power supply during 
external synchronization
To m

aintain a continuous pow
er supply, connect 

the external pow
er supply to the D

C IN
 connector 

before rem
oving the battery pack. You m

ay lose 
tim

ecode external synchronization if you rem
ove 

the battery pack first.

Camcorder genlock during external 
synchronization
D

uring external synchronization, the cam
corder is 

genlocked to the reference video signal input from
 

the G
EN

LO
CK IN

 connector.
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Basic O
perations

This section explains the basic shooting and 
recording procedures.
Before starting to shoot, inspect the cam

era 
system

 to verify that it is operating properly.

1 
Attach a fully charged battery pack 
(page 22).

2 
Load one or tw

o SxS m
em

ory cards 
(page 30).
If you load tw

o cards, the cam
corder sw

itches 
autom

atically to the second card w
hen the 

first card becom
es full.

3 
Set the cam

corder’s PO
W

ER sw
itch 

(page 3) to O
N

.

4 
M

ake the follow
ing settings.

M
arker display: O

n (page 93)
Iris: Auto (page 40)
Zoom

: Auto
Cam

era output: Select the picture currently 
being shot (cam

era picture), and turn the 
D

CC function on (page 6)
Tim

ecode advance m
ode: F-RU

N
 (Free Run) or 

R-RU
N

 (Rec Run) (page 45)
Audio input channel selection: Auto 

(page 9)

5 
Push the AU

TO
 W

/B BAL sw
itch to the BLACK 

position to adjust the black balance 
(page 37).

6 
Select a filter according to the lighting 
conditions, and adjust the w

hite balance 
(page 37).

7 
Point the cam

corder at the subject, and adjust 
the focus and zoom

.

8 
If you are using the electronic shutter, select an 
appropriate shutter m

ode and speed 
(page 39).

9 
D

o one of the follow
ing to start recording.

 –Press the REC START button (page 4).
 –Press the VTR button on the lens.
 –Turn on the assignable sw

itch to w
hich the 

Rec function has been assigned (page 114).

D
uring recording, the TALLY indicators, the 

tally indicator on the front panel of the 
view

finder, and the REC indicator on the 
view

finder screen light. Adjust the zoom
 and 

focus as required.

 
[N

otes]
ˎˎ N

ever rem
ove the battery pack w

hile the cam
corder 

is recording (w
hile the ACCESS indicator on the 

right-side panel is lit in blue and the ACCESS indicator 
in the card slot section is lit in orange). D

oing so 
risks the loss of several seconds of data before 
the recording w

as interrupted, because internal 
processing w

ill not end norm
ally.

ˎˎ The playback control buttons (EJECT, F REV, F FW
D

, 
N

EXT, PREV, PLAY/PAU
SE, STO

P) do not function 
during recording.

10 To stop recording, perform
 one of the 

operations listed in step 9.
The TALLY indicators, the tally indicator on the 
front panel of the view

finder, and the REC 
indicator on the view

finder screen go out, and 
cam

corder enters recording standby (Stby) 
m

ode.
A clip is created from

 the video and audio data 
and the m

etadata recorded betw
een steps 9 

and 10.

To review the recording (rec review)
W

ith the cam
corder in recording standby 

m
ode, press an assignable sw

itch assigned 
w

ith the Rec Review
 function to play back the 

last tw
o seconds of the clip at norm

al speed. 
Press and hold an assignable sw

itch assigned 
w

ith the Rec Review
 function for one second 

or longer to start play back from
 the fram

e tw
o 

seconds prior to the last fram
e at four tim

es 
speed in the reverse direction. Then, release 

the button to play the clip from
 that point at 

norm
al speed. The clip is played to the end, 

then Rec Review
 ends and the cam

corder 
returns to Stby m

ode.
W

hen the Rec Review
 function is assigned to 

the RET button on the lens, you can also 
conduct a review

 by using the RET button.

11 Repeat steps 9 and 10 to continue recording.
W

ith each repetition, another clip is created on 
the m

em
ory card.

Clip 1
Clip 2

Clip 3

[N
otes]
ˎˎ You cannot resum

e recording for about one second after 
stopping recording.
ˎˎ The m

axim
um

 num
ber of clips that can be recorded on 

one m
em

ory card is 600. Even if the m
em

ory card has 
enough free capacity to record m

ore clips, w
hen 600 clips 

have been recorded, no further recording is possible.

Clip names
Eight-character clips nam

es (consisting of a 
four-character prefix and a four-digit num

ber) are 
generated autom

atically for clips recorded by this 
cam

corder.
Exam

ple: ABCD
0001

You can also use O
peration >Clip >Title Prefix 

in the setup m
enu to set the clip nam

e prefix 
to a user-specified string of characters (four to 
46 characters in length). (A user-specified prefix 
cannot be changed after recording.)
The four-digit num

ber at the end of clip nam
es is 

generated autom
atically, increm

enting as clips are 
recorded.

Playing Recorded Clips

W
hen the cam

corder is in standby (Stby) m
ode, 

you can play all or part of the m
ost recently 

recorded clip (page 47).

1 
Insert the SxS m

em
ory card to play 

(page 30).

2 
Press the PREV button (page 8) or the F REV 
button (page 7) to cue up the clip to play.

3 
Press the PLAY/PAU

SE button.
The PLAY/PAU

SE indicator lights, and the 
playback picture appears in the view

finder.

Pausing playback
Press the PLAY/PAU

SE button.
The PLAY/PAU

SE indicator flashes w
hile play is 

paused.
Press the button again to return to play m

ode.

High-speed playback
Press the F FW

D
 button (page 8) or the F REV 

button (page 7).
To return to norm

al playback, press the PLAY/
PAU

SE button.

Stopping playback
Press the STO

P button: Playback stops, and the 
cam

corder enters E-E m
ode.

Press the TH
U

M
BN

AIL button: Playback stops and 
the thum

bnail screen (page 78) appears in 
the view

finder.
Playback also stops and the tim

ecode screen 
appears in the view

finder w
hen you start 

recording during playback, and w
hen you eject an 

SxS m
em

ory card.
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Switching between memory cards
W

hen tw
o m

em
ory cards are loaded, press the 

SLO
T SELECT button (page 30) to select the 

active slot.
It is not possible to sw

itch betw
een m

em
ory cards 

during playback.
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Recording Shot Marks

O
n this cam

corder, tw
o types of shot m

arks are 
available. You can record them

 at user-specified 
positions to m

ake it easier for editors to cue up 
those positions.
The m

axim
um

 num
ber of shot m

arks per clip is 
999.

You can also use the Thum
bnail m

enu to add and delete shot 
m

arks in clips. For details, see “Adding/D
eleting Essence M

arks on 
Clips” (page 82).

To record shot m
arks, turn on an assignable sw

itch 
assigned w

ith the Shot M
ark 1 or Shot M

ark 2 
function.
W

hen a shot m
ark is recorded, a “Shot M

ark 1” or 
“Shot M

ark 2” indication appears in the view
finder 

for about three seconds near the tim
ecode 

indicator.

[N
ote]

An SD
XC card inserted in an SxS card slot using the M

EAD
-

SD
02 M

edia Adaptor (option) cannot be used for recording.

Setting Clip Flags

To m
ake it easier for editors to select good clips, 

you can set clip flags in recorded clips.
Clip flags are set in the Thum

bnail m
enu. For 

details, see “Adding Clip Flags to Clips” (page 81) 
and “D

eleting a Clip Flag” (page 82).

[N
ote]

An SD
XC card inserted in an SxS card slot using the M

EAD
-

SD
02 M

edia Adaptor (option) cannot be used for recording.

Recording Retroactive Images 
(Picture Cache Rec Function)

The cam
corder alw

ays m
aintains a cache of video 

and audio data for a set interval (m
axim

um
 of 

15 seconds) in internal storage m
em

ory w
hen 

shooting, allow
ing you to record several seconds 

of footage before the start of recording.
This function is enabled w

hen the cam
corder is set 

to any of the follow
ing video form

ats (page 34).
XAVC-I
XAVC-L
M

PEG
 H

D
 422

M
PEG

 H
D

 420
M

PEG
 IM

X 50

To start recording in picture cache m
ode, picture 

cache m
ode and the storage tim

e of im
ages 

in m
em

ory (picture cache tim
e) m

ust be set 
beforehand in the O

peration m
enu.

W
hen recording is started, the duration of footage 

that can be recorded retroactively is determ
ined 

by the picture cache tim
e. The duration that can 

be recorded retroactively m
ay be reduced in som

e 
circum

stances, as described in [N
otes] below

.

[N
otes]
ˎˎ The storage of video in m

em
ory starts w

hen picture 
cache m

ode is selected. H
ow

ever, if recording is started 
im

m
ediately after selecting this m

ode, a portion of the 
im

ages shot im
m

ediately prior to selecting picture cache 
m

ode w
ill not be recorded.

ˎˎ Im
ages are not stored in m

em
ory during playback, 

recording review
, or thum

bnail display, so picture 
cache recording of im

ages during these periods is not 
supported.

Setting the picture cache time

1 
Select O

peration >Rec Function >Picture 
Cache Rec in the setup m

enu.

2 
Turn the M

EN
U

 knob to select [O
n], then press 

the knob.

3 
Select O

peration >Rec Function > Cache Rec 
Tim

e in the setup m
enu.

4 
Turn the M

EN
U

 knob to select the picture 
cache tim

e setting, then press the knob.
0 to 2, 2 to 4, 4 to 6, 6 to 8, 8 to 10, 10 to 12, 12 
to 14, or 13 to 15 seconds can be selected.

O
nce picture cache m

ode is selected, it is 
m

aintained until the settings are changed.
Alternatively, instead of perform

ing steps 1 and 
2, you can also select picture cache m

ode using 
an assignable sw

itch (page 114) w
hich has been 

assigned w
ith the Picture Cache function.

[N
otes]
ˎˎ O

nly one special recording function, such as picture cache 
recording, can be used at any one tim

e.  
If another special recording m

ode is enabled w
hile picture 

cache recording is in use, picture cache recording is 
autom

atically released.
ˎˎ Changing system

 settings, such as the video form
at, 

clears all im
ages stored in m

em
ory. Consequently, im

ages 
shot just before changing settings cannot be recorded, if 
recording is started im

m
ediately after changing settings. 

Picture cache m
ode is autom

atically released.
ˎˎ The picture cache tim

e cannot be set during recording.

Starting picture cache recording
Shoot as described in “Basic O

perations” 
(page 47).

W
hen recording starts, the “Ć

Cache” indication in 
the view

finder changes to the “Ć
Rec” indication. 

The TALLY indicators and the tally indicator on 
the front panel of the view

finder light as they do 
during norm

al recording.

To exit, stop the recording,

Canceling picture cache mode
In recording standby m

ode, set O
peration >Rec 

Function >Picture Cache Rec in the setup m
enu 

to O
ff.

Device operation when recording in picture cache 
mode
The recording procedure is essentially the sam

e, 
except for the follow

ing points w
here operation 

varies from
 norm

al.
ˎˎ If recording is started w

hile accessing m
edia, 

the actual start point of recording m
ay be 

delayed even longer than the set picture cache 
tim

e. The delay increases w
ith the num

ber 
of recorded clips, so stopping recording and 
quickly restarting recording should be avoided 
in picture cache m

ode.
ˎˎ Regardless of the setting of the F-RU

N
/SET/R-

RU
N

 sw
itch, the cam

corder operates in F-RU
N

 
m

ode.
ˎˎ In picture cache m

ode, tim
e data cannot be set 

by sw
itching the F-RU

N
/SET/R-RU

N
 sw

itch to 
SET.  
To set tim

e data, first stop picture cache m
ode.

ˎˎ If the rem
aining recording tim

e of the m
edia 

in the currently selected slot is shorter than the 
picture cache tim

e, im
ages are recorded to the 

m
edia (if there is sufficient rem

aining recording 
tim

e) in the non-selected slot.  
H

ow
ever, im

ages are not recorded if there is no 
m

edia in the non-selected slot or if the m
edia 

in the slot has insufficient rem
aining recording 

tim
e. (A m

essage notifying you that there 
is insufficient rem

aining recording tim
e w

ill 
appear on the view

finder screen.)
ˎˎ Shot m

arks are not recorded, even if the 
shot m

arks are set before the recording start 
operation.

If the camcorder is turned off during recording

ˎˎ If the PO
W

ER sw
itch on the cam

corder is set 
to the O

FF position, the m
edia is accessed for 

several seconds to record the im
ages stored 

in m
em

ory up till that m
om

ent, and then the 
pow

er turns off autom
atically.

ˎˎ If the battery is rem
oved, the D

C cable 
disconnected, or the AC adaptor turned off 

Advanced O
perations
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during recording, the video and audio data 
stored in m

em
ory is erased, and im

ages up till 
that point are not recorded. Care should be 
exercised w

hen exchanging the battery.

Recording Time-lapse Video (Interval 
Rec Function)

The cam
corder’s Interval Rec function allow

s you 
to capture tim

e-lapse video to the cam
corder’s 

internal m
em

ory. This function is an effective w
ay 

to shoot slow
-m

oving subjects.  
W

hen you start recording, the cam
corder 

autom
atically records a specified num

ber of 
fram

es at a specified interval tim
e.

This function is enabled w
hen the cam

corder is set 
to any of the follow

ing video form
ats (page 34).

XAVC-I
XAVC-L
M

PEG
 H

D
 422

Recording interval (Interval Tim
e)

N
um

ber of fram
es in one take

(N
um

ber of Fram
es)

A pre-lighting function is available w
hen Interval 

Rec is enabled. This function autom
atically turns 

on the video light before recording starts, w
hich 

allow
s you to record pictures under stable light 

and color tem
perature conditions.

[N
otes]
ˎˎ O

nly one special recording function, such as Interval Rec 
recording, can be used at any one tim

e.  
If another special recording m

ode is enabled w
hile 

Interval Rec is in use, for exam
ple, Interval Rec is 

autom
atically released.

ˎˎ Interval Rec settings cannot be changed during recording.

Setting Interval Rec

1 
Select O

peration >Rec Function >Interval Rec 
in the setup m

enu.

2 
Turn the M

EN
U

 knob to select [O
n], then press 

the knob.
The cam

corder enters Interval Rec m
ode, and 

“Int Stby” appears at the REC indicator position 
on the view

finder screen. (The green tally 
indicator in the H

D
VF series view

finder also 
flashes.)

3 
Select [N

um
ber of Fram

es], turn the M
EN

U
 

knob to select the num
ber of fram

es to record 
in one take, and then press the knob.
You can select 2, 6, or 12 w

hen the form
at is 

50P or 59.9P.
You can select 1, 3, 6, or 9 w

hen the form
at is 

23.98P, 25P, 29.97P, 50i, or 59.94i.

4 
Select [Interval Tim

e], turn the M
EN

U
 knob to 

select the desired interval, and then press the 
knob.
You can select 1 to 10/15/20/30/40/50 sec, 1 
to 10/15/20/30/40/50 m

in, or 1 to 4/6/12/24 
hour.

5 
As required, select [Pre-Lighting], turn the 
M

EN
U

 knob to select the length of lighting 
tim

e before recording starts, and then press 
the knob.
You can select 2, 5, 10 seconds. or O

ff.

 
[N

otes]
ˎˎ If you w

ant to turn the video light on before the start 
of recording, set the cam

corder’s LIG
H

T sw
itch to 

AU
TO

. The video light sw
itch m

ust also be turned on. 
W

hen this is done, the video light turns on and off 
autom

atically. H
ow

ever, the video light rem
ains lit if 

the tim
e that it w

ould be off is five seconds or less.
ˎˎ If you set the LIG

H
T sw

itch to M
AN

U
AL and turn the 

video light sw
itch on, the video light is alw

ays lit. (The 
video light does not turn on and off autom

atically.)

The cam
corder exits Interval Rec m

ode w
hen it is 

pow
ered off, but the num

ber of fram
es, interval 

tim
e, and pre-lighting settings are m

aintained. You 
do not need to set them

 again the next tim
e you 

shoot in Interval Rec m
ode.

Starting Interval Rec recording
M

ake the settings and preparations described 
in “Basic O

perations” (page 47), secure the 
cam

corder so that it does not m
ove, and begin 

shooting.

W
hen Interval Rec m

ode is set to O
n, “Int Stby” 

appears at the REC position on the view
finder 

screen. W
hen you start recording, “Ć

Int Rec” and 
“Ć

Int Stby” are displayed alternately. The TALLY 
indicators and the tally indicator on the front panel 
of the view

finder light as they do during norm
al 

recording. (The green tally indicator in the H
D

VF 
series view

finder also flashes at high speed.)
If you are using the pre-lighting function, the video 
light com

es on before recording starts.

To exit, stop the recording,
W

hen shooting ends, the video data stored in 
m

em
ory up to that point is w

ritten to the m
edia.

Canceling Interval Rec mode
D

o one of the follow
ing.

ˎˎ Set the PO
W

ER sw
itch to O

FF.
ˎˎ In recording standby m

ode, set O
peration >Rec 

Function >Interval Rec in the setup m
enu to O

ff.

[N
ote]

Restarting the cam
corder autom

atically releases Interval Rec 
m

ode.

Limitations during recording

ˎˎ Regardless of the setting of the F-RU
N

/SET/R-
RU

N
 sw

itch, the advance m
ode of the internal 

tim
ecode generator is alw

ays R-RU
N

.
ˎˎ Audio is not recorded.
ˎˎ Review

ing the recording (Rec Review
) is not 

possible.
ˎˎ G

enlock is not possible.

If the camcorder is turned off during recording

ˎˎ If the PO
W

ER sw
itch on the cam

corder is set 
to the O

FF position, the m
edia is accessed for 

several seconds to record the im
ages stored 

in m
em

ory up till that m
om

ent, and then the 
pow

er turns off autom
atically.

ˎˎ If pow
er is lost because the battery w

as 
rem

oved, the D
C pow

er cord w
as disconnected, 

or the pow
er w

as turned off on the AC adaptor 
side, then the video and audio data shot up to 
that point m

ay be lost (m
axim

um
 10 seconds). 

Care should be exercised w
hen exchanging the 

battery.

Shooting with Slow & Quick Motion

W
hen the video form

at (page 34) is set to one 
of the form

ats listed below
, you can specify a 

recording fram
e rate that is different from

 the 
playback fram

e rate.

[N
ote]

If shooting in XAVC recording form
at, the use of SxS Pro+ 

m
em

ory cards is recom
m

ended. The use of other SxS 
m

em
ory cards m

ay be subject to lim
itations, so you should 

contact your dealer.
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Recording 
form

at
System

 
frequency

S&Q
 fram

e rate

XAVC-I 1080P
59.94P/50P/ 
29.97P/23.98P/ 
25P

1 FPS to 60 FPS 
(1 FPS units)

XAVC-L 50 
1080P

59.94P/50P/ 
29.97P/23.98P/ 
25P

XAVC-L 35 
1080P

59.94P/50P/ 
29.97P/23.98P/ 
25P

H
D

422 50 
1080P

29.97P
1 FPS to 30 FPS 
(1 FPS units)

23.98P
25P

1 FPS to 25 FPS 
(1 FPS units)

By shooting w
ith a fram

e rate that differs from
 

the playback fram
e rate, you can obtain slow

 and 
quick m

otion effects that are sm
oother than low

-
speed or high-speed playback of content recorded 
at the norm

al fram
e rate.

Setting Slow & Quick Motion

1 
Select O

peration >Rec Function >Slow
 & Q

uick 
M

otion in the setup m
enu.

2 
Turn the M

EN
U

 knob to select [O
n], then press 

the knob.
Slow

 & Q
uick M

otion starts, and “S&Q
 Stby” 

appears in the recording status indicator area 
in the view

finder.
N

ext, set the fram
e rate.

3 
Select O

peration >Rec Function >Slow
 & Q

uick 
M

otion >Fram
e Rate in the setup m

enu.

4 
Turn the M

EN
U

 knob to select the fram
e rate, 

then press the knob.

W
hen you finish m

aking these settings, the system
 

frequency and the fram
e rate appear at the top of 

the view
finder screen. You can change the fram

e 
rate w

hile view
ing the display in the view

finder by 
turning the M

EN
U

 knob.
The Slow

 & Q
uick M

otion m
ode setting and the 

fram
e rate are retained even after the cam

corder is 
pow

ered off.

[N
otes]
ˎˎ O

nly one special recording function, such as Slow
 & Q

uick 
M

otion, can be used at any one tim
e.

ˎˎ If another special recording function is enabled w
hile 

using Slow
 & Q

uick M
otion, Slow

 & Q
uick M

otion is 
autom

atically canceled.
ˎˎ Slow

 & Q
uick M

otion cannot be set during recording, 
playback, or w

hile the thum
bnail screen is displayed.

ˎˎ Slow
 & Q

uick M
otion cannot be set if the slow

 shutter 
function is set.

Starting Slow & Quick Motion recording
Shoot as described in “Basic O

perations” 
(page 47).

W
hen recording starts, the “S&Q

 Stby” indication 
in the view

finder changes to the “Ć
S&Q

 Rec” 
indication. The TALLY indicators and the tally 
indicator on the front panel of the view

finder light 
as they do during norm

al recording.

To exit, stop the recording,

[N
ote]

It takes longer than norm
al for recording to stop w

hen the 
fram

e rate is set to a low
 value (for a slow

 fram
e rate).

Canceling Slow & Quick Motion mode
W

ith the cam
corder in recording standby m

ode, 
set O

peration >Rec Function >Slow
 & Q

uick in the 
setup m

enu to O
ff.

Limitations during recording

ˎˎ Regardless of the setting of the F-RU
N

/SET/R-
RU

N
 sw

itch, the advance m
ode of the internal 

tim
ecode generator is alw

ays R-RU
N

.
ˎˎ Audio cannot be recorded w

hen the recording 
and playback fram

e rates differ.

ˎˎ Review
ing the recording (Rec Review

) is not 
possible.
ˎˎ If you change the recording fram

e rate to a 
value faster than the current shutter speed, the 
shutter speed is changed to the slow

est value 
for w

hich shooting is possible.  
Exam

ple: If the fram
e rate is 32 and the shutter 

speed is 1/40, and you change the fram
e rate to 

55, then the shutter speed is changed to 1/60.  
It is not possible to select a shutter speed that is 
slow

er than the recording fram
e rate.

ˎˎ G
enlock is not possible.

Recording with the Clip Continuous 
Rec Function

N
orm

ally, a clip is created as an independent file 
each tim

e that you start and stop recording. But 
this function allow

s you to start and stop recording 
w

hile continuously recording to the sam
e clip, for 

as long as the function rem
ains enabled. This is 

convenient w
hen you do not w

ant to generate a 
large num

ber of short clips, and w
hen you w

ant 
to record w

ithout w
orrying about exceeding the 

clip lim
it.

It is still easy to find recording start points, because 
a Rec Start essence m

ark is recorded at the 
recording start point each tim

e you start recording.
This function is enabled w

hen the cam
corder is set 

to any of the follow
ing video form

ats (page 34).
XAVC-I
XAVC-L
M

PEG
 H

D
 422

Setting Clip Continuous Rec

1 
Select O

peration >Rec Function >Clip 
Continuous Rec in the setup m

enu.

2 
Turn the M

EN
U

 knob to select [O
n], then press 

the knob.
“Cont Stby” appears in the view

finder, and the 
function is enabled.

[N
otes]
ˎˎ O

nly one special recording function, such as Clip 
Continuous Rec, can be used at any one tim

e.
ˎˎ If another special recording m

ode is enabled w
hile Clip 

Continuous Rec is in use, for exam
ple, the currently 

selected m
ode is autom

atically released.

You can assign the Clip Continuous Rec on/off 
function to one of the ASSIG

N
. 1/2/3 sw

itches, 
ASSIG

N
ABLE 4/5 sw

itches, or the O
N

LIN
E button.

For details, see “Assigning Functions to Assignable Sw
itches” 

(page 114).

Starting Clip Continuous Rec recording
Shoot as described in “Basic O

perations” 
(page 47).
W

hen recording starts, the “Cont Stby” indication 
in the view

finder changes to “Ć
Cont Rec” 

indication.
The TALLY indicators and the tally indicator on 
the front panel of the view

finder light as they do 
during norm

al recording.

[N
ote]

D
uring recording or in recording standby m

ode (w
hen 

“Cont Stby” indication is displayed), if you rem
ove the m

edia, 
the battery, or the pow

er source, the m
edia needs to be 

restored. It is not possible to restore m
edia on a device other 

than this cam
corder.

Exit Clip Continuous Rec m
ode (page 52) and then rem

ove 
the m

edia.
W

hen “Cont Stby” indication is flashing (once per second), 
you can rem

ove the m
edia.

To exit, stop the recording,

[N
ote]

Stop the recording after recording for tw
o or m

ore seconds.
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Canceling Clip Continuous Rec mode
W

ith the cam
corder in recording standby m

ode, 
set O

peration >Rec Function >Clip Continuous 
Rec in the setup m

enu to O
ff.

Limitations during recording
A single continuous clip cannot be created if you 
perform

 one of the follow
ing operations w

hile the 
cam

corder is in recording or recording standby 
m

ode. (A new
 clip w

ill be created w
hen you next 

start recording.)
ˎˎ O

perate on a clip (lock, delete, or renam
e a clip)

ˎˎ Sw
itch slots

ˎˎ Change the recording form
at

ˎˎ Turn off the PO
W

ER sw
itch

ˎˎ Playback
ˎˎ Sw

itch to the thum
bnail screen

Recording Video Simultaneously to 
Two SxS Memory Cards (Simul Rec)

W
hen the video form

at (page 34) is set to one of 
the options in the follow

ing table, you can record 
the sam

e video to tw
o SxS m

em
ory cards. This 

function is useful for m
aking a video backup w

hile 
shooting.

[N
ote]

It is recom
m

ended that both SxS m
em

ory cards be 
form

atted (initialized) using the cam
corder before use.

O
peration >Form

at 
>Rec Form

at in the 
setup m

enu

O
peration >Form

at 
>Frequency in the setup 
m

enu
XAVC-I 1920×1080P

59.94/59/29.97/25/23.98
XAVC-I 1920×1080i

59.94/50
XAVC-I 1280×720P

59.94/50
XAVC-L 50 
1920×1080P

59.94/50/29.97/25/23.98

O
peration >Form

at 
>Rec Form

at in the 
setup m

enu

O
peration >Form

at 
>Frequency in the setup 
m

enu
XAVC-L 50 
1920×1080i

59.94/50

XAVC-L 50 1280×720P
59.94/50

XAVC-L 35 1080P
59.94/50/29.97/25/23.98

XAVC-L 35 1080i
59.94/50

XAVC-L 25 1080i
59.94/50

H
D

 422 50 1080P
29.97/25/23.98

H
D

 422 50 1080i
59.94/50

H
D

 422 50 720P
59.94/50/29.97/25/23.98

H
Q

 1920×1080P
29.97/25/23.98

H
Q

 1920×1080i
59.94/50

H
Q

 1440×1080i
59.94/50

H
Q

 1280×720P
59.94/50

Setting Simul Rec

1 
Select O

peration >Rec Function >Sim
ul Rec in 

the setup m
enu.

2 
Turn the M

EN
U

 knob to select [O
n], then press 

the knob.

[N
otes]
ˎˎ O

nly one special recording function, such as Sim
ul Rec, 

can be used at any one tim
e.

ˎˎ If another special recording m
ode is enabled w

hile using 
Sim

ul Rec, Sim
ul Rec is autom

atically released.
ˎˎ Sim

ul Rec cannot be set during recording, playback, or 
w

hile the thum
bnail screen is displayed.

Starting Simul Rec recording

1 
Insert SxS m

em
ory cards in both m

em
ory slots 

A and B.
The ACCESS indicators for SxS slots A and B are 
lit. Also, icons for SxS slots A and B appear in 
the view

finder (page 18).

2 
Shoot as described in “Basic O

perations” 
(page 47).

[N
otes]
ˎˎ Sim

ultaneous recording is not possible if either of the 
m

edia is defective or if the m
edia is w

rite protected.
ˎˎ D

uring sim
ultaneous recording, if either of the m

edia 
becom

es full or an error occurs and recording cannot 
continue, recording to that m

edia stops but recording to 
the other m

edia continues.

To exit, stop the recording,

Canceling Simul Rec mode
In recording standby m

ode, set O
peration >Rec 

Function >Sim
ul Rec in the setup m

enu to O
ff.
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Proxy data is m
ade up of low

-resolution video data 
(H

.264) and audio data (AAC-LC). This lightw
eight 

proxy data can be used in the sam
e w

ay as the 
original data, but it can be transferred m

ore 
quickly, for m

ore efficient view
ing and editing.

D
uring clip recording, proxy data is recorded onto 

the SD
 card inserted into the PRO

XY SD
 card slot. 

PRO
XY SD

 card slot

By im
porting proxy data recorded on the SD

 
card into a com

puter, you can quickly check the 
recorded content or perform

 rapid offline editing.
You can record proxy data separately from

 
recording to SxS m

em
ory cards.

Proxy Recording using the Camcorder

ˎˎ Proxy recording w
ill not start unless an SxS 

m
em

ory card is inserted.
ˎˎ W

hen the cam
corder has been turned on for 

about 35 seconds, the 
 icon (m

edia status 
indicator for Proxy SD

 slot) turns on in the LCD
 

m
onitor and view

finder screen to indicate that 
proxy recording is enabled.  
If you start shooting w

hile the 
 icon is 

flashing or is not lit, proxy files are not recorded.
ˎˎ Before rem

oving an SD
 card from

 the 
cam

corder, alw
ays check that the ACCESS 

indicator for the PRO
XY SD

 card slot is not lit, 
then turn off the cam

corder or turn off the proxy 
recording/w

ireless LAN
 connection function.  

To turn off the proxy recording/w
ireless LAN

 
connection function, m

ake the follow
ing 

settings in the setup m
enu.

 – Set O
peration >Proxy Recording M

ode 
>Setting to O

ff.
 – Set M

aintenance >N
etw

ork >Setting to O
ff.

ˎˎ Attem
pting to rem

ove the SD
 card w

hile either 
the proxy recording or w

ireless LAN
 connection 

function is enabled m
ay display a w

arning 
(E91-1C0) in som

e cases. If the w
arning appears 

w
hile recording, data is still recorded correctly 

to the SxS m
em

ory cards, but proxy files are not 
recorded. The w

arning m
essage can be cleared 

by turning the cam
corder off and then on again.

ˎˎ Proxy recording w
ill not start if Picture Cache 

Rec, Interval Rec, Slow
 & Q

uick M
otion, or 

stream
ing is enabled.

SD Cards

SD cards supported for recording proxy data
SD

H
C m

em
ory cards

* (Speed Class: 4 or higher, 
Capacity: up to 32 G

B)
SD

XC m
em

ory cards* (Speed Class: 4 or higher)
* 

Referred to as “SD
 cards” in this m

anual.

Formatting (initializing) SD cards
SD

 cards m
ust be form

atted the first tim
e they are 

used in the cam
corder.

SD
 cards for use in the cam

corder should be 
form

atted using the form
at function of the 

cam
corder. If a m

essage appears w
hen the SD

 card 
is inserted into the cam

corder, form
at the SD

 card.

1 
Select O

peration >Proxy Recording M
ode 

>Setting in the setup m
enu.

2 
Turn the M

EN
U

 knob to select [O
n], then press 

the knob.

3 
Select O

peration >Form
at M

edia >SD
 

Card(Proxy) in the setup m
enu.

4 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
A confirm

ation screen prom
pting w

hether to 
form

at the card appears.

5 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
Form

atting begins.
D

uring form
atting, a m

essage and progress 
state (%

) is displayed and the ACCESS indicator 
is lit orange.
W

hen form
atting ends, a com

pletion m
essage 

appears. Press the M
EN

U
 knob to dism

iss the 
m

essage.

[N
ote]

Form
atting an SD

 card erases all data on the card. The card 
cannot be restored.

Checking the remaining recording capacity
You can check the rem

aining capacity on an SD
 

card on the M
edia Status screen (page 15).

To use an SD card formatted on the camcorder in 
the slot of another device
First, m

ake a backup of the card, then reform
at the 

card in the device to be used.

Recording Proxy Data

To record proxy data simultaneously

1 
Select O

peration >Proxy Recording M
ode 

>Setting in the setup m
enu.

2 
Turn the M

EN
U

 knob to select [O
n], then press 

the knob.

3 
Insert an SD

 card for recording proxy data into 
the PRO

XY SD
 card slot.

4 
Start recording.
The proxy data file is saved in the “/PRIVATE/
PXRO

O
T/Clip” directory of the SD

 card at the 
sam

e tim
e as the original data is being 

recorded onto an SxS m
em

ory card.
Proxy data recording autom

atically stops w
hen 

you stop recording.

To record proxy data separately from recording 
original data
You can start and stop proxy recording 
independently by assigning the Proxy Rec Start/
Stop function to an assignable sw

itch.

[N
otes]
ˎˎ If sim

ultaneous proxy recording is started w
hile recording 

proxy data independently is in progress, the proxy data 
recording continues w

ithout interruption. Subsequently, 
w

hen sim
ultaneous recording is stopped, proxy data 

recording also stops.
ˎˎ If independent proxy recording is stopped w

hile 
sim

ultaneous recording is in progress, only the proxy data 
recording stops.

Proxy recording limitations
Proxy recording is not supported in the follow

ing 
cases.
ˎˎ D

uring stream
ing (M

aintenance >Stream
ing 

>Setting in the setup m
enu set to O

n)
ˎˎ D

uring Interval Rec (O
peration >Rec Function 

>Interval Rec in the setup m
enu set to O

n)
ˎˎ Picture Cache Rec (O

peration >Rec Function 
>Picture Cache Rec in the setup m

enu set to 
O

n)
ˎˎ D

uring Slow
 & Q

uick M
otion (O

peration >Rec 
Function >Slow

 & Q
uick M

otion in the setup 
m

enu set to O
n)

Proxy D
ata
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ˎˎ W
hen netw

ork client m
ode is enabled 

(M
aintenance >N

etw
ork Client M

ode >Setting 
in the setup m

enu is set to O
n). H

ow
ever, 

proxy recording is enabled w
hen M

aintenance 
>N

etw
ork Client M

ode >D
etail Settings >N

CM
 

w
ith Proxy in the setup m

enu is set to Enable.
ˎˎ W

hen O
peration >Form

at >Frequency in the 
setup m

enu is set to 23.98P and O
peration 

>Proxy Recording M
ode >Size is set to H

D
 

Auto(9M
bps) or H

D
 Auto(6M

bps)
ˎˎ Proxy recording is not possible w

hen pow
er is 

being supplied to the external device connector 
(O

peration >U
SB in the setup m

enu).

About the recorded files

ˎˎ The file nam
e extension is “.m

p4”.
ˎˎ The tim

ecode is also recorded sim
ultaneously.

ˎˎ A still im
age of the first fram

e is also recorded 
sim

ultaneously.
ˎˎ Location inform

ation and a Log file are recorded 
sim

ultaneously if the G
PS function is enabled. 

The Log file is saved in “Root/PRIVATE/SO
N

Y/
G

PS.”

Canceling proxy data recording
Set O

peration >Proxy Recording M
ode >Setting in 

the setup m
enu to O

ff.

W
hen there is insufficient remaining capacity on 

an SD card
A w

arning is displayed to indicate that there is 
insufficient free space.

Changing proxy recording settings
Select O

peration >Proxy Recording M
ode >Size 

and Audio Channel in the setup m
enu to change 

the settings for the size of the proxy recording 
form

at and the audio channel for proxy recording, 
respectively.

[N
ote]

W
hen O

peration >Proxy Recording M
ode >Size in the setup 

m
enu is set to H

D
 Auto(9M

bps) or H
D

 Auto(6M
bps) and the 

system
 frequency is set to 29.97, 25, or 23.98, the proxy data 

picture size w
ill be set to 1920×1080 even if the picture size 

of the recording video form
at is set to 1280×720.

Checking proxy recording settings
Select O

peration >Proxy Recording M
ode >Fram

e 
Rate and Bit Rate in the setup m

enu to view
 the 

settings for the video fram
e rate and video bit rate, 

respectively.
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Planning M
etadata

Planning m
etadata is inform

ation about shooting 
and recording plans, recorded in an XM

L file.
You can shoot using clip nam

es and shot m
ark 

nam
es defined in advance in a planning m

etadata 
file.

[N
ote]

U
se a font set that is com

patible w
ith the language set using 

M
aintenance >Language in the setup m

enu w
hen defining 

clip nam
es and shot m

ark nam
es. U

sing fonts for a language 
that is different from

 the language setting on the cam
corder 

m
ay cause characters to be displayed abnorm

ally.

Loading a Planning Metadata File 
into Camcorder Memory when 
Recording a Clip

1 
Save the planning m

etadata file on an SxS 
m

em
ory card beforehand.

Planning m
etadata files are stored in the 

“G
eneral/Sony/Planning” directory.

2 
Insert an SxS m

em
ory card in slot A or B.

3 
Select O

peration >Planning M
etadata >Load 

M
edia(A) or Load M

edia(B) in the setup m
enu.

A file list screen appears.
U

p to 64 planning m
etadata files are displayed 

in the list.

4 
Turn the M

EN
U

 knob to select a file to load 
and press the knob.

5 
Turn the M

EN
U

 knob to select [Load] and press 
the knob, then select [Execute] and press the 
knob again.

[N
ote]

D
ata cannot be loaded from

 SD
XC cards.

Displaying Detailed Information in 
Planning Metadata

After loading planning m
etadata into the 

cam
corder, you can check the detailed inform

ation 
that it contains, such as file nam

es, date and tim
e 

of creation, and titles.

1 
Select O

peration >Planning M
etadata 

>Properties in the setup m
enu.

2 
Turn the M

EN
U

 knob to select [Execute], and 
then press the knob.
The planning m

etadata inform
ation is 

displayed.

Item
Inform

ation
File N

am
e

File nam
e

Assign ID
Assign ID

Created 
D

ate and tim
e of creation

M
odified 

D
ate and tim

e of m
ost recent 

m
odification

M
odified by

N
am

e of person w
ho 

m
odified the file

Title
Title1 specified in file (ASCII 
form

at clip nam
e)

Title2
Title2 specified in file (U

TF-8 
form

at clip nam
e)

M
aterial G

roup
N

um
ber of m

aterial groups  a)

Shot M
ark0 to 

Shot M
ark9

N
am

es defined in file for Shot 
M

ark 0 to Shot M
ark 9

a) M
aterial group: A group of clips recorded w

ith the 
sam

e planning m
etadata.

You can turn the M
EN

U
 knob to scroll the list.

Clearing the Loaded Planning 
Metadata

1 
Select O

peration >Planning M
etadata >Clear 

M
em

ory in the setup m
enu.

2 
Turn the M

EN
U

 knob to select [Execute], and 
then press the knob.
D

eletion starts.  
The m

essage “Clear Planning M
etadata File 

O
K” appears w

hen the deletion finishes.

Defining Clip Names in Planning 
Metadata

The follow
ing tw

o types of clip nam
e strings can 

be w
ritten in a planning m

etadata file.
ˎˎ An ASCII form

at nam
e that appears in the 

view
finder

ˎˎ A U
TF-8 form

at nam
e that is actually registered 

as the clip nam
e

You can select w
hich type of clip nam

e is 
displayed w

ith O
peration >Planning M

etadata 
>Clip N

am
e D

isp in the setup m
enu.

W
hen a clip nam

e is set w
ith planning m

etadata, 
the clip nam

e is displayed.

[N
ote]

W
hen you define both an ASCII form

at nam
e and a U

TF-8 
form

at nam
e w

ith planning m
etadata, the U

TF-8 form
at 

string is used as the clip nam
e string. If you define either an 

ASCII form
at nam

e or a U
TF-8 form

at nam
e w

ith planning 
m

etadata, the defined form
at nam

e is displayed though it is 
not selected by m

enu setting.

Clip name string example
U

se a text editor to m
odify the tw

o fields in the 
<Title> tag that contain the clip nam

e strings.
The shaded fields in the exam

ple are clip nam
e 

strings. “Typhoon” is described in ASCII form
at 

(up to 44 characters). “Typhoon_Strikes_Tokyo” is 
described in U

TF-8 form
at (up to 44 bytes).

“sp” indicates a space and J
 indicates a carriage 

return.

<?xm
lsp version="1.0"sp encoding="

U
TF-8"?>J

<PlanningM
etadata

sp xm
lns="http://

xm
lns.sony.net/pro/m

etadata/
planningm

etadata"sp assignId="
P0001"sp creationD

ate="
2016-11-30T17:00:00+09:00"sp
lastU

pdate="
2016-12-06T17:00:00+09:00"sp
version="1.00">J

<Properties
sp propertyId="

assignm
ent"sp update="

2016-12-06T17:00:00+09:00"sp
m

odifiedBy="Chris">J
<Title

sp usAscii="Typhoon"sp
xm

l:lang="en">Typhoon_Strikes_Tokyo
</Title>J
</Properties>J

</PlanningM
etadata>J

[N
otes]
ˎˎ W

hen you create a file, enter each statem
ent as a single 

line w
ith a CRLF only after the last character in the 

statem
ent line, and do not enter spaces except w

here 
specified.
ˎˎ U

p to 44 bytes (or characters) can be entered for the clip 
nam

e.  
If the U

TF-8 form
at string exceeds 44 bytes, the first 44 

bytes are used as the clip nam
e.  

If only an ASCII form
at nam

e is specified, a 44-character 
string is used as the clip nam

e.  
W

hen neither an ASCII form
at nam

e string nor U
TF-8 

form
at nam

e string can be used, the standard form
at clip 

nam
e is used.
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Setting clip names

1 
Load a planning m

etadata file that contains 
clip nam

es into cam
corder m

em
ory 

(page 97).

2 
Set O

peration >Clip >Clip N
am

ing in the setup 
m

enu to Plan.
Each tim

e that you record a clip, the 
cam

corder autom
atically generates a nam

e 
consisting of the clip nam

e defined in the 
planning m

etadata file, w
ith the addition of an 

underbar (_) and a five-digit serial num
ber 

(00001 to 99999).  
Exam

ples:Typhoon_Strikes_Tokyo_00001, 
Typhoon_Strikes_Tokyo_00002,…

 After the 
num

ber reaches 99999, the next increm
ent 

returns the num
ber to 00001.

[N
ote]

W
hen you load another planning m

etadata file, the serial 
num

ber continues increm
enting. You can change the 

num
bering using O

peration >Clip >N
um

ber Set in the setup 
m

enu.

Selecting the clip name display format
W

hen nam
es are defined in both ASCII form

at and 
U

TF-8 form
at, you can use O

peration >Planning 
M

etadata >Clip N
am

e D
isp in the setup m

enu to 
select w

hich of the nam
es to display on the LCD

 
m

onitor and on the view
finder screen.

To display ASCII form
at nam

es: 
Select Title1(ASCII).  
The clip nam

e becom
es “Typhoon_Strikes_

Tokyo_SerialN
um

ber”, but “Typhoon_
SerialN

um
ber” is displayed on the screen.

To display U
TF-8 form

at nam
es: 

Select Title2(U
TF-8).  

The clip nam
e becom

es “Typhoon_Strikes_
Tokyo_SerialN

um
ber”, and the sam

e nam
e is 

displayed on the screen.

Defining Shot Mark Names in 
Planning Metadata

W
hen you use planning m

etadata to set shot 
m

arks, you can define nam
es for Shot M

ark 0 to 
Shot M

ark 9.
W

hen you record shot m
arks, you can add the 

shot m
ark nam

e strings defined in the planning 
m

etadata.

[N
ote]

O
nly Shot M

ark 1 and Shot M
ark 2 can be recorded on the 

cam
corder.

Shot mark name string example
U

se a text editor to m
odify the fields in the <M

eta 
nam

e> tag.
The shaded fields in the exam

ple are essence m
ark 

nam
e strings. N

am
es can be either in ASCII form

at 
(up to 32 characters) or U

TF-8 form
at (up to 16 

characters).
“sp” indicates a space and J

 indicates a carriage 
return.

[N
ote]

If a nam
e string contains even one non-ASCII character, the 

m
axim

um
 length of that string is 16 characters.

<?xm
lsp version="1.0"sp encoding="

U
TF-8"?>J

<PlanningM
etadata xm

lns="http://
xm

lns.sony.net/pro/m
etadata/

planningm
etadata"sp assignId="

H
00123"sp creationD

ate="
2016-11-30T08:00:00Z"sp lastU

pdate="
2016-11-30T15:00:00Z"sp version=
"1.00">J
<Properties

sp propertyId=
"assignm

ent"sp class="original"sp
update="2016-11-30T15:00:00Z"sp
m

odifiedBy="Chris">J
<Title

sp usAscii="Football
G

am
e"sp xm

l:lang="en">
Football G

am
e 30/11/2016</

Title>J
<M

eta
sp nam

e="_ShotM
ark1"sp

content="G
oal"/>J

<M
eta

sp nam
e="_ShotM

ark2"sp
content="Shoot"/>J
<M

eta
sp nam

e="_ShotM
ark3"sp

content="Corner Kick"/>J
<M

eta
sp nam

e="_ShotM
ark4"sp

content="Free Kick"/>J
<M

eta
sp nam

e="_ShotM
ark5"sp

content="G
oal Kick"/>J

<M
eta

sp nam
e="_ShotM

ark6"sp
content="Foul"/>J
<M

eta
sp nam

e="_ShotM
ark7"sp

content="PK"/>J
<M

eta
sp nam

e="_ShotM
ark8"sp

content="1st H
alf"/>J

<M
eta

sp nam
e="_ShotM

ark9"sp
content="2nd H

alf"/>J
<M

eta
sp nam

e="_ShotM
ark0"sp

content="Kick O
ff"/>J

</Properties>J
</PlanningM

etadata>J

[N
ote]

W
hen you create a definition file, enter each statem

ent 
as a single line w

ith a CRLF only after the last character in 
the statem

ent line, and do not enter spaces except w
here 

specified, except w
ithin essence m

ark nam
e strings.
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O
btaining Location Inform

ation (G
PS)

Location and tim
e inform

ation of video shot 
w

hen positioning is enabled is recorded by the 
cam

corder.
The G

PS function is set to O
ff by factory default.

1 
Check that the cam

corder is in standby state.

2 
Set O

peration G
PS to O

n in the setup m
enu.

 is displayed in the view
finder w

hen the 
cam

corder is seeking G
PS satellites. W

hen 
positioning is established, location inform

ation 
is recorded w

hen shooting video.

The icon displayed in the view
finder varies, 

depending on the signal reception from
 the G

PS 
satellites.

Positioning 
status

D
isplay

G
PS reception state

O
ff

N
o display

G
PS is set to O

ff or an 
error occurred.

Positioning 
not 
available

Location inform
ation 

could not be obtained 
because G

PS signal 
could not be received. 
M

ove to a location w
ith 

a clear view
 of the sky.

Searching 
for satellites

Searching for G
PS 

satellites. Several 
m

inutes m
ay be required 

to acquire satellites.
Positioning

A w
eak G

PS signal is 
being received.
A G

PS signal is being 
received. Location 
inform

ation can be 
acquired.
A strong G

PS signal is 
being received. Location 
inform

ation can be 
acquired.

ˎˎ It m
ay take som

e tim
e to start acquiring location 

inform
ation after turning on the cam

corder.

ˎˎ If a positioning icon is not displayed after several 
m

inutes, there m
ay be a problem

 w
ith signal 

reception. Start shooting w
ithout location 

inform
ation, or m

ove to an area w
ith a clear 

view
 of the sky. Shooting w

hen a positioning 
icon is not displayed m

eans that location 
inform

ation w
ill not be recorded.

ˎˎ The G
PS signal m

ay not be received w
hen 

indoors or near tall structures. M
ove to a 

location w
ith a clear view

 of the sky.
ˎˎ The recording of location inform

ation m
ay be 

interrupted, depending on the strength of the 
received signal, even if a positioning icon is 
displayed.
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N
etw

ork Functions Supported by the Cam
corder

The cam
corder supports various netw

ork functions. This section provides an overview
 and detailed description of the netw

ork connections and functions.

Network Connection Overview

Connecting devices using wireless LAN
The cam

corder can connect to sm
artphones, 

tablets, and other devices using w
ireless LAN

 
connection using the IFU

-W
LM

3 U
SB W

ireless LAN
 

M
odule (supplied) or CBK-W

A02 W
ireless LAN

 
Adaptor (option).

1 
Select the w

ireless connection device.
IFU

-W
LM

3 U
SB W

ireless LAN
 M

odule 
(supplied) y

 (page 59)
CBK-W

A02 W
ireless LAN

 Adaptor (option) y
 

(page 59)

2 
Select the w

ireless LAN
 access m

ode.
W

i-Fi Access Point m
ode y

 (page 60)
W

i-Fi Station m
ode y

 (page 61)

Connecting to the Internet using a LAN cable
Connect the cam

corder to the Internet via a router 
using the netw

ork connector.

1 
Connect the cam

corder and router using a 
LAN

 cable.
y

 (page 63)

Connecting to the Internet using wireless LAN
Connect the cam

corder to the Internet using the 
IFU

-W
LM

3 U
SB W

ireless LAN
 M

odule (supplied), 
CBK-W

A02 W
ireless LAN

 Adaptor (option), or 
m

odem
 (option).

[N
ote]

The CBK-N
A1 N

etw
ork Adaptor Kit (option) is required if 

connecting using a CBK-W
A02 W

ireless LAN
 Adaptor (option) 

or m
odem

 (option).

W
hen using the IFU-W

LM3 (supplied)
1 

Attach the IFU
-W

LM
3 to the cam

corder.
y

 (page 59)

2 
Set the w

ireless LAN
 access m

ode to W
i-Fi 

Station m
ode and connect to the Internet.

y
 (page 64)

W
hen using the CBK-W

A02 (option)
1 

Attach the CBK-W
A02 to the cam

corder.
y

 (page 59)

2 
Set the w

ireless LAN
 access m

ode to W
i-Fi 

Station m
ode and connect to the Internet.

y
 (page 64)

Using a modem
1 

Attach the U
SB extension adaptor of the 

CBK-N
A1 (option).

y
 (page 63)

2 
Connect the m

odem
.

y
 (page 64)

Network Function Overview

Transferring files recorded on the camcorder to a 
server on the Internet
You can transfer proxy files recorded on an SD

 
card and original files recorded on SxS m

em
ory 

cards to a server on the Internet w
hen connected 

via a 3G
/4G

/LTE netw
ork, access point, w

ired LAN
 

router.
y

 (page 66)

Transmitting streaming video and audio
You can transm

it the video and audio captured/
played back w

ith the cam
corder via the Internet or 

local netw
ork.

Streaming using the streaming settings on the camcorder
y

 (page 68)

High-quality streaming using a Sony Network RX Station 
(option) as a Connection Control Manager
y

 (page 69)

Common Information

Using W
i-Fi remote control

You can access the W
i-Fi rem

ote control built into 
the cam

corder from
 a sm

artphone, tablet, or other 
device over a w

ireless LAN
 connection.

y
 (page 70)

Configuring from the web menu
The w

eb m
enu of the cam

corder appears w
hen 

the cam
corder is accessed from

 a brow
ser 

on a device connected using a w
ireless LAN

 
connection.
y

 (page 72)

Supported network functions and operating 
limitations

y
 (page 77)
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The cam
corder can connect to sm

artphones, 
tablets, and other devices using w

ireless LAN
 

connection by attaching the IFU
-W

LM
3 U

SB 
W

ireless LAN
 M

odule (supplied) or CBK-W
A02 

W
ireless LAN

 Adaptor (option).
The follow

ing operations can be perform
ed 

betw
een the cam

corder and devices connected 
using a w

ireless LAN
.

[N
ote]

U
SB w

ireless LAN
 m

odules/adaptors other than the IFU
-

W
LM

3 or CBK-W
A02 cannot be used.

Remote operation via wireless LAN
The cam

corder can be operated rem
otely from

 a 
sm

artphone, tablet, or com
puter that is connected 

using a w
ireless LAN

.

File transfer via wireless LAN
Proxy files (low

-resolution files) stored on the 
cam

corder SD
 card and original files (high-

resolution files) recorded on the cam
corder can be 

transferred to a server via a w
ireless LAN

.

Monitoring video via wireless LAN
You can create a stream

 (H.264) of the cam
era 

picture or playback picture of the cam
corder for 

m
onitoring from

 a device via w
ireless LAN using the 

“Content Brow
ser M

obile” application.

“Content Brow
ser M

obile” is an application that 
can operate the cam

corder rem
otely on the device 

screen, w
hile stream

ing content, and can be used 
to configure the cam

corder.
You can also transfer a cutout part of a file by 
specifying In and O

ut points in the proxy file 
(page 66).
Alw

ays check that you have the latest version of 
the “Content Brow

ser M
obile” application.

For details about the “Content Brow
ser M

obile” application, 
contact your Sony sales or service representative.

[N
otes]
ˎˎ Proxy files (low

-resolution files) recorded on the SD
 card in 

the cam
corder can be stream

ed via a w
ireless LAN

.

ˎˎ Stream
ing is not supported w

hen the video form
at is set 

to M
PEG

-IM
X or D

VCAM
.

ˎˎ O
bstructions and electrom

agnetic interference betw
een 

the cam
corder and w

ireless LAN
 access point or term

inal 
device, or the am

bient environm
ent (such as w

all 
m

aterials) could shorten the com
m

unication range or 
prevent connections altogether. If you experience these 
problem

s, check the connection/com
m

unication status 
after m

oving the cam
corder to a new

 location, or bringing 
the cam

corder and access point/term
inal device closer 

together.

Compatible Devices
You can use a sm

artphone, tablet, or com
puter 

to configure and operate the cam
corder. The 

supported devices, O
S, and brow

sers are show
n in 

the follow
ing table.

D
evice

O
S

Brow
ser

Sm
artphone

Android 
4.4/5.0/5.1/6.0

Chrom
e

iO
S 8.0/8.1/8.2/ 

8.3/8.4/9.0 
Safari

Tablet
Android 
4.4/5.0/5.1/6.0

Chrom
e

iO
S 8.0/8.1/8.2/ 

8.3/8.4/9.0 
Com

puter
M

icrosoft 
W

indow
s 7/

M
icrosoft 

W
indow

s 8/
M

icrosoft 
W

indow
s 10

Chrom
e

M
ac O

S 
10.9/10.10

Safari

[N
ote]

Playback m
ay not be supported, depending on the 

operating system
 of the term

inal device used and the 
brow

ser version. If this occurs, use “Content Brow
ser M

obile.”

Attaching the IFU-W
LM3

1 
O

pen the cover of the U
SB w

ireless LAN
 

m
odule connector.G

uard (supplied)

2 
Attach the protective cap to the IFU

-W
LM

3.

3 
Plug the IFU

-W
LM

3 into the connector.

[N
otes]
ˎˎ Alw

ays turn the cam
corder off before connecting or 

rem
oving the IFU

-W
LM

3.
ˎˎ For attachm

ent of the guard, contact a Sony service 
representative.

If not using the IFU-W
LM3

U
nscrew

 the tw
o screw

s, rem
ove the guard, and 

close the connector cover.

Attaching the CBK-W
A02

1 
Attach the attachm

ent bracket to the handle 
in the position show

n in the follow
ing 

diagram
.

For attachm
ent of the attachm

ent bracket 
(Service Part N

o. A-2092-367-), contact a Sony 
service representative.

Attachm
ent bracket

2 
Attach the U

SB extension adaptor, supplied 
w

ith the CBK-W
A02 (option), to the 

attachm
ent bracket.

3 
Turn the fixing screw

 clockw
ise to secure the 

U
SB extension adaptor.

Connecting D
evices using W

ireless LAN
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Fixing screw

U
SB extension adaptor

You can adjust the position of the U
SB 

extension adaptor over the range show
n in the 

follow
ing diagram

.

4 
Attach the protective cap (supplied) to the 
U

SB connector of the U
SB extension adaptor.

5 
O

pen the cover of the U
SB w

ireless LAN
 

m
odule connector.

For attachm
ent of the guard, contact a Sony 

service representative.

G
uard (supplied)

6 
Plug the U

SB connector of the U
SB extension 

adaptor into the U
SB w

ireless LAN
 m

odule 
connector.

7 
Plug the CBK-W

A02 into the U
SB connector of 

the U
SB extension adaptor.

8 
Set the w

ireless LAN
 channel in M

aintenance 
>N

etw
ork >Channel in the setup m

enu 
(page 108).

For details about using the CBK-W
A02, refer to the instruction 

m
anual supplied w

ith the CBK-W
A02.

[N
otes]
ˎˎ Alw

ays turn the cam
corder off before connecting or 

rem
oving the CBK-W

A02.
ˎˎ Attaching the CBK-W

A02 and selecting W
i-Fi Station 

in M
aintenance >N

etw
ork >Setting in the setup m

enu 
enables connection to a 5 G

H
z access point.

ˎˎ The Ch setting “Auto(5G
H

z)” in W
i-Fi Access Point m

ode 
m

ay not be displayed, depending on the CBK-W
A02 used.

ˎˎ “Auto(5G
H

z)” is not displayed in the m
enu if use of the 

CBK-W
A02 in the 5 G

H
z band is prohibited for outdoor 

use in your country or region. Check that the use of the 
CBK-W

A02 is perm
itted in your country or region. For 

details, refer to the CBK-W
A02 operation m

anual.

If not using the CBK-W
A02

U
nscrew

 the tw
o screw

s, rem
ove the guard, and 

close the connector cover.

Connecting using W
ireless LAN 

Access Point (W
i-Fi Access Point 

Mode)

The cam
corder can connect to devices that are set 

up as an access point.

Sm
artphone/
Tablet

Com
puter

Install “Content Brow
ser M

obile” on the device 
to connect before starting the connection 
configuration.

One-touch connection using NFC-equipped 
devices
D

evices that support N
FC can be connected by 

one touch using N
FC.

1 
Select [Settings] on the device and enable the 
[N

FC] function.
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2 
Turn the cam

corder on, and set M
aintenance 

>N
etw

ork >W
ireless N

etw
ork to W

i-Fi Access 
Point.

3 
Set M

aintenance >N
etw

ork >Setting to O
n.

4 
Enable the N

FC function.
Set N

FC connection m
ode by executing 

M
aintenance >N

etw
ork >N

FC in the setup 
m

enu or by pressing and holding an 
assignable sw

itch that has been assigned w
ith 

the N
FC function for three seconds.

The N
FC function can be used only w

hen 
 is 

displayed on the screen.

[N
ote]

It m
ay take som

e tim
e (30 seconds to 90 seconds) for 

 to 
appear on the screen. W

ait until the netw
ork “AP” (access 

point) w
ireless netw

ork indicator (page 17) stops flashing 
on the view

finder screen.

5 
Touch the device against the cam

corder.
The device connects to the cam

corder, and 
“Content Brow

ser M
obile” launches.

[N
otes]
ˎˎ W

ake a sleeping device and unlock the lock screen 
beforehand.
ˎˎ Continue to hold the device against the cam

corder 
w

ithout m
oving it until “Content Brow

ser M
obile” 

launches (1 to 2 seconds).
ˎˎ If a device w

ith identical SSID
 has already been registered, 

the device m
ay not be able to be connected, depending 

on the O
S version of the device. In this case, you can 

connect the device by deleting the registered SSID
 from

 
the device.

Connecting using W
PS-equipped devices

D
evices that support W

PS can be connected using 
W

PS.

1 
Set M

aintenance >N
etw

ork >W
ireless N

etw
ork 

to W
i-Fi Access Point.

2 
Set M

aintenance >N
etw

ork >Setting to O
n.

[N
ote]

It m
ay take som

e tim
e (30 seconds to 90 seconds) to enable 

access point m
ode. W

ait until the netw
ork “AP” (access point) 

indicator (page 17) stops flashing on the LCD
 m

onitor or 
in the view

finder.

3 
Select M

aintenance >N
etw

ork >W
PS in the 

setup m
enu.

4 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

5 
O

pen the device N
etw

ork Settings or W
i-Fi 

Settings, and turn W
i-Fi on.

6 
Select the cam

corder SSID
 from

 the W
i-Fi 

netw
ork SSID

 list, display O
ption, and select 

W
PS Push Button.

[N
ote]

The steps w
ill vary depending on the device used.

Connecting using SSID and password on the 
device
Connect by entering the SSID

 and passw
ord on 

the device.

1 
Set M

aintenance >N
etw

ork >W
ireless N

etw
ork 

to W
i-Fi Access Point.

2 
Set M

aintenance >N
etw

ork >Setting to O
n.

[N
ote]

It m
ay take som

e tim
e (30 seconds to 90 seconds) to enable 

access point m
ode. W

ait until the net w
ork “AP” (access 

point) indicator (page 17) stops flashing on the LCD
 

m
onitor or in the view

finder.

3 
O

pen the device N
etw

ork Settings or W
i-Fi 

Settings, and turn W
i-Fi on.

4 
Select the cam

corder SSID
 from

 the W
i-Fi 

netw
ork SSID

 list, then enter a passw
ord to 

connect.
For the cam

corder SSID
 and passw

ord, see 
M

aintenance >N
etw

ork >SSID
 & Passw

ord 
(page 108) in the setup m

enu.

[N
ote]

The steps w
ill vary depending on the device used.

Connecting Using W
ireless LAN 

Station Mode (W
i-Fi Station Mode)

The cam
corder can connect to an existing w

ireless 
LAN

 access point as a client.
The device connects via the access point.

Sm
artphone/
Tablet

Com
puter

Access 
point

Connecting to an access point using W
PS

If an access point supports the W
PS function, you 

can connect using a basic setting. If an access 
point does not support the W

PS function, see 
“Connecting to an access point in station m

ode 
w

ithout using W
PS” (page 74).

1 
Turn the access point on.

2 
Turn the cam

corder on.

3 
Set M

aintenance >N
etw

ork >W
ireless N

etw
ork 

to W
i-Fi Station.

4 
Set M

aintenance >N
etw

ork >Setting to O
n.
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[N
ote]

It m
ay take som

e tim
e (30 seconds to 1 m

inute) to enable 
station m

ode. W
ait until the netw

ork indicator (page 17) 
signal strength icon stops flashing on the LCD

 m
onitor or in 

the view
finder.

5 
Select M

aintenance >N
etw

ork >W
PS in the 

setup m
enu.

6 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

7 
Press the access point W

PS button.
For details about W

PS button operation, refer 
to the instruction m

anual for the access point.
W

hen the connection is successful, the 
netw

ork indicator (page 17) signal strength 
icon w

ill show
 a strength of 1 or higher on the 

LCD
 m

onitor or in the view
finder.

[N
ote]

If the connection fails, perform
 the procedure again from

 
step 1.

8 
Connect the device to the access point.
For details about how

 to connect, refer to the 
instruction m

anual for each device.
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You can connect to the Internet using a w
ired LAN

 
or w

ireless LAN
.

For w
ired LAN

, connect a LAN
 cable (not supplied) 

to the netw
ork connector on the cam

corder, and 
connect to the Internet via a router.
For w

ireless LAN
, connect to the Internet using the 

IFU
-W

LM
3 U

SB W
ireless LAN

 M
odule (supplied), 

CBK-W
A02 W

ireless LAN
 Adaptor (option), or 

m
odem

 (option).

Required device for network connection

W
ireless LAN connection

O
ne of the follow

ing devices is required.
ˎˎ IFU

-W
LM

3 U
SB W

ireless LAN
 M

odule (supplied)
ˎˎ CBK-W

A02 W
ireless LAN

 Adaptor (option) + 
CBK-N

A1E U
SB Extension Adaptor supplied w

ith 
the CBK-N

A1 N
etw

ork Adaptor Kit (option)
ˎˎ M

odem
 (option) + CBK-N

A1E U
SB Extension 

Adaptor supplied w
ith the CBK-N

A1 N
etw

ork 
Adaptor Kit (option)

W
ired LAN connection
ˎˎ LAN

 cable (not supplied)

[N
otes]
ˎˎ The w

ireless LAN
 m

odule m
ay not be available in som

e 
countries/regions.
ˎˎ The frequency band for the w

ireless LAN
 m

odule is shared 
by various devices. D

epending on the use environm
ent, 

transm
ission speed and distance m

ay be decreased, or 
com

m
unication m

ay be disconnected, by using other 
devices.
ˎˎ To use the 3G

/4G
/LTE services, you need to contract w

ith 
a cell phone com

pany.
ˎˎ For details about the required com

patible device for the 
netw

ork connection, contact your Sony dealer or a Sony 
service representative.

Limitations on simultaneous use of network 
connection function
The cam

corder can connect to a netw
ork using 

w
ireless LAN

 or w
ired LAN

 m
ethods.

H
ow

ever, there are lim
its on the sim

ultaneous use 
of these connection functions.

For details, see “Lim
itations on Sim

ultaneous U
se 

of N
etw

ork Functions” (page 77).

Connecting Using a LAN Cable 
(W

ired LAN Connection)

You can connect to the Internet using a w
ired LAN

 
connection via a router connected to the netw

ork 
connector on the cam

corder.

Internet

Router

Com
puter

1 
Connect the netw

ork connector of the 
cam

corder and a router using a LAN
 cable.

2 
Set M

aintenance >N
etw

ork >W
ired LAN

 to 
Enable.

3 
Set M

aintenance >N
etw

ork >Setting to O
n.

An IP address is autom
atically assigned to the 

cam
corder.

[N
otes]
ˎˎ It m

ay take som
e tim

e (30 seconds to 1 m
inute) for the 

w
ired LAN

 connection to becom
e enabled. W

ait until 
the netw

ork status indicator (page 17) LAN
 icon stops 

flashing on the LCD
 screen or in the view

finder.
ˎˎ To transfer original files/proxy files recorded on the 

cam
corder, use W

i-Fi rem
ote control, operate the w

eb 
m

enu, or m
onitor output using the “Content Brow

ser 
M

obile” application, set M
aintenance >N

etw
ork >W

ired 
LAN

 Rem
ote in the setup m

enu to O
n (page 108).

ˎˎ W
hen connected to a netw

ork, using a LAN
 cable, that w

ill 
not be used to connect to the Internet, it is recom

m
ended 

that W
ired LAN

 Rem
ote be set to O

n to prevent 
unauthorized access from

 the Internet. W
hen connecting 

to the Internet, check that the netw
ork connection is to a 

secure netw
ork before use.

ˎˎ A w
ired LAN

 connection is not possible if a m
odem

 
(option) is attached to the U

SB w
ireless LAN

 m
odule 

connector. For w
ired LAN

 connection, first rem
ove the 

m
odem

 (option).
ˎˎ W

hen connected to the Internet using W
i-Fi Station m

ode 
and the w

ired LAN
 is not connected to the Internet, a 

netw
ork error m

ay occur and Internet-related functions 
m

ay not operate. In this case, set W
ired LAN

 to D
isable, 

and connect to the Internet using W
i-Fi- Station m

ode 
only.

Preparation for Connection to the 
Internet Using a Modem

Attach the CBK-N
A1E U

SB extension adaptor, 
supplied w

ith the CBK-N
A1 N

etw
ork Adaptor 

Kit (option), to the U
SB w

ireless LAN
 m

odule 
connector on the cam

corder w
hen planning to 

connect to the Internet via a 3G
/4G

 netw
ork using 

the U
SB w

ireless LAN
 m

odule connector.

1 
Attach the attachm

ent bracket to the handle 
in the position show

n in the follow
ing 

diagram
.

For attachm
ent of the attachm

ent bracket 
(Service Part N

o. A-2092-367-), contact a Sony 
service representative.

Attachm
ent bracket

2 
Attach the U

SB extension adaptor to the 
attachm

ent bracket.

Connecting to the Internet
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3 
Turn the fixing screw

 clockw
ise to secure the 

U
SB extension adaptor.

Fixing screw

U
SB extension adaptor

You can adjust the position of the U
SB 

extension adaptor over the range show
n in the 

follow
ing diagram

.

4 
Attach the protective cap (supplied) to the 
U

SB connector of the U
SB extension adaptor.

5 
O

pen the cover of the U
SB w

ireless LAN
 

m
odule connector.

For attachm
ent of the guard, contact a Sony 

service representative.G
uard (supplied)

6 
Plug the U

SB connector of the U
SB extension 

adaptor into the U
SB w

ireless LAN
 m

odule 
connector.

Connecting Using a Modem

You can connect the cam
corder to the Internet via 

a 3G
/4G

 netw
ork by attaching a m

odem
 (option) 

to the cam
corder using a CBK-N

A1 N
etw

ork 
Adaptor Kit (option).

InternetCBK-N
A1

+M
odem

Connecting

1 
Connect the m

odem
 (option) to the U

SB 
connector of the CBK-N

A1E U
SB extension 

adaptor.

For details about connecting a m
odem

, refer to the 
instruction m

anual supplied w
ith the m

odem
.

2 
Set M

aintenance >N
etw

ork >W
ireless N

etw
ork 

to M
odem

.

3 
Set M

aintenance >N
etw

ork >Setting to O
n.

[N
otes]
ˎˎ Alw

ays turn the cam
corder off before connecting or 

rem
oving the CBK-N

A1 and m
odem

.
ˎˎ It m

ay take som
e tim

e (30 seconds to 1 m
inute) to enable 

m
odem

 m
ode. W

ait until the “3G
/4G

” netw
ork status 

indicator (page 17) stops flashing on the LCD
 screen or 

in the view
finder.

Connecting Using W
ireless LAN 

Station Mode (W
i-Fi Station Mode)

You can connect to the Internet using W
i-Fi station 

m
ode by attaching the IFU

-W
LM

3 U
SB W

ireless 
LAN

 M
odule (supplied) or CBK-W

A02 W
ireless LAN

 
Adaptor (option) to the cam

corder, and using a 
3G

/4G
/LTE-com

patible access point (option) or 
using device tethering.
For details about attaching devices, see “Attaching 
the IFU

-W
LM

3” (page 59) and “Attaching the 
CBK-W

A02” (page 59).



000
5. N

etw
ork Configuration: Connecting to the Internet

65

Internet

Internet

Access 
point

Sm
artphone/
TabletSm

artphone/
Tablet

Com
puter

If the access point and device supports W
PS, 

connect using the procedure in “Connecting to 
an access point using W

PS” (page 61). If W
PS is 

not supported, connect using the procedure in 
“Connecting to an access point in station m

ode 
w

ithout using W
PS” (page 74).

First, turn the access point and device on, and 
configure the device tethering function if planning 
to use tethering.
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You can transfer proxy files recorded on an SD
 card 

and original files recorded on SxS m
em

ory cards 
to a server on the Internet w

hen connected to the 
Internet via a 3G

/4G
/LTE netw

ork, access point, or 
w

ired LAN
 router.

Preparation for Transfer

1 
Connect the cam

corder to the Internet using 
the procedures in “Connecting D

evices using 
W

ireless LAN
” (page 59) and “Connecting to 

the Internet” (page 63).

2 
You m

ust first register a server to w
hich you 

w
ant to transfer files.

For details about registering a server, see “To 
register a new

 destination server” (page 75).

Transferring

You can select proxy files on an SD
 card or original 

files on SxS m
em

ory cards for transfer to a server.

Transferring proxy files on an SD card

1 
Connect the cam

corder and device using a 
LAN

 connection, then launch a brow
ser on the 

device to access the cam
corder.

2 
D

isplay a file list screen to select files.

3 
Tap 

 and select [M
edia Info], then tap [SD

 
Card].
The SD

 Card screen appears.

U
sing “Content Brow

ser M
obile” application 

version 2.0 or later, you can quickly display a 
thum

bnail for a proxy file on an SD
 card by 

using the still im
age of the first fram

e.

4 
Select the files you w

ant to transfer.
Tap a file to select it. Tap a file a second tim

e to 
de-select it. You can double-tap a file to play 
the file to check its content.

5 
Tap [Transfer].
The default destination server specified in 
[D

efault Setting] appears (see “To register a 
new

 destination server” (page 75)).
To change the destination server, tap the 
destination server to display a list and then 
select a different server. Enter the directory on 
the destination server, as required.

6 
Tap [Transfer].
Transfer of the selected files begins. To cancel 
file transfer, tap [Cancel].

If M
aintenance >File Transfer >Auto U

pload(Proxy) 
in the setup m

enu is set to O
n beforehand, the file 

is autom
atically uploaded to the specified server 

w
hen proxy recording finishes.

Transferring parts of proxy files
U

sing “Content Brow
ser M

obile” application 
version 2.0 or later, you can specify In/O

ut points in 
proxy files to cut out and transfer the cutout parts.
You can also transfer the cutout portions of 
m

ultiple files using the Storyboard.

[N
otes]
ˎˎ M

argins of up to 15 fram
es are added before and after the 

cutout region in the created file.
ˎˎ Files created from

 cutouts from
 proxy files recorded using 

netw
ork function softw

are (V1.25 or earlier) m
ay not be 

im
ported into non-linear editors.

ˎˎ W
hen partial transfer is perform

ed using the Storyboard, 
the file for sending Storyboard inform

ation to a non-linear 
editor is displayed in the Job List.
ˎˎ W

hen transferring, a G
eneral/Sony/tm

p folder is created 
autom

atically on the SD
 card. The file is tem

porarily stored 
in this folder, and is autom

atically deleted after the file 
transfer is com

pleted.

Transferring original files on SxS memory cards

1 
Connect the cam

corder and device using a 
LAN

 connection, then launch a brow
ser on the 

device to connect to the cam
corder 

“Connecting D
evices using W

ireless LAN
” 

(page 59).

2 
Select M

aintenance >File Transfer >File 
Transfer in the setup m

enu.

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
File transfer m

ode is initiated.

4 
D

isplay a file list screen to select files in the 
brow

ser on the device.

5 
Tap 

 and select [M
edia Info], then tap Slot A 

(for files recorded on m
edia in slot A) or Slot B 

(for files recorded on m
edia in slot B).

The Slot A or Slot B screen appears.
Exam

ple: Slot A screen

6 
Select the files you w

ant to transfer.
Tap a file to select it. Tap a file a second tim

e to 
de-select it.

7 
Tap [Transfer].
The default destination server specified in 
[D

efault Setting] appears (see “To register a 
new

 destination server” (page 75)).
To change the destination server, tap the 
destination server to display a list and then 
select a different server.
Enter the directory on the destination server in 
[D

irectory].

8 
Tap [Transfer].
Transfer of the selected files begins. To cancel 
file transfer, tap [Cancel].
W

hen the transfer of all files is com
pleted, 

transfer m
ode is autom

atically released, and 
the display returns to the cam

era shooting 
screen.

If M
aintenance >File Transfer >Rem

ote File 
Transfer in the setup m

enu is set to Enable 
beforehand, file transfer m

ode is initiated 
autom

atically w
ithout perform

ing steps 2 and 3.
[N

ote]
Files cannot be transferred under the follow

ing conditions.
ˎˎ D

uring recording, playback, or w
hen displaying the 

thum
bnail screen

Transferring Files
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ˎˎ W
hen M

aintenance >N
etw

ork >W
ireless N

etw
ork >W

i-Fi 
Access Point and W

ired LAN
 >D

isable in the setup m
enu 

are set to D
isable

ˎˎ W
hen the stream

ing function is enabled (M
aintenance 

>Stream
ing >Setting is set to O

n)

Transferring parts of original files
U

sing “Content Brow
ser M

obile” application 
version 2.0 or later, you can specify In/O

ut points 
in original files recorded by the cam

corder to cut 
out and transfer the cutout parts.
You can also transfer the cutout portions of 
m

ultiple files using the Storyboard.
The follow

ing form
ats of original files are 

supported.
ˎˎ XAVC-I
ˎˎ XAVC-L
ˎˎ H

D
422 (exFAT/U

D
F)

ˎˎ H
D

420H
Q

 (exFAT/U
D

F)

[N
ote]

To transfer a part of an original file using “Content Brow
ser 

M
obile,” a proxy file w

ith the sam
e file nam

e as the original 
file is required.
Enable the creation of proxy files before you start to record.
The relevant settings are show

n below
.

ˎˎ Set O
peration >Proxy Recording M

ode >Setting in the 
setup m

enu to O
n.

ˎˎ W
hen netw

ork client m
ode is enabled, set M

aintenance 
>N

etw
ork Client M

ode >D
etail Settings> N

CM
 w

ith Proxy 
in the setup m

enu to Enable.

Monitoring the File Transfer

Tap [Job List] on the SD
 Card, Slot A, or Slot B 

screen to display the Job List screen to check the 
status of the file transfer (page 75).
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You can transm
it the video and audio captured/

played back w
ith the cam

corder via the Internet or 
local netw

ork.

Preparation for Streaming 
Transmission

1 
Connect the cam

corder to the Internet using 
the procedures in “Connecting D

evices using 
W

ireless LAN
” (page 59) and “Connecting to 

the Internet” (page 63).

2 
Select Preset1 (or Preset2, Preset3) in 
M

aintenance >Stream
ing in the setup m

enu.
The stream

ing connection destination setup 
screen appears.

3 
Set Size, Bit Rate, Type, and item

s according to 
Type on the screen.
For details and lim

itations about settings, see 
“Stream

ing settings” (page 73).

4 
Select Preset1 (or Preset2, Preset3), set in steps 
1 and 2, in M

aintenance >Stream
ing >Preset 

Select in the setup m
enu.

Starting Streaming

1 
Set M

aintenance >Stream
ing >Setting in the 

setup m
enu to O

n.
Stream

ing starts according to the settings.
You can assign Stream

ing to an assignable 
sw

itch. For details about assignm
ent, see 

“Assigning Functions to Assignable Sw
itches” 

(page 114).

[N
otes]
ˎˎ Stream

ing cannot be started under the follow
ing m

enu 
settings.

 –
W

hen M
aintenance >N

etw
ork >Setting in the setup 

m
enu is set to O

ff
 –

W
hen M

aintenance >N
etw

ork Client M
ode >Setting in 

the setup m
enu is set to O

n
 –

W
hen M

aintenance >N
etw

ork >Setting in the setup 
m

enu is set to O
n, but M

aintenance >N
etw

ork 
>W

ireless N
etw

ork is set to O
ff and M

aintenance 
>N

etw
ork >W

ired LAN
 is set to D

isable
ˎˎ It m

ay take several tens of seconds to stream
 actual video 

or audio after starting stream
ing.

ˎˎ You cannot start stream
ing w

hen playing back an SD
 

form
at clip.

ˎˎ If you set the stream
ing transm

ission destination is set 
incorrectly or the cam

corder does not connect to the 
netw

ork, “×” appears on the screen as the stream
ing 

status indicator.
ˎˎ Stream

ing in netw
ork client m

ode (page 69), 
m

onitoring, proxy recording, and file transfer are not 
available after sw

itching to stream
ing m

ode.
ˎˎ Starting stream

ing w
hile m

onitoring, proxy recording, or 
transferring files w

ill stop the corresponding function.

Stopping Streaming

Set M
aintenance >Stream

ing >Setting to O
ff to 

stop stream
ing.

W
hen Stream

ing is O
n, stream

ing can also be 
stopped by pressing the assignable sw

itch to 
w

hich Stream
ing has been assigned.

W
hen the cam

corder is connected to a device 
via W

ireless LAN
 (page 59) or is connected to 

the Internet using w
ireless LAN

 station m
ode 

(page 61), you can also set the stream
ing 

transm
ission destination and start/stop stream

ing 
from

 the w
eb m

enu (page 72).

Transm
itting Stream

ing Video and Audio
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H
igh-quality stream

ing is supported by enabling 
netw

ork client m
ode and connecting and using 

a N
etw

ork RX Station (option) as a Connection 
Control M

anager (CCM
).

1 
Connect the cam

corder to the netw
ork.

For details, see “Connecting D
evices using 

W
ireless LAN

” (page 59) and “Connecting to 
the Internet” (page 63).

2 
Set each item

 in M
aintenance >N

etw
ork Client 

M
ode >D

etail Settings in the setup m
enu.

Item
D

escription
CCM

 Address
Enter the IP address of the 
CCM

 to connect. (H
ost nam

e 
or IP address)

CCM
 Port

Enter the port num
ber of the 

CCM
 to connect.

U
ser N

am
e

Enter the user nam
e.

Passw
ord

Enter the passw
ord.

N
CM

 W
ith Proxy

Enable/disable proxy 
recording w

hen connected 
w

ith a CCM
.

[N
otes]
ˎˎ N

etw
ork client m

ode cannot be set if values are not 
entered for all item

s.
ˎˎ Setting M

aintenance >N
etw

ork Client M
ode >D

etail 
Settings >N

CM
 w

ith Proxy in the setup m
enu to 

Enable enables proxy recording, even w
hen netw

ork 
client m

ode is enabled. To enable the N
CM

 w
ith 

Proxy setting, set O
peration >Proxy Recording M

ode 
>Setting in the setup m

enu to O
n.

ˎˎ If M
aintenance >N

etw
ork Client M

ode >D
etail 

Settings >N
CM

 w
ith Proxy in the setup m

enu is set to 
D

isable, proxy recording stops if netw
ork client m

ode 
is set to O

n during recording.  
If original file recording is continuing, set both to O

ff 
to restart proxy recording.
ˎˎ If O

peration >Proxy Recording M
ode >Proxy File 

>Size in the setup m
enu is set to H

D
 Auto(9M

bps) 
or H

D
 Auto(6M

bps), N
CM

 w
ith Proxy cannot be 

enabled.  
If H

D
 Auto(9M

bps) or H
D

 Auto(6M
bps) is set after 

N
CM

 w
ith Proxy is set to Enable, the setting is 

m
aintained, but proxy recording is not perform

ed.

3 
Set M

aintenance >N
etw

ork Client M
ode 

>Setting in the setup m
enu to O

n.
N

etw
ork client m

ode is enabled, and the 
cam

corder connects to the N
etw

ork RX 
Station.
Live stream

ing starts in response to N
etw

ork 
RX Station operation.
For details about operation, refer to the 
instruction m

anual for the N
etw

ork RX Station.
You can assign Setting (O

n/O
ff) for N

etw
ork 

Client M
ode to an assignable sw

itch. For 
details about assignm

ent, see “Assigning 
Functions to Assignable Sw

itches” (page 114).

[N
otes]
ˎˎ Changing to netw

ork client m
ode during norm

al 
stream

ing (page 68) is not possible.
ˎˎ After changing to netw

ork client m
ode, norm

al stream
ing 

(page 68) and m
onitoring are not available.

ˎˎ Changing to netw
ork client m

ode w
hile m

onitoring w
ill 

stop the m
onitoring.

ˎˎ File transfer is not supported during stream
ing in netw

ork 
client m

ode. File transfer is supported after stopping 
stream

ing.
ˎˎ If stream

ing in netw
ork client m

ode is started during file 
transfer, the file transfer stops. File transfer restarts after 
stopping stream

ing.
ˎˎ The available stream

ing bit rates that can be configured 
by the N

etw
ork RX Station are lim

ited to the follow
ing, 

depending on the proxy recording form
at.

 –
If the proxy recording form

at is 1280×720 
9M

bps/6M
bps, the stream

ing bit rate is set to 1 M
bps 

or low
er.

 –
If the proxy recording form

at is 640×360 3M
bps, the 

stream
ing bit rate is set to 3 M

bps or low
er.

ˎˎ The proxy form
at cannot be changed in netw

ork client 
m

ode. To change the form
at, first set N

etw
ork Client 

M
ode to O

ff.

Transferring files in network client mode
You can transfer files to a server set by the CCM

 by 
connecting a N

etw
ork RX Station acting as a CCM

 
and the cam

corder in netw
ork client m

ode.

1 
Select the files you w

ant to transfer.
ˎˎ To transfer a proxy recording: 
Follow

 steps 1 to 4 in “Transferring proxy 
files on an SD

 card” (page 66).

ˎˎ To transfer original files: 
Follow

 steps 1 to 6 in “Transferring original 
files on SxS m

em
ory cards” (page 66)

2 
Tap [Transfer].
“N

CM
: RX Server” is displayed as a destination.

Specify “N
CM

: RX Server” as the destination.

3 
Tap [Transfer].
Transfer of the selected files to the server 
specified on the CCM

 starts.

[N
ote]

The destination can also be set to “N
CM

: RX Server” w
hen not 

in netw
ork client m

ode.
In this case, transfer is placed on hold, and then transfer to 
the server specified on the CCM

 starts after connecting to 
the CCM

 in netw
ork client m

ode.

Stream
ing H

igh Q
uality Video
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U
sing W

i-Fi Rem
ote Control

You can access the W
i-Fi rem

ote control built into 
the cam

corder from
 a sm

artphone, tablet, or other 
device over a w

ireless LAN
 connection.

U
sing the W

i-Fi rem
ote control allow

s you to 
operate the cam

corder rem
otely. This allow

s 
you to start/stop recording or configure settings 
rem

otely, and is useful in applications w
here 

the cam
corder is fixed in a rem

ote location or 
m

ounted on a crane, for exam
ple.

Displaying the W
i-Fi Remote Control

The W
i-Fi Rem

ote screen is autom
atically resized 

to m
atch the screen size of the connected device.

1 
Connect the cam

corder to the Internet using 
the procedures in “Connecting D

evices using 
W

ireless LAN
” (page 59) and “Connecting to 

the Internet” (page 63).

2 
Launch a brow

ser on the device and enter 
“http://<IP_address>/rm

.htm
l” in the U

RL bar, 
w

here “<IP_address>” is the IP address 
(M

aintenance >N
etw

ork >IP Address (W
ireless) 

in the setup m
enu) of the cam

corder.
For exam

ple, if the IP address is 192.168.1.1, 
enter “http://192.168.1.1/rm

.htm
l” in the U

RL 
bar.

3 
Enter the user nam

e and passw
ord 

(M
aintenance >Basic Authentication 

(page 108) in the setup m
enu) on the 

brow
ser screen.

W
hen connection is successful, the W

i-Fi 
Rem

ote screen appears on the device.
You use the W

i-Fi Rem
ote screen to operate 

the cam
corder.

You can disable the REC button operation by 
sliding the Lock knob to the right on the 
screen.
You can also display the W

i-Fi rem
ote control 

using [Cam
 Rem

ote Control] (page 72) from
 

the w
eb m

enu.

[N
otes]
ˎˎ To display the page for a sm

artphone, change “rm
.

htm
l” to “rm

s.htm
l” in the U

RL. To display the page for a 
tablet, change “rm

.htm
l” to “rm

t.htm
l” in the U

RL. W
hen 

“rm
.htm

l” is entered, the page autom
atically sw

itches 
for display on the corresponding device. H

ow
ever, the 

appropriate page m
ay not be displayed, depending on 

the device.
ˎˎ The W

i-Fi Rem
ote screen m

ay not m
atch the cam

corder 
settings under the follow

ing circum
stances. If this occurs, 

reload the brow
ser w

indow
.

 –
If the cam

corder is restarted w
hile connected

 –
If the cam

corder is operated directly w
hile connected

 –
If the device has been reconnected

 –
If the brow

ser Forw
ard/Back buttons have been used

ˎˎ The W
i-Fi rem

ote control m
ay not function if the w

ireless 
signal strength becom

es w
eak.

W
i-Fi Remote Screen (Smartphones)

Main screen

ˎˎ Status display
ˎˎ Shooting settings 

Iris, Focus, Zoom
, S&Q

 FPS, 
Shutter, W

hite, G
am

m
a, Auto 

Iris, G
ain, ATW

, Color Bars, Auto 
Black, Auto W

hite

Playback screen

ˎˎ Status display
ˎˎ Playback control buttons 

F Rev, Play/Pause, F Fw
d, Prev, 

Stop, N
ext

Cursor screen

ˎˎ Status indicators
ˎˎ Cursor control buttons, m

enu/
status display 
U

p, Left, Set, Right, D
ow

n, 
Cancel/Back, M

enu, Status, 
Thum

bnail, O
ption (SH

IFT + 
SET)

Assign screen

ˎˎ Status display
ˎˎ Assignable sw

itches 
Assignable sw

itch 0, 1, 3, 4, 5
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W
i-Fi Remote Screen (Tablets)

Main screen

ˎˎ Status display
ˎˎ Assignable sw

itches 
Assignable sw

itch 0, 1, 3, 4, 5
ˎˎ Shooting settings 

S&Q
 FPS, Shutter, W

hite, G
am

m
a, Auto Iris, G

ain, ATW
, 

Color Bars, Auto Black, Auto W
hite

Playback screen

ˎˎ Status display
ˎˎ Playback control buttons 

F Rev, Play/Pause, F Fw
d, Prev, Stop, N

ext

Cursor screen

ˎˎ Status display
ˎˎ Cursor control buttons, m

enu/status display 
U

p, Left, Set, Right, D
ow

n, Cancel/Back, M
enu, Status, 

Thum
bnail, O

ption (SH
IFT + SET)

Assign screen

ˎˎ Assignable sw
itches 

Assignable sw
itch 0, 1, 3, 4, 5
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Configuring from
 the W

eb M
enu

The w
eb m

enu of the cam
corder appears w

hen 
the cam

corder is accessed from
 a brow

ser 
on a device connected using a w

ireless LAN
 

connection. U
sing the w

eb m
enu, you can 

configure settings related to w
ireless functions, 

transfer files, and perform
 other actions.

Displaying the W
eb Menu

1 
Connect the cam

corder to the Internet using 
the procedures in “Connecting D

evices using 
W

ireless LAN
” (page 59) and “Connecting to 

the Internet” (page 63).

2 
Launch a brow

ser on the device and enter 
“http://192.168.1.1:8080/index.htm

l” in the U
RL 

bar.
The user nam

e and passw
ord entry screen 

appears.

3 
Enter a user nam

e and passw
ord, then select 

[O
K].

For the user nam
e and passw

ord for access 
authentication, see M

aintenance >Basic 
Authentication (page 108) in the setup m

enu.

Setup Menu

Launch a brow
ser on the device and enter 

“http://<IP_address>:8080” in the U
RL bar, w

here 
“<IP_address>” is the IP address (M

aintenance 
>N

etw
ork >IP Address in the setup m

enu) of the 
cam

corder, to display the M
edia Info >SD

 Card 
screen of the cam

corder
Tapping 

 in the top left of the w
eb m

enu screen 
w

ill display the configuration m
enus. Tap the item

 
you w

ant to configure.

The m
enu has the follow

ing item
s: Settings, M

edia 
Info, Job List, and Cam

 Rem
ote Control.

Settings
U

sed to configure the cam
corder. This screen has 

the follow
ing item

s.

Item
D

escription
See

W
ireless 

M
odule 

>Stream
ing 

Form
at

Stream
ing 

form
at 

settings

Stream
ing Form

at 
Settings (page 72)

W
ireless 

M
odule 

>Proxy 
Form

at

Proxy form
at 

settings
Proxy Form

at 
Settings (page 73)

W
ireless LAN

 
>Station 
Settings

W
ireless LAN

 
settings

W
ireless LAN

 Station 
Settings (page 73)

W
ireless LAN

 
>Status

W
ireless LAN

 
settings status

Checking w
ireless 

LAN
 settings 

(page 74)
W

ired LAN
 

>W
ired LAN

 
Settings

W
ired LAN

 
settings

W
ired LAN

 Settings 
(page 74)

W
ired LAN

 
>Status

W
ired LAN

 
settings status

Checking w
ired LAN

 
settings (page 74)

U
pload 

Settings
Transfer 
settings

Transfer (U
pload) 

Settings (page 75)

Media Info
D

isplays m
edia inform

ation and is used to select 
files to transfer from

 m
edia.

ˎˎ SD
 Card: M

edia inserted into the PRO
XY SD

 card 
slot of the cam

corder 
D

ouble-clicking a file w
ill start playback of the 

selected file.

 
[N

ote]
Playback m

ay not be supported, depending on the 
operating system

 of the term
inal device used and the 

brow
ser version. If this occurs, use “Content Brow

ser 
M

obile.”

ˎˎ Slot A: M
edia inserted into card slot A of the 

cam
corder

ˎˎ Slot B: M
edia inserted into card slot B of the 

cam
corder

Job List
D

isplays the Job List screen for m
anaging file 

transfers (page 75).

Cam Remote Control
D

isplays the W
i-Fi rem

ote control screen 
(page 70).

Streaming Format Settings

You can configure the stream
 for m

onitoring 
by devices, and set the form

at and transm
ission 

destination of the stream
 for stream

ing via the 
Internet or local netw

ork.

Video

ˎˎ AVC/H
.264 M

ain Profile, 4:2:0 Long G
O

P
ˎˎ Size is selected in the follow

ing settings.

Audio

ˎˎ AAC-LC com
pression

ˎˎ Sam
pling frequency: 48 kH

z
ˎˎ Bit rate: 128 kbps for stereo

Monitoring Settings

You can set the form
at for m

onitoring by devices.

Item
D

escription
Setting

M
onitoring 

Size
Sets the video size 
and bit rate for 
m

onitoring.

480×270(1M
bps)/ 

480×270(0.5M
bps)

M
onitoring 

Fram
e Rate

D
isplays the video 

fram
e rate for 

m
onitoring.

23.98fps/25fps/ 
29.97fps/50fps/ 
59.94fps

M
onitoring 

Bit Rate
D

isplays the video 
bit rate for 
m

onitoring.

1M
bps(VBR)/ 

0.5M
bps(VBR)

[N
otes]
ˎˎ The bit rate is an average value, so this value m

ay be 
exceeded at tim

es.
ˎˎ A video fram

e rate of 24 fps is not supported.
ˎˎ 640×360 (3M

bps (VBR)) is not supported for M
onitoring 

Size.
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Streaming settings

You can set the form
at and transm

ission 
destination for stream

ing. U
p to three settings can 

be preset.

Item
D

escription
Setting

O
n/O

ff
Sw

itches stream
ing 

transm
ission on/off.

O
n/O

ff

Preset
Selects the preset 
from

 Preset 1 to 
Preset 3. You can 
edit Preset by 
tapping Edit.

Preset1/Preset2/
Preset3

Type
Selects the type of 
video for stream

ing.
M

PEG
-2 TS/U

D
P/ 

M
PEG

-2 TS/ 
RTP

Size
Sets the size of 
video for stream

ing.
W

hen H
D

 Auto is 
selected, the size is 
set to 1920×1080 or 
1280×720, 
according to the 
setting of the 
recording form

at 
recorded on the 
SxS m

em
ory card or 

the form
at of the 

clip to be played 
back.

H
D

 Auto/ 
1280×720/ 
640×360/ 
480×270/
320×180

Bit Rate
Sets the bit rate of 
video for stream

ing.
The selectable bit 
rate varies 
depending on the 
Size setting.

9M
bps/6M

bps/ 
3M

bps/2M
bps/ 

1M
bps/0.5M

bps/ 
0.3M

bps(M
ono L)/ 

0.3M
bps(M

ono R)/ 
0.2M

bps(M
ono L)/ 

0.2M
bps(M

ono R)
Destination 
Address

Enter the address of 
the transm

ission 
destination server 
for stream

ing data.

H
ost nam

e or IP 
address

Item
D

escription
Setting

Destination 
Port

Enter the port 
num

ber of the 
transm

ission 
destination server 
used for stream

ing.

1 to 65535

Audio 
Channel 
Select

Selects the audio 
channels for the 
stream

ing output.

Ch-1 & Ch-2/ 
Ch-3 & Ch-4

[N
otes]
ˎˎ W

hen Stream
ing is set to O

n, the m
onitoring function 

cannot be used.
ˎˎ Audio/video data is transm

itted as-is via the Internet.  
Accordingly, the data m

ay potentially be exposed to other 
parties.  
Alw

ays check that the transm
ission destination can 

receive the stream
ing data.  

The data m
ay be sent to an unintended party if the 

address or other settings are configured incorrectly.
ˎˎ N

ot all fram
es m

ay be played, depending on the status of 
the netw

ork.
ˎˎ The picture quality m

ay deteriorate in scenes w
ith 

excessive m
otion.

ˎˎ N
ot all fram

es m
ay be played w

hen the stream
 is set to a 

large size w
ith a sm

all bit rate.  
To reduce this, select a sm

aller size for the Size setting.
ˎˎ If a netw

ork w
ith bandw

idth of less than 500 kbps is used, 
Size and Bit Rate are set to the follow

ing.
 –

W
hen Size is 480×270, Bit Rate is set to 0.3M

bps(M
ono 

L), 0.3M
bps(M

ono R), 0.2M
bps(M

ono L), or 
0.2M

bps(M
ono R).

 –
W

hen Size is 320×180, Bit Rate is set to 0.2M
bps(M

ono 
L) or 0.2M

bps(M
ono R). 

W
hen this occurs, video is set to a fram

e rate of 10 fps, and 
audio is set to a sam

pling frequency of 48 kH
z and a bit 

rate of 56 kbps.
ˎˎ W

hen Bit Rate is 0.3M
bps(M

ono L) or 0.2M
bps(M

ono L), 
Audio Channel Select >Ch-1 & Ch-2 is set to Ch-1 or Ch-3 
& Ch-4 is set to Ch-3.  
W

hen Bit Rate is 0.3M
bps(M

ono R) or 0.2M
bps(M

ono R), 
Audio Channel Select >Ch-1 & Ch-2 is set to Ch-2 or Ch-3 
& Ch-4 is set to Ch-4.

Proxy Format Settings

You can set the form
at of the proxy file that is 

recorded on the SD
 card of the cam

corder.

Video

ˎˎ XAVC Proxy (AVC/H
.264 M

ain Profile, 4:2:0 Long 
G

O
P)

ˎˎ Size is selected in the follow
ing settings.

Audio

ˎˎ AAC-LC com
pression

ˎˎ Sam
pling frequency: 48 kH

z
ˎˎ Bit rate: 128 kbps for stereo

Item
D

escription
Setting

Proxy File 
recording 
>Size

Sets the video size 
and bit rate for 
proxy files.

HD Auto(9M
bps)/ 

HD Auto(6M
bps)/ 

1280×720(9M
bps)/ 

1280×720(6M
bps)/ 

640×360(3M
bps)/ 

480×270(1M
bps)/ 

480×270(0.5M
bps)

Proxy File 
recording 
>Fram

e 
Rate

D
isplays the video 

fram
e rate for proxy 

files.

23.98fps/ 
25fps/ 
29.97fps/ 
50fps/ 
59.94fps

Proxy File 
recording 
>Bit Rate

D
isplays the video 

bit rate for proxy 
files.

9M
bps(VBR)/ 

6M
bps(VBR)/ 

3M
bps(VBR)/ 

1M
bps(VBR)/ 

0.5M
bps(VBR)

Item
D

escription
Setting

Proxy File 
recording 
>Audio 
Channel 
Select

Sets the audio 
channel to record 
to proxy data.

Ch-1 & Ch-2/ 
Ch-3 & Ch-4

[N
otes]
ˎˎ The bit rate is an average value, so this value m

ay be 
exceeded at tim

es.
ˎˎ 24 fps is not supported.
ˎˎ W

hen H
D

 Auto is selected for Size in the proxy form
at 

settings, the proxy form
at is set according to the setting of 

the recording form
at recorded on the SxS m

em
ory card or 

the form
at of the clip to be played back.

ˎˎ Proxy files recorded w
ith Size set to H

D
 Auto in the proxy 

form
at settings m

ay not be able to be played in a brow
ser 

or Content Brow
ser M

obile. Insert SD
 cards for recording 

proxy files directly into a com
puter to play the files.

W
ireless LAN Station Settings

U
se this screen to m

ake settings for connecting 
the cam

corder to a w
ireless LAN

.

Item
D

escription
H

ost N
am

e
N

am
e of the cam

corder (can be 
m

odified)
SSID

D
isplays the SSID

 selected in 
[Access Point].

Key
Enter the passw

ord for the 
access point.
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Item
D

escription
D

H
CP

Enables/disables D
H

CP.
W

hen set to [O
n], an IP address 

is autom
atically assigned to the 

cam
corder.

To enter the cam
corder IP 

address m
anually, set to [O

ff].
IP Address

Enter the IP address of the 
cam

corder. Enabled only w
hen 

D
H

CP is [O
ff].

Subnet m
ask

Enter the subnet m
ask of the 

cam
corder.

Enabled only w
hen D

H
CP is 

[O
ff].

G
atew

ay
Enter the gatew

ay for the access 
point.
Enabled only w

hen D
H

CP is 
[O

ff].
D

N
S Auto

O
btains D

N
S address 

autom
atically.

W
hen set to O

n, the address of 
the D

N
S server is obtained 

autom
atically.

Prim
ary D

N
S 

Server
Enter the prim

ary D
N

S server for 
the access point.
Enabled only w

hen D
N

S Auto is 
[O

ff].
Secondary D

N
S 

Server
Enter the secondary D

N
S server 

for the access point.
Enabled only w

hen D
N

S Auto is 
[O

ff].
Subm

it
Applies the w

ireless LAN
 

settings.

Connecting to an access point in station mode 
without using W

PS

1 
Connect the cam

corder and device using 
access point m

ode (page 60).

2 
Configure settings on the Station Settings 
screen.

Configure settings to m
atch the settings of the 

access point connection.

For details about access point settings, refer to the 
instruction m

anual for the access point.

3 
Tap [Subm

it].
The specified settings are applied.

4 
Select M

aintenance >N
etw

ork >W
ireless 

N
etw

ork in the setup m
enu.

5 
Turn the M

EN
U

 knob to select [W
i-Fi Station], 

then press the knob.
This step connects the cam

corder to the 
access point in station m

ode. Proceed to step 
9 in “Connecting to an access point using W

PS” 
(page 61) to access the cam

corder from
 the 

device.

Checking wireless LAN settings
U

se the W
ireless LAN

 >Status tab to m
onitor the 

w
ireless LAN

 status.
The displayed settings w

ill vary depending on the 
w

ireless LAN
 m

ode of the cam
corder.

Access point mode

Station mode

W
ired LAN Settings

U
se this screen to m

ake settings for connecting 
the cam

corder to a w
ired LAN

.

Item
D

escription
D

H
CP

Enables/disables D
H

CP.
W

hen set to [O
n], an IP address 

is autom
atically assigned to the 

cam
corder.

To enter the cam
corder IP 

address m
anually, set to [O

ff].
IP Address

Enter the IP address of the 
cam

corder.
Enabled w

hen D
H

CP is [O
ff].

Subnet m
ask

Enter the subnet m
ask of the 

cam
corder. Enabled w

hen 
D

H
CP is [O

ff].
G

atew
ay

Enter the gatew
ay for the access 

point.
Enabled w

hen D
H

CP is [O
ff].

Item
D

escription
D

N
S Auto

O
btains D

N
S address 

autom
atically.

W
hen set to O

n, the address of 
the D

N
S server is obtained 

autom
atically.

Prim
ary D

N
S 

Server
Enter the prim

ary D
N

S server of 
the router.
Enabled w

hen D
N

S Auto is [O
ff].

Secondary D
N

S 
Server

Enter the secondary D
N

S server 
of the router.
Enabled w

hen D
N

S Auto is [O
ff].

W
eb/Cam

 
Rem

ote
Enables/disables access to the 
cam

corder w
eb m

enu and W
i-Fi 

rem
ote control.

W
hen set to O

n, access is 
perm

itted.
Subm

it
Sets the w

ired LAN
 settings.

[N
ote]

To prevent unauthorized access from
 the Internet, it is 

recom
m

ended that W
eb/Cam

 Rem
ote be set to O

n only 
w

hen the w
ired LAN

 netw
ork is not connected to the 

Internet. W
hen connecting to the Internet, check that the 

netw
ork connection is a secure netw

ork before use.

Checking wired LAN settings
U

se the W
ired LAN

 >Status tab to m
onitor the 

w
ired LAN

 status.
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Transfer (Upload) Settings

You can register and set servers for transferring 
proxy files or original files recorded on the 
cam

corder.

Auto transfer ON/OFF
If [Auto upload] is [O

n] and an Internet connection 
exists, proxy files are autom

atically transferred to 
the default server specified on the U

pload Settings 
tab w

hen recording ends.
The default server is set to “Sony Ci” by factory 
default.
“Sony Ci” is the M

edia Cloud Services provided by 
Sony. You can transfer files to the “Sony Ci” cloud 
service.

[N
otes]
ˎˎ A subscription is required in order to use the “Sony Ci” 

cloud service. For details, visit w
w

w
.SonyM

CS.com
/

w
ireless.

ˎˎ The nam
e of the transfer destination folder is specified in 

[D
estination D

irectory]. If not specified, a folder nam
e w

ith 
the current date is used. To change the setting, see “To 
change registered server settings” (page 75).

U
se the follow

ing procedure to register w
ith “Sony 

Ci.”

1 
Check that “Sony Ci” is displayed on the 
[U

pload Settings] tab, then click [Edit].
The “Sony Ci” setup screen appears.

2 
Enter a user nam

e and passw
ord.

For details, visit w
w

w
.SonyM

CS.com
/w

ireless.

3 
Tap [Link].
A com

pletion m
essage appears after a short 

w
hile.

[Link] associates the user w
ith the cam

corder. 
An Internet connection is required to execute 
[Link].

4 
Tap [O

K].
After registering w

ith “Sony Ci,” [U
nlink] 

appears on the Settings screen. Tapping 
[U

nlink] releases the user account to enable 
other user accounts to link w

ith the 
cam

corder.

To register a new destination server
Tap [Create N

ew
] to display a configuration screen.

After specifying settings, tap [O
K] to apply the 

settings. Tapping [Cancel] discards the settings.

Item
D

escription
D

efault Server
Set to [O

n] to set the default 
file destination server. 
(D

isplayed at the top of the 
server list for file transfers.)

D
isplay N

am
e

Enter the nam
e of the server 

to display in the list.
Service

D
isplays the type of server.

FTP: FTP server
H

ost N
am

e
Enter the address of the server.

[N
ote]

If a port num
ber other than the 

default num
ber of 21 is used, 

append a colon and the port 
num

ber at the end of the address 
(for exam

ple, “:123”).

Item
D

escription
U

ser
Enter the user nam

e.
Passw

ord
Enter the passw

ord.
PASV M

ode
Enable/disable PASV m

ode.

D
estination 

D
irectory

Specify the destination 
directory.

[N
ote]

If an invalid character is entered 
in the directory nam

e, the 
directory is not created and files 
are transferred to the top level of 
the default transfer destination 
directory.

U
sing Secure 

Protocol
Set w

hether to use secure FTP.

Load Certification
Load an interm

ediate CA 
certificate.
D

isplayed w
hen U

sing Secure 
Protocol is set to O

n.

[N
otes]
ˎˎ Com

m
unication using FTP is 

not encrypted. The use of FTPS 
is recom

m
ended.

ˎˎ An interm
ediate CA certificate 

containing a root certificate is 
required.
ˎˎ The certificate to be loaded 

m
ust be in PEM

 form
at, and 

should be w
ritten to the root 

directory of the SD
 card w

ith 
“certification.pem

” file nam
e.

[N
ote]

Com
m

unication using FTP is not encrypted. The use of FTPS 
is recom

m
ended.

To change registered server settings
Select the server w

hose settings you w
ant to 

change on the U
pload Settings screen, then 

tap [Edit]. Change the setting on the displayed 
configuration screen.
For details about item

s, see “To register a new
 

destination server”.

Deleting a registered server
Select the server you w

ant to delete on the U
pload 

Settings screen, then tap [D
elete]. A confirm

ation 
m

essage appears. Tap [O
K] to delete the server 

and return to the previous screen.

Monitoring File Transfers (Job List)

You can m
onitor file transfer status, m

anage files in 
the transfer file list, and start/stop file transfers.
The cam

corder supports the FTP resum
e function 

(for continuing file transfer if transfer stops).

Item
D

escription
Total

Progress status of the transfer 
of all files

Status
Progress status of the file 
being transferred

Rem
ain tim

e
Predicted rem

aining transfer 
tim

e
Transfer data rate

Transfer rate

To stop/restart file transfer or delete a file from 
the transfer list

1 
Select a file.

2 
Tap 

 on the top right of the screen.
Select a m

enu item
.
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ˎˎ Abort selected: Stop file transfer.
ˎˎ D

elete from
 list: D

elete the file from
 the 

transfer list.
ˎˎ Start selected: Start file transfer.
ˎˎ Select All: Select all files in the list.
ˎˎ Clear com

pleted: D
elete all files that have 

been transferred from
 the list.
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Supported N
etw

ork Functions and O
perating Lim

itations
Network Functions and Network Connection Settings

The supported netw
ork functions and corresponding netw

ork connection settings (M
aintenance 

>N
etw

ork >W
ireless N

etw
ork and W

ired LAN
 settings) are show

n below
.

To enable the netw
ork functions, set M

aintenance >N
etw

ork >Setting in the setup m
enu to O

n.

N
etw

ork function
M

aintenance >N
etw

ork>W
ireless N

etw
ork in the 

setup m
enu

M
aintenance >N

etw
ork 

>W
ired LAN

 in the setup 
m

enu
W

i-Fi Access Point
W

i-Fi Station
M

odem
O

ff
Enable

D
isable

Proxy recording  1)

(page 53)
Yes

Yes
Yes

Yes
Yes

Yes

Proxy playback
(page 72)

Yes
2)

Yes
 2)

N
o

N
o

Yes
 2)

N
o

File transfer
(page 66)

N
o

Yes
 2)

Yes
 2)

N
o

Yes
 2)

N
o

Stream
ing 

transm
ission

(page 68)

N
o

Yes
Yes

N
o

Yes
N

o

M
onitoring

(page 72)
Yes

 2)
Yes

 2)
N

o
N

o
Yes

 2)
N

o

N
etw

ork client m
ode

(page 69)
N

o
Yes

Yes
N

o
Yes

N
o

Cam
corder rem

ote 
control
(page 70)

Yes
 2)

Yes
 2)

N
o

N
o

Yes
 2)

N
o

1) Proxy recording is enabled w
hen O

peration >Proxy Recording M
ode >Setting in the setup m

enu is set to O
n.

2) Supports cam
corder and netw

ork-connected device functions.

Limitations on Simultaneous Use of Network Functions

The follow
ing lim

itations apply to the sim
ultaneous use of netw

ork functions.

W
ireless LAN

 connection
W

ired LAN
 

connection
O

peration

N
one

D
isabled

N
etw

ork function stopped
U

SB w
ireless LAN

 m
odule

D
isabled

U
SB w

ireless LAN
 m

odule operating
3G

/4G
/LTE U

SB m
odem

D
isabled

3G
/4G

/LTE U
SB m

odem
 operating

N
one

Enabled
W

ired LAN
 operating

U
SB w

ireless LAN
 m

odule
Enabled

U
SB w

ireless LAN
 m

odule and w
ired LAN

 operating
 1)

1) Stream
ing and file transfer operate using w

ired LAN
. The U

SB w
ireless LAN

 m
odule is reserved for W

i-Fi rem
ote control 

operation.

[N
ote]

W
ired LAN

 connection is not possible w
hen the U

SB extension adaptor of the CBK-N
A1R Ethernet Adaptor, supplied w

ith the 
CBK-N

A1 (option), is attached to the U
SB w

ireless LAN
 m

odule on the cam
corder.
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Clip O
perations on the Thum

bnail Screen
Thumbnail Screen

OK
S

1
2

3
4

9
10

11
12

13

6
5

7
8

Cursor 
(yellow

)

The thum
bnail screen appears if you press the 

TH
U

M
BN

AIL button in E-E or playback m
ode. 

Thum
bnail screens display lists of the index pictures 

of clips stored on SxS m
em

ory cards as thum
bnails.

You can select any clip (page 79) on the thum
bnail 

screen and start playback of that clip (page 79).
You can also add a clip flag to any clip on the 
thum

bnail screen to filter clips according to the flags. 
You can also sw

itch to the Essence M
ark thum

bnail 
screen from

 the thum
bnail screen and add essence 

m
arks (for exam

ple, shot m
arks) to any fram

e in the 
clip.

To hide the thum
bnail screen, press the TH

U
M

BN
AIL 

button.

1. 
Thum

bnail (index picture)
W

hen a clip is recorded, its first fram
e is autom

atically 
displayed as the index picture. You can change the 
index picture to any fram

e (page 82).

2. 
Selected m

edia icon/m
edia status

A 
 m

ark is displayed if the m
edia is protected.

If tw
o SxS m

em
ory cards are inserted in the cam

corder, you 
can sw

itch betw
een them

 using the SLOT SELECT button.

[N
ote]

You cannot sw
itch betw

een SxS m
em

ory cards w
hile the 

Essence M
ark thum

bnail screen is displayed.

3. 
Clip num

ber / total num
ber of clips

4. 
Battery / Voltage status

5. 
Playback disabled indicator

6. 
Clip status

D
isplays the clips status using an icon.

Icon
M

eaning
S, O

K, N
G

, KP 
icons

Essence m
ark or clip flag attached 

to a clip
Lock icon

Clip is locked (protected)

7. 
Clip select checkbox

Place a check m
ark in the checkbox to select a clip 

(thum
bnail).

8. 
Thum

bnail inform
ation

D
isplays thum

bnail inform
ation. The displayed 

inform
ation varies according to the Custom

ize View
 

setting (page 83).

9. 
Clip nam

e / title
D

isplays the nam
e or title of the selected clip.

10. Recording video form
at

11. Special recording inform
ation

D
isplays the recording m

ode if the clip w
as recorded 

using a special recording m
ode (Slow

 & Q
uick M

otion).
For Slow

 & Q
uick M

otion clips, the [Recording fram
e 

rate/Playback fram
e rate] are displayed on the right.

12. Clip duration

13. Creation date
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Selecting Clips

To select a clip thum
bnail, do one of the follow

ing 
to m

ove the yellow
 cursor to the thum

bnail that 
you w

ant to select.
ˎˎ Press the ^

, x
, _

, y
 buttons.

ˎˎ Turn the M
EN

U
 knob.

ˎˎ Press the PREV or N
EXT button.

Selecting the First Thumbnail

Press and hold the F REV button, and press the 
PREV button.

Selecting the Last Thumbnail

Press and hold the F FW
D

 button, and press the 
N

EXT button.

Playing Clips Sequentially Starting 
from the Selected Clip

1 
Select the thum

bnail of the clip that you 
w

ant to play first.

2 
Press the PLAY/PAU

SE button.
Playback begins from

 the start of the 
selected clip.

It plays all clips sequentially starting from
 the 

selected clip.

After the last clip has been played, the 
cam

corder enters pause (still im
age) m

ode at 
the last fram

e of the last clip.
Press the TH

U
M

BN
AIL button to return to the 

thum
bnail screen.

[N
otes]
ˎˎ N

ot all clips m
ay be played back sequentially if the 

clips on the SxS m
em

ory cards w
ere recorded w

ith a 
m

ixture of different recording form
ats.

ˎˎ Clips w
ith an playback disabled icon (page 78) 

displayed on the thum
bnail screen are not played. 

The corresponding clips are skipped and sequential 
playback continues.
ˎˎ There m

ay be m
om

entary picture breakup or still 
im

age display at the boundary betw
een clips. D

uring 
this tim

e, the play controls and the TH
U

M
BN

AIL button 
cannot be operated.
ˎˎ W

hen you select a clip in the thum
bnail screen and 

begin playback, there m
ay be m

om
entary picture 

breakup at the start of the clip. To view
 the start of the 

clip w
ithout breakup, put the cam

corder into playback 
m

ode, pause, use the PREV button to return to the start 
of the clip, and start play again.

Pausing Playback

Press the PLAY/PAU
SE button.

The PLAY/PAU
SE indicator flashes w

hile play is 
paused.
Press the button again to return to play m

ode.

Playing at High Speed

Press the F FW
D

 button (page 8) or the F REV 
button (page 7).
To return to norm

al playback, press the PLAY/
PAU

SE button.

Returning to the Start of the 
Current Clip

Press the PREV button.
ˎˎ D

uring playback or F FW
D

, this jum
ps to the 

start of the current clip and starts playback.
ˎˎ D

uring F REV or pause, this jum
ps to the start 

of the current clip and displays a still im
age.

ˎˎ Each subsequent press of the button m
oves 

to the previous clip.

Playing from the Start of the First 
Clip

Sim
ultaneously press the PREV and F REV 

buttons. This jum
ps to the start of the first clip 

on the SxS m
em

ory card.

Jumping to the Start of the Next 
Clip

Press the N
EXT button.

ˎˎ D
uring playback or F FW

D
, this jum

ps to the 
start of the next clip and starts playback.
ˎˎ D

uring F REV or pause, this jum
ps to the start 

of the next clip and displays a still im
age.

ˎˎ Each subsequent press of the button m
oves 

to the next clip.

Jumping to the Last Clip

Sim
ultaneously press the F FW

D
 and N

EXT 
buttons. This jum

ps to the last fram
e of the last 

clip recorded on the SxS m
em

ory card.

Adding a Shot Mark during 
Playback

You can add shot m
arks to clips during playback 

by using the sam
e m

ethod used during 
recording (page 49).

[N
otes]
ˎˎ Shot m

arks cannot be recorded w
hen the SxS m

em
ory 

card is w
rite protected.

ˎˎ Shot m
arks cannot be added to the first fram

e of each 
clip or the last fram

e of the last clip.

Stopping Playback

Press the STO
P button: Playback stops, and the 

cam
corder enters E-E m

ode.
Press the TH

U
M

BN
AIL button: Playback stops 

and the thum
bnail screen (page 78) 

appears in the view
finder.

Play also stops if you eject the m
em

ory card. 
In this case, the cam

era picture appears in the 
view

finder.
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Basic Thumbnail Menu Operations

The Thum
bnail m

enu is used to protect/delete 
clips, check properties, add/delete clip flags and 
essence m

arks to fram
es in a clip, and other tasks.

1 
Press the TH

U
M

BN
AIL button.

The thum
bnail screen appears.

2 
Set the M

EN
U

 O
N

/O
FF sw

itch to O
N

, or press 
the M

EN
U

 button.
The m

enu screen appears.

3 
Turn the M

EN
U

 knob to select [Thum
bnail], 

then press the knob.
You can also press the ^

 or x
 button to select 

[Thum
bnail], and press the SET button.

To hide the Thum
bnail m

enu, press the M
EN

U
 

button again.

To select a m
enu item

/sub-item
, do one of the 

follow
ing.

ˎˎ Turn the M
EN

U
 knob to select an item

 or sub-
item

, then press the knob.
ˎˎ Press the arrow

 buttons (^
, x

, _
, y

) to select 
an item

 or sub-item
, then press the SET button.

A selection list or a clip properties screen appears 
(page 81) according to the selected item

 or 
sub-item

.
To return to the previous screen, push the M

EN
U

 
CAN

CEL/PRST/ESCAPE sw
itch dow

n to the ESCAPE 
position.

[N
otes]
ˎˎ W

hen an SxS m
em

ory card is w
rite protected, it is not 

possible to copy, delete, change index pictures, or add 
and delete clip flags m

arks and shot m
arks.

ˎˎ Som
e item

s cannot be selected, depending on the state 
w

hen the m
enu w

as displayed.

For details about the thum
bnail screen structure, 

see “Thum
bnail M

enu” (page 83).

Protecting Clips

You can protect a specified clip or all clips to 
protect the clips from

 being deleted.
 is added to the thum

bnails of protected clips.
Clips can be protected on the thum

bnail screen or 
the filtered clip thum

bnail screen (page 82).

Protecting a specific clip

1 
Select Thum

bnail >Lock/U
nlock Clip >Select 

Clip in the setup m
enu.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
The clip selection screen appears.

3 
Turn the M

EN
U

 knob to select a clip to protect, 
then press the knob.
A check m

ark is attached to the selected clip.

4 
Sim

ultaneously press the SET button and SH
IFT 

button.
A confirm

ation screen appears.

5 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
The clip is protected, and a com

pletion 
m

essage appears.

6 
Press the M

EN
U

 knob to dism
iss the m

essage.

Protecting all clips

1 
Select Thum

bnail >Lock/U
nlock Clip >Lock All 

Clips in the setup m
enu.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
A confirm

ation screen appears.

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
All clips are protected, and a com

pletion 
m

essage appears.

4 
Press the M

EN
U

 knob to dism
iss the m

essage.

Unlocking all clips

1 
Select Thum

bnail >Lock/U
nlock Clip >U

nlock 
All Clips in the setup m

enu.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
A confirm

ation screen appears.

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
All clips are unlocked, and a com

pletion 
m

essage appears.

4 
Press the M

EN
U

 knob to dism
iss the m

essage.

Copying Clips

You can copy clips to another SxS m
em

ory card.
Clips are copied to destination SxS m

em
ory cards 

using the sam
e nam

es as the original clips.

[N
otes]
ˎˎ If a clip w

ith the sam
e nam

e already exists at the 
copy destination SxS m

em
ory card, a one-digit 

num
ber in parentheses is added to the original 

nam
e.  

The num
ber in parentheses is the sm

allest 
num

ber that does not exist at the copy 
destination.  
Exam

ple: 
ABCD

0002�
ABCD

0002(1) 
ABCD

0002(1)�
ABCD

0002(2) 
ABCD

0005(3)�
ABCD

0005(4)
ˎˎ If the parenthetical num

bers (1) to (999) already 
exist at the copy destination, because a clip 
has been copied m

ore than 1000 tim
es, it is 

not possible to copy any m
ore clips under that 

nam
e.

ˎˎ A m
essage appears if there is not enough free 

space on the copy destination SxS m
em

ory card. 
Exchange the card for one w

ith m
ore free space.

ˎˎ W
hen m

ultiple clips are recorded on the source 
SxS m

em
ory card, it m

ay not be possible to copy 
all clips even w

hen the source and destination 
m

em
ory cards have the sam

e capacity, 
depending on the m

em
ory characteristics and 

usage of the m
em

ory cards.

Copying a specific clip

1 
Select Thum

bnail >Copy Clip >Select Clip in 
the setup m

enu.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
The clip selection screen appears.

3 
Turn the M

EN
U

 knob to select a clip to copy, 
then press the knob.
A check m

ark is attached to the selected clip.

4 
Sim

ultaneously press the SET button and SH
IFT 

button.
A confirm

ation screen appears.
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5 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
The clip is copied, and a com

pletion m
essage 

appears.

6 
Press the M

EN
U

 knob to dism
iss the m

essage.

Copying all clips
You can copy all clips stored on the sam

e SxS 
m

em
ory card at the sam

e tim
e to another SxS 

m
em

ory card.

1 
Select Thum

bnail >Copy Clip >All Clips in the 
setup m

enu.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
A confirm

ation screen appears.

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
All clips are copied, and a com

pletion m
essage 

appears.

4 
Press the M

EN
U

 knob to dism
iss the m

essage.

Deleting Clips

You can delete clips from
 SxS m

em
ory cards. Clips 

can be deleted on the thum
bnail screen or the 

filtered clip thum
bnail screen (page 82).

1 
Select Thum

bnail >D
elete Clip >Select Clip in 

the setup m
enu.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
The clip selection screen appears.

3 
Turn the M

EN
U

 knob to select a clip to delete, 
then press the knob.
A check m

ark is attached to the selected clip.

4 
Sim

ultaneously press the SET button and SH
IFT 

button.
A confirm

ation screen appears.

5 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
The clip is deleted, and a com

pletion m
essage 

appears.

6 
Press the M

EN
U

 knob to dism
iss the m

essage.

The clips below
 the deleted clip on the thum

bnail 
screen m

ove up one position.

Deleting all clips
You can delete all clips stored on the sam

e SxS 
m

em
ory card at the sam

e tim
e.

[N
otes]
ˎˎ D

eleted clips cannot be restored.
ˎˎ If the m

edia or clip is protected, this function is disabled.

1 
Select Thum

bnail >D
elete Clip >All Clips in the 

setup m
enu.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
A confirm

ation screen appears.

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
All clips are deleted, and a com

pletion 
m

essage appears.

4 
Press the M

EN
U

 knob to dism
iss the m

essage.

Displaying Clip Properties

The clip properties screen for the selected clip appears w
hen you select Thum

bnail >D
isplay Clip 

Properties in the setup m
enu.

123

4567

OK
S

1. 
Current clip im

age
D

isplays the index picture and status of the 
selected clip.

2. 
Tim

ecode display
TC Index: Tim

ecode of the displayed im
age

Start: Tim
ecode of the recording start point

End: Tim
ecode of the recording end point

D
uration: D

uration betw
een start and end points

3. 
Creation date and m

odified date

4. 
Clip nam

e

5. 
Recording form

at
Video Codec: Video codec
Size: Picture size
FPS: Fram

e rate
Audio Codec: Audio codec
Ch/Bit: Audio recording channel/N

um
ber of bits 

for audio recording

6. 
Special recording inform

ation

7. 
Recording device nam

e

To hide the clip properties screen, do one of the 
follow

ing.

Press the RESET/RETU
RN

 button: Returns to the 
Thum

bnail m
enu screen.

Press the TH
U

M
BN

AIL button: Sets the cam
corder 

to E-E m
ode and displays the cam

era picture.
Press the PLAY/PAU

SE button: Starts playback of 
the selected clip.

Adding Clip Flags to Clips

You can add clip flags (O
K, N

G
 or KP m

arks) to clips 
to filter the display of clips based on the clip flags. 
You can perform

 this operation on the thum
bnail 

screen or the filtered clip thum
bnail screen 

(page 82).

1 
Select the thum

bnail for the clip to w
hich you 

w
ant to add the clip flag, then select 

Thum
bnail >Set Clip Flag in the setup m

enu.

2 
Turn the M

EN
U

 knob to select a clip flag, then 
press the knob.
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Setting
Added clip flag

Add O
K

O
K

Add N
G

N
G

Add KEEP
KP

The clip flag is added to the thum
bnail of the 

selected clip.

You can also use an assignable sw
itch assigned 

w
ith the clip flag function to add clip flags 

(page 114).

Deleting a Clip Flag

1 
Select the thum

bnail for the clip from
 w

hich 
you w

ant to delete a clip flag, then select 
Thum

bnail >Set Clip Flag >D
elete Clip Flag in 

the setup m
enu.

The clip flag is deleted.

Filtering the Clips Displayed using the 
Filtered Clip Screen

1 
Select Thum

bnail >Filter Clips in the setup 
m

enu.

2 
Turn the M

EN
U

 knob to select a clip flag used 
to filter clips, then press the knob.

Setting
Filter clip flag

O
K

O
K

N
G

N
G

KEEP
KP

N
one

(Clips are not filtered)

The clip screen appears show
ing the clips 

filtered by the selected clip flag. This screen is 
referred to as the filtered clip screen.

To cancel filtering, do one of the follow
ing.

ˎˎ Press the RESET/RETU
RN

 button.
ˎˎ Select Thum

bnail >Thum
bnail View

 >All in the 
setup m

enu.

Adding/Deleting Essence Marks on 
Clips

You can add (and delete) essence m
arks (shot 

m
arks, recording start m

arks) to any fram
e in a clip. 

You add/delete essence m
arks on the essence 

m
ark thum

bnail screen.

Adding a shot mark

1 
Select Thum

bnail > Thum
bnail View

 > Essence 
M

ark Thum
bnail in the setup m

enu.

2 
Turn the M

EN
U

 knob to select [All], and then 
press the knob.

3 
Select the thum

bnail for the fram
e to w

hich 
you w

ant to add the essence m
ark on the 

essence m
ark thum

bnail screen, then select 
Thum

bnail >Set Shot M
ark in the setup m

enu.

4 
Turn the M

EN
U

 knob to select one of the 
follow

ing, then press the knob.

Setting
O

peration

Add Shot M
ark1

Adds Shot M
ark 1

Add Shot M
ark2

Adds Shot M
ark 2

The shot m
ark is added to the selected fram

e.

Deleting a shot mark

1 
Select Thum

bnail > Thum
bnail View

 > Essence 
M

ark Thum
bnail in the setup m

enu.

2 
Select the type of shot m

ark to delete.

3 
Select the thum

bnail for the fram
e from

 w
hich 

you w
ant to delete a shot m

ark on the essence 
m

ark thum
bnail screen, then select Thum

bnail 
>Set Shot M

ark in the setup m
enu.

4 
Turn the M

EN
U

 knob to select one of the 
follow

ing, then press the knob.

Setting
O

peration

D
elete Shot M

ark1
D

eletes Shot M
ark 1

D
elete Shot M

ark2
D

eletes Shot M
ark 2

The shot m
ark is deleted from

 the selected 
fram

e.

Filtering Clips (Frames) using the 
Essence Mark Thumbnail Screen

The essence m
ark thum

bnail screen displays only 
those fram

es in a clip w
here an essence m

ark has 
been recorded in thum

bnail view
. D

isplay the 
thum

bnail screen, then either press the ESSEN
CE 

M
ARK button (page 9) or use the follow

ing 
procedure to display the essence m

ark thum
bnail 

screen.

1 
Select Thum

bnail >Thum
bnail View

 >Essence 
M

ark Thum
bnail in the setup m

enu.

2 
Turn the M

EN
U

 knob to select an essence 
m

ark used to filter fram
es, then press the knob.

Setting
D

escription

All
All fram

es w
ith added essence 

m
arks

Rec Start
Fram

es w
ith a recording start 

m
ark and the first fram

e of 
clips that do not have a 
recording start m

ark

Shot M
ark0 to 

Shot M
ark9

Fram
es w

ith each shot m
ark

The essence m
ark thum

bnail screen appears 
filtered by the selected essence m

ark.

If a clip is recorded using planning m
etadata that 

defines nam
es for shot m

ark 0 to shot m
ark 9, the 

selection options in the list are displayed by the 
defined nam

es.

Changing the Index Picture of a Clip

You can set the fram
e selected on the essence 

m
ark thum

bnail screen as the index picture for the 
clip.
Select the thum

bnail of the fram
e you w

ant to 
set as the index picture for the clip, then select 
Thum

bnail >Set Index Picture in the setup m
enu.



000
6. Clip O

perations: Clip O
perations on the Thum

bnail Screen
83

Thumbnail Menu

D
efault values are show

n in bold.

Item
Sub-item

 setting
D

escription
D

isplay Clip Properties
–

D
isplays clip properties (page 81).

Set Index Picture
–

Sets/changes the index picture of a clip 
(page 82).

Thum
bnail View

Changes the thum
bnail 

screen displayed.

Essence M
ark Thum

bnail
All/Rec Start/Shot M

ark1/Shot 
M

ark2/Shot M
ark3/Shot M

ark4/
Shot M

ark5/Shot M
ark6/Shot 

M
ark7/Shot M

ark8/Shot M
ark9/

Shot M
ark0

D
isplays the essence m

ark thum
bnail screen 

w
ith clips filtered by essence m

ark (page 82).

Clip Thum
bnail

D
isplays the thum

bnail screen (clip thum
bnail 

screen) (page 78).
Set Shot M

ark
Adds/deletes shot m

arks.
Add Shot M

ark1
Adds Shot M

ark 1 to a fram
e (page 82).

D
elete Shot M

ark1
D

eletes Shot M
ark 1 (page 82).

Add Shot M
ark2

Adds Shot M
ark 2 to a fram

e (page 82).

D
elete Shot M

ark2
D

eletes Shot M
ark 2 (page 82).

Set Clip Flag
Adds/deletes clip flags.

Add O
K

Adds an O
K flag to a clip (page 81).

Add N
G

Adds an N
G

 flag to a clip (page 81).

Add KEEP
Adds a KP (Keep) flag to a clip (page 81).

D
elete Clip Flag

D
eletes a clip flag (page 82).

Lock/U
nlock Clip

Protects/unlocks a clip.
Select Clip

Selects the clip to protect (page 80).

Lock All Clips
Protects all clips on the m

edia (page 80).

U
nlock All Clips

U
nlocks all clips on the m

edia (page 80).

Copy Clip
Copies clips.

Select Clip 
Selects the clip to copy (page 80).

All Clips
Copies all clips on the m

edia (page 81).

D
elete Clip

D
eletes clips.

Select Clip 
Selects the clip to delete (page 81).

All Clips
D

eletes all clips on the m
edia (page 81).

Item
Sub-item

 setting
D

escription
Filter Clips
Filters the display of clips 
by clip flag.

O
K

Filters the display of clips by O
K flags 

(page 82).
N

G
Filters the display of clips by N

G
 flags 

(page 82).
KEEP

Filters the display of clips by KP (Keep) flags 
(page 82).

N
one

Clips are not filtered (page 82).
Custom

ize View
Thum

bnail Caption
D

ate Tim
e/Tim

e Code/
D

uration/Sequential 
N

um
ber

Selects the inform
ation displayed beneath clip 

thum
bnails.

D
ate Tim

e: D
isplays the date and tim

e.
Tim

e Code: D
isplays the tim

ecode.
D

uration: D
isplays the duration of the clip.

Sequential N
um

ber: D
isplays a sequential 

num
ber for each clip.
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Setup M
enu O

rganization
O

n this cam
corder, settings for shooting and 

playback are m
ade in the setup m

enu, w
hich 

appears in the view
finder.

The setup m
enu can also be displayed on an 

external video m
onitor (page 126).

Menu Structure

U
ser m

enu
M

enu used to arrange item
s from

 the setup 
m

enu in any chosen order (page 88).
O

peration m
enu

M
enu used to m

ake settings related to 
shooting (excluding settings related to picture 
quality).

Paint m
enu

M
enu used to m

ake settings related to picture 
quality.

Thum
bnail m

enu
M

enu used to m
ake settings related to clip 

thum
bnails (page 83).

 
[N

ote]
The Thum

bnail m
enu can be used only w

hen a 
thum

bnail screen (page 78) is displayed. It is disabled 
w

hen the thum
bnail screen is not displayed.

M
aintenance M

enu
M

enu used to m
ake settings related to 

cam
corder m

aintenance and system
 

m
anagem

ent.
File m

enu
M

enu used to m
ake perform

 operations on 
files.

Menu Items

Operation menu

Item
D

escription
Page

Form
at

System
 settings

90
Form

at M
edia

M
edia form

at settings
91

Input/O
utput

Input/output signal 
settings

91

Super Im
pose

Superim
position settings

91

LCD
LCD

 m
onitor settings

91
Rec Function

Special recording m
ode 

settings
92

Proxy Recording 
M

ode
Proxy data settings

92

Assignable 
Sw

itch
Assign functions to 
assignable sw

itches
93

VF Setting
View

finder settings
93

M
arker

M
arker settings

93
G

ain Sw
itch

G
ain value settings

94
Auto Iris

Auto iris settings
94

Zebra
Zebra pattern settings

94
D

isplay O
n/O

ff
View

finder display item
 

settings
94

“!” LED
View

finder “!” settings
95

W
hite Setting

W
hite balance settings

96

O
ffset W

hite
O

ffset w
hite settings

96
Shutter

Shutter settings
96

Slow
 Shutter

Slow
 shutter settings

96

Tim
e Zone

Tim
e settings

96
Clip

Clip settings
97

U
pdate M

edia
U

pdate m
edia 

m
anagem

ent 
inform

ation

97

G
PS

Location inform
ation 

(G
PS) settings

97

Item
D

escription
Page

Planning 
M

etadata
Planning m

etadata 
settings

97

Flash Band 
Reduce

Flashband correction 
settings

98

Paint menu

Item
D

escription
Page

Sw
itch Status

Correction functions and 
test signal on/off 
settings

98

W
hite

Color tem
perature 

settings
98

Black
Black level settings

99
Flare

Flare correction settings
99

G
am

m
a

G
am

m
a correction 

settings
99

Black G
am

m
a

Black gam
m

a correction 
settings

99

Knee
Knee correction settings

100
W

hite Clip
W

hite clip settings
100

D
etail(H

D
)

D
etail settings

100
D

etail(SD
)

D
etail settings

100
Aperture

Aperture correction 
settings

101

Skin D
etail

Skin detail correction 
settings

101

M
atrix

M
atrix correction 

settings
101

M
ulti M

atrix
M

ulti m
atrix correction 

settings
101

V M
odulation

V m
odulation shading 

correction settings
102

Low
 Key 

Saturation
Low

 key saturation 
correction settings

102

Saturation 
M

ode
Saturation correction 
settings

102

N
oise 

Suppression
N

oise suppression 
settings

102
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Maintenance menu

Item
D

escription
Page

W
hite Shading

W
hite shading 

correction settings
103

Black Shading
Black shading correction 
settings

103

Battery
Battery settings

103
D

C Voltage 
Alarm

External D
C source 

voltage alarm
 settings

103

Audio
Audio settings

103
W

RR Setting
W

ireless tuner settings
105

Tim
e Code

Tim
ecode settings

105
Essence M

ark
Essence m

ark settings
106

Cam
era Config

Cam
corder operation 

settings
106

Preset W
hite

Preset w
hite settings

107

W
hite Filter

Filter settings
107

D
CC Adjust

D
CC settings

107
Flicker Reduce

Flicker correction 
settings

108

G
enlock

G
enlock settings

108
Auto Shading

Auto black shading 
correction settings

108

APR
APR settings

108
Basic 
Authentication

Basic authentication 
settings

108

N
etw

ork
N

etw
ork connection 

settings
108

N
etw

ork Client 
M

ode
N

etw
ork client m

ode 
settings

109

File Transfer
W

i-Fi transfer settings
109

Stream
ing

Stream
ing settings

109
Clock Set

Internal clock settings
110

Language
D

isplay language 
settings

110

H
ours M

eter
D

igital tim
e counter 

settings
110

N
etw

ork Reset
N

etw
ork reset

110

Item
D

escription
Page

Fan Control
Fan control settings

110
VF D

isplay 
Setting

View
finder display 

settings
110

Version
Version settings

111

File menu

Item
D

escription
Page

U
ser File

U
ser file settings

111

All File
ALL file settings

111
Scene File

Scene file settings
112

Reference File
Reference file settings

112

Lens File
Lens file settings

112
U

ser G
am

m
a

G
am

m
a file settings

113
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Displaying the Setup Menu

Set the M
EN

U
 O

N
/O

FF sw
itch to O

N
, or press the 

M
EN

U
 button.

The cam
corder enters m

enu m
ode and the m

enu 
list appears on the screen.

The follow
ing exam

ple show
s the cursor 

positioned at the O
peration m

enu
M

enu list

M
enu item

 selection area

[N
ote]

The setup m
enu cannot be used w

hen the cam
corder is in 

focus m
agnification m

ode. Exit focus m
agnification m

ode 
by pressing the assignable sw

itch to w
hich the Focus M

ag 
function has been assigned.

Making Menu Settings

1 
Turn the M

EN
U

 knob, or press the ^
 or x

 
button, to m

ove the cursor to the desired 
m

enu.
A list of selectable m

enu item
s appears in the 

m
enu item

 selection area to the right of the 
m

enu list.

2 
Press the M

EN
U

 knob or the SET button.
The m

enu item
 selection screen appears.  

You can also display the m
enu item

 selection 
screen by pressing the y

 button.

ˎˎ The m
enu item

 selection area displays a 
m

axim
um

 of seven lines. You can scroll 
through m

enus w
ith m

ore than seven lines 
by m

oving the cursor up and dow
n.

M
enu item

 selection area
ˎˎ If the selected item

 has sub-item
s, 

they appear on the right.
ˎˎ If there are no sub-item

s, the current 
setting appears on the right.
ˎˎ Select [Back] to return to the previous 
level.

D
isplayed w

hen there are further 
m

enu item
s below

.

3 
Turn the M

EN
U

 knob, or press the ^
 or x

 
button, to m

ove the cursor to the m
enu item

 
that you w

ant to set, and then confirm
 by 

pressing the M
EN

U
 knob or the SET button.

The sub-item
s area appears to the right of the 

m
enu item

 selection area, and the cursor 
m

oves to the first sub-item
.

Settings area
ˎˎ D

isplays sub-item
s and their current settings

ˎˎ To return to the previous level, select [Back], 
press the _

 button, or push the M
EN

U
 

CAN
CEL/PRST/ESCAPE sw

itch dow
n to the 

ESCAPE position.

4 
Turn the M

EN
U

 knob, or press the ^
 or x

 
button, to m

ove the cursor to the sub-item
 

that you w
ant to set, and then confirm

 by 
pressing the M

EN
U

 knob or the SET button.
The settings of the selected sub-item

 appear, 
and the cursor m

oves to the currently selected 
value.

Settings area

ˎˎ The settings area displays a m
axim

um
 of 

nine lines. You can scroll through m
enus 

w
ith m

ore than nine sub-item
s by m

oving 
the cursor up and dow

n.
ˎˎ For sub-item

s w
ith a large settings range (for 

exam
ple, –99 to +99), the settings area is not 

displayed. The current setting is highlighted 
to indicate that the value can be changed.

5 
Turn the M

EN
U

 knob, or press the ^
 or x

 
button, to select the value to set, and then 
confirm

 by pressing the M
EN

U
 knob or the SET 

button.
The setting is changed, and the display is 
updated to show

 the new
 setting.

If you select [Execute] for an executable item
, 

the corresponding function is executed.

If an item
 requires confirm

ation before execution, 
selecting the item

 in step 3 hides the m
enu and 

a confirm
ation m

essage appears. Follow
 the 

instructions in the m
essage to execute or cancel 

the operation.

Entering Text

W
hen you select an item

, such as a file nam
e, 

w
hich requires character entry, the character entry 

screen appears.

12
3

1 
Press the M

EN
U

 knob to select the type of 
character to enter, then press the M

EN
U

 knob 
or SET button.
ABC: U

ppercase alphabetic characters
abc: Low

ercase alphabetic characters
123: N

um
eric characters

!#$: Special characters

2 
Select a character from

 the selected character 
type, then press the knob.
The cursor m

oves to the next field.
Space: Enters a space character at the cursor 

position.
h

/�
: M

oves the position of the cursor.
BS: D

eletes the character on the left of the 
cursor (backspace).

3 
W

hen finished, select [D
one] and press the 

dial.
The character string is confirm

ed and the 
character entry screen disappears.

Basic Setup M
enu O

perations
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Canceling Changes to Settings

1 
Push the M

EN
U

 CAN
CEL/PRST/ESCAPE sw

itch 
dow

n to the ESCAPE position.

Exiting the Menu

1 
Set the M

EN
U

 O
N

/O
FF sw

itch to O
FF or press 

the M
EN

U
 button.

The norm
al cam

era picture reappears.

Locking/Unlocking the Menu

You can lock the setup m
enu so that only the U

ser 
m

enu is displayed.

Locking the menu

1 
Press and hold the M

EN
U

 knob and press the 
M

EN
U

 O
N

/O
FF sw

itch dow
n to display the 

setup m
enu.

2 
D

isplay M
aintenance >Cam

era Config >U
ser 

M
enu w

ith Lock in the setup m
enu.

 
[N

otes]
ˎˎ W

hen you press and hold the M
EN

U
 knob and press 

the M
EN

U
 O

N
/O

FF sw
itch dow

n, Cam
era Config 

>U
ser M

enu O
nly changes to U

ser M
enu w

ith Lock.
ˎˎ If you press the M

EN
U

 O
N

/O
FF sw

itch dow
n w

ithout 
pressing the M

EN
U

 knob or you press the M
EN

U
 

button to display the m
enu, Cam

era Config >U
ser 

M
enu w

ith Lock is not displayed.

3 
Select “O

n,” then press the M
EN

U
 knob.

The view
finder screen display sw

itches to the 
passcode num

ber input screen.

4 
Enter an arbitrary passcode num

ber.
The valid input range is 0000 to 9999. The 
default value is 0000.
Enter a num

ber and press the M
EN

U
 knob to 

m
ove the cursor to the next digit.

W
hen all digits have been entered, m

ove the 
cursor to [Set].

5 
W

ith [Set] selected, press the M
EN

U
 knob.

The entry is applied.
A confirm

ation m
essage appears. 

Subsequently, only the U
ser m

enu is displayed.

 
[N

otes]
ˎˎ If the m

enu is locked w
ithout registering the 

follow
ing setup m

enu item
s in the U

ser m
enu, 

assigning the m
enu function to an assignable sw

itch 
is not possible.
ˎˎ If som

e of the follow
ing setup m

enu item
s are 

assigned to an assignable sw
itch w

hen the m
enu 

is locked, the setting for the functions assigned to 
assignable sw

itches are forcibly set to O
ff w

hen the 
m

enu is locked.

Setup m
enu

Functions assignable 
to assignable 
sw

itches
O

peration >Rec Function 
>Picture Cache Rec

Picture Cache Rec

O
peration >Rec Function 

>Clip Continuous Rec
Clip Continuous Rec

O
peration >VF Setting 

>Color M
ode

VF M
ode

O
peration >D

isplay O
n/

O
ff >Video Signal 

M
onitor

Video Signal M
onitor

O
peration >D

isplay O
n/

O
ff >Lens Info

Lens Info

O
peration >Auto Iris 

>M
ode

Spotlight
Backlight

O
peration >M

arker 
>Setting

M
arker

M
aintenance >Audio 

>Front M
IC Select

Front M
IC

M
aintenance >N

etw
ork 

Client M
ode >Setting

N
etw

ork Client 
M

ode

M
aintenance >File 

Transfer >Auto 
U

pload(Proxy)

Auto U
pload(Proxy)

Unlocking the menu

1 
Press and hold the M

EN
U

 knob and press the 
M

EN
U

 O
N

/O
FF sw

itch dow
n to display the 

setup m
enu.

2 
D

isplay U
ser >Cam

era Config >U
ser M

enu 
w

ith Lock in the setup m
enu.

 
[N

otes]
ˎˎ W

hen you press and hold the M
EN

U
 knob and press 

the M
EN

U
 O

N
/O

FF sw
itch dow

n, Cam
era Config 

>U
ser M

enu O
nly changes to U

ser M
enu w

ith Lock.
ˎˎ If you press the M

EN
U

 O
N

/O
FF sw

itch dow
n w

ithout 
pressing the M

EN
U

 knob or you press the M
EN

U
 

button to display the m
enu, Cam

era Config >U
ser 

M
enu w

ith Lock is not displayed.

3 
Select “O

ff,” then press the M
EN

U
 knob.

The view
finder screen display sw

itches to the 
passcode num

ber input screen.

4 
Enter the passcode num

ber used to lock the 
m

enu.
The valid input range is 0000 to 9999.
Enter a num

ber and press the M
EN

U
 knob to 

m
ove the cursor to the next digit.

W
hen all digits have been entered, m

ove the 
cursor to [Set].

5 
W

ith [Set] selected, press the M
EN

U
 knob.

The entry is applied.
If the entered passcode num

ber m
atches the 

passcode num
ber used to lock the m

enu, a 
confirm

ation m
essage appears and the display 

of all m
enus is enabled.

 
[N

otes]
ˎˎ If the entered passcode num

ber does not m
atch the 

passcode num
ber used to lock the m

enu, the m
enu 

is not unlocked.

ˎˎ It is recom
m

ended that you leave a record of the 
passcode nearby, just in case it is forgotten. If you 
do forget the passcode num

ber, contact your Sony 
service representative.



000
7. M

enu D
isplay and Settings

88

You can edit the U
ser m

enu, such as adding item
s, 

deleting item
s, and rearranging item

s, to m
ake the 

U
ser m

enu m
ore useful using Edit U

ser M
enu.

You can select item
s in the O

peration m
enu, Paint 

m
enu, M

aintenance m
enu, and som

e item
s in the 

File m
enu, and add them

 to the U
ser m

enu.
U

p to 20 item
s can be registered in the U

ser m
enu. 

There are six item
s registered in the U

ser m
enu 

by factory default, one of w
hich m

ust alw
ays be 

present, allow
ing you to add up to 19 new

 item
s.

[N
ote]

Editing is unavailable w
hen the m

enu is locked.

Displaying the Edit User Menu Screen

You edit the U
ser m

enu on the Edit U
ser M

enu 
screen.

1 
Turn the M

EN
U

 knob to select U
ser >Edit U

ser 
M

enu, then press the knob.

The Edit U
ser M

enu screen appears.

Adding Items and Sub-Items

1 
Turn the M

EN
U

 knob to select Edit U
ser M

enu 
>Add Item

, then press the knob.
The item

s that can be added are displayed.

2 
Turn the M

EN
U

 knob to select an item
, then 

press the knob.
A screen for selecting sub-item

s to add 
appears.

3 
Turn the M

EN
U

 knob to select a sub-item
, then 

press the knob.
Place a check m

ark in the All checkbox to add 
all sub-item

s.
Place a check m

ark in the individual 
checkboxes to specify w

hich sub-item
s to add.

4 
Turn the M

EN
U

 knob to select [O
K], then press 

the knob.
The item

/sub-item
(s) are added.

[N
ote]

The sam
e item

 or sub-item
 cannot be registered tw

ice. Also, 
the nam

e of the item
 or sub-item

 cannot be changed.

Editing Sub-Items

You can specify the sub-item
s to display.

1 
D

isplay the Edit U
ser M

enu screen.

2 
Turn the M

EN
U

 knob to select an item
 to edit, 

then press the knob.
The edit function list appears.

3 
Turn the M

EN
U

 knob to select Edit Sub Item
 in 

the edit function list, then press the knob.

The Edit Sub Item
 screen appears.

All sub-item
s are checked w

hen the screen is 
first opened (function to display all sub-item

s).
Rem

ove the check m
arks for the sub-item

s you 
do not w

ant to display in the U
ser m

enu.

4 
Turn the M

EN
U

 knob to select [O
K], then press 

the knob.
Editing is com

pleted.

Deleting Items

1 
D

isplay the Edit U
ser M

enu screen.

2 
Turn the M

EN
U

 knob to select an item
 to edit, 

then press the knob.
The edit function list appears.

3 
Turn the M

EN
U

 knob to select D
elete in the 

edit function list, then press the knob.

The item
 is deleted.

Moving Items

1 
D

isplay the Edit U
ser M

enu screen.

2 
Turn the M

EN
U

 knob to select an item
 to 

m
ove, then press the knob.

The edit function list appears.

3 
Turn the M

EN
U

 knob to select M
ove in the edit 

function list, then press the knob.

The item
 to m

ove is highlighted, and a triangle 
m

ark and line indicate the destination position.

Triangle m
ark and line indicating m

ove 
destination

Editing the U
ser M

enu
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4 
Turn the M

EN
U

 knob to m
ove the triangle and 

line to the desired destination, then press the 
knob.
The item

 is m
oved.

Restoring the User Menu to Factory 
Default State

1 
Turn the M

EN
U

 knob to select Edit U
ser M

enu 
>Custom

ize Reset, then press the knob.
The Custom

ize Reset screen appears.

2 
Turn the M

EN
U

 knob to select [Reset], then 
press the knob.
A confirm

ation screen appears.

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
The U

ser m
enu is restored to the factory 

default state.
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User Menu (Factory Default Configuration)

The U
ser m

enu consists of the follow
ing item

s w
hen it is in the factory default state.

ˎˎ Form
at M

edia (page 91)
ˎˎ Rec Function (page 92)
ˎˎ Input/O

utput (page 91)
ˎˎ Clip (page 97)
ˎˎ Assignable Sw

itch
 1) (page 93)

ˎˎ Cam
era Config

 2) (page 106)

1) Excluding sub-item
 0

2) Contains only U
ser M

enu O
nly as sub-item

For details about editing the U
ser m

enu, see “Editing the U
ser M

enu” (page 88).

Operation Menu

D
efault values are show

n in bold.

O
peration >Form

at
Sets the system

 frequency, recording m
ode, recording form

at, and recording aspect ratio.

Item
Setting

D
escription

Frequency
59.94/50/29.97/25/23.98

Selects the system
 frequency (execute by 

selecting Execute).
File System

exFAT/U
D

F
Sw

itches the recording m
ode betw

een exFAT and 
U

D
F (execute by selecting Execute)

O
peration >Form

at
Sets the system

 frequency, recording m
ode, recording form

at, and recording aspect ratio.

Item
Setting

D
escription

Rec Form
at

Settings vary according to the 
system

 frequency setting.
Selects the recording form

at (execute by selecting 
Execute).

XAVC-I 1920×1080P
XAVC-I 1920×1080i
XAVC-I 1280×720P
XAVC-L 50 1920×1080P
XAVC-L 50 1920×1080i
XAVC-L 50 1280×720P
XAVC-L 35 1080P
XAVC-L 35 1080i
XAVC-L 25 1080i
H

D
422 50 1080i

H
D

422 50 720P
H

Q
 1920×1080i

H
Q

 1440×1080i
H

Q
 1280×720P

M
PEG

 IM
X 50

D
VCAM

W
hen the file system

 is exFAT and the system
 

frequency is 59.94 or 50.

XAVC-I 1920×1080P
XAVC-L 50 1920×1080P
XAVC-L 35 1080P
H

D
422 50 1080P

H
D

422 50 720P
H

Q
 1920×1080P

W
hen the file system

 is exFAT and the system
 

frequency is 29.97, 25, or 23.98.

H
D

422 50 1080i
H

D
422 50 720P

H
Q

 1920×1080i
H

Q
 1440×1080i

H
Q

 1280×720P
M

PEG
 IM

X 50
D

VCAM

W
hen the file system

 is U
D

F and the system
 

frequency is 59.94 or 50.

H
D

422 50 1080P
H

D
422 50 720P

H
Q

 1920×1080P

W
hen the file system

 is U
D

F and the system
 

frequency is 29.97, 25, or 23.98.

Aspect Ratio (SD
)

16:9/4:3
Selects the SD

 m
ode aspect ratio.

Audio Length
24bit/16bit

Selects the audio bit rate for recording in IM
X 

form
at.

M
enu List
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O
peration >Form

at M
edia

Form
ats the m

edia.

Item
Setting

D
escription

M
edia (A)

Execute/Cancel
Initializes the SxS m

em
ory card in slot A (execute 

by selecting Execute).
M

edia (B)
Execute/Cancel

Initializes the SxS m
em

ory card in slot B (execute 
by selecting Execute).

SD
 Card(U

tility)
Execute/Cancel

Initializes the SD
 card in the U

TILITY SD
 card slot 

(execute by selecting Execute).
SD

 Card(Proxy)
Execute/Cancel

Initializes the SD
 card in the PRO

XY SD
 card slot 

(execute by selecting Execute).

O
peration >Input/O

utput
Sets input/output signals.

Item
Setting

D
escription

O
utput Form

at
Settings vary according to the 
system

 frequency setting.
Selects the output form

at (execute by selecting 
Execute).
Settings vary according to the recording form

at 
setting (page 35).

Source Select
Cam

era/External
Selects the cam

era picture (Cam
era) or SD

I IN
 

connector input signal for the video input source.
SD

I O
ut1 O

utput
O

n/O
ff

Turns the output signal from
 the SD

I O
U

T1 
connector on/off.

SD
I O

ut2 O
utput

O
n/O

ff
Turns the output signal from

 the SD
I O

U
T2 

connector on/off.
H

D
M

I O
utput

O
n/O

ff
Turns the output signal from

 the H
D

M
I connector 

on/off.
SD

I O
ut2/H

D
M

I Super
O

ff/O
n

Turns character inform
ation (superim

posed) from
 

the SD
I O

U
T2 and H

D
M

I connectors on/off.
Video O

ut Super
O

ff/O
n

Turns character inform
ation (superim

posed) from
 

the VID
EO

 O
U

T connector on/off.
D

ow
n Converter

Edge Crop/Letter Box/Squeeze
Selects the signal conversion m

ode for output of 
SD

 signals.
Edge Crop: Crops the edges of the 16:9 picture for 

output as a 4:3 picture.
Letter Box: M

asks the top and bottom
 of the 4:3 

picture and displays a 16:9 picture in the 
center of the screen.

Squeeze: Squeezes the 16:9 picture horizontally 
for output as a 4:3 picture.

O
peration >Input/O

utput
Sets input/output signals.

Item
Setting

D
escription

W
ide ID

Through/Auto
Selects w

hether to add a w
ide ID

 signal to the SD
 

output signal.
Through: O

utputs w
ithout adding a w

ide ID
 

signal.
Auto: Adds and outputs a w

ide ID
 signal to the 

video signal w
hen the w

ide ID
 signal is set to 

Squeeze.
W

ide M
ode(Ext)

Auto/16:9
W

hen the input signal is SD
, sets the m

ethod that 
determ

ines w
ide screen inform

ation.
Auto: Records w

ith 16:9 aspect ratio w
hen the 

w
ide screen inform

ation of the input signal is 
Squeeze. O

therw
ise, records w

ith 4:3 aspect 
ratio.

16:9: Records w
ith 16:9 aspect ratio.

O
peration >Super Im

pose
Sets character inform

ation/m
arkers to be superim

posed.

Item
Setting

D
escription

Super(VF D
isplay)

O
n/O

ff
W

hen Input/O
utput >SD

I O
ut2/H

D
M

I Super or 
Input/O

utput >Video O
ut Super is set to O

n, this 
turns superim

position of character inform
ation on 

the output from
 the SD

I O
U

T connector or VID
EO

 
O

U
T connector, respectively.

Super(M
enu)

O
n/O

ff

Super(M
arker)

O
n/O

ff
W

hen Input/O
utput >SD

I O
ut2/H

D
M

I Super or 
Input/O

utput >Video O
ut Super is set to O

n, this 
turns superim

position of m
arkers on the output 

from
 the SD

I O
U

T connector or VID
EO

 O
U

T 
connector on/off, respectively.

O
peration >LCD

Sets the LCD
 m

onitor.

Item
Setting

D
escription

LCD
 Color

–99 to ±0 to +99
Adjusts the color depth of the LCD

 m
onitor.

LCD
 M

arker&Zebra
O

n/O
ff

Turns the m
arker and zebra pattern display on the 

LCD
 m

onitor on/off.
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O
peration >Rec Function

Sets the special recording m
ode.

Item
Setting

D
escription

Slow
 & Q

uick M
otion

O
n/O

ff
Turns Slow

 & Q
uick M

otion on/off. (W
hen set to 

O
n, the settings for other special recording m

odes 
are set to O

ff.)
Fram

e Rate
Settings vary according to the 
recording form

at setting.
W

hen Slow
 & Q

uick M
otion is O

n, selects the 
fram

e rate for Slow
 & Q

uick M
otion shooting.

1 to 60
W

hen the recording m
ode is exFAT, and the 

recording form
at is XAVC Intra or XAVC Long.

1 to 50
W

hen the recording m
ode is U

D
F, and the 

recording form
at is M

PEG
2 H

D
 422 50M

 
(1280×720), 50P/25P.

1 to 30 
W

hen the recording m
ode is exFAT or U

D
F, and 

the recording form
at is M

PEG
2 H

D
 422 50M

 
(1920×1080), 29.97P/23.98P.

1 to 25
W

hen the recording m
ode is exFAT or U

D
F, and 

the recording form
at is M

PEG
2 H

D
 422 50M

 
(1920×1080), 25P.

Clip Continuous Rec
O

n/O
ff

Turns Clip Continuous Rec m
ode on/off. (W

hen 
set to O

n, the settings for other special recording 
m

odes are set to O
ff.)

Picture Cache Rec
O

n/O
ff

Turns picture cache recording m
ode on/off. 

(W
hen set to O

n, the settings for other special 
recording m

odes are set to O
ff.)

Cache Rec Tim
e

Settings vary according to the 
recording form

at setting.
Sets the picture cache recording tim

e, w
hen 

Picture Cache Rec is set to O
n.

0 to 2/2 to 4sec
W

hen the recording form
at is XAVC-I 1920×1080P 

(system
 frequency is 59.94/50)

0 to 2/2 to 4/4 to 6/6 to 8sec
W

hen the recording form
at is XAVC-I 1920×1080P 

(system
 frequency is 29.97/25/23.98), XAVC-I 

1920×1080i, or XAVC-I 1280×720P
0 to 2/2 to 4/4 to 6/6 to 8/
8 to 10/10 to 12/12 to 14/
13 to 15sec

W
hen the recording form

at is XAVC-L, M
PEG

2 H
D

 
422, M

PEG
2 H

D
 420, or M

PEG
 IM

X 50.

Interval Rec
O

n/O
ff

Turns Interval Rec m
ode on/off. (W

hen set to O
n, 

the settings for other special recording m
odes are 

set to O
ff.)

O
peration >Rec Function

Sets the special recording m
ode.

Item
Setting

D
escription

N
um

ber of Fram
es

The available settings vary 
depending on the Form

at 
>Frequency setting.

W
hen Interval Rec is set to O

n, this sets the 
num

ber of fram
es to shoot in one Interval Rec 

take.
2fram

es/6fram
es/12fram

es
W

hen the recording form
at fram

e rate is 50P or 
59.94P.

1fram
e/3fram

es/6fram
es/ 

9fram
es

W
hen the recording form

at fram
e rate is 23.98P, 

25P, 29.97P, 50i, or 59.94i.
Interval Tim

e
1/2/3/4/5/6/7/8/9/10/15/20/30/
40/50 (sec) 
1/2/3/4/5/6/7/8/9/10/15/20/30/
40/50/ (m

in) 
1/2/3/4/6/12/24 (hour)

W
hen Interval Rec is set to O

n, this sets the 
interval for Interval Rec shooting.

Pre-Lighting
O

ff/2sec/5sec/10sec
Sets the num

ber of seconds that the video light is 
turned on prior to the start of Interval Rec 
shooting. To not turn the video light on, select 
O

ff.
Sim

ul Rec
O

n/O
ff

Turns sim
ultaneous recording to slots A and B on/

off.

O
peration >Proxy Recording M

ode
Sets proxy recording.

Item
Setting

D
escription

Setting
O

n/O
ff

Turns proxy recording on/off.

Size
H

D
 Auto(9M

bps)/
H

D
 Auto(6M

bps)/
1280×720(9M

bps)/ 
1280×720(6M

bps)/ 
640×360(3M

bps)/ 
480×270(1M

bps)/ 
480×270(0.5M

bps)

Selects the size of the proxy recording form
at.

Fram
e Rate

23.98fps/25fps/29.97fps/50fps/ 
59.94fps

Selects the fram
e rate of the proxy recording 

form
at.

Bit Rate
9M

bps/6M
bps/3M

bps/1M
bps/ 

0.5M
bps

Selects the bit rate of the proxy recording form
at.

Audio Channel
CH

1/CH
2/CH

3/CH
4

Selects the audio channel to record to proxy data.
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O
peration >Assignable Sw

itch
Assigns functions to assignable sw

itches.

For details about assigning functions, see “Assigning Functions to Assignable Sw
itches” (page 114).

Item
Setting

D
escription

<0>
114

Assigns a function to the ASSIG
N

. 0 sw
itch.

<1>
115

Assigns a function to the ASSIG
N

. 1 sw
itch.

<2>
114

Assigns a function to the ASSIG
N

. 2 sw
itch.

<3>
115

Assigns a function to the ASSIG
N

. 3 sw
itch.

<4>
115

Assigns a function to the ASSIG
N

ABLE 4 sw
itch.

<5>
115

Assigns a function to the ASSIG
N

ABLE 5 sw
itch.

Lens RET
116

Assigns a function to RET button on the lens.

O
nline

115
Assigns a function to the O

N
LIN

E button.

Zoom
 Speed

0 to 20 to 99
W

hen Zoom
 has been assigned to the 

ASSIG
N

ABLE 4 or 5 sw
itch, this sets the zoom

 
speed.

O
peration >VF Setting

Sets the view
finder screen.

Item
Setting

D
escription

Color
–99 to ±0 to +99

Adjusts the color depth of the view
finder im

age.

Color M
ode

Color/B&W
Selects the view

finder display m
ode (w

hen using 
CBK-VF02).
Color: Color
B&W

: Black & w
hite

Peaking Type
N

orm
al/Color

Selects the type of peaking (w
hen using CBK-

VF02).
N

orm
al: N

orm
al peaking

Color: Color peaking
Peaking Frequency

N
orm

al/H
igh

W
hen Peaking Type is set to N

orm
al, this selects 

N
orm

al or H
igh peaking frequency (w

hen using 
CBK-VF02).

Peaking Color
B&W

/Red/Yellow
/Blue

Selects the peaking color w
hen Peaking Type is 

set to Color (w
hen using CBK-VF02).

B&W
: Black & w

hite
Red: Red
Yellow

: Yellow
Blue: Blue

VF D
etail Level

–99 to ±0 to +99
Sets the detail level (set on the cam

corder) of the 
view

finder (w
hen using H

D
VF-20A).

O
peration >M

arker
Sets the m

arker display in the view
finder.

Item
Setting

D
escription

Setting
O

n/O
ff

Turns the display of all m
arkers on/off.

[N
ote]

W
hen M

arker is assigned to the ASSIG
N

. 2 sw
itch, this 

setting is disabled.

Color
W

hite/Yellow
/Cyan/G

reen/
M

agenta/Red/Blue
Selects the m

arker display color.

Center M
arker

1/2/3/4/O
ff

W
hen the center m

arker is displayed, selects the 
type. Select O

ff if you do not w
ant to display the 

m
arker.

Safety Zone
O

n/O
ff

Turns the safety zone indicator on/off.

Safety Area
80%

/90%
/92.5%

/95%
Selects the safety zone range.

Aspect M
arker

Line/M
ask/O

ff
W

hen an aspect m
arker is to be displayed, selects 

the display m
ethod. Select O

ff if you do not w
ant 

to display the m
arker.

Line: Show
 as w

hite lines.
M

ask: D
isplays a low

er video signal level for areas 
outside the m

arker area.
Aspect Select

15:9/14:9/13:9/4:3/1.66:1/ 
1.85:1/2.35:1/2.4:1

Selects the aspect ratio of the m
arker.

Aspect M
ask

0%
 to 12%

 to 15%
W

hen the Aspect M
arker setting is M

ask, this sets 
the video signal level of areas outside the m

arker 
area as a percentage value relative to the video 
signal level of areas inside the m

arker area.
Aspect Safety Zone

O
n/O

ff
Turns the aspect safety zone m

arker on/off.

Aspect Safety Area
80%

/90%
/92.5%

/95%
Selects the size of the aspect safety zone m

arker 
(as a percentage of total screen size).

100%
 M

arker
O

n/O
ff

Turns the 100%
 safety zone m

arker indicator on/
off.

U
ser Box

O
n/O

ff
Turns the box cursor display on/off.

U
ser Box W

idth
40 to 500 to 999

Sets the box cursor w
idth (distance from

 the 
center to the left and right edges).

U
ser Box H

eight
70 to 500 to 999

Sets the box cursor height (distance from
 the 

center to the top and bottom
 edges).

U
ser Box H

 Position
–479 to 0 to 479

Sets the horizontal position of the box cursor 
center.

U
ser Box V Position

–464 to 0 to 464
Sets the vertical position of the box cursor center.
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O
peration >G

ain Sw
itch

Sets the gain value sw
itch settings.

Item
Setting

D
escription

G
ain<L>

–3dB/0dB/3dB/6dB/9dB/12dB/1
8dB/24dB/30dB/36dB/42dB

Selects the gain value for the L position of the 
G

AIN
 sw

itch.
G

ain<M
>

–3dB/0dB/3dB/6dB/9dB/12dB/1
8dB/24dB/30dB/36dB/42dB

Selects the gain value for the M
 position of the 

G
AIN

 sw
itch.

G
ain<H

>
–3dB/0dB/3dB/6dB/ 
9dB/12dB/18dB/24dB/30dB/ 
36dB/42dB

Selects the gain value for the H
 position of the 

G
AIN

 sw
itch.

G
ain <Turbo>

–3dB/0dB/3dB/6dB/ 
9dB/12dB/8dB/24dB/30dB/36dB/
42dB

Selects the gain value w
hen the Turbo G

ain 
function is assigned to an assignable sw

itch.

Shockless G
ain

O
n/O

ff
Turns shockless gain (function that sw

itches the 
gain sm

oothly w
hen the gain is sw

itched) on/off.

O
peration >Auto Iris

Sets the auto iris.

Item
Setting

D
escription

Iris O
verride

O
n/O

ff
Turns iris override (setting opens or closes the iris 
m

ore than norm
al) on/off.

M
ode

Backlight/Standard/Spotlight
Selects the control m

ode of the auto iris.
Backlight: Backlight m

ode (m
ode for reduced 

darkening of a subject w
hen the subject is 

backlit)
Standard: Standard m

ode (cannot be selected 
w

hen using optional rem
ote control 

connection)
Spotlight: Spotlight m

ode (m
ode for reduced 

blow
n out highlights w

hen subject is lit by 
spotlighting)

Level
–99 to ±0 to +99

Sets the convergence target level (larger values 
increase brightness.)

Speed
–99 to ±0 to +99

Sets the control speed (speed of response to 
changes in the video). (Larger values specify 
quicker reaction tim

es.)
Clip H

igh light
O

n/O
ff

Turns the function that ignores brightest areas to 
provide a flatter reaction to high lum

inance on/
off.

D
etect W

indow
1/2/3/4/5/6/Var

Selects the type of auto iris detection w
indow

.
Var: Variable

D
etect W

indow
 

Indication
O

n/O
ff

Turns the function that displays the auto iris 
detection w

indow
 fram

e using a m
arker on/off.

O
peration >Auto Iris

Sets the auto iris.

Item
Setting

D
escription

Iris APL Ratio
–99 to ±0 to +99

If the M
ode setting for Auto Iris is set to Standard, 

sets the m
ix ratio of peak to m

ean auto iris 
detection value.

Iris Var W
idth

40 to 500 to 999
Sets the w

idth of the w
indow

 w
hen Iris W

indow
 is 

set to Var.
Iris Var H

eight
70 to 500 to 999

Sets the height of the w
indow

 w
hen Iris W

indow
 

is set to Var.
Iris Var H

 Position
–479 to 0 to 479

Sets the horizontal position of the w
indow

 w
hen 

Iris W
indow

 is set to Var.
Iris Var V Position

–464 to 0 to 464
Sets the vertical position of the w

indow
 w

hen Iris 
W

indow
 is set to Var.

O
peration >Zebra

Sets the display of zebra patterns.

Item
Setting

D
escription

Zebra Select
1/2/Both

Selects the zebra pattern type (Zebra 1, Zebra 2, 
Both).

Zebra1 Level
50%

 to 70%
 to 107%

Sets the Zebra 1 display level.

Zebra1 Aperture Level
1 to 10%

 to 20%
Sets the Zebra 1 aperture level.

Zebra2 Level
52%

 to 100%
 to 109%

Sets the Zebra 2 display level.

O
peration >D

isplay O
n/O

ff
Selects the item

s to display in the view
finder.

Item
Setting

D
escription

Video Level W
arning

O
n/O

ff
Turns the w

arnings that appear w
hen the video 

level is too bright or too dark on/off.
Shutter Setting

O
n/O

ff
Turns the shutter m

ode and shutter speed 
indicators on/off.

N
D

 Filter Position
O

n/O
ff

Turns the N
D

 filter setting indicator on/off.

G
ain Setting

O
n/O

ff
Turns the gain setting indicator on/off.

Rec/Play Status
O

n/O
ff

Turns the recording and playback indicators on/
off.

Color Tem
p.

O
n/O

ff
Turns the color tem

perature indicator on/off.

Fram
e Rate/Interval

O
n/O

ff
Turns the special recording m

ode indicator on/
off.
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O
peration >D

isplay O
n/O

ff
Selects the item

s to display in the view
finder.

Item
Setting

D
escription

Battery Rem
ain

Auto/Voltage/O
ff

Sets the m
ode of the rem

aining battery capacity 
and input voltage indicators.
Auto: D

isplays the rem
aining capacity, according 

to the battery type.
Voltage: D

isplays the input voltage, regardless of 
the battery type.

O
ff: N

o display.
Tim

ecode
O

n/O
ff

Turns the display of tim
e data (tim

ecode, user bits, 
counter, duration) on/off.

Audio Level M
eter

O
n/O

ff
Turns the display of the audio level m

eter on/off.

M
edia Status

O
n/O

ff
Turns the m

edia status indicator on/off.

SD
 Card(U

tility) 
O

n/O
ff

Turns the SD
 card (U

tility) indicator on/off.

Focus Position
M

eter/Feet/O
ff

Turns the lens focus position indicator on/off and 
selects the display units.

Iris Position
O

n/O
ff

Turns the lens iris position indicator on/off.

Zoom
 Position

O
n/O

ff
Turns the lens zoom

 position indicator on/off.

Extender
O

n/O
ff

Turns the lens and digital extender indicator on/
off.

ALAC
O

n/O
ff

Turns the lens aberration correction indicator on/
off.

AE M
ode

O
n/O

ff
Turns AE m

ode and the AE level setting indicator 
on/off.

Focus M
ode

O
n/O

ff
Turns the focus m

ode indicator on/off.

W
hite Balance M

ode
O

n/O
ff

Turns the w
hite balance m

ode indicator on/off.

CC5600K
O

n/O
ff

Turns the CC5600K indicator on/off.

Rec Form
at

O
n/O

ff
Turns the recording form

at indicator on/off.

G
am

m
a

O
n/O

ff
Turns the selected gam

m
a type indicator on/off.

Tim
ecode Lock

O
n/O

ff
Turns the tim

ecode indicator on/off.

N
etw

ork Condition
O

n/O
ff

Turns the netw
ork connection status indicator on/

off.
Proxy Status

O
n/O

ff
Turns the proxy status indicator on/off.

N
W

 Client M
ode Status

O
n/O

ff
Turns the netw

ork client m
ode indicator on/off.

Stream
ing Status

O
n/O

ff
Turns stream

ing transm
ission on/off.

G
PS

O
n/O

ff
Turns the G

PS reception status indicator on/off.

O
peration >D

isplay O
n/O

ff
Selects the item

s to display in the view
finder.

Item
Setting

D
escription

Video Signal M
onitor

O
ff/W

aveform
/Vector/H

istogram
Selects w

hether to display the video signal, and 
the type of video signal to display.

[N
ote]

N
ot displayed in the follow

ing circum
stances.

W
hen O

peration >Input/O
utput >SD

I O
ut1 Select and 

SD
I O

ut2 Select in the setup m
enu are both set to O

ff. 
W

hen O
peration >Input/O

utput >O
utput Form

at in the 
setup m

enu is set to 720×480P or 720×576P.

Clip N
am

e
O

n/O
ff

Turns the clip nam
e display on/off.

Focus Assist Indicator
O

n/O
ff

Turns the focus assist indicator on/off.

Focus Area M
arker

O
n/O

ff
Turns the focus area m

arker indicator on/off.

Lens Info
M

eter/Feet/O
ff

Selects w
hether to display depth of field and the 

units to display.
W

RR RF Level
O

n/O
ff

Turns the w
ireless tuner reception status indicator 

on/off.
Clip N

um
ber

O
n/O

ff
Turns the clip inform

ation display on/off.

O
peration >"!"LED

Sets the “!” indicator in the view
finder. (Enabled w

hen using H
D

VF-20A).

Item
Setting

D
escription

G
ain <!>

O
n/O

ff
Turns the function to light the ! indicator on/off 
w

hen the gain is set to other than 0 dB.
Shutter <!>

O
n/O

ff
Turns the function to light the ! indicator on/off 
w

hen the SH
U

TTER sw
itch is set to O

N
.

W
hite Preset <!>

O
n/O

ff
Turns the function to light the ! indicator on/off 
w

hen the W
H

ITE BAL sw
itch is set to PRST.

ATW
 Run <!>

O
n/O

ff
Turns the function to light the ! indicator on/off 
w

hen ATW
 is used.

Extender <!>
O

n/O
ff

Turns the function to light the ! indicator on/off 
w

hen the digital extender function or lens 
extender is used.

Filter <!>
O

n/O
ff

Turns the function to light the ! indicator on/off 
w

hen the N
D

 filter is set to other than 1.
Iris O

verride <!>
O

n/O
ff

Turns the function to light the ! indicator on/off 
w

hen the auto iris override is not set to Standard.
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O
peration >W

hite Setting
M

akes settings related to w
hite balance adjustm

ent.

Item
Setting

D
escription

W
hite Sw

itch<B>
M

em
ory/ATW

Sets the operating m
ode selected by the B 

position of the W
H

ITE BAL sw
itch.

M
em

ory: Auto w
hite balance

ATW
: Auto tracing w

hite balance
Shockless W

hite
O

ff/1/2/3
Selects the transition tim

e w
hen the W

H
ITE BAL 

sw
itch setting is changed (1 is fastest).

ATW
 Speed

1/2/3/4/5
Selects the ATW

 (auto tracing w
hite) transition 

speed (1 is fastest).
AW

B Fixed Area
O

n/O
ff

Runs AW
B (auto w

hite balance) for the center of 
the screen.

Filter W
hite M

em
ory

O
n/O

ff
Sets the w

hite balance m
em

ory area for each 
FILTER knob position num

ber w
hen W

hite 
Balance is set to Preset or ATW

.
 ˎW

hen Electrical CC is assigned to an assignable 
sw

itch, this sets independent w
hite balance 

m
em

ory areas for Electrical CC A, B, C, and D
 

settings.
 ˎW

hen Electrical CC is not assigned to an 
assignable sw

itch, this sets w
hite balance 

m
em

ory areas for each FILTER knob position 
num

ber.

O
peration >O

ffset W
hite

M
akes settings related to w

hite balance offset values.

Item
Setting

D
escription

O
ffset W

hite<A>
O

n/O
ff

Selects w
hether to add (O

n) or not to add (O
ff) an 

offset value to the w
hite balance in m

em
ory A.

W
arm

 Cool <A>
Approxim

ate color tem
perature 

display
(Approx. 1600K to 3200K to 
16000K)

W
hen O

ffset W
hite<A> is set to O

n, this specifies 
the offset (as a color tem

perature) to add to the 
w

hite balance in m
em

ory A. (N
ote that the error 

increases for higher offset color tem
peratures. 

Adjust w
hile view

ing the actual im
age.)

W
arm

 Cool 
Balance<A>

–99 to ±0 to +99
Specifies a m

ore precise color tem
perature, for 

use w
hen a satisfactory im

age cannot be 
obtained w

ith the W
arm

 Cool <A> setting.
O

ffset W
hite <B>

O
n/O

ff
W

hen this is set to O
n, the offset adjusted here is 

added to the w
hite balance of channel B.

O
peration >O

ffset W
hite

M
akes settings related to w

hite balance offset values.

Item
Setting

D
escription

W
arm

 Cool <B>
Approxim

ate color tem
perature 

display
(Approx. 1600K to 3200K to 
16000K)

W
hen O

ffset W
hite<B> is set to O

n, this specifies 
the offset (as a color tem

perature) to add to the 
w

hite balance in m
em

ory A. (N
ote that the error 

increases for higher offset color tem
peratures. 

Adjust w
hile view

ing the actual im
age.)

W
arm

 Cool 
Balance<B>

–99 to ±0 to +99
Specifies a m

ore precise color tem
perature, for 

use w
hen a satisfactory im

age cannot be 
obtained w

ith the W
arm

 Cool <B> setting.

O
peration >Shutter

Sets the shutter operating m
ode.

Item
Setting

D
escription

M
ode

Speed/Angle
Selects the operating m

ode of the electronic 
shutter.
Speed: Sets the shutter speed as a tim

e (units: 
seconds).

Angle: Sets the shutter speed as an angle (units: 
degrees).

O
peration >Slow

 Shutter
Sets the slow

 shutter.

Item
Setting

D
escription

Setting
O

n/O
ff

Turns the slow
 shutter function on/off.

N
um

ber of Fram
es

2/3/4/5/6/7/8/16
Sets the num

ber of accum
ulated fram

es for the 
slow

 shutter function.

O
peration >Tim

e Zone
Sets the tim

e zone.

Item
Setting

D
escription

Tim
e Zone

U
TC +14:00 to U

TC G
reenw

ich 
to U

TC –12:00 Kw
ajalein

Selects the difference in tim
e from

 U
TC 

(G
reenw

ich M
ean Tim

e) in units of 30 m
inutes.
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O
peration >Clip

M
akes settings relating to clip nam

es and m
anagem

ent.

 
[N

ote]
D

o not assign clip nam
es that begin w

ith the “.” (period) sym
bol. Clips w

ith nam
es in w

hich the first character is “.” 
cannot be view

ed in the application softw
are on a com

puter.

Item
Setting

D
escription

Clip N
am

ing
Title/Plan

Selects the clip nam
ing form

at.
Title: N

am
e specified by Title Prefix.

Plan: N
am

e specified in planning m
etadata (if no 

nam
e is specified in planning m

etadata, the 
nam

e specified by Title Prefix is used.)
Title Prefix

Text input
Sets the title part (4 to 46 alphanum

eric 
characters) of clip titles using a character string 
entry screen (page 86).

N
um

ber Set
Settings vary according to the 
Clip N

am
ing setting.

Sets the num
eric portion of the clip nam

e.
W

hen Clip N
am

ing is set to Title: 
0001 to 9999

W
hen Clip N

am
ing is set to Plan and a planning 

m
etadata file is loaded: 

00001 to 99999

O
peration >U

pdate M
edia

U
pdates the m

edia’s m
anagem

ent file.

Item
Setting

D
escription

M
edia (A)

Execute/Cancel
U

pdates the m
anagem

ent inform
ation of the SxS 

m
em

ory card in slot A (execute by selecting 
Execute).

M
edia (B)

Execute/Cancel
U

pdates the m
anagem

ent inform
ation of the SxS 

m
em

ory card in slot B (execute by selecting 
Execute).

O
peration >G

PS
Turns location inform

ation (G
PS) on/off.

Item
Setting

D
escription

G
PS

O
n/O

ff
Turns the G

PS function on/off.

O
peration >Planning M

etadata
M

akes settings relating to planning m
etadata operations.

Item
Setting

D
escription

Load M
edia (A)

Execute/Cancel
Loads planning m

etadata from
 the SxS m

em
ory 

card in slot A.
Execute to display a list of planning m

etadata files 
stored on the SxS m

em
ory card in slot A. Select a 

file to display the properties screen.

O
peration >Planning M

etadata
M

akes settings relating to planning m
etadata operations.

Item
Setting

D
escription

Load M
edia (B)

Execute/Cancel
Loads planning m

etadata from
 the SxS m

em
ory 

card in slot B.
Execute to display a list of planning m

etadata files 
stored on the SxS m

em
ory card in slot B. Select a 

file to display the properties screen.
Properties

Execute/Cancel
D

isplays the planning m
etadata content loaded in 

the cam
corder (execute by selecting Execute).

Clear M
em

ory
Execute/Cancel

Clears the planning m
etadata loaded in the 

cam
corder (execute by selecting Execute).

Clip N
am

e D
isp

Title1(ASCII)/Title2(U
TF-8)

Selects the display form
at if the clip nam

e is 
specified in planning m

etadata (page 55).

O
peration >U

SB
M

akes settings related to copying clips from
 the recording m

edia inserted in an SxS card slot of the cam
corder to U

SB 
m

edia.

Item
Setting

D
escription

Select Folder
Selects a folder on the U

SB m
edia.

Creates a new
 folder on the U

SB m
edia.

View
 Clip List

D
isplays a list of clips on the U

SB m
edia.

Renam
e Folder

Renam
es a folder on the U

SB m
edia.

Error Check
O

n/O
ff

Selects w
hether to perform

 error checking w
hen 

copying clips from
 the recording m

edia inserted 
in an SxS card slot of the cam

corder to U
SB m

edia.
Form

at U
SB

Execute/Cancel
Form

ats the U
SB m

edia (execute by selecting 
Execute).

Copy to U
SB

M
edia(A) to U

SB/
M

edia(B) to U
SB/

M
edia(A)(B) to U

SB

Selects the target slot w
hen copying all clips from

 
an SxS card slot.
M

edia(A) to U
SB: Copies all clips from

 the 
recording m

edia inserted in slot A.
M

edia(B) to U
SB: Copies all clips from

 the 
recording m

edia inserted in slot B.
M

edia(A)(B) to U
SB: Copies all clips from

 the 
recording m

edia inserted in slot A and slot B.
M

edia Rem
ain

(Free space: num
eric display and 

bar display)
D

isplays the rem
aining free space on the U

SB 
m

edia.
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O
peration >Flash Band Reduce

Corrects the flashband phenom
ena.

[N
ote]

This item
 is disabled (grayed out) during recording and w

hen Slow
&Q

uick is set to O
n.

Item
Setting

D
escription

Setting
O

n/O
ff

Turns the flashband reduction function on/off.

[N
otes]
ˎˎ M

om
entary noise m

ay occur due to discontinuous 
video and audio w

hen sw
itching Flash Band Reduce 

on/off.
ˎˎ The setting returns to the default value w

hen pow
er 

is sw
itched off.

Paint Menu

D
efault values are show

n in bold.

Paint >Sw
itch Status

Turns various correction functions and the test signal on/off.

Item
Setting

D
escription

G
am

m
a

O
n/O

ff
Turns the gam

m
a function on/off.

Black G
am

m
a

O
n/O

ff
Turns the black gam

m
a function on/off.

M
atrix

O
n/O

ff
Turns the m

atrix function on/off.

Knee
O

n/O
ff

Turns the knee function on/off.

W
hite Clip

O
n/O

ff
Turns the w

hite clip function on/off.

[N
ote]

If set to O
ff, it is reset to O

n w
hen pow

er is next turned 
on.

D
etail

O
n/O

ff
Turns the detail function on/off.

Aperture
O

n/O
ff

Turns the aperture function on/off.

Flare
O

n/O
ff

Turns the flare correction function on/off.

Test Saw
O

n/O
ff

Turns the test signal on/off.

Paint >W
hite

Sets the color tem
perature, and adjusts w

hite balance m
anually.

Item
Setting

D
escription

Color Tem
p <A>

1500K to 3200K to 50000K
D

isplays the w
hite balance color tem

perature 
saved in m

em
ory A.

Color Tem
p Balance 

<A>
–99 to ±0 to +99

Sets the w
hite balance gain value saved in 

m
em

ory A (linked to R gain and B gain).
R G

ain<A>
–99 to ±0 to +99

Sets the w
hite balance R gain value saved in 

m
em

ory A.
B G

ain<A>
–99 to ±0 to +99

Sets the w
hite balance B gain value saved in 

m
em

ory A.
Color Tem

p <B>
1500K to 3200K to 50000K

D
isplays the w

hite balance color tem
perature 

saved in m
em

ory B.
Color Tem

p Balance 
<B>

–99 to ±0 to +99
Sets the w

hite balance gain values saved in 
m

em
ory B (linked R gain and B gain).

R G
ain <B>

–99 to ±0 to +99
Sets the w

hite balance R gain value saved in 
m

em
ory B.

B G
ain <B>

–99 to ±0 to +99
Sets the w

hite balance B gain value saved in 
m

em
ory B.
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Paint >Black
Sets the black level (im

age level w
ithout lighting).

You can achieve a desired look by adjusting the black level for deeper or shallow
er blacks.

Item
Setting

D
escription

M
aster Black

–99 to ±0 to +99
Sets the m

aster black level.

R Black
–99 to ±0 to +99

Sets the R black level.

B Black
–99 to ±0 to +99

Sets the B black level.

Paint >Flare
M

akes settings related to flare correction.
Flare is a phenom

enon w
here the video level increases across the entire im

age due to the effects of bright 
regions in the im

age, increasing the brightness of darker regions and reducing contrast. It is caused by 
reflected light inside the lens.

Item
Setting

D
escription

Setting
O

n/O
ff

Turns the flare correction function on/off.

M
aster Flare

–99 to ±0 to +99
Sets the m

aster flare correction level.

R Flare
–99 to ±0 to +99

Sets the R flare correction level.

G
 Flare

–99 to ±0 to +99
Sets the G

 flare correction level.

B Flare
–99 to ±0 to +99

Sets the B flare correction level.

Paint >G
am

m
a

M
akes settings related to gam

m
a correction.

G
am

m
a correction allow

s you to adjust the contrast of the im
age to significantly alter the im

pression of an 
im

age.
Item

Setting
D

escription

Setting
O

n/O
ff

Turns the gam
m

a correction function on/off.

Step G
am

m
a

0.35 to 0.45 to 0.90
(0.05 steps)

Sets a gam
m

a correction value in 0.05 steps.

M
aster G

am
m

a
–99 to ±0 to +99

Sets the m
aster gam

m
a level.

R G
am

m
a

–99 to ±0 to +99
Sets the R gam

m
a level.

G
 G

am
m

a
–99 to ±0 to +99

Sets the G
 gam

m
a level.

B G
am

m
a

–99 to ±0 to +99
Sets the B gam

m
a level.

G
am

m
a Category

STD
/H

G
/U

ser
Selects the gam

m
a category.

STD
: Standard gam

m
a curve for video signals

H
G

: G
am

m
a curve that im

itates gradation and 
color reproduction of shooting w

ith film
U

ser: U
ser-defined gam

m
a curve created using 

CvpFileEditorTM
 V4.2

Paint >G
am

m
a

M
akes settings related to gam

m
a correction.

G
am

m
a correction allow

s you to adjust the contrast of the im
age to significantly alter the im

pression of an 
im

age.
Item

Setting
D

escription

G
am

m
a Select

Settings vary according to the 
G

am
m

a Category setting.
Selects the gam

m
a table used for gam

m
a 

correction.

W
hen G

am
m

a Category is STD
STD

1 D
VW

: D
VW

 cam
corder equivalent

STD
2 x4.5: ×4.5 gain

STD
3 x3.5: ×3.5 gain

STD
4 240M

: SM
PTE-240M

 equivalent
STD

5 R709: ITU
-R709 equivalent (default setting)

STD
6 x5.0: ×5.0 gain

W
hen G

am
m

a Category is H
G

H
G

1 3250G
36: Com

presses 325%
 video input to 

100%
 video output.

H
G

2 4600G
30: Com

presses 460%
 video input to 

100%
 video output.

H
G

3 3259G
40: Com

presses 325%
 video input to 

109%
 video output.

H
G

4 4609G
33: Com

presses 460%
 video input to 

109%
 video output (default setting).

W
hen G

am
m

a Category is U
ser

U
ser 1: G

am
m

a table registered in U
ser1 (default 

setting)
U

ser 2: G
am

m
a table registered in U

ser2
U

ser 3: G
am

m
a table registered in U

ser3
U

ser 4: G
am

m
a table registered in U

ser4
U

ser 5: G
am

m
a table registered in U

ser5

Paint >Black G
am

m
a

M
akes settings related to black gam

m
a correction.

Black gam
m

a correction allow
s you to reproduce gradations and colors in black or near-black (dark) parts 

of the picture.
Item

Setting
D

escription

Setting
O

n/O
ff

Turns the black gam
m

a correction function on/
off.

[N
ote]

To enable the black gam
m

a function, set Saturation 
M

ode to Low
 Key.
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Paint >Black G
am

m
a

M
akes settings related to black gam

m
a correction.

Black gam
m

a correction allow
s you to reproduce gradations and colors in black or near-black (dark) parts 

of the picture.
Item

Setting
D

escription

Range
Low

/L.M
id/H

.M
id

Selects the effective range of the black gam
m

a 
correction.
Low

: 0 to 3.6%
L.M

id: 0 to 7.2%
H

.M
id: 0 to 14.4%

M
aster Black G

am
m

a
–99 to ±0 to +99

Sets the m
aster black gam

m
a level.

Paint >Knee
M

akes settings related to knee correction.
Knee correction is processing that prevents blow

n out highlights by com
pressing the bright parts of the 

im
age in response to the upper lim

it for the dynam
ic range of the recorded/output im

age. The signal level 
w

here knee processing begins is called the “knee point,” and the slope of knee com
pression is called the 

“knee slope.”
Item

Setting
D

escription

Setting
O

n/O
ff

Turns the knee correction function on/off.

Point
75%

 to 95%
 to 109%

Sets the knee point w
hen the D

CC function is off.

Slope
–99 to ±0 to +99

Sets the knee slope w
hen the D

CC function is off.

Knee Saturation
O

n/O
ff

Turns the knee saturation function on/off.

[N
ote]

To enable the knee saturation function, set Saturation 
M

ode to Knee.

Knee Saturation Level
–99 to ±0 to +99

Sets the knee saturation level.

Paint >W
hite Clip

M
akes settings related to w

hite clip adjustm
ent.

W
hite clip processing lim

its the m
axim

um
 level of video output signals. The m

axim
um

 video output signal 
value is called the “w

hite clip level.”
Item

Setting
D

escription

Setting
O

n/O
ff

Turns the w
hite clip adjustm

ent function on/off.

Level
90.0%

 to 109.0%
The default setting varies 
according to the system

 
frequency setting.

Sets the w
hite clip level.

The default setting is 108.0%
 w

hen the system
 

frequency is 59.94, 29.97, 24, or 23.98. The setting 
is 105.0%

 w
hen the system

 frequency is 50.25.

Paint >D
etail(H

D
)/D

etail(SD
)

M
akes settings related to detail adjustm

ents in H
D

 m
ode and SD

 m
ode.

D
etail adjustm

ent processing im
proves the clarity of im

ages by adding a detail signal to the outline of the 
subject.

Item
Setting

D
escription

Setting
O

n/O
ff

Turns the detail adjustm
ent function on/off.

Level
–99 to ±0 to +99

Sets the detail level.

H
/V Ratio

–99 to ±0 to +99
Sets the m

ix ratio betw
een the H

 detail level and 
the V detail level.

Crispening
–99 to ±0 to +99

Sets the crispening level.

Level D
epend

O
n/O

ff
Turns the level dependence adjustm

ent function 
on/off.

Level D
epend Level

–99 to ±0 to +99
Sets the level dependence level.

Frequency
–99 to ±0 to +99

Sets the center frequency of the H
 detail signal 

(larger values give finer detail).
Knee Aperture

O
n/O

ff
Turns the knee aperture correction function on/
off.

Knee Aperture Level
–99 to ±0 to +99

Sets the knee aperture level.

Lim
it

–99 to ±0 to +99
Sets the detail lim

iter for both the w
hite-side and 

black-side directions.
W

hite Lim
it

–99 to ±0 to +99
Sets the w

hite-side detail lim
iter.

Black Lim
it

–99 to ±0 to +99
Sets the black-side detail lim

iter.

V Black Lim
it

–99 to ±0 to +99
Sets the black-side V detail lim

iter.

V D
etail Creation

N
AM

/Y/G
/G

+R
Selects the source signal used to generate the V 
detail signal.
N

AM
: V detail signal created from

 the R signal, V 
detail signal created from

 the G
 signal, or V 

detail signal created from
 the B signal, 

w
hichever signal has the highest level

Y: Y signal
G

: G
 signal

G
+R: M

ixed signal com
prising the G

 signal and R 
signal in a 1:1 ratio

Cross Color Suppress 
(SD

 m
ode)

–99 to ±0 to +99
Sets the cross color suppression level of the detail.

[N
ote]

This setting is disabled if the detail adjustm
ent function 

is O
ff, and w

hen O
peration Form

at Frequency in the 
setup m

enu is set to 50 or 25.
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Paint >Aperture
M

akes settings related to aperture correction.
Aperture correction processing im

proves resolution by adding high-frequency aperture signals to the 
video signal, w

hich corrects deterioration due to high-frequency characteristics.
Item

Setting
D

escription

Setting
O

n/O
ff

Turns the aperture correction function on/off.

Level
–99 to ±0 to +99

Sets the aperture level.

Paint >Skin D
etail

M
akes settings related to skin detail correction.

Skin detail correction processing increases or decreases the detail level of a specified color range, for the 
purpose of obtaining attractive reproduction of skin tones.

Item
Setting

D
escription

Setting
O

n/O
ff

Turns the skin detail correction function on/off.

Area D
etection

Execute/Cancel
D

isplays a color detection screen for detecting 
colors for skin detail correction (execute by 
selecting Execute).

Area Indication
O

n/O
ff

Turns the display of a zebra pattern in areas 
targeted for skin detail correction on/off.

Level
–99 to ±0 to +99

Sets the skin detail level.

Saturation
–99 to ±0 to +99

Sets the saturation of the color targeted for skin 
detail correction.

H
ue

0 to 359
Sets the hue of the color targeted for skin detail 
correction.

W
idth

0 to 40 to 90
Sets the range for the hue of the color targeted 
for skin detail correction.

Paint >M
atrix

M
akes settings related to m

atrix correction.
Adjusts the hue and vividness of the im

age using m
atrix correction.

You can select a m
atrix to achieve a specific purpose using “Adaptive M

atrix” to control the effect of a 
linear m

atrix or “Preset M
atrix” for a predefined param

eter set. You can also set user-defined param
eters as 

a “U
ser M

atrix.”
Item

Setting
D

escription

Setting
O

n/O
ff

Turns the m
atrix correction function on/off.

Adaptive M
atrix

O
n/O

ff
Turns the adaptive m

atrix function on/off.

Preset M
atrix

O
n/O

ff
Turns the preset m

atrix function on/off.

Paint >M
atrix

M
akes settings related to m

atrix correction.
Adjusts the hue and vividness of the im

age using m
atrix correction.

You can select a m
atrix to achieve a specific purpose using “Adaptive M

atrix” to control the effect of a 
linear m

atrix or “Preset M
atrix” for a predefined param

eter set. You can also set user-defined param
eters as 

a “U
ser M

atrix.”
Item

Setting
D

escription

Preset Select
1: SM

PTE240M
2: ITU

-709
3: SM

PTE W
ide

4: N
TSC

5: EBU
6: PAL

Selects a preset m
atrix.

1: SM
PTE240M

: SM
PTE-240M

 equivalent
2: ITU

-709: ITU
-709 equivalent

3: SM
PTE W

ide: SM
PTE W

ID
E equivalent

4: N
TSC: N

TSC equivalent
5: EBU

: EBU
 equivalent

6: PAL: PAL equivalent
U

ser M
atrix

O
n/O

ff
Turns the user m

atrix correction function on/off.

Level
–99 to ±0 to +99

Sets the saturation of the color of the entire 
im

age.
Phase

–99 to ±0 to +99
Sets the color tone (phase) of the entire im

age.

U
ser M

atrix R-G
–99 to ±0 to +99

Sets a user-defined R-G
 user m

atrix.

U
ser M

atrix R-B
–99 to ±0 to +99

Sets a user-defined R-B user m
atrix.

U
ser M

atrix G
-R

–99 to ±0 to +99
Sets a user-defined G

-R user m
atrix.

U
ser M

atrix G
-B

–99 to ±0 to +99
Sets a user-defined G

-B user m
atrix.

U
ser M

atrix B-R
–99 to ±0 to +99

Sets a user-defined B-R user m
atrix.

U
ser M

atrix B-G
–99 to ±0 to +99

Sets a user-defined B-G
 user m

atrix.

Paint >M
ulti M

atrix
M

akes settings related to m
ulti m

atrix correction.
M

ulti-m
atrix correction sets the saturation using a 16-axis hue space.

Item
Setting

D
escription

Setting
O

n/O
ff

Turns the m
ulti m

atrix correction function on/off.

Area Indication
O

n/O
ff

Turns the display of a zebra pattern in the color 
area targeted for m

ulti m
atrix correction on/off.

Color D
etection

Execute/Cancel
D

isplays a color detection screen for detecting 
colors for m

ulti m
atrix correction (execute by 

selecting Execute).
Reset

Execute/Cancel
Sets all hue and saturation on each axis to default 
values (execute by selecting Execute).

Axis
B/B+/M

G
–/M

G
/M

G
+/R/R+/YL–/

YL/YL+/G
–/G

/G
+/CY/CY+/B–

Sets the color targeted for m
ulti m

atrix correction 
(16-axis m

ode)
H

ue
–99 to ±0 to +99

Sets the hue of the color targeted for m
ulti m

atrix 
correction for each 16-axis m

ode.
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Paint >M
ulti M

atrix
M

akes settings related to m
ulti m

atrix correction.
M

ulti-m
atrix correction sets the saturation using a 16-axis hue space.

Item
Setting

D
escription

Saturation
–99 to ±0 to +99

Sets the saturation of the color targeted for m
ulti 

m
atrix correction for each 16-axis m

ode.

Paint >V M
odulation

M
akes settings related to V m

odulation shading correction.
V m

odulation shading corrects the vertical slope of the sensitivity arising from
 the relationship betw

een 
the lens and prism

.
Item

Setting
D

escription

Setting
O

n/O
ff

Turns the V m
odulation shading correction 

function on/off.
M

aster V M
odulation

–99 to ±0 to +99
Sets the m

aster V m
odulation level.

R V M
odulation

–99 to ±0 to +99
Sets the V m

odulation level of the R signal.

G
 V M

odulation
–99 to ±0 to +99

Sets the V m
odulation level of the G

 signal.

B V M
odulation

–99 to ±0 to +99
Sets the V m

odulation level of the B signal.

Paint >Low
 Key Saturation

M
akes settings related to low

 key saturation correction.
Corrects the saturation of colors in dark parts of the im

age.
Item

Setting
D

escription

Setting
O

n/O
ff

Turns the low
 key saturation correction function 

on/off.

[N
ote]

To enable the low
 key saturation function, set Saturation 

M
ode to Low

 Key.

Level
–99 to ±0 to +99

Sets the saturation of colors in low
 lum

inance 
areas.

Range
Low

/L.M
id/H

.M
id

Selects the lum
inance level for w

hich low
 key 

saturation is enabled.

Paint >Saturation M
ode

M
akes settings related to saturation correction.

Item
Setting

D
escription

Saturation M
ode

Knee/Low
 Key

Selects w
hether the saturation function operates 

at high levels (Knee) or low
 levels (Low

 Key).
Knee Saturation

O
n/O

ff
Turns the knee saturation function on/off.

Black G
am

m
a

O
n/O

ff
Turns the black gam

m
a correction function on/

off.
Low

 Key Saturation
O

n/O
ff

Turns the low
 knee saturation function on/off.

Paint >N
oise Suppression

M
akes settings related to noise suppression (noise com

pression).
This allow

s you to effectively suppress noise com
ponents w

hile preserving fine edge com
ponents of the 

subject.
Item

Setting
D

escription

Setting
O

n/O
ff

Turns the noise suppression function on/off.

Level
Low

/M
id/H

igh
Selects the noise suppression level.
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Maintenance Menu

D
efault values are show

n in bold.

M
aintenance >W

hite Shading
M

akes settings related to w
hite shading correction.

W
hite shading is required for each different lens to correct lum

inance and color irregularities in bright 
areas arising from

 lens characteristics.
Item

Setting
D

escription

Channel Select
Red/G

reen/Blue
Selects the target for w

hite shading correction.

W
hite H

 Saw
–99 to ±0 to +99

Sets the SAW
 w

hite shading correction value for 
the horizontal direction.

W
hite H

 Para
–99 to ±0 to +99

Sets the parabola w
hite shading correction value 

for the horizontal direction.
W

hite V Saw
–99 to ±0 to +99

Sets the SAW
 w

hite shading correction value for 
the vertical direction.

W
hite V Para

–99 to ±0 to +99
Sets the parabola w

hite shading correction value 
for the vertical direction.

W
hite Saw

/Para
O

n/O
ff

Turns the w
hite shading SAW

/parabola correction 
function on/off.

M
aintenance >Black Shading

M
akes settings related to black shading correction.

Item
Setting

D
escription

Channel Select
Red/G

reen/Blue
Selects the target for black shading correction.

Black H
 Saw

–99 to ±0 to +99
Sets the SAW

 black shading correction value for 
the horizontal direction.

Black H
 Para

–99 to ±0 to +99
Sets the parabola black shading correction value 
for the horizontal direction.

Black V Saw
–99 to ±0 to +99

Sets the SAW
 black shading correction value for 

the vertical direction.
Black V Para

–99 to ±0 to +99
Sets the parabola black shading correction value 
for the vertical direction.

Black Saw
/Para

O
n/O

ff
Turns the black shading SAW

/parabola correction 
function on/off.

M
aster Black

–99 to ±0 to +99
Sets the m

aster black level.

M
aster G

ain (TM
P)

–3dB/0dB/3dB/6dB/9dB/12dB/ 
18dB/24dB/30dB/36dB/42dB

Sets a tem
porary m

aster gain value.

M
aintenance >Battery

M
akes settings related to batteries.

Item
Setting

D
escription

N
ear End: Info Battery

5%
/10%

/15%
...95%

/100%
Sets the threshold value for displaying the “Battery 
N

ear End” w
arning w

hen using a BP-FLX75/
G

L65A/G
L95A battery pack.

End: Info Battery
0%

/1%
/2%

/3%
/4%

/5%
Sets the threshold value for displaying the “Battery 
End” w

arning w
hen using a BP-FLX75/G

L65A/
G

L95A battery pack.
N

ear End: Sony Battery
11.5V to 17V  
(0.1V steps)

Sets the threshold value for displaying the “Battery 
N

ear End” w
arning w

hen using a BP-L60S/L80S 
battery pack.

End: Sony Battery
11.0V to 11.5V 
(0.1V steps)

Sets the threshold value for displaying the “Battery 
End” w

arning w
hen using a BP-L60S/L80S battery 

pack.
N

ear End: O
ther Battery

11.5V to 11.8V to 17.0V 
(0.1V steps)

Sets the threshold value for displaying the “Battery 
N

ear End” w
arning w

hen using a non-Sony 
battery pack.

End: O
ther Battery

11.0V to 14.0V 
(0.1V steps)

Sets the threshold value for displaying the “Battery 
End” w

arning w
hen using a non-Sony battery 

pack.
D

etected Battery
Sony Info Battery/Sony Battery/ 
O

ther Battery/D
C IN

D
isplays the result of autom

atic battery pack type 
detection.

M
aintenance >D

C Voltage Alarm
Sets alarm

s relating to external D
C supply voltage.

Item
Setting

D
escription

D
C Low

 Voltage1
11.5V to 17V 
(0.1V steps)

Sets the threshold value for displaying the “Battery 
N

ear End” w
arning w

hen using an external pow
er 

source connected to the D
C IN

 connector.
D

C Low
 Voltage2

11.0V to 14.0V 
(0.1V steps)

Sets the threshold value for displaying the “Battery 
End” w

arning w
hen using an external pow

er 
source connected to the D

C IN
 connector.

M
aintenance >Audio

M
akes settings related to audio.

Item
Setting

D
escription

Front M
IC Select

M
ono/Stereo

Selects w
hether the front m

icrophone is 
m

onaural (M
ono) or stereo (Stereo).

Rear XLR Auto
O

n/O
ff

Turns the autom
atic detection function on/off for 

detecting cable connections on the AU
D

IO
 IN

 
CH

-1/CH
-2 connectors on the rear panel.

Front M
IC CH

1 Ref
–70dB/–60dB/–50dB/–40dB/ 
–30dB

Selects the reference level of the front 
m

icrophone for channel 1.
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M
aintenance >Audio

M
akes settings related to audio.

Item
Setting

D
escription

Front M
IC CH

2 Ref
–70dB/–60dB/–50dB/–40dB/ 
–30dB

Selects the reference level of the front 
m

icrophone for channel 2.
Rear M

IC CH
1 Ref

–70dB/–60dB/–50dB/–40dB/ 
–30dB

Selects the reference input level w
hen the AU

D
IO

 
IN

 CH
1 sw

itch is set to M
IC.

Rear M
IC CH

2 Ref
–70dB/–60dB/–50dB/–40dB/ 
–30dB

Selects the reference input level w
hen the AU

D
IO

 
IN

 CH
2 sw

itch is set to M
IC.

Line Input Ref
+4dB/0dB/–3dB/EBU

L
Selects the reference input level w

hen the AU
D

IO
 

IN
 CH

1 and AU
D

IO
 IN

 CH
2 sw

itches are set to 
LIN

E.
M

in Alarm
 Volum

e
O

ff/Set
Selects the volum

e w
hen the ALARM

 knob is 
turned all the w

ay dow
n.

O
ff: Inaudible

Set: Audible
Speaker Attenuate

O
ff/3dB/6dB/9dB/12dB

Selects the volum
e from

 the m
onitor speakers 

(does not affect earphone volum
e).

H
eadphone O

ut
M

ono/Stereo
Selects w

hether the earphones are m
onaural 

(M
ono) or stereo (Stereo).

Reference Level
–20dB/–18dB/–16dB/–12dB/ 
EBU

L
Sets the output level of the 1 kH

z test signal.

Reference O
ut

+4dB/0dB/–3dB/EBU
L

Sets the output level relative to the reference 
input level.

CH
1&2 AG

C M
ode

M
ono/Stereo

Autom
atically adjusts the input level of analog 

audio signals recorded on channels 1 and 2, and 
selects w

hether to m
ake the adjustm

ents 
separately for each channel (M

ono) or in stereo 
m

ode (Stereo).
CH

3&4 AG
C M

ode
M

ono/Stereo
Autom

atically adjusts the input level of analog 
audio signals recorded on channels 3 and 4, and 
selects w

hether to m
ake the adjustm

ents 
separately for each channel (M

ono) or in stereo 
m

ode (Stereo).
AG

C Spec
–6dB/–9dB/–12dB/–15dB/–17dB

Selects the AG
C characteristic (saturation level).

Lim
iter M

ode
O

ff/–6dB/–9dB/–12dB/–15dB/ 
–17dB

Selects the lim
iter characteristic (saturation level) 

for large input signals w
hen adjusting the audio 

input level m
anually. Select O

ff if not using the 
lim

iter.
O

utput Lim
iter

O
n/O

ff
Turns the audio output lim

iter on/off.

CH
1 W

ind Filter
O

n/O
ff

Turns the channel 1 w
ind noise reduction filter 

on/off.

M
aintenance >Audio

M
akes settings related to audio.

Item
Setting

D
escription

CH
2 W

ind Filter
O

n/O
ff

Turns the channel 2 w
ind noise reduction filter 

on/off.
CH

2 W
ind Filter

O
n/O

ff
Turns the channel 3 w

ind noise reduction filter 
on/off.

CH
4 W

ind Filter
O

n/O
ff

Turns the channel 4 w
ind noise reduction filter 

on/off.
1kH

z Tone on Color 
Bars

O
n/O

ff/Auto
Sets w

hether to output (O
n) or not output (O

ff) a 
1 kH

z test signal in color bar m
ode.

Auto: O
utputs a test signal only w

hen the AU
D

IO
 

SELECT CH
1 sw

itch is set to AU
TO

.
M

IC CH
1 Level

Side1/Front/Front+Side1
Selects the knob for adjusting the audio level 
w

hen recording input audio from
 the front 

m
icrophone on channel 1.

Side1: LEVEL knob (left) on the side panel
Front: M

IC LEVEL knob on the front panel
Front+Side1: LEVEL knob (left) and M

IC LEVEL 
knob (linked control)

M
IC CH

2 Level
Side2/Front/Front+Side2

Selects the knob for adjusting the audio level 
w

hen recording input audio from
 the front 

m
icrophone on channel 2.

Side2: LEVEL knob (right) on the side panel
Front: M

IC LEVEL knob on the front panel
Front+Side2: LEVEL knob (right) and M

IC LEVEL 
knob (linked control)

Rear1/W
RR Level

Side1/Front/Front+Side1
Selects the knob for adjusting the audio level of a 
w

ireless m
icrophone or a device connected to the 

AU
D

IO
 IN

 CH
-1 connector on the rear panel.

Side1: LEVEL knob (left) on the side panel
Front: M

IC LEVEL knob on the front panel
Front+Side1: LEVEL knob (left) and M

IC LEVEL 
knob (linked control)

Rear2/W
RR Level

Side2/Front/Front+Side2
Selects the knob for adjusting the audio level of a 
w

ireless m
icrophone or a device connected to the 

AU
D

IO
 IN

 CH
-2 connector on the rear panel.

Side2: LEVEL knob (right) on the side panel
Front: M

IC LEVEL knob on the front panel
Front+Side2: LEVEL knob (right) and M

IC LEVEL 
knob (linked control)
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M
aintenance >Audio

M
akes settings related to audio.

Item
Setting

D
escription

Audio CH
3 Level

Side3/Front/Front+Side3
Selects the knob for adjusting the audio level 
recorded on channel 3.
Side3: LEVEL knob on the side panel
Front: M

IC LEVEL knob on the front panel
Front+Side3: LEVEL knob and M

IC LEVEL knob 
(linked control)

Audio CH
4 Level

Side4/Front/Front+Side4
Selects the knob for adjusting the audio level 
recorded on channel 4.
Side4: LEVEL knob on the side panel
Front: M

IC LEVEL knob on the front panel
Front+Side4: LEVEL knob and M

IC LEVEL knob 
(linked control)

M
aintenance >W

RR Setting
M

akes settings related to the w
ireless tuner.

Item
Setting

D
escription

W
RR Valid CH

 Sel
All/CH

1
Selects w

hether to enable channels 1 and 2 of the 
w

ireless tuner (All) or channel 1 only (CH
1).

W
RR CH

 Select
TX1/TX2

Selects the reception channel for display in the 
m

enu.
TX1: D

isplays channel 1.
TX2: D

isplays channel 2.
W

RR D
elay Com

p
O

n/O
ff

Selects w
hether to enable (O

n) or disable (O
ff) the 

delay com
pensation function for w

ireless input 
audio. (W

hen O
n is selected, all E-E output audio 

is delayed by about 8 m
s.)

TX
---

D
isplays the nam

e of the transm
itter w

hose 
signals are being received on the channel 
selected by W

RR CH
 Select.

TX Audio Peak
---/Peak

D
isplays w

hether the AF level of the transm
itter 

w
hose signals are being received on the channel 

selected by W
RR CH

 Select are over peak.
TX Input Level 

---/M
ic/Line

D
isplays w

hether the input level of the transm
itter 

w
hose signals are being received on the channel 

selected by W
RR CH

 Select is set to m
icrophone 

(M
ic) or line (Line).

TX ATT Level
---

Sets the ATT level of the transm
itter w

hose signals 
are being received on the channel selected by 
W

RR CH
 Select. (The setting range varies 

depending on the transm
itter.)

M
aintenance >W

RR Setting
M

akes settings related to the w
ireless tuner.

Item
Setting

D
escription

TX LCF Frequency
---

Sets the low
 cut filter frequency of the transm

itter 
w

hose signals are being received on the channel 
selected by W

RR CH
 Select. (The setting range 

varies depending on the transm
itter.)

TX System
 D

elay
Auto/0.0m

s to 8.0m
s

Sets the am
ount of audio delay.

Auto: Autom
atically corrects for the am

ount of 
delay so that the delay in the audio from

 the 
w

ireless tuner is zero.
0.0m

s to 8.0m
s: Sets the am

ount of estim
ated 

w
ireless system

 delay, for cases in w
hich 

several w
ireless system

s are being used via a 
device such as an audio m

ixer.
TX RF Pow

er
H

igh (Pow
er value) m

W
/M

id 
(Pow

er value) m
W

/Low
 (Pow

er 
value) m

W

Sets the RF pow
er level of the transm

itter 
com

m
unicating on the channel selected by W

RR 
CH

 Select. (The setting range varies depending on 
the transm

itter.)
TX Pow

er Save
Active/Sleep

Sets the pow
er saving m

ode of the transm
itter 

w
hose signals are being received on the channel 

selected by W
RR CH

 Select.
Active: Set the transm

itter to startup m
ode.

Sleep: Set the transm
itter to pow

er saving m
ode.

M
aintenance >Tim

e Code
M

akes settings related to tim
ecode.

Item
Setting

D
escription

TC O
ut 

Auto/G
enerator

Selects the tim
ecode output.

Auto: O
utputs the tim

ecode generator value 
during recording, and the tim

ecode reader 
value during playback.

G
enerator: O

utputs the tim
ecode generator value 

during recording and playback.
D

F/N
D

F
D

F/N
D

F
Selects drop-fram

e m
ode (D

F) or non-drop-fram
e 

m
ode (N

D
F).

LTC U
BIT

Fix/Tim
e

Sets the data recorded in LTC user bits.
Fix: Records user-specified data.
Tim

e: Records the current tim
e.
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M
aintenance >Tim

e Code
M

akes settings related to tim
ecode.

Item
Setting

D
escription

Counter D
isplay 

Counter/D
uration

Select the m
ethod used to reset the counter value 

displayed on the view
finder screen.

Counter: Continue to increm
ent until the RESET 

button is pressed.
D

uration: Reset each tim
e that recording is 

started.

M
aintenance >Essence M

ark
M

akes settings related to essence m
arks.

Item
Setting

D
escription

Find M
ode

Clip/Rec Start
Sets the operation w

hen the N
EXT/PREV button is 

pressed.
Rec Start: M

oves to the next or the previous 
recording start m

ark, respectively.
Clip: M

oves to the start of the next clip w
hen the 

N
EXT button is pressed. M

oves to the start of 
the current clip w

hen the PREV button is 
pressed (or m

oves to the start of the previous 
clip if the PREV button is pressed at the start 
of the clip).

M
aintenance >Cam

era Config
M

akes settings related to various cam
corder operations.

Item
Setting

D
escription

H
D

 SD
I Rem

ote I/F
O

ff/Characters/ 
G

reen Tally/Red Tally
Sets w

hether to enable the recording control 
function for an external device connected to the 
SD

I O
U

T 1/2 connector (H
D

 SD
I output) of the 

cam
corder. If enabled, it selects the indicator used 

to display the recording state of the external 
device.
O

ff: Recording control function is disabled.
Chara: D

isplayed using the external device control 
indicator on the status display in the 
view

finder.
G

-Tally: D
isplayed using the TALLY indicator 

(green tally) in the view
finder.

R-Tally: D
isplayed using the REC indicator 

(recording red tally) in the view
finder.

Color Bars Select
ARIB/100%

/75%
/SM

PTE
Selects the color bar type.

U
ser M

enu O
nly

O
n/O

ff
Selects w

hether to display the U
ser m

enu only 
(O

n) or display the m
enu list (O

ff) w
hen the 

cam
corder is displaying the m

enu.

M
aintenance >Cam

era Config
M

akes settings related to various cam
corder operations.

Item
Setting

D
escription

U
ser M

enu w
ith Lock

O
n/O

ff
Selects w

hether to lock the m
enu display, 

show
ing the U

ser m
enu only.

O
n: Enter an arbitrary passcode num

ber to lock 
the m

enu display. (O
nly the U

ser m
enu is 

displayed.)
O

ff: Enter the passcode num
ber entered w

hen 
“O

n” w
as selected to unlock the m

enu 
display. (W

hen unlocked, the norm
al m

enu 
list is displayed.)

[N
ote]

In norm
al m

enu display operation, this item
 is not 

displayed.
For details about m

enu display operation, see 
page 87.

RM
 Com

m
on M

em
ory

O
n/O

ff
Selects w

hether to share (O
n) or not share (O

ff) 
settings betw

een w
hen using a rem

ote control 
unit connection and w

hen the cam
corder is 

operated locally.
RM

 Rec Start
RM

/Cam
era/PARA

Selects w
hich of the recording start/stop buttons 

are enabled w
hen a rem

ote control unit is 
connected,
RM

: Rem
ote control unit

Cam
era: Cam

corder
PARA: Both

SET Key on Thum
bnail

Pause/Play
Selects the operation w

hen the M
EN

U
 knob is 

pressed w
ith only one thum

bnail selected.
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M
aintenance >Cam

era Config
M

akes settings related to various cam
corder operations.

Item
Setting

D
escription

ALAC
Auto/O

ff
Sets w

hether to execute ALAC (Auto Lens 
Aberration Correction) autom

atically.
Auto: Execute ALAC autom

atically w
hen an 

ALAC-com
patible lens is attached and ALAC 

is enabled.
O

ff: D
o not execute.

[N
ote]

D
epending on the aberration correction lens, the 

aberration correction function m
ay not be activated 

im
m

ediately (“ALAC” does not appear on the view
finder 

screen) after turning the pow
er on, even w

hen this 
setting is set to Auto. If this occurs, turn the lens zoom

 
ring and focus ring to the end stop and back, and check 
w

hether the “ALAC” indicator appears on the view
finder 

screen.

Contact a Sony service representative for inform
ation about 

aberration correction lenses.

M
aintenance >Preset W

hite
M

akes settings related to w
hite balance preset values.

Item
Setting

D
escription

Color Tem
p <P>

1500K to 3200K to 50000K
Sets the w

hite balance preset value.

C.Tem
p BAL <P>

–99 to ±0 to +99
Sets the fine color tem

perature settings, for use 
w

hen a satisfactory im
age cannot be obtained 

using Color Tem
p<P>.

R G
ain <P>

–99 to ±0 to +99
Sets the R gain preset value.

B G
ain <P>

–99 to ±0 to +99
Sets the B gain preset value.

AW
B Enable <P>

O
n/O

ff
Turns execution of the AW

B (auto w
hite balance) 

function on/off w
hen the W

H
ITE BAL sw

itch is set 
to PRST.

Color Tem
p <P>

1500K to 3200K to 50000K
Sets the w

hite balance preset value.

C.Tem
p BAL <P>

–99 to ±0 to +99
Sets the fine color tem

perature settings, for use 
w

hen a satisfactory im
age cannot be obtained 

using Color Tem
p<P>.

R G
ain <P>

–99 to ±0 to +99
Sets the R gain preset value.

B G
ain <P>

–99 to ±0 to +99
Sets the B gain preset value.

AW
B Enable <P>

O
n/O

ff
Turns execution of the AW

B (auto w
hite balance) 

function on/off w
hen the W

H
ITE BAL sw

itch is set 
to PRST.

M
aintenance >W

hite Filter
M

akes settings related to filters.

Item
Setting

D
escription

N
D

 Filter C.Tem
p

O
n/O

ff
Turns the function that assigns electrical CC filters 
to N

D
 filters on/off.

N
D

 FLT C.Tem
p<1>

3200K/4300K/5600K/6300K
Selects the color tem

perature w
hen electrical CC 

filters are assigned to N
D

 filters (filter 1).
N

D
 FLT C.Tem

p<2-4>
3200K/4300K/5600K/6300K

Selects the color tem
perature w

hen electrical CC 
filters are assigned to N

D
 filters (filters 2 to 4).

Electrical CC<A>
3200K/4300K/5600K/6300K

Selects the color tem
perature w

hen the electrical 
CC filter sw

itching function is assigned to an 
assignable sw

itch.
Electrical CC<B>

3200K/4300K/5600K/6300K
Selects the color tem

perature w
hen the electrical 

CC filter sw
itching function is assigned to an 

assignable sw
itch.

Electrical CC<C>
3200K/4300K/5600K/6300K/ 
---

Selects the color tem
perature w

hen the electrical 
CC filter sw

itching function is assigned to an 
assignable sw

itch. Select “----” if not using C.
Electrical CC<D

>
3200K/4300K/5600K/6300K/ 
---

Selects the color tem
perature w

hen the electrical 
CC filter sw

itching function is assigned to an 
assignable sw

itch. Select “----” if not using D
.

M
aintenance >D

CC Adjust
M

akes settings related to D
CC (dynam

ic contrast control).

Item
Setting

D
escription

D
CC Function Select

D
CC/Fix

Selects the setting m
ethod for the knee point 

w
hen the O

U
TPU

T/D
CC sw

itch is set to CAM
 w

ith 
D

CC on.
D

CC: Autom
atically adjusts the knee point to 

m
atch the lum

inance of the subject.
Fix: Sets the knee point to a fixed value.

D
CC D

 Range
400%

/450%
/500%

/550%
/600%

Sets the dynam
ic range w

hen the O
U

TPU
T/D

CC 
sw

itch is set to CAM
 w

ith D
CC on.

D
CC Point

–99 to ±0 to +99
Sets the D

CC m
inim

um
 knee point.

D
CC G

ain
–99 to ±0 to +99

Sets the gain relative to the D
CC detected value.

D
CC D

elay Tim
e

–99 to ±0 to +99
Sets the D

CC control speed (speed of response to 
changes in the video).

D
CC Peak Filter

–99 to ±0 to +99
Adjusts the response sensitivity relative to the 
peaks in D

CC detected values.
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M
aintenance >Flicker Reduce

M
akes settings related to the flicker correction function.

You can correct the flicker created w
hen shooting a subject under lighting w

here the brightness varies 
periodically, such as fluorescent lighting, due to the relationship betw

een the frequency and the recording 
fram

e rate.
Item

Setting
D

escription

M
ode

Auto/O
n/O

ff
Sets the operation of the flicker correction 
function.
O

n: Alw
ays operating.

Auto: O
perates w

hen flicker is detected.
O

ff: D
oes not operate.

Frequency
60H

z/50H
z

The factory setting is 60H
z w

hen System
 

Frequency is set to 59.94, 29.97, or 23.98.
The factory setting is 50H

z w
hen System

 
Frequency is set to 50 or 25.

M
aintenance >G

enlock
M

akes settings related to genlock.

Item
Setting

D
escription

G
enlock

O
n/O

ff
Turns the genlock function on/off.

Reference
Internal/External(H

D
)/

External(SD
)/SD

I IN
/CA

D
isplays the type of reference signal used by the 

cam
corder.

M
aintenance >Auto Shading

Executes auto black shading correction.

Item
Setting

D
escription

Auto Black Shading
Execute/Cancel

Executes auto black shading correction (execute 
by selecting Execute).

Reset Black Shading
Execute/Cancel

Clears the black shading correction value (execute 
by selecting Execute).

M
aster G

ain (TM
P)

–3dB/0dB/3dB/6dB/9dB/12dB/ 
18dB/24dB/30dB/36dB/42dB

Sets a tem
porary m

aster gain value. (The value is 
the sam

e as the value selected w
ith the G

AIN
 

sw
itch.)

M
aintenance >APR

M
akes settings related to autom

atic pixel noise reduction.

Item
Setting

D
escription

APR
Execute/Cancel

Executes the autom
atic pixel noise reduction 

function to suppress w
hite flecks in SLS m

ode 
(execute by selecting Execute).

Reset
Execute/Cancel

D
eletes w

hite flecks data that w
ere added by 

execution of the APR and autom
atic black balance 

adjustm
ent functions (execute by selecting 

Execute).

M
aintenance >Basic Authentication

M
akes settings related to basic authentication.

Item
Setting

D
escription

U
ser N

am
e

(D
isplays the current user nam

e.)
Sets the user nam

e (arbitrary nam
e for basic 

authentication). Set to “adm
in” by factory default.

Passw
ord

*******
Sets the passw

ord (for basic authentication). Set 
to “pxw

-x400” by factory default.

M
aintenance >N

etw
ork

M
akes settings related to netw

ork connections.

Item
Setting

D
escription

Setting
O

n/O
ff

Turns the netw
ork function on/off.

W
ireless N

etw
ork

W
i-Fi Access Point/W

i-Fi Station/ 
M

odem
/O

ff
Sets the operating m

ode for w
ireless LAN

 
connections.

N
FC

Execute/Cancel
Initiates a one-touch connection using N

FC 
(execute by selecting Execute).

W
PS

Execute/Cancel
Starts W

i-Fi Protected Setup (W
PS) (execute by 

selecting Execute).
Channel

Auto(5G
H

z)/Auto/CH
1/CH

2/
CH

3/CH
4/CH

5/CH
6/CH

7/CH
8/

CH
9/CH

10/CH
11

Sets the w
ireless LAN

 channel.

[N
ote]

“Auto(5G
H

z)” m
ay not be displayed, depending on the 

w
ireless LAN

 m
odule used.

SSID
 & Passw

ord
(SSID

 display)
(Passw

ord display)
D

isplays the SSID
 and passw

ord.

D
evice N

am
e (W

ireless)
D

isplays the nam
e of netw

ork device attached to 
the U

SB w
ireless LAN

 m
odule connector

IP Address (W
ireless)

D
isplays the IP address w

hen connected to a 
w

ireless LAN
.

Subnet M
ask (W

ireless)
D

isplays the subnet m
ask w

hen connected to a 
w

ireless LAN
.

M
AC Address (W

ireless)
D

isplays the M
AC address of the U

SB W
ireless LAN

 
M

odule attached to the cam
corder.

Regenerate Passw
ord

Execute/Cancel
Regenerates a passw

ord (execute by selecting 
Execute).

W
ired LAN

Enable/D
isable

Enables/disables w
ired LAN

 connection.

W
ired LAN

 Rem
ote

O
n/O

ff
If connected to a netw

ork using a LAN
 cable, 

operation from
 a W

i-Fi rem
ote control, w

eb 
m

enu, and “Content Brow
ser M

obile” is enabled.
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M
aintenance >N

etw
ork

M
akes settings related to netw

ork connections.

Item
Setting

D
escription

W
ired LAN

 D
etail 

Settings
D

H
CP (O

n/O
ff)

Enables/disables D
H

CP.
W

hen set to O
n, an IP address is autom

atically 
assigned to the cam

corder.
To enter the cam

corder IP address m
anually, set 

to O
ff.

IP Address (D
H

CP/O
n: obtain 

autom
atically, D

H
CP/O

ff: 
192.168.2.50)

Enter the IP address of the cam
corder.

Enabled only w
hen D

H
CP is O

ff.

Subnet M
ask (D

H
CP/O

n: obtain 
autom

atically, D
H

CP/O
ff: 

255.255.255.0)

Enter the subnet m
ask of the cam

corder.
Enabled only w

hen D
H

CP is O
ff.

G
atew

ay (D
H

CP/O
n: obtain 

autom
atically, D

H
CP/O

ff: 0.0.0.0)
Enter the gatew

ay for the access point.
Enabled only w

hen D
H

CP is O
ff.

D
N

S Auto (O
n/O

ff)
Enables/disables autom

atic D
N

S.
W

hen set to O
n, the address of the D

N
S server is 

obtained autom
atically.

Prim
ary D

N
S Server (D

N
S Auto/

O
n: obtain autom

atically, D
N

S 
Auto/O

ff: 0.0.0.0)

Enter the prim
ary D

N
S server for the router.

Enabled only w
hen D

N
S Auto is O

ff.

Secondary D
N

S Server (D
N

S 
Auto/O

n: obtain autom
atically, 

D
N

S Auto/O
ff: 0.0.0.0)

Enter the secondary D
N

S server for the router.
Enabled only w

hen D
N

S Auto is O
ff.

M
aintenance >N

etw
ork Client M

ode
M

akes settings related to netw
ork client m

ode.

 
[N

ote]
N

etw
ork client m

ode cannot be set if values are not entered for all item
s.

Item
Setting

D
escription

Setting
O

n/O
ff

Turns netw
ork client m

ode on/off.

[N
ote]

W
hen set to O

n, the firm
w

are version cannot be 
updated.

M
aintenance >N

etw
ork Client M

ode
M

akes settings related to netw
ork client m

ode.

 
[N

ote]
N

etw
ork client m

ode cannot be set if values are not entered for all item
s.

Item
Setting

D
escription

D
etail Settings

CCM
 Address

Sets the address of the CCM
 to connect.

H
ost nam

e or IP address
CCM

 Port (1 to 65535 (8443))
Sets the port num

ber of the CCM
 to connect

U
ser N

am
e

Sets the user nam
e for authentication of the CCM

 
to connect.

Passw
ord

Sets the passw
ord of the CCM

 to connect.

N
CM

 w
ith Proxy (Enable/D

isable)
Enable: Enable proxy recording w

hen connected 
w

ith a CCM
.

D
isable: D

isable proxy recording w
hen connected 

w
ith a CCM

.

M
aintenance >File Transfer

M
akes settings related to netw

ork transfer of data on SxS m
em

ory cards in the cam
corder.

Item
Setting

D
escription

File Transfer
Execute/Cancel

Sw
itches to transfer m

ode (execute by selecting 
Execute).

Rem
ote File Transfer

Enable/D
isable

Sets w
hether to enable/disable sw

itching to 
transfer m

ode to transfer original files recorded on 
the cam

corder by rem
ote operation over a 

netw
ork.

Enable: Enable sw
itching to transfer m

ode by 
rem

ote operation over a netw
ork.  

It is not necessary to execute a transfer using 
M

aintenance >File Transfer.
D

isable: D
isable sw

itching to transfer m
ode by 

rem
ote operation over a netw

ork.  
It is necessary to execute a transfer using 
M

aintenance >File Transfer.
Auto U

pload (Proxy)
O

ff/O
n

Turns proxy file auto transfer on/off.

M
aintenance >Stream

ing
M

akes settings related to stream
ing.

Item
Setting

D
escription

Setting
O

n/O
ff

Turns stream
ing transm

ission on/off.

[N
otes]
ˎˎ This setting is set to O

ff w
hen you turn the pow

er on 
again.
ˎˎ W

hen set to O
n, the m

onitoring function is not 
available.
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M
aintenance >Stream

ing
M

akes settings related to stream
ing.

Item
Setting

D
escription

Preset Select
Preset 1/Preset 2/Preset 3

Selects a stream
ing preset.

The settings are com
m

on to Preset 1/Preset 2/
Preset 3. See below

 for descriptions for the 
settings in a preset.

Size
H

D
 Auto/1280×720/640×360/ 

480×270/320×180
Sets the size of video for stream

ing.
W

hen “H
D

 Auto” is selected, the size is set to 
1920×1080 or 1280×720, according to the setting 
of the recording form

at recorded on the SxS 
m

em
ory card or the form

at of the clip to be 
played back.

Bit Rate
9M

bps/6M
bps/3M

bps/ 
2M

bps/1M
bps/0.5M

bps/
0.3M

bps(M
ono L)/

0.3M
bps(M

ono R)/
0.2M

bps(M
ono L)/

0.2M
bps(M

ono R)

Sets the bit rate of video for stream
ing.

The selectable bit rate varies depending on the 
Size setting.

[N
otes]
ˎˎ Audio/video data is transm

itted as-is via the Internet. 
Accordingly, the data m

ay potentially be exposed 
to other parties. Alw

ays check that the transm
ission 

destination can receive the stream
ing data.

ˎˎ The data m
ay be sent to an unintended party if the 

address or other settings are configured incorrectly.
ˎˎ N

ot all fram
es m

ay be played, depending on the 
status of the netw

ork.
ˎˎ The picture quality m

ay deteriorate in scenes w
ith 

excessive m
otion.

ˎˎ N
ot all fram

es m
ay be played w

hen the stream
 is set 

to a large size w
ith a sm

all bit rate. To reduce this, 
select a sm

aller size for the Size setting.

Type
M

PEG
-2 TS/U

D
P/M

PEG
-2 TS/ 

RTP
Selects the type of video for stream

ing.

D
estination Address

Character string (0.0.0.0)
Enter the address of the transm

ission destination 
server for stream

ing data.
D

estination Port
1 to 65545 (1234)

Enter the port num
ber of the transm

ission 
destination server used for stream

ing.
Audio Channel 

CH
1/CH

2/CH
3/CH

4
Selects the audio channel for the stream

ing 
output.

M
aintenance >Clock Set

Sets the internal clock.

Item
Setting

D
escription

D
ate M

ode
YYM

M
D

D
/M

M
D

D
YY/D

D
M

M
YY

Selects the display form
at for dates.

12H
/24H

12H
/24H

Selects the clock display form
at.

D
ate

D
isplays the date setting screen.

M
aintenance >Clock Set

Sets the internal clock.

Item
Setting

D
escription

Tim
e

D
isplays the tim

e setting screen.

M
aintenance >Language

Selects the display language for m
essages.

Item
Setting

D
escription

Select
English/ 

 /
Espanol/ Русский

Selects the display language for m
essages.

M
aintenance >H

ours M
eter

M
akes settings related to the digital hours m

eter.

Item
Setting

D
escription

H
ours (System

)
xxxxH
(xxxx hours)

D
isplays the cum

ulative hours of use (cannot be 
reset).

H
ours (Reset)

xxxxH
(xxxx hours)

D
isplays the cum

ulative hours of use (can be 
reset).

Reset
Execute/Cancel

Resets the H
ours (Reset) display to 0 (execute by 

selecting Execute).

M
aintenance >N

etw
ork Reset

Returns netw
ork-related settings to their factory default state.

Item
Setting

D
escription

Reset
Execute/Cancel

Resets netw
ork related settings (execute by 

selecting Execute).

M
aintenance >Fan Control

Sets the fan control m
ode.

Item
Setting

D
escription

Setting
Auto/M

inim
um

/O
ff in Rec

Selects the fan control m
ode.

M
aintenance >VF D

isplay Setting
M

akes settings related to the view
finder display.

Item
Setting

D
escription

Chara/M
arker 

Brightness
5/4/3/2/1

Sets the brightness of character strings, icons, and 
m

arkers superim
posed in the view

finder im
age.
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M
aintenance >Version

D
isplays the version of the cam

corder, and updates the cam
corder.

Item
Setting

D
escription

N
um

ber
Version U

p
Execute/Cancel

D
isplays the softw

are version of the cam
corder 

(Vx.xx).
U

pdates the cam
corder (execute by selecting 

Execute).

[N
ote]

Cannot be selected w
hen the version updater SD

 card is 
not inserted.

N
et-Func Version 

N
um

ber
D

isplays the firm
w

are version of the w
ireless LAN

 
connection function of the cam

corder (Vx.xx)
N

et-Func Ver.U
p

Execute/Cancel
U

pdates the firm
w

are of the w
ireless LAN

 
connection function (execute by selecting 
Execute).

File Menu

D
efault values are show

n in bold.

File >U
ser File

M
akes settings relating to user file operations.

Item
Setting

D
escription

Load SD
 Card

D
isplays a screen for loading user file settings 

from
 an SD

 card.
Save SD

 Card
D

isplays a screen for saving user file settings onto 
an SD

 card.
File ID

D
isplays a screen for displaying/editing the file ID

 
of user files.

Recall U
ser Preset

Execute/Cancel
Returns the value of m

enu item
s registered in the 

U
ser m

enu to the preset values (execute by 
selecting [Execute]).

Store U
ser Preset

Execute/Cancel
Stores the value of m

enu item
s registered in the 

U
ser m

enu item
s as the preset values (execute by 

selecting [Execute]).
Clear U

ser Preset
Execute/Cancel

Returns the current settings and preset values of 
m

enu item
s registered in the U

ser m
enu to the 

factory default values (execute by selecting 
[Execute]).

Load Custom
ize D

ata
O

n/O
ff

Sets w
hether to load U

ser m
enu custom

ized 
inform

ation w
hen [Load SD

 Card] is executed.
Load W

hite D
ata

O
n/O

ff
Sets w

hether to load w
hite balance inform

ation 
w

hen [Load SD
 Card] is executed.

File >All File
M

akes settings related to ALL file operations.

Item
Setting

D
escription

Load SD
 Card

D
isplays a screen for loading All File settings from

 
an SD

 card.
Save SD

 Card
D

isplays a screen for saving All File settings onto 
an SD

 card.
File ID

D
isplays a screen for displaying/editing the file ID

 
of All Files.

All Preset
Execute/Cancel

Returns all item
s to their preset values (execute by 

selecting Execute).
Store All Preset

Execute/Cancel
Stores the current settings of all item

s as the 
preset values (execute by selecting [Execute]).
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File >All File
M

akes settings related to ALL file operations.

Item
Setting

D
escription

Clear All Preset
Execute/Cancel

Returns the current settings and presets of All File 
m

enu item
s to their factory default values 

(execute by selecting Execute).
3Sec Clear Preset

O
n/O

ff
Turns the function that clears the currents settings 
and presets of each item

 on/off, w
hen the M

EN
U

 
CAN

CEL/PRST/ESCAPE sw
itch is pushed up and 

held for three seconds in the CAN
CEL/PRST 

position.

File >Scene File
M

akes settings related to scene file operations.

Item
Setting

D
escription

Recall Internal M
em

ory
D

isplays a screen for recalling scene files from
 

internal m
em

ory.
Store Internal M

em
ory

D
isplays a screen for storing scene files in internal 

m
em

ory.
Load SD

 Card
D

isplays a screen for loading scene files from
 an 

SD
 card.

Save SD
 Card

D
isplays a screen for saving scene files onto an SD

 
card.

File ID
D

isplays a screen for displaying/editing the file ID
 

of scene files.
Scene W

hite D
ata

O
n/O

ff
Sets w

hether to reflect the w
hile balance data of 

scene files w
hen recalling scene files.

File >Reference File
M

akes settings related to reference file operations.

Item
Setting

D
escription

Store Reference
Execute/Cancel

Stores the current settings of reference file target 
m

enu item
s as the preset values (execute by 

selecting [Execute]).
Clear Reference

Execute/Cancel
Returns the current settings and preset values of 
reference file target m

enu item
s to the factory 

default values (execute by selecting [Execute]).
Load Reference(SD

 
Card)

Execute/Cancel
Loads reference file settings from

 and SD
 card and 

sets the preset values (execute by selecting 
[Execute]).

Save Reference(SD
 

Card)
Execute/Cancel

Stores the preset values of reference file target 
m

enu item
s to an SD

 card (execute by selecting 
[Execute]).

File >Reference File
M

akes settings related to reference file operations.

Item
Setting

D
escription

File ID
D

isplays a screen for displaying/editing the file ID
 

of reference files.

File >Lens File
M

akes settings related to lens file operations.

Item
Setting

D
escription

D
isplay M

ode
M

odel N
am

e/Lens ID
Selects the item

s to display in the list box that 
appears w

hen saving or loading a file.
Recall Internal M

em
ory

D
isplays a screen for recalling lens files from

 
internal m

em
ory.

Store Internal M
em

ory
D

isplays a screen for storing lens files in internal 
m

em
ory.

Load SD
 Card

D
isplays a screen for loading lens files from

 an SD
 

card.
Save SD

 Card
D

isplays a screen for saving lens files onto an SD
 

card.
File ID

D
isplays a screen for displaying/editing the file ID

 
of lens files.

File Source
D

isplays the num
ber of the selected file.

Clear Lens O
ffset

Execute/Cancel
Clears the lens file (execute by selecting Execute).

Lens Auto Recall
O

ff/O
n(Lens N

am
e)/ 

O
n(Serial N

um
ber)

Sets w
hether to autom

atically recall a lens file 
w

hen a lens that supports serial com
m

unication is 
attached.

Lens Serial N
um

ber
D

isplays the serial num
ber of the attached lens 

(lenses that support serial com
m

unication only).
Lens N

am
e

D
isplays the m

odel nam
e of the attached lens 

(lenses that support serial com
m

unication only).
Lens M

anufacturer
D

isplays the nam
e of the m

anufacturer of the 
attached lens (lenses that support serial 
com

m
unication only).

M
aster V M

odulation
–99 to ±0 to +99

Sets the SAW
 shading correction value in the 

vertical direction in the lens file.
Lens Center H

–40 to ±0 to +40
Sets the horizontal position of the center m

arker 
in the lens file.

Lens Center V
–40 to ±0 to +40

Sets the vertical position of the center m
arker in 

the lens file.
R Flare

–99 to ±0 to +99
Sets the R flare level in the lens file.

G
 Flare

–99 to ±0 to +99
Sets the G

 flare level in the lens file.

B Flare
–99 to ±0 to +99

Sets the B flare level in the lens file.
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File >Lens File
M

akes settings related to lens file operations.

Item
Setting

D
escription

W
hite O

ffset R
–99 to ±0 to +99

Sets the w
hite balance offset R channel correction 

value for the lens in the lens file.
W

hite O
ffset B

–99 to ±0 to +99
Sets the w

hite balance offset B channel correction 
value for the lens in the lens file.

Shading Ch Select
Red/G

reen/Blue
Selects the target for w

hite shading correction.

Shading H
 SAW

–99 to ±0 to +99
Sets the SAW

 w
hite shading correction value in 

the horizontal direction in the lens file.
Shading H

 PARA
–99 to ±0 to +99

Sets the parabola w
hite shading correction value 

in the horizontal direction in the lens file.
Shading V SAW

–99 to ±0 to +99
Sets the SAW

 w
hite shading correction value in 

the vertical direction in the lens file.
Shading V PARA

–99 to ±0 to +99
Sets the parabola w

hite shading correction value 
in the vertical direction in the lens file.

File >U
ser G

am
m

a
M

akes settings related to user gam
m

a.

Item
Setting

D
escription

Current Settings
D

isplays a list screen of the current user gam
m

a 
file settings (file nam

es).
Load SD

 Card
D

isplays a screen for loading U
ser G

am
m

a 
settings from

 an SD
 card.

Reset
1/2/3/4/5/All

Resets the settings in the selected user gam
m

a 
file (execute by selecting Execute).
Select All to reset all user gam

m
a files.
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Assigning Functions to Assignable Sw
itches

U
sing the Assignable Sw

itch item
 of the O

peration m
enu, you can assign user-specified functions to the 

ASSIG
N

. 0 to 3 sw
itches, the ASSIG

N
ABLE 4 and 5 sw

itches, the O
N

LIN
E button, and the RET button on the 

lens.
The follow

ing tables lists the functions that are assigned w
hen the cam

corder is shipped from
 the factory.

Sw
itch or button

Function
Assignable Sw

itch setting
ASSIG

N
. 0 sw

itch
N

o assignm
ent

O
ff

ASSIG
N

. 1 sw
itch

N
o assignm

ent
O

ff
ASSIG

N
. 2 sw

itch
N

o assignm
ent

O
ff

ASSIG
N

. 3 sw
itch

N
o assignm

ent
O

ff
ASSIG

N
ABLE 4 sw

itch
N

o assignm
ent

O
ff

ASSIG
N

ABLE 5 sw
itch

N
o assignm

ent
O

ff
RET button

Rec Review
 (if playback is allow

ed)
Lens RET

O
N

LIN
E button

Auto transfer proxy clip
N

etw
ork Client M

ode

Functions That Can Be Assigned to the ASSIGN. 0 Switch

Assignable Sw
itch setting

Function
State w

hen cam
corder is 

next pow
ered on

O
ff

N
o assignm

ent
—

M
arker

Turns the display of all m
arkers on/off.

Setting retained
ATW

 H
old

H
olds the w

hite balance setting in the ATW
 

(auto-tracking w
hite balance) m

ode
—

Picture Cache Rec 
Turns picture cache recording m

ode on/off.
Setting retained

Focus M
agnifier

Turns the focus m
agnification function on/off.

Setting not retained
Zebra

Turns zebra display on/off.
Setting not retained

Shot M
ark1

W
rites Shot M

ark1.
—

Shot M
ark2

W
rites Shot M

ark2.
—

Clip Flag O
K

Adds/Clears an O
K m

ark to/from
 the clip being 

recorded or played.
Setting not retained

Clip Flag N
G

Adds/Clears an N
G

 m
ark to/from

 the clip being 
recorded or played.

Setting not retained

Clip Flag Keep
Adds/Clears a KP (Keep) m

ark to/from
 the clip 

being recorded or played.
Setting not retained

Flash Band Reduce
Turns the flashband correction function on/off.

Setting not retained

Functions That Can Be Assigned to the ASSIGN. 2 Switch

[N
ote]

Im
m

ediately after you assign a function to the ASSIG
N

. 2 sw
itch or you sw

itch the recording form
at, the setting of the sw

itch at 
that point m

ay not m
atch the cam

corder’s internal state. After assigning a function, sw
itch the ASSIG

N
. 2 sw

itch or pow
er the 

cam
corder off and on again.

Assignable Sw
itch setting

Function
O

ff
N

o assignm
ent

Front M
ic

Sw
itches betw

een stereo and m
onaural w

hen a stereo m
icrophone is connected.

M
arker

Turns the display of all m
arkers on/off.

Picture Cache Rec
 1)

Turns picture cache recording m
ode on/off.

Zebra
Turns zebra display on/off.

Clip Continuous Rec
Turns Clip Continuous Rec m

ode on/off.
Rec Source

Sw
itches the signals to be recorded betw

een the cam
era picture and external 

input. (If the cam
corder is currently recording or playing, the sw

itch takes effect 
after recording or playback ends.)

D
igital Extender ×2

Turns the screen m
agnification (×2) function on/off.

D
igital Extender ×3

Turns the screen m
agnification (×3) function on/off.

D
igital Extender ×4

Turns the screen m
agnification (×4) function on/off.

1) W
hen Picture Cache Rec is assigned, O

peration >Rec Function is disabled (grayed out) and cannot be set.
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Functions That Can Be Assigned to the ASSIGN. 1 and 3 Switches, the 
ASSIGNABLE 4 and 5 Switches, and the ONLINE Button

Assignable Sw
itch setting

Function
State w

hen cam
corder is 

next pow
ered on

O
ff

N
o assignm

ent
—

Front M
ic

Sw
itches betw

een stereo (O
n) and m

onaural (O
ff) 

w
hen a stereo m

icrophone is connected.
Setting retained

M
arker

Turns the display of all m
arkers on/off.

Setting retained
ATW

Turns ATW
 (auto tracing w

hite balance) m
ode on/

off.
Setting not retained

ATW
 H

old
H

old the w
hite balance setting in the ATW

 m
ode.

—
Turbo G

ain
Executes Turbo G

ain according to the setting of 
O

peration >G
ain Sw

itch >G
ain Turbo.

Setting not retained

Rec Review
Executes recording review

.
—

Rec
Starts or stops recording.

—
N

FC
Executes the N

FC function.
—

 
N

etw
ork Client M

ode
Turns netw

ork client m
ode on/off.

Setting retained
Stream

ing
Turns stream

ing transm
ission on/off.

Setting not retained
Auto U

pload(Proxy)
Turns proxy file auto transfer on/off.

Setting retained
Picture Cache Rec 

Turns picture cache recording m
ode on/off.

Setting retained
Spotlight

Turns the spotlight function in auto iris m
ode on/

off.
Setting retained

Backlight
Turns the backlight function in auto iris m

ode on/
off.

Setting retained

VF M
ode

Sw
itches the view

finder screen betw
een B&W

 
(O

n) and color (O
ff).

Setting retained

Video Signal M
onitor

Sw
itches the video signal m

onitor display 
function.

Setting retained

Lens Info
Sw

itches the depth of field indication betw
een 

off, displayed in m
eters, and displayed in feet.

Setting retained

Zoom
 Tele/W

ide
W

hen a lens that supports serial com
m

unication 
is installed, assigns the Zoom

 Tele function to 
ASSIG

N
ABLE 4, and assigns the Zoom

 W
ide 

function to ASSIG
N

ABLE 5 (displayed only w
hen 

<4> and <5> are set).

—

Zoom
 W

ide/Tele
W

hen a lens that supports serial com
m

unication 
is installed, assigns the Zoom

 W
ide function to 

ASSIG
N

ABLE 4, and assigns the Zoom
 Tele 

function to ASSIG
N

ABLE 5 (displayed only w
hen 

<4> and <5> are set).

—

Assignable Sw
itch setting

Function
State w

hen cam
corder is 

next pow
ered on

M
anual Focus Assist

Turns the m
anual focus assist function on/off.

Setting retained
Focus M

agnifier
Turns the focus m

agnification function on/off.
Setting not retained

Zebra
Turns zebra display on/off.

Setting not retained
Lens RET

D
isplays return video signal.

W
hen a cam

era extension unit is not connected: 
Rec Review

 (if playback is allow
ed)

—

Return Video
D

isplays the return 1 video signal.
—

Return Video2
D

isplays the return 2 video signal.
—

Return Video3
D

isplays the return 3 video signal.
—

Return Video4
D

isplays the return 4 video signal.
—

Shot M
ark1

W
rites Shot M

ark1.
—

Shot M
ark2

W
rites Shot M

ark2.
—

Clip Flag O
K

Adds/Clears an O
K m

ark to/from
 the clip being 

recorded or played.
Setting not retained

Clip Flag N
G

Adds/Clears an N
G

 m
ark to/from

 the clip being 
recorded or played.

Setting not retained

Clip Flag Keep
Adds/Clears a KP (Keep) m

ark to/from
 the clip 

being recorded or played.
Setting not retained

Color Tem
p SW

 3200K 
Adjusts w

hite balance using 3200K preset value.
Setting retained

Color Tem
p SW

 4300K 
Adjusts w

hite balance using 4300K preset value.
Setting retained

Color Tem
p SW

 5600K 
Adjusts w

hite balance using 5600K preset value.
Setting retained

Color Tem
p SW

 6300K 
Adjusts w

hite balance using 6300K preset value.
Setting retained

Electrical CC
Function that sw

itches the electrical CC filter 
(3200K/4300K/5600K/6300K) applied to w

hite 
balance adjustm

ent values.
Sequence w

ith each press of the sw
itch/button:

3200K �
 4300K �

 5600K �
 6300K

Can be changed using m
enu settings (Electrical 

CC <A> <B> <C> <D
>).

[N
ote]

This function is not available w
hen M

aintenance >W
hite 

Filter >N
D

 Filter C.Tem
p in the setup m

enu is set to O
n.

If you set N
D

 Filter C.Tem
p to O

n after assigning the 
function, the assignable sw

itch ceases to function.

Setting retained

CC5600K
Applies a 5600K electrical CC filter to w

hite 
balance adjustm

ent values.
Setting retained

Clip Continuous Rec
Turns Clip Continuous Rec m

ode on/off.
Setting not retained

Slot Select
W

hen recording m
edia is loaded in both card 

slots A and B, selects the card you w
ant to use.

—

D
igital Extender ×2

Turns the screen m
agnification (×2) function on/

off.
Setting not retained
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Assignable Sw
itch setting

Function
State w

hen cam
corder is 

next pow
ered on

D
igital Extender ×3

Turns the screen m
agnification (×3) function on/

off.
Setting not retained

D
igital Extender ×4

Turns the screen m
agnification (×4) function on/

off.
Setting not retained

D
igital Extender

×2×3×4
Sw

itches the m
agnification of the screen 

m
agnification function.

Each press of the sw
itch or button sw

itches in the 
order O

ff �
ˎ×2 �

ˎ×3 �
ˎ×4 �

ˎO
ff.

Setting not retained

Flash Band Reduce
Turns the flashband correction function on/off.

Setting not retained
Proxy Rec Start/Stop

Starts/stops proxy recording.
Setting not retained

Functions That Can Be Assigned to the RET Button on the Lens

Assignable Sw
itch setting

Function
State w

hen cam
corder is 

next pow
ered on

O
ff

N
o assignm

ent
—

Lens RET
D

isplays return video signal.
W

hen a cam
era extension unit is not connected: 

Rec Review
 (if playback is allow

ed)

—

Return Video
D

isplays return video signal.
—

Rec Review
Executes recording review

.
—

Shot M
ark1

W
rites Shot M

ark1.
—

Shot M
ark2

W
rites Shot M

ark2.
—

Clip Flag O
K

Adds/Clears an O
K m

ark to/from
 the clip being 

recorded or played.
Setting not retained

Clip Flag N
G

Adds/Clears an N
G

 m
ark to/from

 the clip being 
recorded or played.

Setting not retained

Clip Flag Keep
Adds/Clears a KP (Keep) m

ark to/from
 the clip 

being recorded or played.
Setting not retained

Focus M
agnifier

Turns the focus m
agnification function on/off.

Setting not retained
D

igital Extender ×2
Turns the screen m

agnification (×2) function on/
off.

Setting not retained

D
igital Extender ×3

Turns the screen m
agnification (×3) function on/

off.
Setting not retained

D
igital Extender ×4

Turns the screen m
agnification (×4) function on/

off.
Setting not retained

D
igital Extender

×2×3×4
Sw

itches the m
agnification of the screen 

m
agnification function.

Each press of the sw
itch or button sw

itches in the 
order O

ff �
ˎ×2 �

ˎ×3 �
ˎ×4 �

ˎO
ff.

Setting not retained

Proxy Rec Start/Stop
Starts/stops proxy recording.

Setting not retained
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You can save setup m
enu settings in the 

cam
corder’s internal m

em
ory and on SD

 cards. 
This allow

s you to quickly recall an appropriate set 
of m

enu settings for the current situation.
To save setup data on an SD

 card, insert a w
ritable 

SD
 card (page 32) into the U

TILITY SD
 card slot 

before proceeding.

Inserting an SD card (for saving configuration 
data)

1 
O

pen the sw
itch cover.

2 
Insert the SD

 card (for saving configuration 
data) in the U

TILITY SD
 card slot.

3 
Close the sw

itch cover.

Ejecting an SD card (for saving configuration data)

1 
O

pen the sw
itch cover.

2 
Press the SD

 card in slightly, then rem
ove the 

card.

[N
otes]
ˎˎ If the cam

corder is turned off or the SD
 card is rem

oved 
w

hile the SD
 is being accessed, the integrity of data on 

the card cannot be guaranteed. All data recorded on the 
card m

ay be discarded. Alw
ays m

ake sure the ACCESS 
indicator is off before turning off the cam

corder or 
rem

oving the SD
 card.

ˎˎ Take caution to prevent the SD
 card from

 flying out w
hen 

inserting/ejecting the card.

The follow
ing user data is supported.

User Files

U
ser files save the setting item

s and data of the 
custom

izable U
ser m

enu. You can save up to 64 
files on an SD

 card. By loading this file into the 
cam

corder m
em

ory, you can custom
ize the setup 

of the U
ser m

enu.

ALL Files

ALL files save the configuration data of all m
enus. 

You can save up to 64 files on an SD
 card.

[N
ote]

D
evice specific data (shading, output levels, and other data 

that requires adjustm
ent for the specific device) is not saved.

Scene Files

Scene files save adjustm
ents to Paint m

enu item
s 

for the purpose of shooting a particular scene. You 
can save up to five files in the cam

corder’s internal 
m

em
ory and up to 64 files on an SD

 card.
Scene files allow

 you to save the follow
ing types 

of data.
ˎˎ Values set in the Paint m

enu
ˎˎ Shutter speeds set in standard m

ode or ECS 
m

ode
ˎˎ W

hite balance data 
The data that is saved and loaded depends on 
the setting of File >Scene File >Scene W

hite 
D

ata in the setup m
enu.

Scene files can be stored in internal m
em

ory on 
the cam

corder or on an SD
 card.

Scene files can also be loaded into the cam
corder.

Reference Files

Reference files save the scene file standard settings 
(w

hen File ID
 is Standard). You can save one file in 

the cam
corder’s internal m

em
ory and one file on 

an SD
 card.

Lens Files

You can set the follow
ing data for correcting for 

the lens characteristics, and save the data as a 
lens file. You can save up to 32 lens files in the 
cam

corder’s internal m
em

ory and up to 64 lens 
files on an SD

 card.

Configuration data
Sub-item

s
V m

odulation shading 
correction values

M
 V M

odulation

Center m
arker position

Lens Center H
Lens Center V

Flare level
R Flare
G

 Flare
B Flare

W
hite balance correction 

value
W

hite O
ffset R

W
hite O

ffset B
W

hite shading correction 
value

Shading Ch Select
Shading H

 SAW
Shading H

 PARA
Shading V SAW
Shading V PARA

Gamma Files

You can save up to five user-defined gam
m

a 
table data files (U

ser G
am

m
a D

ata File) in internal 
m

em
ory.

U
ser Configuration D

ata
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Saving a User File

1 
Select File > U

ser File >Save SD
 Card in the 

setup m
enu.

A screen for selecting a user file save 
destination appears.

2 
Turn the M

EN
U

 knob to select a destination, 
then press the knob.
You can save files in row

s w
ith a File ID

 of “N
o 

File.” Selecting a row
 w

ith a specified File ID
 

nam
e w

ill overw
rite the selected file.

The File ID
 is generated autom

atically, but you 
can m

odify it.

3 
Turn the M

EN
U

 knob to select [Execute] on the 
confirm

ation m
essage screen, then press the 

knob.

Changing the File ID

1 
Select File >U

ser File >File ID
 in the setup 

m
enu.

A screen for editing the File ID
 appears.

2 
Select characters and enter the File ID

.

3 
Turn the M

EN
U

 knob to select [D
one], then 

press the knob.
The File ID

 is updated.

Loading a User File

1 
Select File >U

ser File >Load SD
 Card in the 

setup m
enu.

A user file list screen appears.

2 
Turn the M

EN
U

 knob to select a file to load, 
then press the knob.
A confirm

ation screen appears.

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

[N
ote]

The cam
corder w

ill reboot autom
atically after loading 

configuration data.

U
ser Files
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Saving Configuration Data as an ALL 
File

1 
Select File >All File >Save SD

 Card in the setup 
m

enu.
A screen for selecting an ALL file save 
destination appears.

2 
Turn the M

EN
U

 knob to select a destination, 
then press the knob.
You can save files in row

s w
ith a File ID

 of “N
o 

File.” Selecting a row
 w

ith a specified File ID
 

nam
e w

ill overw
rite the selected file.

The File ID
 is generated autom

atically, but you 
can m

odify it.

3 
Turn the M

EN
U

 knob to select [Execute] on the 
confirm

ation m
essage screen, then press the 

knob.

If an error message appears
O

ne of the follow
ing error m

essages m
ay appear 

during execution of the save, or as soon as you 
select [Execute]. In this case, the file is not saved.

Error 
m

essage
Problem

Solution

File Access
N

G
N

o recordable 
m

edia is inserted.
Insert recordable 
m

edia.

Changing the File ID

1 
Select File >All File >File ID

 in the setup m
enu.

A screen for editing the File ID
 appears.

2 
Select characters and enter the File ID

.

3 
Turn the M

EN
U

 knob to select [D
one], then 

press the knob.
The File ID

 is updated.

Loading Configuration Data

1 
Select File >All File >Load SD

 Card in the setup 
m

enu.
An ALL file list screen appears.

2 
Turn the M

EN
U

 knob to select a file to load, 
then press the knob.
A confirm

ation screen appears.

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

[N
otes]
ˎˎ W

hen you load a file from
 an SD

 card, the data saved in 
the cam

corder’s internal m
em

ory is overw
ritten.

ˎˎ W
hen loading files from

 one device to another, if the 
firm

w
are versions on the tw

o devices do not m
atch, the 

setting values for functions that are not supported on the 
destination device are not loaded.
ˎˎ The cam

corder w
ill reboot autom

atically after loading 
configuration data.

If an error message appears
O

ne of the follow
ing error m

essages m
ay appear 

during execution of the load, or as soon as you 
select [Execute]. In this case, the file is not loaded.

Error 
m

essage
Problem

Solution

File Access
N

G
There is no 
readable m

edia
The specified file 
does not exist on 
the m

edia

Insert the m
edia 

that contains the 
file you w

ant.

Restoring All Current Settings to 
Preset Values

In this docum
ent, initial setup m

enu settings 
configured/saved by the user are referred to as 
“preset values.”
Even after loading files to set up the cam

corder, 
and overw

riting original files w
ith new

 settings, 
you can reset the contents of the files by 
recovering the preset values.

1 
Select File >All File >All Preset in the setup 
m

enu.
A confirm

ation screen appears.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

Saving All Current Settings as Preset 
Values

1 
Select File >All File >Store All Preset in the 
setup m

enu.
A confirm

ation screen appears.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

[N
ote]

The cam
corder w

ill reboot autom
atically after executing.

Resetting Current Settings and Preset 
Values to Factory Default Settings

1 
Select File >All File >Clear All Preset in the 
setup m

enu.
A confirm

ation screen appears.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

[N
ote]

The cam
corder w

ill reboot autom
atically after executing.

ALL Files
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Saving a Scene File in Internal 
Memory

1 
Select File >Scene File >Store Internal M

em
ory 

in the setup m
enu.

A scene file list screen appears.
If the File ID

 is set to “Standard” destination, 
preconfigured standard settings are saved.

2 
Turn the M

EN
U

 knob to select a destination, 
then press the knob.
The scene file is saved, overw

riting any existing 
file, in the selected destination.

3 
Turn the M

EN
U

 knob to select [Execute] on the 
confirm

ation m
essage screen, then press the 

knob.

Saving a Scene File on an SD Card

1 
Select File >Scene File >Save SD

 Card in the 
setup m

enu.
A scene file save destination screen appears.

2 
Turn the M

EN
U

 knob to select a destination, 
then press the knob.
You can save files in row

s w
ith a File ID

 of “N
o 

File.” Selecting a row
 w

ith a specified File ID
 

nam
e w

ill overw
rite the selected file.

The File ID
 is generated autom

atically, but you 
can m

odify it.

3 
Turn the M

EN
U

 knob to select [Execute] on the 
confirm

ation m
essage screen, then press the 

knob.

Changing the File ID

1 
Select File >Scene File >File ID

 in the setup 
m

enu.
A screen for editing the File ID

 appears.

2 
Select characters and enter the File ID

.

3 
Turn the M

EN
U

 knob to select [D
one], then 

press the knob.
The File ID

 is updated.

Loading a Scene File from Internal 
Memory

1 
Select File >Scene File >Recall Internal M

em
ory 

in the setup m
enu.

A scene file list screen appears.

2 
Turn the M

EN
U

 knob to select a file to load, 
then press the knob.
A confirm

ation screen appears.

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

Load a Scene File from an SD Card

1 
Select File >Scene File >Load SD

 Card in the 
setup m

enu.
A scene file list screen appears.

2 
Turn the M

EN
U

 knob to select a file to load, 
then press the knob.
A confirm

ation screen appears.

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

Scene Files
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Saving Current Settings as Preset 
Values

1 
Select File >Reference File >Store Reference in 
the setup m

enu.
A confirm

ation screen appears.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

Saving Current Settings as Preset 
Values on an SD Card

1 
Select File >Reference File >Save Reference(SD

 
Card) in the setup m

enu.
A confirm

ation screen appears.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

Changing the File ID

1 
Select File >Reference File >File ID

 in the setup 
m

enu.
A screen for editing the File ID

 appears.

2 
Select characters and enter the File ID

.

3 
Turn the M

EN
U

 knob to select [D
one], then 

press the knob.
The File ID

 is updated.

Loading a Reference File from an SD 
Card

1 
Select File >Reference File >Load Reference(SD

 
Card) in the setup m

enu.
A confirm

ation screen appears.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

Resetting Current Settings and Preset 
Values to Factory Default Settings

1 
Select File >Reference File >Clear Reference in 
the setup m

enu.
A confirm

ation screen appears.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

Reference Files



000
8. Saving and Loading U

ser Configuration D
ata

122

Saving a Lens File in Internal Memory

1 
Select File >Lens File >Store Internal M

em
ory 

in the setup m
enu.

A lens file list screen appears.

2 
Turn the M

EN
U

 knob to select a destination, 
then press the knob.
You can save files in row

s w
ith File ID

 of “N
o 

offset.” Selecting a row
 w

ith a specified File ID
 

nam
e w

ill overw
rite the selected file.

The File ID
 is generated autom

atically, but you 
can m

odify it.

3 
Turn the M

EN
U

 knob to select [Execute] on the 
confirm

ation m
essage screen, then press the 

knob.

Saving a Lens File on an SD Card

1 
Select File >Lens File >Save SD

 Card in the 
setup m

enu.
A lens file save destination screen appears.

2 
Turn the M

EN
U

 knob to select a destination, 
then press the knob.
You can save files in row

s w
ith a File ID

 of “N
o 

File.” Selecting a row
 w

ith a specified File ID
 

nam
e w

ill overw
rite the selected file.

The File ID
 is generated autom

atically, but you 
can m

odify it.

3 
Turn the M

EN
U

 knob to select [Execute] on the 
confirm

ation m
essage screen, then press the 

knob.

Changing the File ID

1 
Select File >Lens File >File ID

 in the setup 
m

enu.
A screen for editing the File ID

 appears.

2 
Select characters and enter the File ID

.

3 
Turn the M

EN
U

 knob to select [D
one], then 

press the knob.
The File ID

 is updated.

Loading a Lens File from Internal 
Memory

1 
Select File >Lens File >Recall Internal M

em
ory 

in the setup m
enu.

A lens file list screen appears.

2 
Turn the M

EN
U

 knob to select a file to load, 
then press the knob.
A confirm

ation screen appears.

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

Loading a Lens File from an SD Card

1 
Select File >Lens File >Load SD

 Card in the 
setup m

enu.
A lens file list screen appears.

2 
Turn the M

EN
U

 knob to select a file to load, 
then press the knob.
A confirm

ation screen appears.

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

Loading a Lens File Automatically

W
hen you are using a lens that supports serial 

com
m

unication, you can set up the cam
corder 

by autom
atically loading the lens file that 

corresponds to the lens settings (Lens Auto Recall 
function).
To use the Lens Auto Recall function, set File >Lens 
File >Lens Auto Recall in the setup m

enu to one of 
the follow

ing.
O

ff: D
o not use the Lens Auto Recall function.

O
n (Lens N

am
e): Load the lens file that 

corresponds to the lens m
odel nam

e.
O

n (Serial N
um

ber): Load the lens file that 
corresponds to the lens m

odel nam
e and 

serial num
ber (w

hen the lens supports 
com

m
unication of the serial num

ber).
If the lens does not support com

m
unication of 

the serial num
ber, even w

hen set to O
n (Serial 

N
um

ber), load the lens file that corresponds to the 
lens m

odel nam
e.

Lens Files
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Checking the Current Gamma File 
Settings (File Names)

Select File >U
ser G

am
m

a >Current Settings in 
the setup m

enu to display a list of the currently 
configured user gam

m
a files.

Loading a User Gamma File from an 
SD Card

1 
Select File >U

ser G
am

m
a >Load SD

 Card in the 
setup m

enu.
A user gam

m
a file list screen appears.

2 
Turn the M

EN
U

 knob to select a file to load, 
then press the knob.
A confirm

ation screen appears.

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

Using User Gamma Files Created 
Using CvpFileEditorTM V4.3

Save created user gam
m

a files to be loaded in the 
“PRIVATE/SO

N
Y/PRO

/CAM
ERA/H

D
_CAM

” directory 
of the SD

 card.

Resetting a User Gamma File to Initial 
State

1 
Select File >U

ser G
am

m
a >Reset in the setup 

m
enu.

A gam
m

a file num
ber reset screen appears.

2 
Turn the M

EN
U

 knob to select the num
ber of 

the gam
m

a file to reset (1 to 5).
To reset all gam

m
a files, select [All].

A confirm
ation screen appears.

3 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.

G
am

m
a Files
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Connecting a Rem
ote Control U

nit
W

hen an RM
-B170 Rem

ote Control U
nit, 

RCP1001/1501 Rem
ote Control Panel, or other 

control unit is connected, som
e cam

corder 
functions can be controlled from

 that unit.
You can use the display on the RM

-B170 or a video 
m

onitor connected to the M
O

N
ITO

R connector 
of the rem

ote control unit to perform
 cam

corder 
m

enu operations and m
onitor the cam

corder 
picture.

Connecting a Remote Control Unit

U
sing the rem

ote control cable, connect betw
een 

the REM
O

TE connector (8-pin) of the cam
corder 

and the cam
era connector of the rem

ote control 
unit.
W

hen you turn on the cam
corder after m

aking the 
connection, the cam

corder enters rem
ote control 

m
ode, enabling m

enu operations and shooting 
operations.

[N
otes]
ˎˎ Rem

ote control operation is not supported if U
SB 

connection to the cam
corder is enabled.

ˎˎ If a U
SB connection to the cam

corder is enabled during 
rem

ote control, rem
ote control m

ode is released.
ˎˎ D

o not connect or disconnect the rem
ote control unit 

w
hen the cam

corder is on.
ˎˎ A rem

ote control cable is not supplied w
ith the RCP-

1001/1501 Rem
ote Control U

nit.

The follow
ing sw

itches of the cam
corder are 

disabled w
hen a rem

ote control unit is connected.
ˎˎ G

AIN
 sw

itch
ˎˎ W

H
ITE BAL sw

itch
ˎˎ AU

TO
 W

/B BAL sw
itch

ˎˎ SH
U

TTER sw
itch

ˎˎ O
U

TPU
T/D

CC sw
itch

ˎˎ ASSIG
N

. 1/3 sw
itches, ASSIG

N
ABLE 4/5 sw

itches, 
and the O

N
LIN

E button to w
hich the Turbo G

ain 
or ATW

 function has been assigned

Releasing Remote Control Mode

Turn off the cam
corder and disconnect the rem

ote 
control unit.
The sw

itch settings on the cam
corder becom

e 
enabled.

Connecting a Monitor to an RM-B170

The M
O

N
ITO

R connector (BN
C type) of the RM

-
B170 outputs the sam

e signal as the output from
 

the VID
EO

 O
U

T connector.
To connect a m

onitor to the M
O

N
ITO

R connector 
on the RM

-B170, use the black cable supplied w
ith 

the RM
-B170.

Image Quality Adjustment when an 
RM-B170 is Connected

W
hen the RM

-B170 is connected, the param
eters 

for cam
era im

age quality adjustm
ent item

s (paint 
data) are set to the param

eters that w
ere specified 

the last tim
e that the RM

-B170 w
as connected.

Function of Recording Start/Stop 
Buttons when an RM-B170 is 
Connected

Set the function of the buttons using M
aintenance 

>Cam
era Config >RM

 Rec Start in the setup m
enu.

The functions of the buttons for the RM
 Rec Start 

settings are given below
.

Button
RM

 Rec Start setting
RM

Cam
era

PARA
Cam

corder REC 
START button

D
isabled

Enabled
Enabled

Lens VTR button
D

isabled
Enabled

Enabled

ASSIG
N

. 1/3 
sw

itches, 
ASSIG

N
ABLE 4/5 

sw
itches, and 

O
N

LIN
E button 

assigned w
ith 

recording start/
stop function

D
isabled

Enabled
Enabled

RM
-B170 VTR 

button
Enabled

D
isabled

Enabled

Data Structure of Image Quality 
Adjustment Data

The non-volatile m
em

ory of the cam
corder used 

for storing cam
era im

age quality adjustm
ent data 

(paint data) consists of the tw
o regions show

n 
below

: a “m
ain data block” that is used w

hen 
a rem

ote control unit is not connected, and a 
“rem

ote control data block” that is used w
hen a 

rem
ote control unit is connected. Paint adjustm

ent 
data is autom

atically selected and output to the 
cam

era section depending on w
hether or not 

a rem
ote control unit, such as the RM

-B170, is 
connected.

Cam
corder setup m

enu

M
ain data block

Rem
ote control data 

block

Cam
era unit hardw

are

RM
-B170 connected

RM
-B170 not connected RM

-B170

Cam
corder non-volatile m

em
ory

W
hen a rem

ote control unit is connected, the 
“rem

ote control data block” is selected as the 
current paint data block, and the paint adjustm

ent 
param

eters that w
ere in effect the last tim

e the 
rem

ote control unit w
as used are loaded.

H
ow

ever, w
hen the settings of absolute value 

controls
 1) and absolute value sw

itches
 2) are set 

on the rem
ote control unit, the settings on the 

rem
ote control unit override the settings on the 

cam
corder.

W
hen the rem

ote control unit is disconnected 
from

 the cam
corder, the “m

ain data block” is re-
enabled, and the cam

corder returns to the settings 
that w

ere in effect before the rem
ote control unit 

w
as connected.

1) Absolute value controls: D
ata corresponding to the 

angular position of the control is output. Controls for 
w

hich data corresponding to the am
ount of rotation is 

output are called relative value controls.
2) Absolute value sw

itches: Sw
itches (or knobs), such 

as toggle sw
itches or slide sw

itches (except m
ost 

m
om

entary sw
itches) w

hose positions m
ust coincide w

ith 
their functions are called absolute value sw

itches.

W
hen M

aintenance >Cam
era Config >RM

 
Com

m
on M

em
ory in the setup m

enu is set to 
[O

n], you can use settings of the paint adjustm
ent 
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data stored in the m
ain data block even if a 

rem
ote control unit is connected. In this case, 

the settings stored in the m
ain data block w

ill 
be updated w

hen you change the settings on 
the rem

ote control unit. Thus, the settings of the 
paint data m

ade w
ith the rem

ote control unit w
ill 

be retained even after the rem
ote control unit is 

rem
oved. H

ow
ever, if the sw

itch position on the 
rem

ote control unit differs from
 the one on the 

cam
corder, the sw

itch position on the cam
corder 

takes precedence.
Also, it is possible to keep the settings that are in 
effect before you connect the rem

ote control unit. 
In this case, you m

ust set the control knobs to 
relative value m

ode on the rem
ote control unit.

For details, refer to the operation m
anual supplied w

ith the 
rem

ote control unit.

Operating the Menu from the 
RM-B170

1 
Set the D

ISPLAY sw
itch to the M

EN
U

 position.
The m

enu is displayed on the m
onitor 

connected to the M
O

N
ITO

R connector of the 
RM

-B170.

2 
Select and set m

enu item
s using the M

EN
U

 
SELECT knob and CAN

CEL/EN
TER sw

itch.

3 
W

hen finished, set the D
ISPLAY sw

itch to the 
O

N
 or O

FF position to exit the m
enu.

For details about RM
B170 operation, refer to the operation 

m
anual of the RM

-B170.
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Select the output signal and use an appropriate cable for the m
onitor to be connected.

BN
C cable (not supplied)

BN
C cable (not supplied)

Regardless of w
hether the signal is H

D
 or SD

, 
the sam

e status inform
ation and m

enus can be 
displayed on the external m

onitor as those on the 
view

finder screen.

[N
ote]

The SD
 signal dow

n-converted output is enabled w
hen 

O
peration >Input/O

utput >O
utput Form

at in the setup 
m

enu is set to 720×486i or 720×576i.

SDI OUT Connector (BNC)

The SD
I O

U
T connector can be used to connect a 

device that supports SD
I. The device type can be a 

m
onitor, sw

itcher, VTR, or other recording device.
The output signal from

 this connector can be 
turned on and off using O

peration >Input/O
utput 

>SD
I O

ut1 O
utput/SD

I O
ut2 O

utput in the setup 
m

enu (page 91).
For connection, use a BN

C cable (not supplied).

VIDEO OUT Connector

The VID
EO

 O
U

T connector can be used to connect 
a device that supports analog com

posite signals. 
The device type can be a m

onitor, VTR, or other 
recording device.
The output signal changes in conjunction w

ith 
the setting of O

peration >Input/O
utput >O

utput 
Form

at in the setup m
enu.

To input the VID
EO

 O
U

T connector output signal 
to an external analog com

posite device, it m
ay 

be necessary to change the input signal setting 

of that external device to m
atch the analog 

com
posite signal setting for the VID

EO
 O

U
T 

connector.
To input cam

corder output audio to an external 
device such as a m

onitor, VTR, or other recording 
device, connect the audio output of the AU

D
IO

 
O

U
T connector to the audio input of that external 

device.
For connection, use a BN

C cable (not supplied).

HDMI OUT Connector (Type A 
Connector)

You can turn the output signal from
 the 

cam
corder on/off using O

peration >Input/O
utput 

>H
D

M
I O

utput in the setup m
enu.

The output signal form
at is set using O

peration 
>Input/O

utput >O
utput Form

at in the setup 
m

enu.
U

se a com
m

ercially available H
D

M
I cable for 

connection.

Connecting an External M
onitor
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The clips recorded on SxS m
em

ory cards w
ith this 

cam
corder can be controlled on a com

puter or 
edited using optional nonlinear editing softw

are.
You can copy clips on SxS m

em
ory cards to 

portable storage or other U
SB m

edia if portable 
m

edia/U
SB m

edia is connected to the external 
device connection connector.

USB Connection with a Computer

W
hen you connect the cam

corder to a com
puter 

using a U
SB cable (not supplied), the m

em
ory card 

in the slot is recognized as an extended drive by 
the com

puter.
W

hen tw
o m

em
ory cards are m

ounted in 
the cam

corder, they are recognized as tw
o 

independent extended drives by the com
puter.

U
SB cable 

(not supplied)

[N
otes]
ˎˎ Turn the cam

corder on and w
ait until the im

age and 
inform

ation are displayed on the screen, then connect the 
U

SB cable to the cam
corder.

ˎˎ W
hen connecting the U

SB cable to the com
puter, be 

careful to check the form
 and direction of the U

SB 
connector.
ˎˎ The cam

corder does not w
ork on the bus pow

er from
 the 

com
puter.

To start USB connection
W

hen you connect a com
puter to the PC 

connector w
ith a U

SB cable (not supplied), the 
m

essage “Connect U
SB N

ow
?” is displayed to 

prom
pt you to confirm

 that you w
ish to enable the 

U
SB connection.

If you select “Cancel” or push the M
EN

U
 CAN

CEL/
PRST/ESCAPE sw

itch dow
n to the ESCAPE position, 

or if you disconnect the U
SB cable, the m

essage 
“Connect U

SB N
ow

?” disappears.
If you select “Execute” and press the M

EN
U

 knob, 
the U

SB connection is enabled and the cam
corder 

is recognized as an extension drive.
If the U

SB connection is enabled during recording/
playback operation, the operation is stopped and 
the m

essage “U
SB Connecting” appears on the 

view
finder screen.

At this tim
e, the output signal from

 the VID
EO

 O
U

T 
connector and SD

I O
U

T 1/2 connectors changes to 
a black signal.

[N
otes]
ˎˎ The cam

corder cannot be operated for recording, 
playback, and so on w

hile the m
essage “U

SB Connecting” 
is displayed.
ˎˎ W

hen the com
puter accesses the m

edia loaded in 
the cam

corder, do not try to carry out the follow
ing 

operations.
 –

O
perating the cam

corder (turning the pow
er on/off, 

sw
itching the operating m

ode, etc.)
 –

Rem
oving or loading a m

edia from
 an active slot 

(being accessed from
 the com

puter)
 –

Rem
oving or connecting the U

SB cable

Releasing the USB connection
To release the U

SB connection, follow
 the sam

e 
procedure as that for rem

oving a device from
 the 

com
puter.

To enable the U
SB connection again, first 

disconnect the U
SB cable and then reconnect it. 

The m
essage “Connect U

SB N
ow

?” appears again.

To remove an SxS memory card

On W
indows

1 
Click on the “Safely Rem

ove H
ardw

are” icon on 
the task bar of the com

puter.

2 
Select “Safely rem

ove SxS M
em

ory Card - 
D

rive(X:)” from
 the displayed m

enu.

3 
Check that the “Safe To Rem

ove H
ardw

are” 
m

essage appears, then rem
ove the card.

On Macintosh
D

rag the SxS m
em

ory card icon on the desktop to 
the Trash.
If the SxS m

em
ory card icon is displayed in the 

Finder, click on the eject icon.

To use the application software
To copy clips to the local disk of your com

puter, 
the dedicated application softw

are m
ust be 

dow
nloaded and installed on your com

puter. For 
details about dow

nloading softw
are, see “Softw

are 
D

ow
nloads” (page 147).

Although the data regarding recorded m
aterials 

are stored over m
ultiple files and folders, you 

can easily handle the clips w
ithout considering 

such data and directory structure by using the 
dedicated application softw

are.

[N
ote]

If you perform
 operations on clips, such as copying the clips 

on the SxS m
em

ory card using Explorer (W
indow

s) or Finder 
(M

acintosh), the subsidiary data contained by the clips m
ay 

not be m
aintained.

To use a nonlinear editing system
In a nonlinear editing system

, editing softw
are 

(option) that supports the form
ats recorded by the 

cam
corder is required.

Store the clips to be edited on the H
D

D
 of 

your com
puter in advance, using the supplied 

application softw
are.

Som
e editing softw

are m
ay not operate properly. 

Be sure to confirm
 before use that it conform

s to 
the recording form

ats used w
ith this cam

corder.

Connecting Portable Storage/USB 
Media

W
hen portable storage, U

SB H
D

D
, or sim

ilar m
edia 

is connected to the external device connection 
connector, you can copy clips from

 the recording 
m

edia inserted in an SxS card slot of the 
cam

corder to U
SB m

edia.

1 
Specify the destination folder for copying clips 
in O

peration >U
SB >Select Folder in the setup 

m
enu.

You can also select [N
ew

] on the screen to 
create a new

 folder.

 
[N

ote]
If a folder is not specified, a folder is autom

atically 
created w

ith a folder nam
e the sam

e as the creation 
date of the first clip to be copied, and clips are copied 
to that folder.

2 
Select O

peration >U
SB >Copy to U

SB in the 
setup m

enu.

3 
Select the slot in w

hich the target recording 
m

edia is inserted.
M

edia(A) to U
SB: Copy all clips from

 the 
recording m

edia inserted in slot A.
M

edia(B) to U
SB: Copy all clips from

 the 
recording m

edia inserted in slot B.
M

edia(A)(B) to U
SB: Copy all clips from

 the 
recording m

edia inserted in slot A and slot 
B.

M
anaging/Editing Clips w

ith a Com
puter
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[N

ote]
W

hen a copy destination folder is specified in step 1 and 
M

edia(A)(B) to U
SB is selected, slot A clips are copied to 

the specified destination folder. Slot B clips are copied 
to a folder that is autom

atically created w
ith a folder 

nam
e the sam

e as the creation date of the first clip.

4 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
All clips on the target recording m

edia are 
copied to the U

SB m
edia.

 
[N

ote]
If a clip w

ith the sam
e file nam

e as the clip to copy 
already exists in the destination folder, the clip is not 
copied.

Displaying a list of clips on portable storage/USB 
media
You can display a list of the clips on portable 
storage/U

SB m
edia using O

peration >U
SB >View

 
Clip List in the setup m

enu.

Renaming a folder on portable storage/USB 
media
You can renam

e a folder using O
peration >U

SB 
>Renam

e Folder in the setup m
enu.

1 
Select O

peration >U
SB >Renam

e Folder in the 
setup m

enu.

2 
Select the folder to renam

e, and press the SET 
button.
A file nam

e input screen appears.

3 
Enter a folder nam

e, and select [D
one] on the 

screen.
The folder is renam

ed.

Checking for copy read errors
You can check for read errors after w

riting clips by 
setting O

peration >U
SB >Error Check in the setup 

m
enu to O

n.

Formatting portable storage/USB media
You can form

at portable storage/U
SB m

edia in 
exFAT form

at using O
peration >U

SB >Form
at U

SB 
in the setup m

enu.

1 
Select O

peration >U
SB >Form

at U
SB in the 

setup m
enu.

2 
Turn the M

EN
U

 knob to select [Execute], then 
press the knob.
Initialization (form

atting) begins.

3 
W

hen the form
atting is com

pleted, a m
essage 

appears on the screen. Select [O
K].

Checking free space on portable storage/USB 
media
The free space on portable storage/U

SB m
edia is 

displayed in the M
edia Rem

ain row
 on the screen 

displayed w
hen O

peration >U
SB in the setup 

m
enu is selected.

About power supply to portable storage/USB 
media
Pow

er is supplied to portable storage/U
SB m

edia 
from

 the external device connector autom
atically 

w
hen perform

ing an operation in O
peration >U

SB 
in the setup m

enu.
H

ow
ever, pow

er supply is not started under the 
follow

ing conditions, even w
hen perform

ing an 
operation in O

peration >U
SB in the setup m

enu. 
To start the supply of pow

er, perform
 the solution 

show
n in the table.

State
Solution

D
uring clip recording, 

playback, thum
bnail 

display, proxy recording, 
stream

ing, proxy transfer, 
or live transfer m

ode

Term
inate the previous 

operation.

N
etw

ork Client M
ode is 

O
n

Set N
etw

ork Client M
ode 

to O
ff.

M
edia adaptor is 

connected
U

nm
ount the m

edia 
adaptor connection.

[N
otes]
ˎˎ Clips on portable storage or other U

SB m
edia cannot be 

copied to recording m
edia inserted in an SxS card slot.

ˎˎ Clips cannot be recorded w
hile pow

er is supplied to 
the external device connector. To start recording clips, 
term

inate the O
peration >U

SB operation in the setup 
m

enu.
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You can m
ount a CA-FB70/TX70 H

D
 Cam

era Adaptor to the cam
corder and connect a Cam

era Control 
U

nit (CCU
).

This allow
s you to configure a shooting and recording system

 consisting of m
ultiple cam

corders w
ith 

cam
era extension units connected to a rem

ote control unit.

For m
ore inform

ation about the CA-FB70 and CA-TX70, refer to their respective operation m
anuals.

[N
otes]
ˎˎ W

hen using the cam
corder in this system

, do not connect a video light to the cam
corder.

ˎˎ Supported only for XAVC and M
PEG

 H
D

 recording.
ˎˎ N

ot supported for proxy recording and w
ireless LAN

 connection function.

Tally and Call Indicators

The tally and call indicators for a system
 are as follow

s.

D
ata received from

 system
H

D
VF LED

 indicators
Text display on view

finder screen

Tally
G

reen 
Tally

CA call
N

on-CA 
call

REC/
TALLY 
LED

G
REEN

 
TALLY 
LED

Ć
Ć

CALL

O
FF

O
FF

O
FF

O
FF

N
ot lit

N
ot lit

N
o display

N
o display

N
o display

O
FF

O
FF

O
FF

O
N

Lit
N

ot lit
Ć

N
o display

CALL
O

FF
O

FF
O

N
O

FF
N

ot lit
N

ot lit
N

o display
N

o display
CALL

O
FF

O
FF

O
N

O
N

Lit
N

ot lit
Ć

N
o display

CALL
O

FF
O

N
O

FF
O

FF
N

ot lit
Lit

N
o display

Ć
N

o display
O

FF
O

N
O

FF
O

N
Lit

Lit
Ć

Ć
CALL

O
FF

O
N

O
N

O
FF

N
ot lit

Lit
N

o display
Ć

CALL
O

FF
O

N
O

N
O

N
Lit

Lit
Ć

Ć
CALL

O
N

O
FF

O
FF

O
FF

Lit
N

ot lit
Ć

N
o display

N
o display

O
N

O
FF

O
FF

O
N

N
ot lit

N
ot lit

N
o display

N
o display

CALL
O

N
O

FF
O

N
O

FF
Lit

N
ot lit

Ć
N

o display
CALL

O
N

O
FF

O
N

O
N

N
ot lit

N
ot lit

N
o display

N
o display

CALL
O

N
O

N
O

FF
O

FF
Lit

Lit
Ć

Ć
N

o display
O

N
O

N
O

FF
O

N
N

ot lit
Lit

N
o display

Ć
CALL

O
N

O
N

O
N

O
FF

Lit
Lit

Ć
Ć

CALL
O

N
O

N
O

N
O

N
N

ot lit
Lit

N
o display

Ć
CALL

[N
ote]

Alarm
 indications using the tally indicator in the w

arning display are not displayed w
hile a CA-FB70/TX70 Cam

era Adaptor is 
connected.

Configuring a Shooting and Recording System
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Supported Formats and Limitations of Shooting/Recording Systems

The supported form
ats and operation lim

itations of a shooting/recording system
 com

prising the 
cam

corder, cam
era adaptor, and cam

era control unit are show
n in the follow

ing table.

O
peration m

enu
System

 form
at of  

cam
era adaptor /  

cam
era control unit

Cam
corder 

lim
itation

Form
at

Input/O
utput

Return video 
display

Frequency
Rec Form

at
O

utput Form
at

SD
I

59.94
XAVC-I 1920×1080P

1920×1080i
1920×1080 59.94i

N
o

XAVC-L 50 1920×1080P
XAVC-L 35 1080P 
XAVC-I 1920×1080i

1920×1080i
1920×1080 59.94i

Yes
XAVC-L 50 1920×1080i
XAVC-L 35 1080i
XAVC-L 25 1080i
H

D
422 50 1080i

H
Q

 1920×1080i
H

Q
 1440×1080i

XAVC-I 1280×720P
1280×720P

1280×720 59.94P
Yes

XAVC-L 50 1280×720P
H

D
422 50 720P

H
Q

 1280×720P
29.97

XAVC-I 1920×1080P
1920×1080PsF

1920×1080 29.97PsF
 a)

1920×1080 59.94i
Yes

XAVC-L 50 1920×1080P
XAVC-L 35 1080P
H

D
422 50 1080P

H
Q

 1920×1080P
H

D
422 50 720P

1280×720P
1280×720 59.94P

N
o

23.98
XAVC-I 1920×1080P

1920×1080i 
(2-3PD

)
1920×1080 59.94i

N
o

XAVC-L 50 1920×1080P
XAVC-L 35 1080P
H

D
422 50 1080P

H
Q

 1920×1080P
H

D
422 50 720P

1280×720P 
(2-3PD

)
1280×720 59.94P

N
o

O
peration m

enu
System

 form
at of  

cam
era adaptor /  

cam
era control unit

Cam
corder 

lim
itation

Form
at

Input/O
utput

Return video 
display

Frequency
Rec Form

at
O

utput Form
at

SD
I

50
XAVC-I 1920×1080P

1920×1080i
1920×1080 50i

N
o

XAVC-L 50 1920×1080P
XAVC-L 35 1080P
XAVC-I 1920×1080i

1920×1080i
1920×1080 50i

Yes
XAVC-L 50 1920×1080i
XAVC-L 35 1080i
XAVC-L 25 1080i
H

D
422 50 1080i

H
Q

 1920×1080i
H

Q
 1440×1080i

XAVC-I 1280×720P
1280×720P

1280×720 50P
Yes

XAVC-L 50 1280×720P
H

D
422 50 720P

H
Q

 1280×720P
25

XAVC-I 1920×1080P
1920×1080PsF

1920×1080 25PsF
 a)

1920×1080 50i
Yes

XAVC-L 50 1920×1080P
XAVC-L 35 1080P
H

D
422 50 1080P

H
Q

 1920×1080P
H

D
422 50 720P

1280×720P
1280×720 50P

N
o

a) A PsF setting is recom
m

ended w
hen a CA-TX70 Cam

era Adaptor is connected.

[N
ote]

In a shooting/recording system
, special recording functions, such as w

ireless LAN
 connection function or Slow

 & Q
uick M

otion, 
cannot be used sim

ultaneously.
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You can record SD
I signals from

 devices connected to the SD
I IN

 connector of the cam
corder.

To output and record input signals instead of the cam
era picture, set O

peration >Input/O
utput >Source 

Select in the setup m
enu to [External].

[N
otes]
ˎˎ External input signals cannot be recorded in Slow

 & Q
uick M

otion m
ode. W

hen a special recording m
ode, such as Slow

 & 
Q

uick M
otion m

ode, is selected, the recording m
ode is canceled w

hen you set O
peration >Input/O

utput >Source Select in 
the setup m

enu to [External].
ˎˎ Execution of autom

atic adjustm
ent functions, such as autom

atic black balance, and operations, such as playback, Rec 
Review

, and thum
bnail display, w

ill end w
hen O

peration >Input/O
utput >Source Select in the setup m

enu is set to 
[External]. The cam

corder enters stop m
ode and then the cam

era picture sw
itches to external input.

ˎˎ Recording m
ay stop if the input signal is disturbed w

hile recording external input. Recording autom
atically resum

es w
hen 

the input signal returns to norm
al.

ˎˎ N
ot supported for proxy recording and w

ireless LAN
 connection function.

Supported External Input Signal Formats and Camcorder Recording Formats

H
D

/SD
O

peration >Form
at >Rec 

Form
at in the setup m

enu
O

peration >Form
at 

>Frequency in the setup m
enu

Supported external input signal 
form

ats

H
D

XAVC-I 1920×1080i
59.94

H
D

 1920×1080 29.97PsF/59.94i
H

D
 1280×720 59.94P

50
H

D
 1920×1080 25PsF/50i

H
D

 1280×720 50P
XAVC-I 1280×720P

59.94
H

D
 1920×1080 29.97PsF/59.94i

H
D

 1280×720 59.94P
50

H
D

 1920×1080 25PsF/50i
H

D
 1280×720 50P

XAVC-L 50 1920×1080i
59.94

H
D

 1920×1080 29.97PsF/59.94i
H

D
 1280×720 59.94P

50
H

D
 1920×1080 25PsF/50i

H
D

 1280×720 50P
XAVC-L 50 1280×720P

59.94
H

D
 1920×1080 29.97PsF/59.94i

H
D

 1280×720 59.94P
50

H
D

 1920×1080 25PsF/50i
H

D
 1280×720 50P

H
D

422 50 1080i
59.94

H
D

 1920×1080 29.97PsF/59.94i
H

D
 1280×720 59.94P

50
H

D
 1920×1080 25PsF/50i

H
D

 1280×720 50P

H
D

/SD
O

peration >Form
at >Rec 

Form
at in the setup m

enu
O

peration >Form
at 

>Frequency in the setup m
enu

Supported external input signal 
form

ats

H
D

H
D

422 50 720P
59.94

H
D

 1920×1080 29.97PsF/59.94i
H

D
 1280×720 59.94P

50
H

D
 1920×1080 25PsF/50i

H
D

 1280×720 50P
H

Q
 1920×1080i

59.94
H

D
 1920×1080 29.97PsF/59.94i

H
D

 1280×720 59.94P
50

H
D

 1920×1080 25PsF/50i
H

D
 1280×720 50P

H
Q

 1440×1080i
59.94

H
D

 1920×1080 29.97PsF/59.94i
H

D
 1280×720 59.94P

50
H

D
 1920×1080 25PsF/50i

H
D

 1280×720 50P
H

Q
 1280×720P

59.94
H

D
 1920×1080 29.97PsF/59.94i

H
D

 1280×720 59.94P
50

H
D

 1920×1080 25PsF/50i
H

D
 1280×720 50P

SD
M

PEG
 IM

X 50
59.94

SD
 486 59.94i

50
SD

 576 50i
D

VCAM
59.94

SD
 486 59.94i

50
SD

 576 50i

Recording External Input Signals
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M
aintenance

Cleaning the Viewfinder

U
se a dust blow

er to clean the CRT screen and 
m

irror inside the view
finder barrel.

Clean the lens and protecting filter w
ith a 

com
m

ercially available lens cleaner.

[N
ote]

N
ever use organic solvents such as thinners.

Note about the Battery Terminals

The battery term
inal of this unit (the connector for 

battery packs and AC adaptors) is a consum
able 

part.
Pow

er m
ay not be supplied to the unit properly 

if the pins of the battery term
inal are bent or 

deform
ed by shock or vibrations, or if they becom

e 
corroded due to prolonged outdoor use.
Periodic inspections are recom

m
ended to keep 

the unit w
orking properly and to prolong its 

usable lifetim
e.

Contact a Sony service or sales representative for 
m

ore inform
ation about inspections.

Exchanging the Battery of the 
Internal Clock

The cam
corder’s internal clock is pow

ered by a 
lithium

 battery. If the m
essage “BackU

p Battery 
End” appears in the view

finder, this battery 
m

ust be exchanged. Contact a Sony service 
representative.
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If a w
arning, caution, or operating condition that requires confirm

ation occurs on the cam
corder, a m

essage is displayed in the view
finder, the corresponding indicators start flashing, and a w

arning sound is em
itted.

You can adjust the volum
e of the w

arning sound using the ALARM
 knob. If the ALARM

 knob is set to m
inim

um
, the w

arning sound w
ill not be audible.

Error Display

The cam
corder w

ill stop operation w
hen the follow

ing kind of display occurs.
Error m

essage
W

arning sound
W

ARN
IN

G
 

indicator
Tally/REC indicator

Cause and Solution

E + error code
Continuous

—
H

igh-speed flashing
Indicates an abnorm

ality in the cam
corder.

Turn off the cam
corder, and check for any problem

 w
ith connected devices, cables, or m

edia.
(If the cam

corder does not turn off w
hen the PO

W
ER sw

itch is set to O
FF, rem

ove the battery or disconnect the AC supply.)
If the error persists w

hen the cam
corder is turned on again, contact your Sony service representative.

W
arning Display

Follow
 the instructions provided if the follow

ing display occurs.
W

arning m
essage

W
arning sound

W
ARN

IN
G

 
indicator

Tally/REC indicator
Cause and Solution

M
edia N

ear Full
Interm

ittent
Flashing

Flashing
The rem

aining capacity on the SxS m
em

ory card is getting low
.

Replace at the earliest convenience.
M

edia Full
Continuous

O
n

H
igh-speed flashing

Clips could not be recorded, copied, or split because there is no rem
aining capacity on the SxS m

em
ory card.

Replace im
m

ediately.
Battery N

ear End
Interm

ittent
Flashing

Flashing
The rem

aining capacity of the battery pack is getting low
.

Recharge at the earliest convenience.
(The battery indicator flashes in the view

finder.)
Battery End

Continuous
O

n
H

igh-speed flashing
The battery pack is dead.
Recording is disabled.
Connect a pow

er source to D
C IN

 and allow
 the battery pack to recharge w

ithout attem
pting to operate the cam

corder.
(The battery indicator flashes in the view

finder.)
Tem

perature H
igh

Interm
ittent

Flashing
Flashing

The internal tem
perature is high.

Turn off the cam
corder and allow

 it to cool dow
n before operating it again.

Voltage Low
Interm

ittent
Flashing

Flashing
The D

C IN
 voltage is low

 (level 1).
Check the pow

er source.
Insufficient Voltage

Continuous
O

n
H

igh-speed flashing
The D

C IN
 voltage is too low

 (level 2).
Recording is disabled.
Connect a different pow

er source.
(The battery indicator flashes in the view

finder.)

Error/W
arning System
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W
arning m

essage
W

arning sound
W

ARN
IN

G
 

indicator
Tally/REC indicator

Cause and Solution

Clips Full
Continuous

O
n

H
igh-speed flashing

The m
axim

um
 num

ber of clips that can be recorded on an SxS m
em

ory card has been reached. Recording or copying m
ore 

clips is not possible. Replace im
m

ediately.
Last Clip Recording

Interm
ittent

Flashing
Flashing

The clip currently recording is the last clip that can be recorded, as the m
axim

um
 num

ber of clips has been reached.
Prepare a new

 SxS m
em

ory card.
Clips N

ear Full
Interm

ittent
Flashing

Flashing
The num

ber of additional clips that can be recorded on the SxS m
em

ory card is getting low
.

Replace at the earliest convenience.
M

edia(Proxy) Full
Continuous

O
n

H
igh-speed flashing

Proxy data cannot be recorded because there is no rem
aining free space on the proxy data SD

 card. Replace im
m

ediately.
Clips(Proxy) Full

Continuous
O

n
H

igh-speed flashing
The m

axim
um

 num
ber of clips that can be recorded on the proxy data SD

 card has been reached. Recording m
ore clips is not 

possible. Replace im
m

ediately.
M

edia(Proxy) N
ear Full

Interm
ittent

Flashing
Flashing

The rem
aining free space on the proxy data SD

 card is getting low
.

Replace at the earliest convenience.
Last Clip(Proxy) Rec

Interm
ittent

Flashing
Flashing

The proxy data currently recording is the last clip that can be recorded, as the m
axim

um
 num

ber of clips has been reached.
Prepare a new

 proxy data SD
 card.

Clips(Proxy) N
ear Full

Interm
ittent

Flashing
Flashing

The num
ber of additional clips that can be recorded on the proxy data SD

 card is getting low
. Replace at the earliest 

convenience.
M

edia(A)  1) Full
Continuous

O
n

H
igh-speed flashing

W
hen using the sim

ultaneous recording function
M

edia(A)  1) Clips Full
Continuous

O
n

H
igh-speed flashing

W
hen using the sim

ultaneous recording function
M

edia(A)  1) N
ear Full

Interm
ittent

Flashing
Flashing

W
hen using the sim

ultaneous recording function
M

edia(A)  1) Last Clip Rec
Interm

ittent
Flashing

Flashing
W

hen using the sim
ultaneous recording function

1) “(B)” is displayed for cards in slot B.
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Caution and Operation Confirmation Display

The follow
ing caution and operation m

essages m
ay appear in the center of the screen. Follow

 the 
instructions provided to resolve the issue.

D
isplay indication

Cause and Solution
Battery Error
Please Change Battery

An error w
as detected in the battery pack.

Replace w
ith a norm

al battery pack.

Backup Battery End
Please Change

The rem
aining capacity of the backup battery is insufficient.

Replace the backup battery.

U
nknow

n M
edia(A)  1)

Please Change
A m

em
ory card that has been partitioned or a m

em
ory card 

containing m
ore clips that can be handled by the cam

corder w
as 

inserted.
The card cannot be used in the cam

corder, and m
ust be 

replaced.
M

edia Error
M

edia(A)  1) N
eeds to be Restored

An error occurred on the m
em

ory card, and the card m
ust be 

restored.
Eject and then re-insert the card, then repair the card.

M
edia Error

Cannot Record to M
edia(A)  1)

The m
em

ory card m
ay be dam

aged, and can no longer be used 
for recording.
Playback m

ay be possible, so m
aking a copy and replacing the 

m
em

ory card is recom
m

ended.
M

edia Error
Cannot U

se M
edia(A)  1)

The m
em

ory card m
ay be dam

aged, and can no longer be used 
for recording or playback.
The card cannot be used in the cam

corder, and m
ust be 

replaced.
Cannot U

se M
edia(A)  1)

U
nsupported File System

A card using a different file system
 or an unform

atted card w
as 

inserted.
The card cannot be used in the cam

corder, and m
ust be 

replaced or form
atted using the cam

corder.
M

edia(A)  1) Error
Playback H

alted
Cannot continue playback because an error occurred w

hile 
reading from

 the m
em

ory card.
If the problem

 persists, m
ake a copy and replace the m

em
ory 

card.
M

edia(A)  1) Error
Recording is stopped because an error occurred on the m

em
ory 

card.
If the problem

 persists, replace the m
em

ory card.
D

ifferent M
edia is Inserted

Cannot U
se M

edia(A)  1)
D

ifferent m
edia w

as inserted. Eject the inserted card, and insert a 
card of the sam

e type as the previously inserted card.

1) “(B)” is displayed for cards in slot B.
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11. Appendix

M
essages D

isplayed D
uring O

peration
This section describes the m

eaning of m
essages that m

ay be displayed in response to button, sw
itch, or knob operation.

[N
otes]
ˎˎ Covers only the m

essages displayed about possible causes in response to an operation.
ˎˎ M

essages displayed w
hen an operation is attem

pted w
hile a m

enu item
 cannot be selected (grayed out) are not described.

O
peration

M
essage

M
eaning and possible cause

REC button w
as pressed

M
edia not exist

Cannot record because there is no recording m
edia in an SxS card slot.

M
edia(Proxy)

Cannot Record
N

o M
edia in Slot(Proxy)

Proxy data recording m
ode is set to O

n, but cannot record proxy data because the proxy SD
 card is not inserted.

M
edia(Proxy)

Cannot Record
M

edia(Proxy) Error

Cannot record proxy data because cannot w
rite to the proxy SD

 card due to a m
edia error.

M
edia(Proxy)

Cannot Record
M

edia(Proxy): W
rite Protected

Cannot record proxy data because the proxy SD
 card is w

rite-protected.

M
edia(Proxy)

Cannot Record
N

G
: Preparing

Cannot record proxy data because the proxy data recording circuitry initialization is not com
pleted.

Assignable sw
itch assigned w

ith Proxy Rec 
Start/Stop w

as operated
M

edia(Proxy)
Cannot Record
N

o M
edia in Slot(Proxy)

Cannot record proxy data because the proxy SD
 card is not inserted.

M
edia(Proxy)

Cannot Record
M

edia(Proxy) Error

Cannot record proxy data because cannot w
rite to the proxy SD

 card due to a m
edia error.

M
edia(Proxy)

Cannot Record
M

edia(Proxy): W
rite Protected

Cannot record proxy data because the proxy SD
 card is w

rite-protected.

M
edia(Proxy)

Cannot Record
N

G
: Preparing

Cannot record proxy data because the proxy data recording circuitry initialization is not com
pleted.

PREV button w
as pressed

First Clip Top!
Cannot execute because the playback position is at the first fram

e of the first clip.
F REV button w

as pressed
First Clip Top!

Cannot execute because the playback position is at the first fram
e of the first clip.

PREV + F REV buttons w
ere pressed

First Clip Top!
Cannot execute because the playback position is at the first fram

e of the first clip.
PLAY button w

as pressed
Last Clip End!

Cannot execute because the playback position is at the last fram
e of the last clip.

N
EXT button w

as pressed
Last Clip End!

Cannot execute because the playback position is at the last fram
e of the last clip.

F FW
D

 button w
as pressed

Last Clip End!
Cannot execute because the playback position is at the last fram

e of the last clip.
N

EXT + F FW
D

 buttons w
ere pressed

Last Clip End!
Cannot execute because the playback position is at the last fram

e of the last clip.
M

edia slot w
as changed

Cannot Sw
itch Slots

Cannot change slots during playback.
Recording m

edia w
as rem

oved
M

edia rem
oved

M
edia w

as rem
oving w

hile reading from
 recording m

edia or w
hile w

riting to recording m
edia (ACCESS indicator is lit).
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O
peration

M
essage

M
eaning and possible cause

G
AIN

 sw
itch w

as operated
G

ain: xxxxdB
(w

here “xxxx” is the gain value)
G

ain setting w
as changed.

D
CC sw

itch w
as operated

D
CC: O

n
D

CC w
as set to O

n.
D

CC: O
ff

D
CC w

as set to O
ff.

Fixed By H
yper G

am
m

a !
Cannot set D

CC to O
n because G

am
m

a Category is set to H
G

 or U
ser.

W
hite balance sw

itch w
as operated

W
hite: Preset xxxxK

(w
here “xxxx” is the color tem

perature 
value)

W
hite balance w

as changed to the preset value.

W
hite: A xxxxK 

(w
here “xxxx” is the color tem

perature 
value)

W
hite balance w

as changed to the m
em

ory A value.

W
hite: B xxxxK 

(w
here “xxxx” is the color tem

perature 
value)

W
hite balance w

as changed to the m
em

ory B value.

W
hite: ATW

     xxxxK 
(w

here “xxxx” is the color tem
perature 

value)

W
hite balance m

ode w
as changed to ATW

.

SH
U

TTER sw
itch w

as operated
Shutter: 1/xxxx
(w

here “xxxx” is the shutter value)
Shutter speed w

as changed (standard, Speed m
ode settings).

Shutter: xxxx
(w

here “xxxx” is the shutter value)
Shutter speed w

as changed (standard, Angle m
ode settings).

ECS: xxxxH
z

(w
here “xxxx” is the frequency value)

Shutter speed w
as changed (ECS m

ode).

M
enu knob w

as turned
ECS: xxxxH

z
(w

here “xxxx” is the frequency value)
Shutter speed w

as changed (ECS m
ode).

Iris O
verride: +x.xx

(w
here “x.xx” is a num

eric value)
Iris override level w

as changed.

Auto black sw
itch w

as operated
Color Bars
Cannot Proceed

Cannot execute because a color bar signal is being output.

Test Saw
Cannot Proceed

Cannot execute because a test signal is being output.

N
ot Available

Recording
Cannot execute because recording is in progress.

N
ot Available

Playing back
Cannot execute because playback is in progress.

N
ot Available

D
isplaying Thum

bnails
Cannot execute because the thum

bnail screen is displayed.
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O
peration

M
essage

M
eaning and possible cause

Auto w
hite sw

itch w
as operated

Color Bars
Cannot Proceed

Cannot execute because a color bar signal is being output.

N
ot Available

Cannot execute because playback is in progress.
Playing back
N

ot Available
D

isplaying Thum
bnails

Cannot execute because the thum
bnail screen is displayed.

W
hite Balance Preset

Cannot execute because the w
hite balance is set to the preset value.

Assignable sw
itch assigned w

ith ATW
 H

old 
function w

as operated
ATW

 H
old

ATW
 H

old function w
as enabled.

ATW
 H

old O
ff

ATW
 H

old function w
as disabled.

Assignable sw
itch assigned w

ith Clip 
Continuous Rec w

as operated
Cannot Proceed
Recording

Cannot execute because recording is in progress.

Cannot Proceed
Cannot execute because a CA-FB70/TX70 Cam

era Adaptor is connected to the CCU
.

Assignable sw
itch assigned w

ith Picture 
Cache Rec w

as operated
Cannot Proceed
Recording

Cannot execute because recording is in progress.

Cannot Proceed
Cannot execute because of the follow

ing conditions.
r�Playback is in progress
r�Thum

bnail screen is displayed
r�CA-FB70/TX70 Cam

era Adaptor is connected to the CCU
.

Assignable sw
itch assigned w

ith Stream
ing 

w
as operated

Cannot Proceed
N

etw
ork Client M

ode Setting is “O
n”

Cannot execute because netw
ork client m

ode is enabled.

Cannot Proceed
N

etw
ork Function is D

isabled
Cannot execute because netw

ork connection setting is set to O
ff.

Cannot Proceed
N

etw
ork Client M

ode Setting is “O
n”

N
etw

ork Function is D
isabled

N
etw

ork client m
ode is set to O

n, but cannot execute because netw
ork connection is unavailable.

Cannot Start Stream
ing

Stream
ing D

isabled Tem
porarily

Cannot execute because of the follow
ing conditions.

r�Proxy data playback is in progress
r�1280×720 clip playback is in progress w

ith recording form
at set to 1920×1080

r�1920×1080 clip playback is in progress w
ith recording form

at set to 1280×720
Cannot Start Stream

ing
Please stop Recording or Playback

Cannot execute because recording/playback w
as started w

hile w
ireless function circuitry w

as initializing (including thum
bnail display).

Stop recording/playback (including thum
bnail display) to enable execution.
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O
peration

M
essage

M
eaning and possible cause

Assignable sw
itch assigned w

ith Stream
ing 

w
as operated w

hile netw
ork client m

ode is 
enabled

Cannot Proceed
Stream

ing Setting is “O
n”

Cannot configure because stream
ing is in progress.

Cannot Connect to CCM
N

etw
ork Function is D

isabled
Cannot connect to Connection Control M

anager because netw
ork connection is unavailable.

Cannot Record Proxy
Cannot record proxy data, w

hen proxy data recording is started, because M
aintenance >N

etw
ork Client M

ode >D
etail Settings >N

CM
 

w
ith Proxy in the setup m

enu is set to D
isable.

Proxy Recoding w
ill be Stopped

Proxy data recording w
ill stop because M

aintenance >N
etw

ork Client M
ode >D

etail Settings >N
CM

 w
ith Proxy in the setup m

enu is set 
to D

isable.
Cannot Connect to CCM
Cannot Record Proxy

r�Cannot connect to Connection Control M
anager because netw

ork connection is unavailable.
r�Cannot record proxy data, w

hen proxy data recording is started, because M
aintenance >N

etw
ork Client M

ode >D
etail Settings 

>N
CM

 w
ith Proxy in the setup m

enu is set to D
isable.

Cannot Connect to CCM
Proxy Recoding w

ill be Stopped
r�Cannot connect to Connection Control M

anager because netw
ork connection is unavailable.

r�Proxy data recording w
ill stop because M

aintenance >N
etw

ork Client M
ode >D

etail Settings >N
CM

 w
ith Proxy in the setup m

enu is 
set to D

isable.
Cannot Connect to CCM
Invalid U

ser N
am

e or Passw
ord

Connection Control M
anager authentication error occurred.

Cannot Connect to CCM
Invalid Address or Port N

um
ber

Cannot connect to Connection Control M
anager because the Connection Control M

anager address or port num
ber settings is 

incorrect.
Assignable sw

itch assigned w
ith Auto 

U
pload(Proxy) w

as operated
Cannot Proceed
N

etw
ork Function is D

isabled
Cannot execute because proxy data recording circuitry and w

ireless function circuitry initialization are not com
pleted.

O
N

LIN
E button w

as pressed and held
Cannot Proceed

Cannot execute because w
ireless function circuitry is sw

itching m
ode or pow

er supply is sw
itching off.

Assignable sw
itch assigned w

ith Zebra w
as 

operated or ZEBRA sw
itch on view

finder 
w

as changed

Zebra: O
n

Zebra w
as set to O

n.
Zebra: O

ff
Zebra w

as set to O
ff.

ZEBRA sw
itch on view

finder w
as operated

Zebra: O
n

Zebra w
as set to O

n.
Zebra: O

ff
Zebra w

as set to O
ff.

Assignable sw
itch assigned w

ith M
aster w

as 
operated

M
arker: O

n
M

arker w
as set to O

n.
M

arker: O
ff

M
arker w

as set to O
ff.

Assignable sw
itch assigned w

ith Peaking 
w

as operated
Peaking: O

n
Peaking w

as set to O
n.

Peaking: O
ff

Peaking w
as set to O

ff.
Assignable sw

itch assigned w
ith Video 

Signal M
onitor w

as operated
Cannot Proceed

Cannot execute because of the follow
ing conditions.

r�O
peration >Input/O

utput >SD
I O

ut1 Select and SD
I O

ut2 Select in the setup m
enu are both set to O

ff
r�O

peration >Input/O
utput >O

utput Form
at in the setup m

enu is set to 720×480P or 720×576P
O

U
TPU

T sw
itch w

as m
oved to the BARS 

position (color bar display)
N

ot Available
S&Q

 M
otion: O

n
Cannot execute because S&Q

 m
otion recording m

ode is enabled.

Assignable sw
itch assigned w

ith digital 
extender w

as operated
Cannot Proceed

Cannot execute because of the follow
ing conditions.

r�Playback is in progress
r�Thum

bnail screen is displayed
r�External input state
r�Color bars or test signal output is in progress
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O
peration

M
essage

M
eaning and possible cause

N
D

 filter w
as changed

2: 1/4N
D

  xxxxK
(w

here “2: 1/4N
D

” is the N
D

 filter type and 
“xxxx” is the color tem

perature value)

N
D

 filter w
as changed.

N
D

:3 CC: x  xxxxK
(w

here “N
D

: 3” is the selected N
D

 filter type 
and “CC: x  xxxx” is the selected CC filter and 
color tem

perature value after electrical color 
tem

perature conversion)

N
D

 filter w
as changed w

ith N
D

 Filter C.Tem
p set to O

ff and Electrical CC assigned to an assignable sw
itch.

Assignable sw
itch assigned w

ith Color 
Tem

p SW
 3200K w

as operated
Color Tem

p SW
 3200K

Color Tem
p SW

 3200K w
as enabled.

Cannot Proceed
N

D
 Filter C.Tem

p: O
n

Cannot change because N
D

 Filter C.Tem
p is set to O

n.

Assignable sw
itch assigned w

ith Color 
Tem

p SW
 4300K w

as operated
Color Tem

p SW
 4300K

Color Tem
p SW

 4300K w
as enabled.

Cannot Proceed
N

D
 Filter C.Tem

p: O
n

Cannot change because N
D

 Filter C.Tem
p is set to O

n.

Assignable sw
itch assigned w

ith Color 
Tem

p SW
 5600K w

as operated
Color Tem

p SW
 5600K

Color Tem
p SW

 5600K w
as enabled.

Cannot Proceed
N

D
 Filter C.Tem

p: O
n

Cannot change because N
D

 Filter C.Tem
p is set to O

n.

Assignable sw
itch assigned w

ith Color 
Tem

p SW
 6300K w

as operated
Color Tem

p SW
 6300K

Color Tem
p SW

 6300K w
as enabled.

Cannot Proceed
N

D
 Filter C.Tem

p: O
n

Cannot change because N
D

 Filter C.Tem
p is set to O

n.

Assignable sw
itch assigned w

ith Electrical 
CC w

as operated
N

D
:3 CC: x  xxxxK

(w
here “N

D
: 3” is the selected N

D
 filter type 

and “CC: x  xxxx” is the selected CC filter and 
color tem

perature value after electrical color 
tem

perature conversion)

Electrical CC filter w
as changed.

Cannot Proceed
Cannot change because N

D
 Filter C.Tem

p is set to O
n.

Assignable sw
itch assigned w

ith CC5600K 
w

as operated
CC 5600K

5600K setting w
as selected.

Cannot Proceed
Cannot execute because of the follow

ing conditions.
r�N

D
 Filter C.Tem

p is set to O
n

r�Electrical CC is assigned to an assignable sw
itch, but 5600K is not assigned to Electrical CC.

Assignable sw
itch assigned w

ith Shot M
ark1 

w
as operated

Shot M
ark1

(arbitrary character string w
hen defining 

planning m
etadata)

Shot m
ark 1 w

as added.

Cannot Record Essence M
ark

Reached Essence M
ark Lim

it
Cannot add because the m

axim
um

 num
ber of essence m

arks has been reached.

Cannot Proceed
Cannot add because of the follow

ing conditions.
r�Cannot w

rite because the m
edia on w

hich to record clips is w
rite-protected

r�Picture Cache Rec function is set to O
n

r�Interval Rec recording is in progress
r�M

edia is w
rite-protected

r�Target clip is recorded on an SD
XC card
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O
peration

M
essage

M
eaning and possible cause

Assignable sw
itch assigned w

ith Shot M
ark2 

w
as operated

Shot M
ark2

(arbitrary character string w
hen defining 

planning m
etadata)

Shot m
ark 2 w

as added.

Cannot Record Essence M
ark

Reached Essence M
ark Lim

it
Cannot add because the m

axim
um

 num
ber of essence m

arks has been reached.

Cannot Proceed
Cannot add because of the follow

ing conditions.
r�Cannot w

rite because the m
edia on w

hich to record clips is w
rite-protected

r�Picture Cache Rec function is set to O
n

r�Interval Rec recording is in progress
r�M

edia is w
rite-protected

r�Target clip is recorded on an SD
XC card

Assignable sw
itch assigned w

ith Clip Flag 
O

K w
as operated

O
K Clip Flag

Clip flag (O
K m

ark) w
as added.

D
elete Clip Flag

Clip flag (O
K m

ark) w
as deleted (by pressing the sw

itch tw
ice).

Cannot Proceed
Cannot execute because of the follow

ing conditions.
r�M

edia is w
rite-protected

r�Target clip is recorded on an SD
XC card

Assignable sw
itch assigned w

ith Clip Flag 
N

G
 w

as operated
N

G
 Clip Flag

Clip flag (N
G

 m
ark) w

as added.
D

elete Clip Flag
Clip flag (N

G
 m

ark) w
as deleted (by pressing the sw

itch tw
ice).

Cannot Proceed
Cannot execute because of the follow

ing conditions.
r�M

edia is w
rite-protected

r�Target clip is recorded on an SD
XC card

Assignable sw
itch assigned w

ith Clip Flag 
Keep w

as operated
KEEP Clip Flag

Clip flag (KEEP m
ark) w

as added.
D

elete Clip Flag
Clip flag (KEEP m

ark) w
as deleted (by pressing the sw

itch tw
ice).

Cannot Proceed
Cannot execute because of the follow

ing conditions.
r�M

edia is w
rite-protected

r�Target clip is recorded on an SD
XC card

Assignable sw
itch assigned w

ith Flash Band 
Reduce w

as operated
Flash Band Reduce: O

n
Flash Band Reduce w

as set to O
n.

Flash Band Reduce: O
ff

Flash Band Reduce w
as set to O

ff.
SLO

T SELECT button w
as operated

Sw
itched Slot

Recording m
edia to use w

as changed.
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U
sage Precautions

The fan and battery are consum
able parts that w

ill 
need periodic replacem

ent.
W

hen operating at room
 tem

perature, a norm
al 

replacem
ent cycle w

ill be about 5 years.
H

ow
ever, this replacem

ent cycle represents only 
a general guideline and does not im

ply that the 
life expectancy of these parts is guaranteed. For 
details on parts replacem

ent, contact your dealer.

The life expectancy of the AC adaptor and the 
electrolytic capacitor is about 5 years under 
norm

al operating tem
peratures and norm

al usage 
(8 hours per day; 25 days per m

onth). If usage 
exceeds the above norm

al usage frequency, the 
life expectancy m

ay be reduced correspondingly.

Use and storage

Do not subject the camcorder to severe shocks
ˎˎ The internal m

echanism
 m

ay be dam
aged or 

the body w
arped.

ˎˎ If an accessory m
ounted on the accessory shoe 

is subjected to severe shock, the accessory shoe 
m

ay be dam
aged. In such a case, stop using 

it and contact your dealer or a Sony service 
representative.

Do not cover the camcorder while operating
Putting a cloth, for exam

ple, over the cam
corder 

can cause excessive internal heat build-up.

After use
Alw

ays turn off the PO
W

ER sw
itch.

Before storing the camcorder for a long period
Rem

ove the battery pack.

Shipping
ˎˎ Rem

ove the m
edia before transporting the 

cam
corder.

ˎˎ If sending the cam
corder by truck, ship, air, 

or other transportation service, pack it in the 
shipping carton of the cam

corder.

Care of the camcorder
Rem

ove dust and dirt from
 the surfaces of the 

lenses or optical filters using a blow
er.

D
o not attem

pt to clean the interior of the cam
era 

using a blow
er. Any dust particles in the air that 

enter com
ponents m

ay cause a m
alfunction.

If the body of the cam
corder is dirty, clean it w

ith 
a soft, dry cloth. In extrem

e cases, use a cloth 
m

oistened in a little neutral detergent, then w
ipe 

dry. D
o not use organic solvents such as alcohol or 

thinners, as these m
ay cause discoloration or other 

dam
age to the finish of the cam

corder.

In the event of operating problems
If you should experience problem

s w
ith the 

cam
corder, contact a Sony service representative.

Use and storage locations
Store in a level, ventilated place.
Avoid using or storing the cam

corder in the 
follow

ing places.
ˎˎ In excessive heat or cold (operating tem

perature 
range: –5 °C to +40 °C (23 °F to 104 °F)) 
Rem

em
ber that in sum

m
er in w

arm
 clim

ates 
the tem

perature inside a car w
ith the w

indow
s 

closed can easily exceed 50 °C (122 °F).
ˎˎ In dam

p or dusty locations
ˎˎ Locations w

here the cam
corder m

ay be 
exposed to rain
ˎˎ Locations subject to violent vibration
ˎˎ N

ear strong m
agnetic fields

ˎˎ Close to radio or TV transm
itters producing 

strong electrom
agnetic fields.

ˎˎ In direct sunlight or close to heaters for 
extended periods

To prevent electromagnetic interference from portable 
communications devices
The use of portable telephones and other 
com

m
unications devices near this cam

corder can 
result in m

alfunction and interference w
ith audio 

and video signals.
It is recom

m
ended that the portable 

com
m

unications devices near this cam
corder be 

pow
ered off.

Condensation
If the unit is suddenly taken from

 a cold to a w
arm

 
location, or if am

bient tem
perature suddenly 

rises, m
oisture m

ay form
 on the outer surface of 

the unit and/or inside of the unit. This is know
n 

as condensation. If condensation occurs, turn off 
the unit and w

ait until the condensation clears 
before operating the unit. O

perating the unit w
hile 

condensation is present m
ay dam

age the unit.

Fitting the zoom lens
It is im

portant to fit the lens correctly, as otherw
ise 

dam
age m

ay result. Be sure to refer to the section 
“M

ounting and Adjusting the Lens” (page 26).

Viewfinder
D

o not leave the cam
corder w

ith the eyepiece 
lens pointing directly at the sun.  
The eyepiece lens can concentrate the sun’s rays 
and m

elt the interior of the view
finder.

About the LCD panels
The LCD

 panel fitted to this unit is m
anufactured 

w
ith high precision technology, giving a 

functioning pixel ratio of at least 99.99%
. Thus a 

very sm
all proportion of pixels m

ay be “stuck”, 
either alw

ays off (black), alw
ays on (red, green, or 

blue), or flashing. In addition, over a long period 
of use, because of the physical characteristics of 
the liquid crystal display, such “stuck” pixels m

ay 

appear spontaneously. These problem
s are not a 

m
alfunction. N

ote that any such problem
s have no 

effect on recorded data.

Phenomena specific to CMOS image sensors
The follow

ing phenom
ena that m

ay appear in 
im

ages are specific to CM
O

S (Com
plem

entary 
M

etal O
xide Sem

iconductor) im
age sensors. They 

do not indicate m
alfunctions.

W
hite flecks

Although the CM
O

S im
age sensors are produced 

w
ith high-precision technologies, fine w

hite flecks 
m

ay be generated on the screen in rare cases, 
caused by cosm

ic rays, etc. This is related to the 
principle of CM

O
S im

age sensors and is not a 
m

alfunction.
The w

hite flecks especially tend to be seen in the 
follow

ing cases:
ˎˎ w

hen operating at a high environm
ental 

tem
perature

ˎˎ w
hen you have raised the m

aster gain 
(sensitivity)
ˎˎ w

hen operating in Slow
-Shutter m

ode
The problem

 m
ay be alleviated by executing 

autom
atic black balance adjustm

ent.

Aliasing
W

hen fine patterns, stripes, or lines are shot, they 
m

ay appear jagged or flicker.

Flicker
If recording is m

ade under lighting produced 
by discharge tubes, such as fluorescent, sodium

, 
or m

ercury-vapor lam
ps, the screen m

ay flicker, 
colors m

ay vary, or horizontal stripes m
ay appear 

distorted.



000
11. Appendix: U

sage Precautions
143

In such cases, set the flicker-reduction function to 
auto m

ode (page 108).
If the fram

e rate selected for recording is close 
to the pow

er-supply frequency, flicker m
ay not 

be reduced sufficiently even if you activate the 
Flicker-Reduction function. In such cases, use the 
electronic shutter.

Focal plane
O

w
ing to the characteristics of the pickup 

elem
ents (CM

O
S im

age sensors) for reading video 
signals, subjects that quickly m

ove across the 
screen m

ay appear slightly skew
ed.

Flashband
The lum

inance at the top and bottom
 of the 

screen m
ay change w

hen shooting a flashlight 
beam

 or a light source that quickly flashes. You can 
use the supplied application softw

are to correct 
clips that contain fram

es w
ith flash bands.

Fragmentation
If pictures cannot be recorded/reproduced 
properly, try form

atting the recording m
edia.

W
hile repeating picture recording/playback w

ith 
a certain recording m

edia for an extended period, 
files in the m

edia m
ay be fragm

ented, disabling 
proper recording/storage. In such a case, m

ake 
a backup of clips in the m

edia then perform
 

form
atting of the m

edia using O
peration >Form

at 
M

edia (page 91) in the setup m
enu.

Notes on security

ˎˎ SO
N

Y W
ILL N

O
T BE LIABLE FO

R D
AM

AG
ES O

F 
AN

Y KIN
D

 RESU
LTIN

G
 FRO

M
 A FAILU

RE TO
 

IM
PLEM

EN
T PRO

PER SECU
RITY M

EASU
RES 

O
N

 TRAN
SM

ISSIO
N

 D
EVICES, U

N
AVO

ID
ABLE 

D
ATA LEAKS RESU

LTIN
G

 FRO
M

 TRAN
SM

ISSIO
N

 
SPECIFICATIO

N
S, O

R SECU
RITY PRO

BLEM
S O

F 
AN

Y KIN
D

.
ˎˎ D

epending on the operating environm
ent, 

unauthorized third parties on the netw
ork m

ay 
be able to access the unit. W

hen connecting the 
unit to the netw

ork, be sure to confirm
 that the 

netw
ork is protected securely.

ˎˎ Com
m

unication content m
ay be unknow

ingly 
intercepted by unauthorized third parties in the 
vicinity of the signals. W

hen using w
ireless LAN

 
com

m
unication, im

plem
ent security m

easures 
properly to protect the com

m
unication content.

ˎˎ From
 a safety standpoint, w

hen using the unit 
connected w

ith the netw
ork, it is strongly 

recom
m

ended to access the Control w
indow

 
via a W

eb brow
ser and change the access 

lim
itation settings from

 the factory preset values 
(page 72).  
Changing the passw

ord regularly is also 
recom

m
ended.

ˎˎ D
o not brow

se any other w
ebsite in the W

eb 
brow

ser w
hile m

aking settings or after m
aking 

settings. Since the login status rem
ains in the 

W
eb brow

ser, close the W
eb brow

ser w
hen you 

com
plete the settings to prevent unauthorized 

third parties from
 using the unit or harm

ful 
program

s from
 running.

About GPS
The G

PS (G
lobal Positioning System

) is a system
 

that calculates geographical location from
 highly 

accurate U
S space satellites. This system

 allow
s 

you to pinpoint your exact location on the earth.
The G

PS satellites are located in 6 orbits, 20,000 km
 

above the earth. The G
PS system

 consists of 24 or 
m

ore G
PS satellites.

A G
PS receiver receives radio signals from

 the 
satellites, and calculates the current location of the 
receiver based on the orbital inform

ation (alm
anac 

data) and travel tim
e of the signals, etc.

D
eterm

ining a location is called “triangulating.” A 
G

PS receiver can determ
ine the location’s latitude 

and longitude by receiving signals from
 3 or m

ore 
satellites.
ˎˎ As the positions of G

PS satellites vary constantly, 
it m

ay take longer to determ
ine the location or 

the receiver m
ay not be able to determ

ine the 
location at all, depending on the location and 
tim

e you use the cam
corder.

ˎˎ “G
PS” is a system

 for determ
ining geographic 

location by triangulating radio signals from
 

G
PS satellites. Avoid using the cam

corder 
in places w

here radio signals are blocked or 
reflected, such as a shadow

y place surrounded 
by buildings or trees, etc. U

se the cam
corder in 

open sky environm
ents.

ˎˎ You m
ay not be able to record location 

inform
ation at locations or in situations w

here 
radio signals from

 the G
PS satellites do not 

reach the cam
corder as follow

s.
 –In tunnels, indoors or under the shade of 

buildings.
 –Betw

een tall buildings or at narrow
 streets 

surrounded by buildings.
 –In underground locations, locations 

surrounded by dense trees, under an 
elevated bridge, or in locations w

here 
m

agnetic fields are generated, such as near 
high voltage cables.

 –N
ear devices that generate radio signals of 

the sam
e frequency band as the cam

corder: 
near 1.5 G

H
z band m

obile telephones, etc.
ˎˎ If you upload and share the im

ages w
hich are 

recorded w
hen the setting “G

PS” is ”O
n,” the 

record location m
ay be exposed on the internet 

even if you do not intend to do so. If you do not 
w

ant to record location inform
ation, select “O

ff” 
for “G

PS” (page 97).

On triangulating errors
ˎˎ If you m

ove to another location right after 
setting “G

PS” to “O
n” in the m

enu, it m
ay 

take a longer tim
e for the cam

corder to start 
triangulating, com

pared to w
hen you stay in the 

sam
e place.

ˎˎ Error caused by the position of G
PS satellites 

The cam
corder autom

atically triangulates your 
current location w

hen the cam
corder receives 

radio signals from
 3 or m

ore G
PS satellites.  

The triangulating error allow
ed by the G

PS 
satellites is about 10 m

 (33 feet). D
epending 

on the environm
ent of the location, the 

triangulating error can be greater. In this case, 
your actual location m

ay not m
atch the location 

on the m
ap based on the G

PS inform
ation. 

M
eanw

hile, the G
PS satellites are controlled 

by the U
nited States D

epartm
ent of D

efense, 
and the degree of accuracy m

ay be changed 
intentionally.
ˎˎ Error during the triangulating process 
The cam

corder acquires location inform
ation 

periodically during triangulating.

On the restriction of use of GPS
U

se G
PS in accordance w

ith the regulations of the 
situation, the countries/regions of use.

On the geographic coordinate system
The “W

G
S-84” geographic coordinate system

 is 
used.
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General

M
ass 

Approx. 3.6 kg (7 lb 15 oz) (body only)
D

im
ensions 

(U
nit: m

m
 (inch), excluding 

protrusions, body only)  1)

150 (6)

269 (10 5/8)

332 (13 1/8)

1) The values for dim
ensions are approxim

ate.

Pow
er requirem

ents
 

 
12 V (11 V to 17.0 V) D

C
Pow

er consum
ption

 
 

Approx. 22 W
 (body only, w

hen 
recording in XAVC, w

ith LCD
 

m
onitor on)

 
 

Approx. 24 W
 (CBK-VF02 view

finder, 
m

anual lens, m
icrophone, w

hen 
recording in XAVC, w

ith LCD
 

m
onitor on)

[N
otes]
ˎˎ D

o not connect video lights w
ith pow

er consum
ption of 

50 W
 or greater.

ˎˎ W
hen using a battery, do not allow

 the total pow
er 

consum
ption of connected peripherals to exceed 40 W

.
ˎˎ W

hen using the AC-D
N

10, do not allow
 the total pow

er 
consum

ption of connected peripherals to exceed 50 W
.

ˎˎ W
hen using the AC-D

N
2B, do not allow

 the total pow
er 

consum
ption of connected peripherals to exceed 85 W

.
ˎˎ Connect only devices w

ith current consum
ption of 1.8 A 

or low
er to the D

C O
U

T connector.

O
perating tem

perature
 

 
0 °C to 40 °C (32 °F to 104 °F)

Storage tem
perature

 
 

–20 °C to +60 °C (–4 °F to +140 °F)
File system
 

 
exFAT, U

D
F

 Continuous operating tim
e

 
 

Approx. 170 m
inutes (using BP-FLX75)

Recording form
at (video)

 
XAVC Intra

 
 

XAVC-I m
ode: CBG

, 223 M
bps (m

ax), 
M

PEG
-4 AVC/H

.264
 

XAVC Long
 

 
XAVC-L 50 m

ode: VBR, 50 M
bps (m

ax), 
M

PEG
-4 AVC/H

.264
 

 
XAVC-L 35 m

ode: VBR, 35 M
bps (m

ax), 
M

PEG
-4 AVC/H

.264
 

 
XAVC-L 25 m

ode: VBR, 25 M
bps (m

ax), 
M

PEG
-4 AVC/H

.264
 

M
PEG

-2 Long G
O

P
 

 
M

PEG
 H

D
422 m

ode: CBR, 50 M
bps, 

M
PEG

-2 422P@
H

L
 

 
M

PEG
 H

D
420 H

Q
 m

ode: VBR, 35 M
bps 

(m
ax), M

PEG
-2 M

P@
H

L
 

M
PEG

 IM
X

 
 

CBR, 50 M
bps

 
D

VCAM
 

 
CBR, 25 M

bps
 

Proxy
 

 
AVC/H

.264 M
ain Profile 4:2:0 Long G

O
P

 
 

1280×720/9 M
bps, 6 M

bps
 

 
640×360/3 M

bps,
 

 
480×270/1 M

bps, 500 Kbps (VBR)
Recording form

at (audio)
 

XAVC Intra
 

 
LPCM

 24-bit, 48 kH
z, 4-channel

 
XAVC Long

 
 

LPCM
 24-bit, 48 kH

z, 4-channel
 

M
PEG

-2 Long G
O

P
 

 
M

PEG
 H

D
422 m

ode: LPCM
 24-bit, 

48 kH
z, 4-channel

 
 

M
PEG

 H
D

420 H
Q

 m
ode: LPCM

 16-bit, 
48 kH

z, 4-channel
 

M
PEG

 IM
X

 
 

LPCM
 16/24-bit, 48 kH

z, 4-channel

 
D

VCAM
 

 
LPCM

 16-bit, 48 kH
z, 2-channel

 
Proxy

 
 

AAC-LC, 128 Kbps, 2-channel
Recording/playback tim

e
 

XAVC Intra
 

 
XAVC-I m

ode
 

 
Approx. 30 m

inutes: U
sing SBP-64D

/
SBS-64G

1B (64 G
B)

 
XAVC Long

 
 

XAVC-L 50 m
ode

 
 

Approx. 120 m
inutes: U

sing SBP-64D
/

SBS-64G
1B (64 G

B)
 

 
XAVC-L 35 m

ode
 

 
Approx. 170 m

inutes: U
sing SBP-64D

/
SBS-64G

1B (64 G
B)

 
 

XAVC-L 25 m
ode

 
 

Approx. 220 m
inutes: U

sing SBP-64D
/

SBS-64G
1B (64 G

B)
 

M
PEG

-2 Long G
O

P
 

 
M

PEG
 H

D
422 m

ode
 

 
Approx. 120 m

inutes: U
sing SBP-64D

/
SBS-64G

1B (64 G
B)

 
 

M
PEG

 H
D

420 H
Q

 m
ode

 
 

Approx. 180 m
inutes: U

sing SBP-64D
/

SBS-64G
1B (64 G

B)
 

M
PEG

 IM
X

 
 

Approx. 120 m
inutes: U

sing SBP-64D
/

SBS-64G
1B (64 G

B)
 

D
VCAM

 
 

 
Approx. 220 m

inutes: U
sing SBP-64D

/
SBS-64G

1B (64 G
B)

[N
ote]

The recording and playback tim
es are for a continuous 

recording as a single clip. The actual tim
es m

ay be shorter, 
depending on the num

ber of clips recorded.

Recording fram
e rate

 
XAVC Intra

 
 

XAVC-I m
ode

 
 

1920×1080/59.94P, 50P, 59.94i, 50i, 
29.97P, 23.98P, 25P

 
 

1280×720/59.94P, 50P

 
XAVC Long

 
 

XAVC-L 50 m
ode

 
 

1920×1080/59.94P, 50P, 59.94i, 50i, 
29.97P, 23.98P, 25P

 
 

1280×720/59.94P, 50P
 

 
XAVC-L 35 m

ode
 

 
1920×1080/59.94P, 50P, 59.94i, 50i, 

29.97P, 23.98P, 25P
 

 
XAVC-L 25 m

ode
 

 
1920×1080/59.94i, 50i

 
M

PEG
-2 Long G

O
P

 
 

M
PEG

 H
D

422 m
ode

 
 

1920×1080/59.94i, 50i, 29.97P, 23.98P, 
25P

 
 

1280×720/59.94P, 50P, 29.97P, 23.98P, 
25P

 
 

M
PEG

 H
D

420 H
Q

 m
ode

 
 

1920×1080/59.94i, 50i, 29.97P, 23.98P, 
25P

 
 

1440×1080/59.94i, 50i
 

 
1280×720/59.94P, 50P

 
M

PEG
 IM

X
 

 
720×486/59.94i

 
 

720×576/50i
 

D
VCAM

 
 

720×480/59.94i
 

 
720×576/50i

 
Proxy

 
 

M
ain line 1920×1080: 29.97P, 25P, 

23.98P
 

 
M

ain line 1280×720: 59.94P, 50P, 
29.97P, 25P, 23.98P

Input/Output Section

Inputs
G

EN
LO

CK IN
:

 
 

BN
C type, 1.0 Vp-p, 75 ohm

s, 
unbalanced

TC IN
: 

BN
C type, 0.5 V to 18 Vp-p, 10 kilohm

s 

Specifications
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AU
D

IO
 IN

 CH
1/CH

2:
 

 
XLR type, 3-pin, fem

ale
 

 
LIN

E / AES/EBU
 / M

IC / M
IC+48V 

sw
itchable

 
 

LIN
E: +4, 0, –3 dBu

 
 

AES/EBU
: AES3 com

pliant
 

 
M

IC: –70 dBu to –30 dBu
M

IC IN
: 

XLR type, 5-pin, fem
ale, –70 dBu to 

–30 dBu
W

RR: 
D

-sub 15-pin
 

 
Analog CH

1: –40 dBu
 

 
D

igital CH
1/CH

2: –40 dBFS
SD

I IN
: 

SM
PTE ST292-1/259 standard 
com

pliant
 

 
4-channel audio

Outputs
VID

EO
 O

U
T:

 
 

BN
C type, SD

 analog com
posite/H

D
-Y 

sw
itchable

SD
I O

U
T 1/2:

 
 

BN
C type, 0.8 Vp-p, unbalanced (3G

 
H

D
/1.5G

 H
D

/SD
 sw

itchable)
 

 
SM

PTE ST424/425 Level-A/B,  
ST292-1/259 standard com

pliant
 

 
4-channel audio

AU
D

IO
 O

U
T:

 
 

XLR type, 5-pin, m
ale, +4/0/–3 dBu 

(balanced)
TC O

U
T: 

BN
C type, 1.0 Vp-p, 75 ohm

s
EARPH

O
N

E (stereo, m
inijack):

 
 

–11 dBu (reference level output, 
m

axim
um

 m
onitor volum

e,  
16-ohm

 load)
H

D
M

I: 
Type A, 19-pin

Other
D

C IN
: 

XLR type, 4-pin, m
ale, 11 V to 17 V D

C
D

C O
U

T: 
Round type 4-pin, 11 V to 17 V D

C, 
1.8 A m

axim
um

 rated current
LEN

S: 
12-pin, lens pow

er source (11 V to 17 V 
D

C, 1.0 A m
axim

um
 rated current)

REM
O

TE: 
8-pin

LIG
H

T: 
2-pin

U
SB: 

4-pin (type A) (2), 4-pin (type B)
VF:  

Rectangular type 26-pin, round type 
20-pin

N
etw

ork connector:
 

 
RJ45 type, 100BASE-TX (IEEE 802.3u), 

10BASE-T (IEEE 802.3)

Camera Section

Im
aging elem

ent
 

 
2/3-inch type, “Exm

or” Full H
D

 CM
O

S 
im

age sensor 
1920 (H

) × 1080 (V) 
Type 

3-chip RG
B

O
ptical system

 
 

F1.4 prism
 system

N
D

 filters
 

 
1: Clear

 
 

2: 1/4N
D

 
 

3: 1/16N
D

 
 

4: 1/64N
D

Sensitivity 
F12 (system

 frequency: 59.94i) (Typical)
 

 
(2000 lx, 89.9%

 reflectance, 3200K)
M

inim
um

 illum
ination

 
 

0.013 lx (F1.4, +42 dB, 16-fram
e 

accum
ulation)

Im
age S/N

 ratio
 

 
62 dB (N

oise Suppression O
n) (Typical)

H
orizontal resolution 

 
 

1000 TVL (TV lines) or higher
Black level 3 ±1%

 (Black set to [±0] in the setup 
m

enu)
Shutter speed
 

 
59.94i/P, 50i/P: 1/60 to 1/2000 sec.

 
 

29.97P: 1/40 to 1/2000 sec.
 

 
25P: 1/33 to 1/2000 sec.

 
 

23.94P: 1/32 to 1/2000 sec.
Slow

 shutter
 

 
2 to 8, 16 fram

es
D

ynam
ic range

 
 

600%
Sm

ear 
–135 dB

Audio Section

Sam
pling frequency

 
 

48 kH
z

Q
uantization

 
 

16/24-bit
H

eadroom
 

 
20 dB (factory default) (20, 18, 16, 

12 dB), EBU
L

Frequency response
 

 
20 H

z to 20 kH
z (±3 dB or less)

D
ynam

ic range
 

 
90 dB (typical)

D
istortion 

0.08%
 or low

er (–40 dBu input level)
Built-in speaker
 

 
M

onaural, 300 m
W

 output

Display Section

LCD
 m

onitor
 

 
Screen size 

8.8 cm
 (3.5 inch) diagonal

 
 

Aspect ratio 
16:9

 
 

N
um

ber of pixels 
960 (H

) × 540 (V)

Media Section

SxS card slots
 

 
Form

 factor: Express Card/34
 

 
N

um
ber of slots: 2

 
 

Connector: PCM
CIA Express Card 

com
pliant

 
 

W
rite rate: 50 M

bps or higher
 

 
Read rate: 50 M

bps or higher

SD
 card slots

 
 

Proxy (1), U
tility (1)

Lens Section (PXW
-X400KC)

Lens m
ount

 
 

Sony 2/3-inch bayonet m
ount

Focal length
 

 
8.2 m

m
 to 164 m

m
Zoom

 
M

anual
Zoom

 factor
 

 
20

M
axim

um
 aperture ratio

 
 

1:1.9
Iris  

Auto/M
anual sw

itchable
 

 
F1.9 to F16 and C (Close)

Focus range
 

 
Auto/M

anual sw
itchable

 
 

Range 
900 m

m
 to ∞

 (m
acro O

FF) 
10 m

m
 to ∞

 (m
acro O

N
, w

ide 
angle)

Filter diam
eter

 
 

M
82 m

m
, 0.75 m

m
 pitch

M
acro 

O
N

/O
FF selectable

Lens Section (PXW
-X400KF)

Lens m
ount

 
 

Sony 2/3-inch bayonet m
ount

Focal length
 

 
8 m

m
 to 128 m

m
 

(35 m
m

 equivalent: 31.5 m
m

 to 
503 m

m
)

Zoom
 

Pow
er/M

anual sw
itchable

Zoom
 factor

 
 

16
M

axim
um

 aperture ratio
 

 
1:1.9
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Iris  
Auto/M

anual sw
itchable

 
 

F1.9 to F16 and C (Close)
Focus range
 

 
Auto/M

anual sw
itchable

 
 

Range 
800 m

m
 to ∞

 (m
acro O

FF) 
50 m

m
 to ∞

 (m
acro O

N
, w

ide 
angle) 
732 m

m
 to ∞

 (m
acro O

N
, 

telephoto)
Filter diam

eter
 

 
M

82 m
m

, 0.75 m
m

 pitch
M

acro 
O

N
/O

FF selectable

Supplied Accessories

Shoulder belt (1)
Cold shoe kit (1)
Lens m

ount cap
U

SB w
ireless LAN

 m
odule (IFU

-W
LM

3)
Protective cap (1)
G

uard (1)
Before U

sing This U
nit (1)

O
perating Instructions (CD

-RO
M

) (1)
Lens (supplied w

ith PXW
-X400KC) (1)

Autofocus lens (supplied w
ith PXW

-X400KF) (1)
Flange focal length (flange back) adjustm

ent chart (1)
Stereo m

icrophone (supplied w
ith PXW

-X400KC/
PXW

-X400KF) (1)
View

finder (supplied w
ith PXW

-X400KC/PXW
-

X400KF) (1)
Stereo m

icrophone w
indscreen (supplied w

ith 
PXW

-X400KC/PXW
-X400KF) (1)

Related Equipment

Power supply and related equipment
AC adaptor
 

 
AC-D

N
10/D

N
2B

Battery pack
 

 
BP-FLX75

Battery charger
 

 
BC-L70/L90/L70A

Lens, viewfinder and related equipment
Lens 

2/3-inch bayonet m
ount lens only

View
finder

 
 

H
D

VF-20A/L750/EL20/EL30
View

finder rotation bracket
 

 
BKW

-401

Equipment for remote control
Rem

ote control unit
 

 
RM

-B170/B750
 

 
RCP-1000/1500/1530

 
 

RCP-1001/1501

[N
ote]

Com
m

and netw
ork unit (CN

U
) is not supported.

HD camera adaptor
CA-FB70/TX70

[N
ote]

If SD
I O

U
T2 is used w

hen the CA-FB70 is attached, use an 
L-shaped adaptor.

Media adaptor
M

EAD
-SD

02 (for SD
XC cards)

XQD ExpressCard adaptor
Q

D
A-EX1 (for XQ

D
 m

em
ory cards)

Recording media
SxS m

em
ory cards

 
 

SxS PRO
+ series

 
 

SxS PRO
 series

 
 

SxS-1 series

Audio equipment
M

icrophone
 

 
ECM

-678/674/673/680S
M

icrophone holder
 

 
CAC-12

D
igital w

ireless receiver
 

 
D

W
R-S02D

U
H

F synthesized tuner unit
 

 
W

RR-855S
 

 
U

RX-S03D

Other peripheral devices
Tripod attachm

ent
 

 
VCT-14/U

14
Video light
 

 
U

C-D
200A (N

ippon Video System
 - 

N
IPRO

S)
 

 
U

ltralight (Anton Bauer)
Pad  

CBK-SP01 soft-type shoulder pad
W

ireless LAN
 adaptor

 
 

CBK-W
A02

N
etw

ork adaptor kit
 

 
CBK-N

A1

Products for maintenance, ease of use/handling
Attachm

ent bracket
 

 
A-2092-367-

D
esign and specifications are subject to change 

w
ithout notice.

Notes
ˎˎ Alw

ays m
ake a test recording, and verify that it 

w
as recorded successfully. 

SO
N

Y W
ILL N

O
T BE LIABLE FO

R D
AM

AG
ES 

O
F AN

Y KIN
D

 IN
CLU

D
IN

G
, BU

T N
O

T LIM
ITED

 
TO

, CO
M

PEN
SATIO

N
 O

R REIM
BU

RSEM
EN

T 
O

N
 ACCO

U
N

T O
F FAILU

RE O
F TH

IS U
N

IT O
R 

ITS RECO
RD

IN
G

 M
ED

IA, EXTERN
AL STO

RAG
E 

SYSTEM
S O

R AN
Y O

TH
ER M

ED
IA O

R STO
RAG

E 
SYSTEM

S TO
 RECO

RD
 CO

N
TEN

T O
F AN

Y TYPE.
ˎˎ Alw

ays verify that the unit is operating 
properly before use. SO

N
Y W

ILL N
O

T BE LIABLE 
FO

R D
AM

AG
ES O

F AN
Y KIN

D
 IN

CLU
D

IN
G

, 
BU

T N
O

T LIM
ITED

 TO
, CO

M
PEN

SATIO
N

 O
R 

REIM
BU

RSEM
EN

T O
N

 ACCO
U

N
T O

F TH
E LO

SS 
O

F PRESEN
T O

R PRO
SPECTIVE PRO

FITS D
U

E 
TO

 FAILU
RE O

F TH
IS U

N
IT, EITH

ER D
U

RIN
G

 TH
E 

W
ARRAN

TY PERIO
D

 O
R AFTER EXPIRATIO

N
 O

F 
TH

E W
ARRAN

TY, O
R FO

R AN
Y O

TH
ER REASO

N
 

W
H

ATSO
EVER.

ˎˎ SO
N

Y W
ILL N

O
T BE LIABLE FO

R CLAIM
S O

F 
AN

Y KIN
D

 M
AD

E BY U
SERS O

F TH
IS U

N
IT O

R 
M

AD
E BY TH

IRD
 PARTIES.

ˎˎ SO
N

Y W
ILL N

O
T BE LIABLE FO

R TH
E LO

SS, 
REPAIR, O

R REPRO
D

U
CTIO

N
 O

F AN
Y D

ATA 
RECO

RD
ED

 O
N

 TH
E IN

TERN
AL STO

RAG
E 

SYSTEM
, RECO

RD
IN

G
 M

ED
IA, EXTERN

AL 
STO

RAG
E SYSTEM

S O
R AN

Y O
TH

ER M
ED

IA O
R 

STO
RAG

E SYSTEM
S.

ˎˎ SO
N

Y W
ILL N

O
T BE LIABLE FO

R TH
E 

TERM
IN

ATIO
N

 O
R D

ISCO
N

TIN
U

ATIO
N

 O
F AN

Y 
SERVICES RELATED

 TO
 TH

IS U
N

IT TH
AT M

AY 
RESU

LT D
U

E TO
 CIRCU

M
STAN

CES O
F AN

Y 
KIN

D
.
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Software Downloads

W
hen the unit is used w

ith a PC connection, 
dow

nload any device drivers, plug-ins, and 
application softw

are you require from
 the 

follow
ing w

ebsites.

Sony Professional products w
ebsite:

U
.S.A. 

http://pro.sony.com
Canada 

http://w
w

w
.sonybiz.ca

Latin Am
erica 

http://sonypro-latin.com
Europe 

http://w
w

w
.pro.sony.eu/pro

M
iddle East, Africa 

http://sony-psm
ea.com

Russia 
http://sony.ru/pro/

Brazil 
http://sonypro.com

.br
Australia 

http://pro.sony.com
.au

N
ew

 Zealand 
http://pro.sony.co.nz

Japan 
http://w

w
w

.sonybsc.com
Asia Pacific 

http://pro.sony-asia.com
Korea 

http://bp.sony.co.kr
China 

http://pro.sony.com
.cn

India 
http://pro.sony.co.in

Sony Creative Softw
are, softw

are dow
nload page:

http://w
w

w
.sonycreativesoftw

are.com
/dow

nload/
softw

are_for_sony_equipm
ent

Chart of Peripheral Devices and Accessories

ECM
-

680S/678/674/673 
M

icrophone
H

D
 m

onitor/SD
 m

onitor

CA-FB70 H
D

 Cam
era Adaptor

CA-TX70 H
D

 Cam
era Adaptor

BP-FLX75 
Battery Pack

BC-L70A 
Battery Charger

AC-D
N

10/D
N

2B 
AC Adaptor

SxS m
em

ory cards
SBS-32G

1B, SBS-64G
1B, SBS-128G

1B, 
SBS-64D

, SBS-128D
, SBS-256D

M
EAD

-SD
02 M

edia Adaptor

Q
D

A-EX1 XQ
D

 ExpressCard Adaptor

W
RR-855S, U

RX-S03D
 

U
H

F Synthesized Tuner U
nit

D
W

R-S02D
 D

igital W
ireless Receiver

CAC-12 
M

icrophone holder

CBK-VF02 
View

finder

RM
-B170/B750

RCP-1000/1500/1530
RCP-1001/1501
Rem

ote Control Unit

PXW
-X400

HDVF-20A/L750/EL20/EL30 
View

finder

VCT-14 
Tripod attachm

ent

MPEG-4 AVC Patent Portfolio License

TH
IS PRO

D
U

CT IS LICEN
SED

 U
N

D
ER TH

E AVC 
PATEN

T PO
RTFO

LIO
 LICEN

SE FO
R TH

E PERSO
N

AL 
U

SE O
F A CO

N
SU

M
ER O

R O
TH

ER U
SES IN

 W
H

ICH
 IT 

D
O

ES N
O

T RECEIVE REM
U

N
ERATIO

N
 TO

(i) EN
CO

D
E VID

EO
 IN

 CO
M

PLIAN
CE W

ITH
 TH

E AVC 
STAN

D
ARD

 (“AVC VID
EO

”) AN
D

/O
R

(ii) D
ECO

D
E AVC VID

EO
 TH

AT W
AS EN

CO
D

ED
 BY 

A CO
N

SU
M

ER EN
G

AG
ED

 IN
 A PERSO

N
AL ACTIVITY 

AN
D

/O
R W

AS O
BTAIN

ED
 FRO

M
 A VID

EO
 PRO

VID
ER 

LICEN
SED

 TO
 PRO

VID
E AVC VID

EO
.

N
O

 LICEN
SE IS G

RAN
TED

 O
R SH

ALL BE IM
PLIED

 
FO

R AN
Y O

TH
ER U

SE. AD
D

ITIO
N

AL IN
FO

RM
ATIO

N
 

M
AY BE O

BTAIN
ED

 FRO
M

 M
PEG

 LA, L.L.C. SEE 
H

TTP://W
W

W
.M

PEG
LA.CO

M
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END USER LICENSE AGREEMENT

IM
PO

RTAN
T: 

BEFO
RE U

SIN
G

 TH
E SO

FTW
ARE CO

N
TAIN

ED
 IN

 TH
E 

CAM
CO

RD
ER, PLEASE READ

 TH
IS EN

D
 U

SER LICEN
SE 

AG
REEM

EN
T (“EU

LA”) CAREFU
LLY. BY U

SIN
G

 TH
E SO

FTW
ARE 

YO
U

 ARE ACCEPTIN
G

 TH
E TERM

S O
F TH

IS EU
LA. IF YO

U
 D

O
 

N
O

T ACCEPT TH
E TERM

S O
F TH

IS EU
LA, YO

U
 M

AY N
O

T U
SE 

TH
E SO

FTW
ARE.

This EU
LA is a legal agreem

ent betw
een you and Sony 

Corporation (“SO
N

Y”). This EU
LA governs your rights 

and obligations regarding the softw
are of SO

N
Y and/or 

its third party licensors (including SO
N

Y’s affiliates) and 
their respective affiliates (collectively, the “TH

IRD
-PARTY 

SU
PPLIERS”) contained in the cam

corder, together w
ith any 

updates/ upgrades provided by SO
N

Y, any printed, on-line or 
other electronic docum

entation for such softw
are, and any 

data files created by operation of such softw
are (collectively, 

the “SO
FTW

ARE”). 

N
otw

ithstanding the foregoing, any softw
are in the 

SO
FTW

ARE having a separate end user license agreem
ent 

(including, but not lim
ited to, G

N
U

 G
eneral Public license 

and Lesser/Library G
eneral Public License) shall be covered 

by such applicable separate end user license agreem
ent 

in lieu of the term
s of this EU

LA to the extent required by 
such separate end user license agreem

ent (“EXCLU
D

ED
 

SO
FTW

ARE”).

SO
FTW

ARE LICEN
SE

The SO
FTW

ARE is licensed, not sold. The SO
FTW

ARE is 
protected by copyright and other intellectual property law

s 
and international treaties. 

CO
PYRIG

H
T

All right and title in and to the SO
FTW

ARE (including, but not 
lim

ited to, any im
ages, photographs, anim

ation, video, audio, 
m

usic, text and “applets” incorporated into the SO
FTW

ARE) 
is ow

ned by SO
N

Y or one or m
ore of the TH

IRD
-PARTY 

SU
PPLIERS.

G
RAN

T O
F LICEN

SE
SO

N
Y grants you a lim

ited license to use the SO
FTW

ARE 
solely in connection w

ith the cam
corder and only for your 

individual use. SO
N

Y and the TH
IRD

-PARTY SU
PPLIERS 

expressly reserve all rights, title and interest (including, but 
not lim

ited to, all intellectual property rights) in and to the 
SO

FTW
ARE that this EU

LA does not specifically grant to you.

REQ
U

IREM
EN

TS AN
D

 LIM
ITATIO

N
S

You m
ay not copy, publish, adapt, redistribute, attem

pt to 
derive source code, m

odify, reverse engineer, decom
pile, or 

disassem
ble any of the SO

FTW
ARE, w

hether in w
hole or in 

part, or create any derivative w
orks from

 or of the SO
FTW

ARE 
unless such derivative w

orks are intentionally facilitated by 
the SO

FTW
ARE. You m

ay not m
odify or tam

per w
ith any 

digital rights m
anagem

ent functionality of the SO
FTW

ARE. 
You m

ay not bypass, m
odify, defeat or circum

vent any 
of the functions or protections of the SO

FTW
ARE or any 

m
echanism

s operatively linked to the SO
FTW

ARE. You m
ay 

not separate any individual com
ponent of the SO

FTW
ARE 

for use on m
ore than one cam

corder unless expressly 
authorized to do so by SO

N
Y. You m

ay not rem
ove, alter, 

cover or deface any tradem
arks or notices on the SO

FTW
ARE. 

You m
ay not share, distribute, rent, lease, sublicense, assign, 

transfer or sell the SO
FTW

ARE. The softw
are, netw

ork 
services or other products other than SO

FTW
ARE upon 

w
hich the SO

FTW
ARE’S perform

ance depends m
ight be 

interrupted or discontinued at the discretion of the suppliers 
(softw

are suppliers, service suppliers, or SO
N

Y). SO
N

Y 
and such suppliers do not w

arrant that the SO
FTW

ARE, 
netw

ork services, contents or other products w
ill continue 

to be available, or w
ill operate w

ithout interruption or 
m

odification. 

EXCLU
D

ED
 SO

FTW
ARE AN

D
 O

PEN
 SO

U
RCE 

CO
M

PO
N

EN
TS

N
otw

ithstanding the foregoing lim
ited license grant, you 

acknow
ledge that the SO

FTW
ARE m

ay include EXCLU
D

ED
 

SO
FTW

ARE. Certain EXCLU
D

ED
 SO

FTW
ARE m

ay be 
covered by open source softw

are licenses (“O
pen Source 

Com
ponents”), w

hich m
eans any softw

are licenses approved 
as open source licenses by the O

pen Source Initiative or any 
substantially sim

ilar licenses, including but not lim
ited to any 

license that, as a condition of distribution of the softw
are 

licensed under such license, requires that the distributor 
m

ake the softw
are available in source code form

at. If and 
to the extent disclosure is required, please visit w

w
w

.sony.
com

/linux or other SO
N

Y-designated w
eb site for a list of 

applicable O
PEN

 SO
U

RCE CO
M

PO
N

EN
TS included in the 

SO
FTW

ARE from
 tim

e to tim
e, and the applicable term

s and 
conditions governing its use. Such term

s and conditions 
m

ay be changed by the applicable third party at any tim
e 

w
ithout liability to you. To the extent required by the licenses 

covering EXCLU
D

ED
 SO

FTW
ARE, the term

s of such licenses 
w

ill apply in lieu of the term
s of this EU

LA. To the extent the 
term

s of the licenses applicable to EXCLU
D

ED
 SO

FTW
ARE 

prohibit any of the restrictions in this EU
LA w

ith respect to 
such EXCLU

D
ED

 SO
FTW

ARE, such restrictions w
ill not apply 

to such EXCLU
D

ED
 SO

FTW
ARE. To the extent the term

s of 
the licenses applicable to O

pen Source Com
ponents require 

SO
N

Y to m
ake an offer to provide source code in connection 

w
ith the SO

FTW
ARE, such offer is hereby m

ade.

U
SE O

F SO
FTW

ARE W
ITH

 CO
PYRIG

H
TED

 
M

ATERIALS
The SO

FTW
ARE m

ay be capable of being used by you to 
view

, store, process and/or use content created by you and/
or third parties. Such content m

ay be protected by copyright, 
other intellectual property law

s, and/or agreem
ents. You 

agree to use the SO
FTW

ARE only in com
pliance w

ith all 
such law

s and agreem
ents that apply to such content. You 

acknow
ledge and agree that SO

N
Y m

ay take appropriate 
m

easures to protect the copyright of content stored, 
processed or used by the SO

FTW
ARE. Such m

easures 
include, but are not lim

ited to, counting the frequency of 
your backup and restoration through certain SO

FTW
ARE 

features, refusal to accept your request to enable restoration 
of data, and term

ination of this EU
LA in the event of your 

illegitim
ate use of the SO

FTW
ARE.

CO
N

TEN
T SERVICE

PLEASE ALSO
 N

O
TE TH

AT TH
E SO

FTW
ARE M

AY BE D
ESIG

N
ED

 
TO

 BE U
SED

 W
ITH

 CO
N

TEN
T AVAILABLE TH

RO
U

G
H

 O
N

E O
R 

M
O

RE CO
N

TEN
T SERVICES (“CO

N
TEN

T SERVICE”). U
SE O

F 
TH

E SERVICE AN
D

 TH
AT CO

N
TEN

T IS SU
BJECT TO

 TH
E TERM

S 
O

F SERVICE O
F TH

AT CO
N

TEN
T SERVICE. IF YO

U
 D

ECLIN
E 

TO
 ACCEPT TH

O
SE TERM

S, YO
U

R U
SE O

F TH
E SO

FTW
ARE 

W
ILL BE LIM

ITED
. You acknow

ledge and agree that certain 
content and services available through the SO

FTW
ARE 

m
ay be provided by third parties over w

hich SO
N

Y has 
no control. U

SE O
F TH

E CO
N

TEN
T SERVICE REQ

U
IRES AN

 
IN

TERN
ET CO

N
N

ECTIO
N

. TH
E CO

N
TEN

T SERVICE M
AY BE 

D
ISCO

N
TIN

U
ED

 AT AN
Y TIM

E.

IN
TERN

ET CO
N

N
ECTIVITY AN

D
 TH

IRD
 PARTY 

SERVICES
You acknow

ledge and agree that access to certain 
SO

FTW
ARE features m

ay require an Internet connection 
for w

hich you are solely responsible. Further, you are solely 
responsible for paym

ent of any third party fees associated 
w

ith your Internet connection, including but not lim
ited 

to Internet service provider or airtim
e charges. O

peration 
of the SO

FTW
ARE m

ay be lim
ited or restricted depending 

on the capabilities, bandw
idth or technical lim

itations of 
your Internet connection and service. The provision, quality 
and security of such Internet connectivity are the sole 
responsibility of the third party providing such service. 

EXPO
RT AN

D
 O

TH
ER REG

U
LATIO

N
S

You agree to com
ply w

ith all applicable export and re-export 
restrictions and regulations of the area or country in w

hich 
you reside, and not to transfer, or authorize the transfer, 
of the SO

FTW
ARE to a prohibited country or otherw

ise in 
violation of any such restrictions or regulations. 

H
IG

H
 RISK ACTIVITIES

The SO
FTW

ARE is not fault-tolerant and is not designed, 
m

anufactured or intended for use or resale as on-line control 
equipm

ent in hazardous environm
ents requiring fail-safe 

perform
ance, such as in the operation of nuclear facilities, 

aircraft navigation or com
m

unication system
s, air traffic 

control, direct life support m
achines, or w

eapons system
s, 

in w
hich the failure of the SO

FTW
ARE could lead to death, 

personal injury, or severe physical or environm
ental dam

age 
(“H

IG
H

 RISK ACTIVITIES”). SO
N

Y, each of the TH
IRD

-PARTY 
SU

PPLIERS, and each of their respective affiliates specifically 
disclaim

 any express or im
plied w

arranty, duty or condition 
of fitness for H

IG
H

 RISK ACTIVITIES. 

EXCLU
SIO

N
 O

F W
ARRAN

TY O
N

 SO
FTW

ARE
You acknow

ledge and agree that use of the SO
FTW

ARE is 
at your sole risk and that you are responsible for use of the 
SO

FTW
ARE. The SO

FTW
ARE is provided “AS IS,” w

ithout 
w

arranty, duty or condition of any kind.

SO
N

Y AN
D

 EACH
 O

F TH
E TH

IRD
-PARTY SU

PPLIERS (for 
purposes of this Section, SO

N
Y and each of the TH

IRD
-

PARTY SU
PPLIERS shall be collectively referred to as 

“SO
N

Y”) EXPRESSLY D
ISCLAIM

 ALL W
ARRAN

TIES, D
U

TIES 
O

R CO
N

D
ITIO

N
S, EXPRESS O

R IM
PLIED

, IN
CLU

D
IN

G
, 

BU
T N

O
T LIM

ITED
 TO

, TH
E IM

PLIED
 W

ARRAN
TIES O

F 
M

ERCH
AN

TABILITY, N
O

N
IN

FRIN
G

EM
EN

T AN
D

 FITN
ESS FO

R 
A PARTICU

LAR PU
RPO

SE. SO
N

Y D
O

ES N
O

T W
ARRAN

T O
R 

M
AKE AN

Y CO
N

D
ITIO

N
S O

R REPRESEN
TATIO

N
S (A) TH

AT 
TH

E FU
N

CTIO
N

S CO
N

TAIN
ED

 IN
 AN

Y O
F TH

E SO
FTW

ARE 
W

ILL M
EET YO

U
R REQ

U
IREM

EN
TS O

R TH
AT TH

EY W
ILL 

BE U
PD

ATED
, (B) TH

AT TH
E O

PERATIO
N

 O
F AN

Y O
F TH

E 
SO

FTW
ARE W

ILL BE CO
RRECT O

R ERRO
R-FREE O

R TH
AT AN

Y 
D

EFECTS W
ILL BE CO

RRECTED
, (C) TH

AT TH
E SO

FTW
ARE 

W
ILL N

O
T D

AM
AG

E AN
Y O

TH
ER SO

FTW
ARE, H

ARD
W

ARE 
O

R D
ATA, (D

) TH
AT AN

Y SO
FTW

ARE, N
ETW

O
RK SERVICES 

(IN
CLU

D
IN

G
 TH

E IN
TERN

ET) O
R PRO

D
U

CTS (O
TH

ER 
TH

AN
 TH

E SO
FTW

ARE) U
PO

N
 W

H
ICH

 TH
E SO

FTW
ARE’S 

PERFO
RM

AN
CE D

EPEN
D

S W
ILL CO

N
TIN

U
E TO

 BE AVAILABLE, 
U

N
IN

TERRU
PTED

 O
R U

N
M

O
D

IFIED
, AN

D
 (E) REG

ARD
IN

G
 

TH
E U

SE O
R TH

E RESU
LTS O

F TH
E U

SE O
F TH

E SO
FTW

ARE 
IN

 TERM
S O

F ITS CO
RRECTN

ESS, ACCU
RACY, RELIABILITY, O

R 
O

TH
ERW

ISE.

N
O

 O
RAL O

R W
RITTEN

 IN
FO

RM
ATIO

N
 O

R AD
VICE G

IVEN
 

BY SO
N

Y O
R AN

 AU
TH

O
RIZED

 REPRESEN
TATIVE O

F SO
N

Y 
SH

ALL CREATE A W
ARRAN

TY, D
U

TY O
R CO

N
D

ITIO
N

 O
R 

IN
 AN

Y W
AY IN

CREASE TH
E SCO

PE O
F TH

IS W
ARRAN

TY. 
SH

O
U

LD
 TH

E SO
FTW

ARE PRO
VE D

EFECTIVE YO
U

 ASSU
M

E 
TH

E EN
TIRE CO

ST O
F ALL N

ECESSARY SERVICIN
G

, REPAIR 
O

R CO
RRECTIO

N
. SO

M
E JU

RISD
ICTIO

N
S D

O
 N

O
T ALLO

W
 

TH
E EXCLU

SIO
N

 O
F IM

PLIED
 W

ARRAN
TIES, SO

 TH
ESE 

EXCLU
SIO

N
S M

AY N
O

T APPLY TO
 YO

U
.
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LIM
ITATIO

N
 O

F LIABILITY
SO

N
Y AN

D
 EACH

 O
F TH

E TH
IRD

-PARTY SU
PPLIERS (for 

purposes of this Section, SO
N

Y and each of the TH
IRD

-PARTY 
SU

PPLIERS shall be collectively referred to as “SO
N

Y”) SH
ALL 

N
O

T BE LIABLE FO
R AN

Y IN
CID

EN
TAL O

R CO
N

SEQ
U

EN
TIAL 

D
AM

AG
ES FO

R BREACH
 O

F AN
Y EXPRESS O

R IM
PLIED

 
W

ARRAN
TY, BREACH

 O
F CO

N
TRACT, N

EG
LIG

EN
CE, STRICT 

LIABILITY O
R U

N
D

ER AN
Y O

TH
ER LEG

AL TH
EO

RY RELATED
 

TO
 TH

E SO
FTW

ARE, IN
CLU

D
IN

G
, BU

T N
O

T LIM
ITED

 TO
, AN

Y 
D

AM
AG

ES ARISIN
G

 O
U

T O
F LO

SS O
F PRO

FITS, LO
SS O

F 
REVEN

U
E, LO

SS O
F D

ATA, LO
SS O

F U
SE O

F TH
E SO

FTW
ARE 

O
R AN

Y ASSO
CIATED

 H
ARD

W
ARE, D

O
W

N
 TIM

E AN
D

 U
SER’S 

TIM
E, EVEN

 IF AN
Y O

F TH
EM

 H
AVE BEEN

 AD
VISED

 O
F TH

E 
PO

SSIBILITY O
F SU

CH
 D

AM
AG

ES. IN
 AN

Y CASE, EACH
 AN

D
 

ALL O
F TH

EIR AG
G

REG
ATE LIABILITY U

N
D

ER AN
Y PRO

VISIO
N

 
O

F TH
IS EU

LA SH
ALL BE LIM

ITED
 TO

 TH
E AM

O
U

N
T 

ACTU
ALLY PAID

 FO
R TH

E PRO
D

U
CT. SO

M
E JU

RISD
ICTIO

N
S 

D
O

 N
O

T ALLO
W

 TH
E EXCLU

SIO
N

 O
R LIM

ITATIO
N

 O
F 

IN
CID

EN
TAL O

R CO
N

SEQ
U

EN
TIAL D

AM
AG

ES, SO
 TH

E ABO
VE 

EXCLU
SIO

N
 O

R LIM
ITATIO

N
 M

AY N
O

T APPLY TO
 YO

U
.

CO
N

SEN
T TO

 U
SE O

F N
O

N
-PERSO

N
AL 

IN
FO

RM
ATIO

N
, LO

CATIO
N

 D
ATA, D

ATA SECU
RITY

You acknow
ledge and agree that SO

N
Y and its affiliates, 

partners and agents m
ay read, collect, transfer, process and 

store certain inform
ation collected from

 the SO
FTW

ARE, 
including but not lim

ited to inform
ation about (i) the 

SO
FTW

ARE and (ii) the softw
are applications, contents and 

peripheral devices that interact w
ith your cam

corder and the 
SO

FTW
ARE (“Inform

ation”). Inform
ation includes, but is not 

lim
ited to: (1) unique identifiers relating to your cam

corder 
and its com

ponents; (2) perform
ance of the cam

corder, the 
SO

FTW
ARE and their com

ponents; (3) configurations of your 
cam

corder, the SO
FTW

ARE and the softw
are applications, 

contents and peripheral devices that interact w
ith the 

cam
corder and the SO

FTW
ARE; (4) use and frequency of use 

of the functions of (x) the SO
FTW

ARE, and (y) the softw
are 

applications, contents and peripheral devices that interact 
w

ith the SO
FTW

ARE; and (5) location data, as indicated 
below

. SO
N

Y and its affiliates, partners and agents m
ay use 

and disclose Inform
ation subject to applicable law

s in order 
to im

prove its products and services or to provide products 
or services to you. Such uses include, but are not lim

ited 
to: (a) adm

inistering the functionalities of the SO
FTW

ARE; 
(b) to im

prove, service, update or upgrade the SO
FTW

ARE; 
(c) im

proving, developing and enhancing the current and 
future products and services of SO

N
Y and other parties; (d) 

to provide you w
ith inform

ation about the products and 
services offered by SO

N
Y and other parties; (e) com

plying 
w

ith applicable law
s or regulations; and (f) to the extent 

offered, providing you w
ith location-based services of SO

N
Y 

and other parties, as indicated below
. In addition, SO

N
Y 

retains the right to use Inform
ation to protect itself and third 

parties from
 illegal, crim

inal or harm
ful conduct.

Certain services available through the SO
FTW

ARE m
ay rely 

upon location inform
ation, including, but not lim

ited to, the 
geographic location of the cam

corder. You acknow
ledge 

that for the purpose of providing such services, SO
N

Y, 
the TH

IRD
-PARTY SU

PPLIERS or their partners m
ay collect, 

archive, process and use such location data, and that such 
services are governed by the privacy policies of SO

N
Y or 

such third party. By using any such services, you agree that 
you have review

ed the privacy policies applicable to such 
services and consent to such activities. 

SO
N

Y, its affiliates, partners and agents w
ill not intentionally 

use Inform
ation to personally identify the ow

ner or user of 
the SO

FTW
ARE w

ithout your know
ledge or consent. Any use 

of Inform
ation w

ill be in accordance w
ith the privacy policies 

of SO
N

Y or such third party. Please contact applicable 
contact address of each area or country for SO

N
Y’s current 

privacy policy.

Please contact applicable third parties for privacy policies 
relating to personally identifiable and other inform

ation 
you provide w

hen you use or access third party softw
are or 

services.

Inform
ation m

ay be processed, stored or transferred to 
SO

N
Y, its affiliates or agents w

hich are located in countries 
outside of your country of residence. D

ata protection and 
inform

ation privacy law
s in certain countries m

ay not offer 
the sam

e level of protection as your country of residence and 
you m

ay have few
er legal rights in relation to Inform

ation 
processed and stored in, or transferred to, such countries. 
SO

N
Y w

ill use reasonable efforts to take appropriate 
technical and organizational steps to prevent unauthorized 
access to or disclosure of Inform

ation, but does not w
arrant it 

w
ill elim

inate all risk of m
isuse of such Inform

ation.

AU
TO

M
ATIC U

PD
ATE FEATU

RE 
From

 tim
e to tim

e, SO
N

Y or the TH
IRD

-PARTY SU
PPLIERS m

ay 
autom

atically update or otherw
ise m

odify the SO
FTW

ARE, 
including, but not lim

ited to, for purposes of enhancem
ent 

of security functions, error correction and im
provem

ent of 
functions, at such tim

e as you interact w
ith SO

N
Y’s or third 

parties’ servers, or otherw
ise. Such updates or m

odifications 
m

ay delete or change the nature of features or other 
aspects of the SO

FTW
ARE, including, but not lim

ited to, 
functions you m

ay rely upon. You acknow
ledge and agree 

that such activities m
ay occur at SO

N
Y’s sole discretion and 

that SO
N

Y m
ay condition continued use of the SO

FTW
ARE 

upon your com
plete installation or acceptance of such 

update or m
odifications. Any updates/m

odifications shall be 
deem

ed to be, and shall constitute part of, the SO
FTW

ARE 
for purposes of this EU

LA. By acceptance of this EU
LA, you 

consent to such update/ m
odification. 

EN
TIRE AG

REEM
EN

T, W
AIVER, SEVERABILITY 

This EU
LA and SO

N
Y’s privacy policy, each as am

ended and 
m

odified from
 tim

e to tim
e, together constitute the entire 

agreem
ent betw

een you and SO
N

Y w
ith respect to the 

SO
FTW

ARE. The failure of SO
N

Y to exercise or enforce any 
right or provision of this EU

LA shall not constitute a w
aiver of 

such right or provision. If any part of this EU
LA is held invalid, 

illegal, or unenforceable, that provision shall be enforced to 
the m

axim
um

 extent perm
issible so as to m

aintain the intent 
of this EU

LA, and the other parts w
ill rem

ain in full force and 
effect. 

G
O

VERN
IN

G
 LAW

 AN
D

 JU
RISD

ICTIO
N

The U
nited N

ations Convention on Contracts for the 
International Sale of G

oods shall not apply to this EU
LA. 

This EU
LA shall be governed by the law

s of Japan, w
ithout 

regards to conflict of law
s provisions. Any dispute arising out 

of this EU
LA shall be subject to the exclusive venue of the 

Tokyo D
istrict Court in Japan, and the parties hereby consent 

to the venue and jurisdiction of such courts.

EQ
U

ITABLE REM
ED

IES
N

otw
ithstanding anything contained in this EU

LA to the 
contrary, you acknow

ledge and agree that any violation 
of or non-com

pliance w
ith this EU

LA by you w
ill cause 

irreparable harm
 to SO

N
Y, for w

hich m
onetary dam

ages 
w

ould be inadequate, and you consent to SO
N

Y obtaining 
any injunctive or equitable relief that SO

N
Y deem

s necessary 
or appropriate in such circum

stances. SO
N

Y m
ay also take 

any legal and technical rem
edies to prevent violation of 

and/or to enforce this EU
LA, including, but not lim

ited to, 
im

m
ediate term

ination of your use of the SO
FTW

ARE, if 
SO

N
Y believes in its sole discretion that you are violating or 

intend to violate this EU
LA. These rem

edies are in addition 
to any other rem

edies SO
N

Y m
ay have at law

, in equity or 
under contract.

TERM
IN

ATIO
N

W
ithout prejudice to any of its other rights, SO

N
Y m

ay 
term

inate this EU
LA if you fail to com

ply w
ith any of its term

s. 
In case of such term

ination, you m
ust: (i) cease all use, and 

destroy any copies, of the SO
FTW

ARE; (ii) com
ply w

ith the 
requirem

ents in the section below
 entitled “Your Account 

Responsibilities”.

AM
EN

D
M

EN
T

SO
N

Y RESERVES TH
E RIG

H
T TO

 AM
EN

D
 AN

Y O
F TH

E TERM
S 

O
F TH

IS EU
LA AT ITS SO

LE D
ISCRETIO

N
 BY PO

STIN
G

 N
O

TICE 
O

N
 A SO

N
Y D

ESIG
N

ATED
 W

EB SITE, BY EM
AIL N

O
TIFICATIO

N
 

TO
 AN

 EM
AIL AD

D
RESS PRO

VID
ED

 BY YO
U

, BY PRO
VID

IN
G

 
N

O
TICE AS PART O

F TH
E PRO

CESS IN
 W

H
ICH

 YO
U

 O
BTAIN

 
U

PG
RAD

ES/ U
PD

ATES O
R BY AN

Y O
TH

ER LEG
ALLY 

RECO
G

N
IZABLE FO

RM
 O

F N
O

TICE. If you do not agree to 

the am
endm

ent, you should prom
ptly contact SO

N
Y for 

instructions. Your continued use of the SO
FTW

ARE after 
the effective date of any such notice shall be deem

ed your 
agreem

ent to be bound by such am
endm

ent. 

TH
IRD

-PARTY BEN
EFICIARIES

Each TH
IRD

-PARTY SU
PPLIER is an express intended third-

party beneficiary of, and shall have the right to enforce, each 
provision of this EU

LA w
ith respect to the SO

FTW
ARE of such 

party.

Should you have any questions concerning this EU
LA, you 

m
ay contact SO

N
Y by w

riting to SO
N

Y at applicable contact 
address of each area or country.

Copyright ©
 2012 Sony Corporation.
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Open Software Licenses

O
n the basis of license contracts betw

een Sony 
and the softw

are copyright holders, this product 
uses open softw

are.
To m

eet the requirem
ents of the softw

are 
copyright holders, Sony is obligated to inform

 you 
of the content of these licenses.
For the content of these licenses, see “License1.
pdf” in the “License” folder of the supplied CD

-
RO

M
.

Trademarks

ˎˎ XD
CAM

 is a tradem
ark of Sony Corporation.

ˎˎ XAVC and 
 are registered tradem

arks of 
Sony Corporation.
ˎˎ Android and G

oogle Chrom
e are tradem

arks or 
registered tradem

arks of G
oogle, Inc.

ˎˎ M
icrosoft and W

indow
s are either registered 

tradem
arks or tradem

arks of M
icrosoft 

Corporation in the U
nited States and/or other 

countries.
ˎˎ Apple, M

acintosh, Safari, and iPhone and their 
logos are tradem

arks or registered tradem
arks 

of Apple Inc. registered in the U
S and other 

countries.
ˎˎ The term

s H
D

M
I and H

D
M

I H
igh-D

efinition 
M

ultim
edia Interface, and the H

D
M

I Logo are 
tradem

arks or registered tradem
arks of H

D
M

I 
Licensing LLC in the U

nited States and other 
countries.
ˎˎ W

i-Fi, the W
i-Fi logo, and W

i-Fi Protected Setup 
are tradem

arks or registered tradem
arks of W

i-Fi 
Alliance.
ˎˎ The N

-M
ark is a tradem

ark or registered 
tradem

ark of N
FC Forum

, Inc. in the U
nited 

States and in other countries.
ˎˎ All system

 nam
es and product nam

es are 
registered tradem

arks or tradem
arks of their 

respective ow
ners. Tradem

arked item
s are not 

indicated by ® or ™ sym
bols in this docum

ent.


